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About this book

This book provides instructions for using IBM® Director 4.20 for
systems-management tasks. IBM Director consists of the following tools to meet
your systems-management needs:

* IBM Director Console is the graphical user interface (GUI) for IBM Director
Server. Using IBM Director Console, you can conduct comprehensive systems
management using either a drop-and-drag action or a single click.

* IBM Director command-line interface (dircli) is the command-line interface for
IBM Director Server. You can use a command-line prompt to access, control, and
gather information from IBM Director Server.

This documentation also provides planning and implementation information for
event management.

Conventions and terminology

These notices are designed to highlight key information:
Note: These notices provide important tips, guidance, or advice.

Important: These notices provide information or advice that might help you avoid
inconvenient or difficult situations.

Attention: These notices indicate possible damage to programs, devices, or data.
An attention notice appears before the instruction or situation in which damage
can occur.

Related information
This topic provides links to additional information related to IBM Director.
IBM Director resources on the World Wide Web
The following Web pages provide resources for understanding, using, and

troubleshooting IBM Director and other systems-management tools.

IBM Director information center
publib.boulder.ibm.com/infocenter /eserver /|
v1r2 /topic/diricinfo/ fqu_main.htm]|

Updated periodically, the IBM Director information center contains the
most up-to-date documentation available on a wide range of topics.

IBM Director Web site on ibm.com®
www.ibm.com /servers /eserver/xseries /|
systems_management/ibm_director/|

The IBM Director Web site on ibm.com has links to downloads and
documentation for all currently supported versions of IBM Director.
Information on this site includes:

e IBM Director 5.10 - downloads and documentation
e IBM Director 4.22 - downloads and documentation

© Copyright IBM Corp. 1999, 2005 xi
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¢ IBM Director 4.22 Upward Integration Modules (UIMs) - downloads and
documentation

e IBM Director 4.21 - downloads and documentation
e IBM Director 4.20 - downloads and documentation

¢ IBM Director Hardware and Software Compatibility document - lists
supported @server and IBM xSeries® systems, as well as all supported
operating systems. It is updated every 6 to 8 weeks.

e Printable documentation for IBM Director - available in Portable
Document Format (PDF) in several languages

IBM Systems Software information center
www.ibm.com /servers/library /infocenter /|

This Web page provides information about IBM Virtualization Engine ",
IBM Director, and other topics.

IBM ServerProven® page
www.ibm.com/pc/us/compat/index.html]|

This Web page provides information about IBM xSeries, BladeCenter®, and
IntelliStation® hardware compatibility with IBM Director.

IBM Systems Management Software: Download/Electronic Support page
www.ibm.com/servers/eserver /xseries /|
Systems_management/ibm_director/|

Use this Web page to download IBM systems-management software,
including IBM Director. Check this Web page regularly for new IBM
Director releases and updates.

IBM Servers
fwww.ibm.com /servers /|

This Web page on ibm.com links to information, downloads, and IBM
Director extensions such as Remote Deployment Manager, Capacity
Manager, Systems Availability and Software Distribution (Premium
Edition) for IBM servers:

» IBM BladeCenter

+ IBM iSeries

« IBM pSeries®

* IBM xSeries

+ IBM zSeries®

IBM Redbooks™

www.ibm.com /redbooks /|

You can download the following documents from the IBM Redbooks Web page.
You also might want to search this Web page for documents that focus on specific
IBM hardware; such documents often contain systems-management material.

Note: Be sure to note the date of publication and to determine the level of IBM
Director software to which the Redbooks publication refers.

* |Creating a Report of the Tables in the IBM Director 4.1 Database (TIPS0185)
« [IBM Director Security| (REDP-0417-00)

* |IBM eServer™ BladeCenter Systems Management with IBM Director V4.1 and Remotd
Deployment Manager V4.1{ (REDP-3776-00)

o |Implementing Systems Management Solutions using IBM Director] (SG24-6188)
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* |Integrating IBM Director with Enterprise Management Solutions| (5G24-5388)
* |Managing IBM TotalStorage® NAS with IBM Director] (SG24-6830)

* |Monitoring Redundant Uninterruptible Power Supplies Using IBM Director|
(REDP-3827-00)

Remote Supervisor Adapter

Remote Supervisor Adapter overview
www.ibm.com /support/docview.wss?uid=psg1 MIGR-4UKSMIL

This Web page includes links to the Remote Supervisor Adapter User’s Guide
and Remote Supervisor Adapter Installation Guide.

Remote Supervisor Adapter II overview
www.ibm.com /support/docview.wss?uid=psg IMIGR-50114

This Web page includes information about the Remote Supervisor Adapter
II.

Other documents

For planning purposes, the following documents might be of interest:
* |Planning and installation quide - IBM eServer BladeCenter (Type 8677)|
* |IBM Management Processor Command-Line Utility User’s Guide version 3.00|

How to send your comments

Your feedback is important in helping to provide the most accurate and highest
quality information. If you have any comments about this book or any other IBM
Director publication, use the form for reader’s comments is provided at the back of
this publication. If the form has been removed, you may address your comments
to:

International Business Machines Corporation
Design & Information Development
Department CGFA

PO Box 12195

Research Triangle Park, NC 27709-9990
USA.
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Chapter 1. Getting started

Introducing IBM Director

This topic provides an overview of IBM Director.

IBM Director is an integrated, easy-to-use suite of tools that provide you with
comprehensive systems-management capabilities to help realize maximum system
availability and lower IT costs. Its open, industry-standard design enables
heterogeneous-hardware management and broad operating-system support,
including most Intel® microprocessor-based systems and certain IBM @ server
System p5®, iSeries, pSeries, System 79® and zSeries servers.

IBM Director automates many of the processes that are required to manage
systems proactively, including capacity planning, asset tracking, preventive
maintenance, diagnostic monitoring, troubleshooting, and more. It has a graphical
user interface that provides easy access to both local and remote systems.

IBM Director can be used in environments with multiple operating systems and
integrated with robust workgroup and enterprise management software from IBM
(such as Tivoli® software), Computer Associates, Hewlett-Packard, Microsoft®,
NetlQ, and BMC Software.

IBM Director environment

IBM Director is designed to manage a complex environment that contains
numerous servers, desktop computers, workstations, mobile computers (notebook
computers), and assorted devices. IBM Director can manage up to 5000 Level-2
systems.

An IBM Director environment contains the following groups of hardware:

* One or more servers on which IBM Director Server is installed. Such servers are
called management servers.

* Servers, workstations, desktop computers, and mobile computers that are
managed by IBM Director. Such systems are called managed systems.

* Network devices, printers, or computers that have Simple Network Management
Protocol (SNMP) agents installed or embedded. Such devices are called SNMP
devices.

* Additional managed objects such as platforms and chassis. Collectively, all
managed systems, devices, and objects are referred to as managed objects.

[Figure 1 on page 2| shows the hardware in an IBM Director environment.
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Figure 1. Hardware in an IBM Director environment

Using IBM Director Console

You can use IBM Director Console to group managed objects, view associations,
start tasks, and set IBM Director options and preferences.

The IBM Director Console interface

This topic describes the main components of the IBM Director Console interface.

Before you begin using IBM Director Console, review the layout of its interface.

Console Tasks Associations Wiew Options Window  Help
- 2 @ & & K- m- -
‘%{_j ﬂnu Managed Objects : System Membership v
Mame | Operating System | Agent Architecture | Agent Type Agent Wer
B = s R=1= e e ) WTCT IS T WOy F T [ La¥]
Iﬂ & toxin.raleigh.ibm... B AK™ 5.3 FowverPC
@, & vLINA 30- Microsoft Windows XP™ 51 1432
@, B KAYAMATH Microsoft Windows Server 2003™ 52 432
3 @ & REERTRAM Microsoft Windows 2000™ 5.0 1432 4
@ & barbuda.raleigh.i.. [EM AK™ 5.3 FoweerP
% ACEBLDIL Microsoft Windows 2000™ 5.0 Agent 21
% ACEBLD-IN Microsoft Windows 2000™ 5.0 Agent 211
% ACEBLDKM Wicrosoft Windows 2000™ 5.0 Agent 2.1
% & dyn9044206162 . Agentless
% Ready Host: IDWORLD User ID: IDWORLDisysadmin 56 objects

Figure 2. IBM Director Console

Along the top of the IBM Director Console interface is both a menu and a toolbar.
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Below the menu and toolbar, one, two, or three panes will be visible. From left to
right, these are:

* Groups

* Group contents (pane title indicates selected group)

* Tasks

Below the panes is the marquee area and hardware-status alert display. The
ticker-tape messages scroll across the marquee area. The hardware-status alert
display is located in the bottom-right corner of the interface.

At the bottom of the IBM Director Console interface is a status bar indicating the
ready or busy status of IBM Director, the host and login information for IBM
Director Server, and the number of managed objects in the Group Contents pane.

IBM Director Console is usually accessed on the management server. On
Windows® management servers, an additional, and separate, Server Status icon
displays the ready or busy status of IBM Director Server in the Windows system
tray.

Note: Icons in the Windows tray, including the IBM Director Server Status icon,
may disappear when a user selects the Windows High Contrast display. To
enable display of the Server Status icon after selecting the high contrast
display, select All Programs »> Startup » Server Status from the Start menu.

IBM Director Console toolbar

This topic describes each of the icons on the IBM Director Console.

Along the top of the IBM Director Console interface is a toolbar containing nine
icons.

Y- 4 i %

Figure 3. IBM Director Console toolbar

From left to right, the icons are briefly described below:

Discover
Clicking the button for this icon starts discovery of all systems and
devices. Clicking the menu arrow for this icon allows you to select a type
of system or device to discover.

Message Browser
Clicking the button for this icon opens the Message Browser window.

User Administration
Clicking the button for this icon opens the User Administration window.

Event Action Plans
Clicking the button for this icon opens the Event Action Plan Builder
window. Clicking the menu arrow for this icon allows you to select the
Event Action Plan Wizard, event logging options, or help for event action
plans.

Scheduler
Clicking the button for this icon opens the Scheduler window. Clicking the
menu arrow for this icon allows you to open help for scheduler.
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Inventory
Clicking the button for this icon opens the Inventory Query Browser
window. Clicking the menu arrow for this icon allows you to build a
custom query, edit the software dictionary, collect inventory, create custom
collections, create or view inventory monitors, or open help for inventory.

Resource Monitors
Clicking the button for this icon opens the Resource Monitors window.
Clicking the menu arrow for this icon allows you to import a plan file,
open the All Available Recordings or All Available Thresholds window, or
open help for resource monitors.

Software Distribution
Clicking the button for this icon opens the Software Distribution Manager
window. Clicking the menu arrow for this icon allows you to manage file
distribution servers, view package history, create a package category, open
a software distribution package, or open help for software distribution.

Remote Control
Clicking the button for this icon opens the Remote Control window.
Clicking the menu arrow for this icon allows you to open help for remote
control.

Panes in IBM Director Console

The IBM Director Console interface includes three panes: Groups, Group Contents,
and Tasks.

You can resize the panes by dragging the borders between them. You can hide
either the Groups or Tasks pane by clicking on the border between that pane and
the Group Contents pane.

Note: The Group Contents pane may not be hidden.

Groups
The Groups pane lists all the groups available, including the default
groups and any groups you have defined.

* Clicking a group selects that group for certain tasks performed from the
toolbar or the menu. It also selects that group in the Group Contents
pane.

* Right-clicking some groups also displays a context menu allowing tasks
to be performed on the group.

Group Contents

The Group Contents pane lists the managed objects included in the group

selected in the Groups pane. The title of the Group Contents pane indicates

which group is selected.

* Clicking the title opens a menu from which you can select a group to
display.

* Clicking a listed object selects that object for certain tasks performed
from the toolbar or the menu.

* Right-clicking an object selects that object and displays a context menu
allowing tasks to be performed on the object.

The icon for each managed object indicates both the type of managed
object and its online status: icons for online objects appear in color, while
icons for offline objects appear in gray.
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A padlock icon beside a managed object indicates that the object is secured
and inventory information about the object cannot be collected. To request
access to the object, right-click the managed object and click Request
Access. By providing a valid user name that has local administrative rights
to that managed object and password, you can access the system.

Notes:

1. (BladeCenter chassis and physical platforms only) The padlock
icon is displayed if a valid login profile does not exist for the
service processor. You can access the system using the Request
Access action as above.

2. (ISMP systems only) You cannot log in to an ISMP directly, as it
lacks a userid and password. Instead, connect out-of-band to an
ISMP installed on an ASM interconnect network through a
Remote Supervisor Adapter or Remote Supervisor Adapter II
serving as the ASM gateway.

3. (ASM processor systems only) Use the Management Processor
Assistant to configure an out-of-band path to the ASM
processor system, then change the userid and password to
request access the physical platform using IBM Director
Console.

Tasks The Tasks pane lists tasks which can be performed in IBM Director.

Note: Although the list of tasks in the Task pane is static, not all tasks are
available for all groups or managed objects.

Right-clicking blank space in any pane displays a context menu from which you
can change the pane’s appearance or sorting, or perform tasks specific to that pane.
For example, in the Group Contents pane you can create new managed objects
manually, find and view objects, or perform actions on the selected group.

Working with tables

This topic describes general procedures for viewing tabular information in IBM
Director Console.

In IBM Director Console, information is often displayed in tables. You can
customize the display of data in many of these tables in several ways.

Note: Not all of these actions may be available for all tabular views. These actions
must be performed with a mouse or other pointing device, and are not
available through the keyboard.

Sort table data on a column

Click a column header to sort the data in the table by the values in that

column. Click the header again to change the sort order.

¢ An upward-pointing triangle symbol indicates the column is sorted in
ascending order

* A downward-pointing triangle symbol indicates the column is sorted in
descending order

* Some columns may have additional sort options that are displayed as
parenthetical text in the column header

Resize table columns
Drag the border of a table column heading to resize it.
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Rearrange table columns
Drag a table column heading left or right to a new column location to
rearrange table columns.

In addition, the details view of the Group contents pane in the main IBM Director
Console window may be customized by selecting what columns are displayed.
Right-click a column heading and select Customize columns. The Console
Preferences window opens to the Details View Preferences page. Select the
columns you wish to view, then click OK.

Starting tasks

This topic describes how to start tasks in IBM Director.

You can start most tasks in IBM Director in four ways:

* Dragging a task from the tasks pane onto a managed object (or a managed
group, in some cases)

* Dragging a managed object (or a managed group, in some cases) onto a task in
the tasks pane

* Right-clicking a managed object (or managed group, in some cases)

* Selecting the managed object or group, then selecting a task from the menu bar

Throughout this documentation, only dragging a task onto a managed object or
group is explained as the method of starting tasks, although you can use any of
the methods.

Some IBM Director functions, such as the Event Action Plan Builder and Scheduler,
may be started either from the menu bar or from the toolbar.

Note: When IBM Director Console is processing a task, the hourglass is displayed
for that window and you cannot use the mouse to work with the window.
Although it might be possible to work with the window using key strokes,
do not do so.
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Chapter 2. Installing ServeRAID Manager

This topic describes the general procedure for installing the ServeRAID™ Manager
extension for IBM Director 5.10.

ServeRAID Manager may be installed on both Windows and Linux® platforms.
Installing ServeRAID Manager is performed in several steps, each of which is
described in a topic in this section.

1. Download the ServeRAID Manager extension.

a. In a Web browser, navigate to the following Web site:
www.ibm.com/servers/eserver /xseries/|
systems_management/ibm_director/ I

b. Navigate to the ServeRAID Manager extension for your operating system,
and download the extension files to a temporary directory.

2. Install ServeRAID Manager on the management server.

Option Description

Windows server “Installing the ServeRAID Manager extension on a|
Windows server” on page 8|

Linux server “Installing the ServeRAID Manager extension on a Linux]
server” on page 9|

3. Optional: Install ServeRAID Manager user-interface components for IBM
Director Console on remote management consoles.

Option Description

Windows console “Installing the ServeRAID Manager extension on a|
Windows console” on page 10|

Linux console “Installing the ServeRAID Manager extension on a Linux|
console” on page 11|

Note: ServeRAID Manager user-interface components for IBM Director Console
are automatically installed on the management server when the
ServeRAID Manager server components are installed. It is not necessary
or possible to separately install ServeRAID Manager console components
on a management server.

4. Install ServeRAID Manager components for IBM Director Agent on managed

systems.

Option Description

Windows systems “Installing the ServeRAID Manager extension on a|
managed Windows system” on page 12

Linux systems “Installing the ServeRAID Manager extension on a|
managed Linux system” on page 13|

NetWare systems “Installing the ServeRAID Manager extension on a|
managed NetWare system” on page 14|

Note: ServeRAID Manager agent components are automatically installed on the
management server when the ServeRAID Manager server components
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are installed. It is not necessary or possible to separately install
ServeRAID Manager agent components on a management server.

Installing the ServeRAID Manager extension on a Windows server

This topic describes the procedure for installing the ServeRAID Manager extension
for IBM Director on a Windows management server.

Complete the following steps to install ServeRAID Manager on a Windows
management server:

1. Copy the downloaded installation files to a temporary directory on the
machine on which you will be performing the installation.

2. Close all applications, including any command-prompt windows.

3. Click Start » Run.

4. In the Run dialog, type the following command in the Open field and press
Enter:
download\raid\server\windows\serveraid_5.10_server_windows.exe

download represents the location to which the ServeRAID Manager download
package was unzipped.

5. In the first panel of the ServeRAID Manager Server InstallShield Wizard, click
Next.

6. In the second panel of the ServeRAID Manager Server InstallShield Wizard,
complete the following steps:

a. Ensure that the hard disk drive icon =] appears to the left of ServeRAID
Manager Server in the list box. If a different icon appears, click the icon
and select This feature, and all subfeatures, will be installed on local
hard drive from the menu.

b. Ensure that the hard disk drive icon =-] appears to the left of each of the
other features you wish to install. You can install the ServeRAID Manager
Agent, ServeRAID Manager Console, and IBM Management Station along
with ServeRAID Manager Server.

c. Click Next.

7. (Only if Management Station is being installed) In the next panel of the
ServeRAID Manager Server InstallShield Wizard, complete the following
steps:

a. Type the user name and password (enter twice for confirmation) for the
user for the ServeRAID Management Station service.

b. Click Next.

8. In the next panel of the ServeRAID Manager Server InstallShield Wizard, click
Install. A new panel displays the installation progress.

9. When installation has completed, click Finish.

10. In the dialog that appears, respond to the prompt to reboot the management
server. Click Yes to reboot immediately, or click No if you will reboot the
management server yourself.

The management server must be rebooted before the ServeRAID Manager

extension will operate. After installing the server components of the ServeRAID
Manager extension, you need to install the console components.
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Installing the ServeRAID Manager extension on a Linux server

This topic describes the procedure for installing ServeRAID Manager on a Linux
management server.

Complete the following steps to install ServeRAID Manager on a Linux
management server:

1.

Copy the downloaded installation files to a temporary directory on the machine
on which you will be performing the installation. The downloaded installation
files are contained in a tar file. Use the tar -x command to extract the contents
to a temporary directory.

Stop IBM Director. From a command prompt, type the following command and
press Enter:

/opt/ibm/director/bin/twgstop

Change to the directory in which the installation package is located. Type the
following command and press Enter:

cd /download/raid/server/linux/

download represents the location into which the ServeRAID Manager download
package was extracted.

Optional: To install the management station service on the Linux management
server, perform the following substeps.

The management station is used to administer IBM System Storage DS300 and
IBM System Storage DS400 devices. This step is only necessary if both of the
following conditions are true:

* You wish to manage IBM System Storage DS300 and IBM System Storage
DS400 devices using IBM Director

* You do not have the standalone version of ServeRAID Manager installed

If either of these conditions is not met, there is no need to install the
management station service.

Note: Although it is possible to install the management station service on a
system other than that on which IBM Director Server is installed, this is
not a recommended configuration, and is not documented here. To use
the standalone version of ServeRAID Manager, or for instructions for
installing the management station service on a different system than the
management server on which IBM Director Server is installed, refer to
the documentation and downloads available on the ServeRAID Web site
at www.ibm.com/pc/support/site.wss/MIGR-495PES.html.

a. List the directory contents. There should be several files named
serveraid-mgmt-version-build.os.i586.rpm, with version, build, and os
indicating the version number, build number, and operating system for the
package. Note the version and build numbers for the following step.

b. Type one of the following commands (substituting the actual values for
version and build) and press Enter:

Installation scenario Command

Performing a new rpm -ivh serveraid-mgmt-version-build.rhel33.1586.rpm
installation on Red Hat
Enterprise Linux AS, ES, and
WS, version 3.0 (Update 3
required)
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Installation scenario Command

Upgrading from a previous |rpm -Uvh --relocate

version on Red Hat /opt/ibm/director=/opt/IBM/director
Enterprise Linux AS, ES, and | serveraid-mgmt-version-build.rhel33.i586.rpm
WS, version 3.0 (Update 3
required)

Performing a new rpm -ivh serveraid-mgmt-version-build.rhel4.i586.rpm
installation on Red Hat
Enterprise Linux AS, ES, and
WS, version 4.0

Upgrading from a previous |rpm -Uvh --relocate

version on Red Hat /opt/ibm/director=/opt/IBM/director
Enterprise Linux AS, ES, and | serveraid-mgmt-version-build.rhel4.i586.rpm
WS, version 4.0

Performing a new rpm -ivh serveraid-mgmt-version-build.s1es8.i586.rpm
installation on SUSE LINUX
Enterprise Server 8

Upgrading from a previous |rpm -Uvh --relocate

version on SUSE LINUX /opt/ibm/director=/opt/IBM/director
Enterprise Server 8 serveraid-mgmt-version-build.sles8.1586.rpm
Performing a new rpm -ivh serveraid-mgmt-version-build.sles9.i586.rpm

installation on SUSE LINUX
Enterprise Server 9

Upgrading from a previous |rpm -Uvh --relocate
version on SUSE LINUX /opt/ibm/director=/opt/IBM/director
Enterprise Server 9 serveraid-mgmt-version-build.sles9.i1586.rpm

The installation progress is displayed.
5. Type one of the following commands and press Enter:

Installation scenario Command
Performing a new rpm -ivhRAIDLxServer-5.10-1.1386.rpm
installation

Upgrading from a previous |rpm -Uvh --relocate
version /opt/ibm/director=/opt/IBM/director
RAIDLxServer-5.10-1.1386.rpm

The installation progress is displayed.

6. Restart IBM Director Server. From a command prompt, type the following
command and press Enter:

/opt/ibm/director/bin/twgstart

The IBM Director ServeRAID Manager Server installation process installs the
server, console, and agent components of ServeRAID Manager on the management
server.

The management server must be rebooted before the ServeRAID Manager
extension will operate. After installing the server components of the ServeRAID
Manager extension, you need to install the console components.

Installing the ServeRAID Manager extension on a Windows console

This topic describes the procedure for installing the ServeRAID Manager extension
on a Windows management console.
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The ServeRAID Manager extension should be installed on the management server
before installing the console components of ServeRAID Manager.

Complete the following steps to install the ServeRAID Manager extension on a
Windows management console:

1. Copy the downloaded installation files to a temporary directory on the machine
on which you will be performing the installation.

2. Close IBM Director Console.
Click Start » Run.

4. In the Run dialog, type the following command in the Open field and press
Enter:

w

download\raid\console\windows\serveraid 5.10 console_windows.exe

download represents the location into which the ServeRAID Manager download
package was unzipped.

5. In the first panel of the ServeRAID Manager Console InstallShield Wizard, click
Next.

6. In the second panel of the ServeRAID Manager Console InstallShield Wizard,
complete the following steps:

a. Ensure that the hard disk drive icon =2-] appears to the left of ServeRAID
Manager Console in the list box. If a different icon appears, click the icon
and select This feature, and all subfeatures, will be installed on local hard
drive from the menu.

b. Click Next.

7. In the third panel of the ServeRAID Manager Console InstallShield Wizard,
click Install. A new panel displays the installation progress.

8. When installation has completed, click Finish.
9. Restart IBM Director Console.

After installing the console components of the extension, you need to install the
ServeRAID Manager Agent components on your managed systems.

Installing the ServeRAID Manager extension on a Linux console

This topic describes the procedure for installing ServeRAID Manager on a Linux
management console.

The ServeRAID Manager extension should be installed on the management server
before installing the console components of ServeRAID Manager.

Note: ServeRAID Manager user-interface components for IBM Director Console are
automatically installed on the management server when the ServeRAID
Manager server components are installed. It is not necessary or possible to
separately install ServeRAID Manager console components on a
management server.

Complete the following steps to install ServeRAID Manager on a Linux console:

1. Copy the downloaded installation files to a temporary directory on the machine
on which you will be performing the installation.

2. Close IBM Director Console.

3. Change to the directory in which the installation package is located. Type the
following command and press Enter:
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cd /download/raid/console/1inux/

download represents the location to which the ServeRAID Manager download
package was extracted.

4. Type one of the following commands and press Enter:

Installation scenario Command
Performing a new rpm -ivh RAIDLxConsole-5.10-1.7386.rpm
installation

Upgrading from a previous |rpm -Uvh --relocate
version /opt/ibm/director=/opt/IBM/director

RAIDLxConsole-5.10-1.1386.rpm

The installation progress is displayed.

5. Restart IBM Director Console.
6. Remove the CD from the CD-ROM drive.

After installing the console components of the extension, you need to install the
ServeRAID Manager Agent components on your managed systems.

Installing the ServeRAID Manager extension on a managed Windows

system

This topic describes the procedure for installing ServeRAID Manager on a
Windows managed system.

The following prerequisites apply to this installation:

ServeRAID Manager should be installed on the management server and
management console before installing the agent components of ServeRAID
Manager on managed systems.

IBM Director Agent should be installed on the managed system before installing
ServeRAID Manager.

Note: An alternative installation method is to use Update Assistant and Software

Distribution. For more information, refer to the "Creating software packages
to distribute” section of the IBM Director Systems Management Guide.

Complete the following steps to install ServeRAID Manager on a Windows
managed system:

1.

Copy the downloaded installation files to a temporary directory on the machine
on which you will be performing the installation. The downloaded installation
files are contained in a zip file. Use the unzip command to extract the contents
to a temporary directory.

Click Start » Run.

In the Run dialog, type the following command in the Open field and press
Enter:

download\raid\agent\windows\serveraid_5.10_agent_windows.exe

download represents the location to which the ServeRAID Manager download
package was extracted.

In the first panel of the ServeRAID Manager Agent InstallShield Wizard, click
Next.
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In the second panel of the ServeRAID Manager Agent InstallShield Wizard,
complete the following steps:

a. Ensure that the hard disk drive icon =] appears to the left of ServeRAID
Manager Agent in the list box. If a different icon appears, click the icon and
select This feature, and all subfeatures, will be installed on local hard
drive from the menu.

b. Click Next.

In the third panel of the ServeRAID Manager Agent InstallShield Wizard, click

Install. A new panel displays the installation progress.

When installation has completed, click Finish.

In the dialog that appears, respond to the prompt to reboot the managed
system. Click Yes to reboot immediately, or click No if you will reboot the
managed system yourself.

You must reboot the managed system before the ServeRAID Manager Agent will
operate.

Installing the ServeRAID Manager extension on a managed Linux

system

This topic describes the procedure for installing ServeRAID Manager on a Linux
managed system.

The following prerequisites apply to this installation:

ServeRAID Manager should be installed on the management server and
management console before installing the agent components of ServeRAID
Manager on managed systems.

IBM Director Agent should be installed on the managed system before installing
ServeRAID Manager.

Note: An alternative installation method is to use Update Assistant and Software

Distribution. For more information, refer to the "Creating software packages
to distribute” section of the IBM Director Systems Management Guide.

Complete the following steps to install ServeRAID Manager on a Linux managed
system:

1.

Copy the downloaded installation files to a temporary directory on the machine
on which you will be performing the installation. The downloaded installation
files are contained in a tar file. Use the tar -x command to extract the contents
to a temporary directory.

Change to the directory in which the installation package is located. Type the
following command and press Enter:

cd /download/raid/agent/1inux/

download represents the location to which the ServeRAID Manager download
package was extracted.

3. Type one of the following commands and press Enter:

Installation scenario Command

Performing a new rpm -ivhRAIDLxAg-5.10-1.1386.rpm
installation (32-bit agent)
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Installation scenario Command

Performing a new rpm -ivhRAIDLxAg-5.10-1.x86_64.rpm
installation (64-bit agent for
Opteron or EM64T)

Upgrading from a previous |rpm -Uvh --relocate
version (32-bit agent) /opt/ibm/director=/opt/IBM/director

RAIDLxAg-5.10-1.1386.rpm

Upgrading from a previous |rpm -Uvh --relocate
version (64-bit agent for /opt/ibm/director=/opt/IBM/director
Opteron or EM64T) RAIDLxAg-5.10-1.x86_64.rpm

The installation progress is displayed.

You must reboot the managed system before the ServeRAID Manager Agent will
operate.

Installing the ServeRAID Manager extension on a managed NetWare

system
1.
2.
3.
4.
5.
6.

14

This topic describes the procedure for installing the ServeRAID Manager extension
on a NetWare managed system.

The ServeRAID Manager extension should be installed on the management
server and management console before installing the agent components of the
ServeRAID Manager extension on managed systems.

IBM Director Agent should be installed on the managed system before installing
the ServeRAID Manager extension.

Note: To install the ServeRAID Manager extension, you must log on to the

NetWare server from a Windows workstation running the NetWare Client
for Windows. The SYS volume must be mapped as a drive to the system
running Windows. Also, you must have administrator or supervisor access
on the NetWare server.

Complete the following steps on the Windows workstation running NetWare Client
for Windows to install the ServeRAID Manager extension on a NetWare managed
system:

Copy the downloaded installation files to a temporary directory on the
Windows workstation on which you will be performing the installation.

Click Start » Run.

In the Run dialog, type the following command in the Open field and press
Enter:

download\raid\agent\windows\serveraid_5.10_agent_netware.exe

download represents the location to which the ServeRAID Manager extension
download package was saved.

If prompted for the language, select a language from the dropdown list and
click OK.

In the first panel of the IBM ServeRAID Manager Agent 5.10 Setup Wizard,
click Next.

In the second panel of the IBM ServeRAID Manager Agent 5.10 Setup Wizard,
complete the following steps:
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a. Select the mapped NetWare drive on which to install ServeRAID Manager
extension Agent.

b. Click Next.

7. In the third panel of the ServeRAID Manager extension Agent InstallShield
Wizard, click Install.

Note: ServeRAID Manager Agent is the only component in the list of
components to be installed, and should already be selected.
A new panel displays the installation progress.

8. When installation has completed, click Finish.
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Chapter 3. Using ServeRAID Manager

Introducing the ServeRAID Manager

You might want to review the following information before using the ServeRAID
Manager:

+ |Using the ServeRAID Manager interface]
» |Configuring the ServeRAID controller: the basic steps|
+ [What's new in the ServeRAID Manager|
* [IBM ServeRAID publications
» |Finding information on the World Wide Web)|

You can use the ServeRAID Manager to configure, administer, and monitor
controllers that are installed locally or remotely in your IBM xSeries servers.

The first time you start the ServeRAID Manager, it will display only your local
system. The local system is displayed in the Enterprise view "tree” and information
about the system is displayed in the right pane, in the Physical and Logical device
views.

Whenever you start the ServeRAID Manager after the first time, it will display an
unknown system icon @ for any remote systems that you have added. When the
ServeRAID Manager connects with the remote systems, it will update the status in
the tree.

For additional information, see the [[BM ServeRAID publications| on the IBM
ServeRAID Support CD.

More information
+ |Using the ServeRAID Manager in bootable-CD mode|
« |Working with systems in the ServeRAID Manager|

* [Monitoring systems over the network|
* [ServeRAID software features|

What’s new in the ServeRAID TM Manager

This release of the ServeRAID Manager has the following new features:

¢ Ability to manage FlashCopy backups of logical drive data in external storage
enclosures

About ServeRAID Manager

ServeRAID software features
You can use the ServeRAID software with the following controllers. Most advanced
features are available only with ServeRAID controllers.

ServeRAID features HostRAID ServeRAID- 8i | ServeRAID- ServeRAID- 7t | ServeRAID- ServeRAID- ServeRAID- 5i
controller 7K 6i/6i+ 6M

ROM Update Wizard No Yes Yes Yes Yes Yes Yes

ServeRAID Manager Yes Yes Yes Yes Yes Yes Yes

BIOS Configuration program | Yes Yes Yes Yes Yes Yes Yes
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ServeRAID features HostRAID ServeRAID- 8i | ServeRAID- ServeRAID- 7t | ServeRAID- ServeRAID- ServeRAID- 5i
controller 7K 6i/6i+ 6M

Comand-Line Tool Yes Yes Yes Yes Yes Yes Yes

IPSSEND FlashCopy function | No No Yes No Yes Yes No

(Windows XP Professional,

Windows 2000, Windows

Server 2003, and Windows

NT only)

IPSMON (NetWare only) No No Yes No Yes Yes Yes

Copy Back No Yes Yes No Yes Yes No

Clustering (Windows 2000 No No No No No Yes No

and Windows NT only)

Failover (Windows 2000 and | No No No No No Yes (Windows | No

Windows NT only) 2000 only)

RAID level-1, RAID level-1E | Yes (1 only) Yes Yes Yes (1 only) Yes Yes Yes

RAID level-0, RAID level-5 Yes (0 only) Yes Yes Yes Yes Yes Yes

RAID level-5E No No No No No No No

RAID level-5EE No Yes Yes No Yes Yes No

RAID level-6 No Yes No No No No No

RAID level-x0 No Yes Yes Yes (10 only) Yes Yes Yes

Integrated RAID

ServeRAID features controller ServeRAID-4 ServeRAID-3 ServeRAID-II

ServeRAID ROM Update Wizard No Yes Yes Yes

ServeRAID Manager Yes Yes Yes Yes

ServeRAID Mini-Configuration program No Yes Yes Yes

IPSSEND No Yes Yes Yes

IPSSEND FlashCopy function (Windows XP No Yes Yes Yes

Professional, Windows 2000, Windows Server

2003, and Windows NT only)

IPSMON (NetWare only) No Yes Yes Yes

Copy Back No No No No

Clustering (Windows 2000 and Windows NT No Yes Yes Yes

only)

Failover (Windows 2000 and Windows NT No Yes Yes Yes

only)

RAID level-1, RAID level-1E Yes (1 only) Yes Yes Yes

RAID level-0, RAID level-5 No Yes Yes Yes

RAID level-5E No Yes Yes No

RAID level-5EE No Yes ( except 4H) No No

RAID level-6 No No No No

RAID level-x0 No Yes No No

IBM ServeRAID-3 hardware features: The following table lists the hardware
features for the IBM ServeRAID-3 controllers:

Feature ServeRAID-3HB ServeRAID-3H ServeRAID-3L
Arrays (max.) 8 8 8
Battery-backup cache | Yes Optional No

Cache memory 32 MB 32 MB 4 MB

Hard disk drives 45 45 15

(max.)

Logical drives (max.) |8 8 8
Microprocessor 40 MHz 40 MHz 25 MHz
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Feature

ServeRAID-3HB

ServeRAID-3H

ServeRAID-3L

SCSI channels

3

3

1

SCSI transfer speed
(max.)

80 MB per sec.

80 MB per sec.

80 MB per sec.

Supported RAID
levels

0, 1, 5, Enhanced-1
(1E), and Enhanced-5
(5E)

0, 1, 5, Enhanced-1
(1E), and Enhanced-5
(5E)

0, 1, 5, Enhanced-1
(1E), and Enhanced-5
(5E)

System PCI data bus

64 bit

64 bit

32 bit

IBM ServeRAID-4 hardware features: The following tables list the hardware
features for the IBM ServeRAID-4 controllers:

Feature ServeRAID-4H ServeRAID-4Mx ServeRAID-4Lx
Arrays (max.) 8 8 8
Battery-backup cache | Yes Yes No

Cache memory 128 MB 64 MB 32 MB

Hard disk drives 60 30 15

(max.)

Logical drives (max.) |8 8 8
Microprocessor 266 MHz 100 MHz 100 MHz

SCSI channels 4 2 1

SCSI transfer speed
(max.)

160 MB per sec.

160 MB per sec.

160 MB per sec.

Supported RAID
levels

0, 1, 5, Enhanced-1
(1E), and Enhanced-5
(5E), 00, 10, 1E0, 50

0, 1, 5, Enhanced-1
(1E), and Enhanced-5
(5E), 00, 10, 1E0, 50

0, 1, 5, Enhanced-1
(1E), and Enhanced-5
(5E), 00, 10, 1E0, 50

System PCI data bus

64 bit at 33 MHz

64 bit at 33 to 66
MHz

64 bit at 33 to 66
MHz

Feature ServeRAID-4M ServeRAID-4L
Arrays (max.) 8 8
Battery-backup cache Yes No

Cache memory 64 MB 16 MB

Hard disk drives (max.) 30 15

Logical drives (max.) 8 8
Microprocessor 100 MHz 100 MHz

SCSI channels 2 1

SCSI transfer speed (max.)

160 MB per sec.

160 MB per sec.

Supported RAID levels

50

0, 1, 5, Enhanced-1 (1E), and
Enhanced-5 (5E), 00, 10, 1EO,

50

0, 1, 5, Enhanced-1 (1E), and
Enhanced-5 (5E), 00, 10, 1EO,

System PCI data bus

64 bit at 33 MHz

64 bit at 33 MHz

IBM ServeRAID-5i hardware features: The following tables list the hardware
features for the IBM ServeRAID-5i controller:
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Feature ServeRAID-5i
Arrays (max.) 8

Battery-backup cache Yes

Cache memory 128 MB

Hard disk drives (max.) 30

Logical drives (max.) 8
Microprocessor 100 MHz

SCSI channels 0

SCSI transfer speed (max.) 320 MB per sec.
Supported RAID levels 0, 1, 5, Enhanced-1 (1E), 00, 10, 1E0, 50
System PCI data bus 64 bit at 66 MHz

Using the ServeRAID Manager interface
Before you begin using the ServeRAID Manager, take some time to review the
layout of its user interface.

. enubar
¢ |Toolbar

EIE
5 <
5]

=

O

=

2.

@

3.

@

= |

+ |Physical and Logical device views|

.
e |Status ba

You can work with the ServeRAID Manager interface by doing any of the
following:

¢ Select actions from the menubar.
¢ (Click an item on the toolbar.

* Right-click an object in the Enterprise view, the Physical devices view, or Logical
devices view.

* Drag and drop objects in the Configuration wizard.

¢ Double-click objects and events.

More information
* |Using ServeRAID Manager Assist, hints and tips|

* |Finding information in the ServeRAID Manageti

* |Hints and tips (action)

* [Searching for information in ServeRAID Manager Assist

* [ServeRAID Manager accessibility features

* [Setting your preferences in the ServeRAID Managed

Using ServeRAID Manager Assist, hints, and tips: Use ServeRAID Manager
Assist to tour and familiarize yourself with objects in the ServeRAID Manager
[Enterprise view| and the [Physical and Logical device views| Click on an object to
view information about that object.

Tip: If you right-click on an object, you can select Hints and tips to view
information about the object and the valid actions for that object.
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Click . (Back) and . (Forward) to review pages already presented during
your current ServeRAID Manager Assist session.

If the ServeRAID Manager is installed on a server that is connected to a printer
i)
and its operating system supports printing in the ServeRAID Manager, the ==

(Print) is displayed on the ServeRAID Manager Assist toolbar. Click this icon to
print the current page.

Note:
1. The ServeRAID Manager might print some pages with overlapping text.
2. You cannot print in bootable-CD mode.

To search for terms in the ServeRAID Manager Assist pages, type one or more

words in the entry field and click @§ (Search). Search will list any page that
contains all the words you typed (it is a Boolean AND search). To search for a
specific phrase, surround the phrase with double quotes. For example,
"logical-drive migration.”

Note: The search is not case sensitive.

To exit the ServeRAID Manager Assist window, click . (Exit) and you return to
the ServeRAID Manager.

More information

+ |Finding information in the ServeRAID Manager

+ |Hints and tips (action)|

s [Searching for information in ServeRAID Manager Assist (action)|

Finding information in ServeRAID Manager:

Tip: If you want to learn more about objects in the Enterprise view or the Physical
and Logical devices views, right-click

If you want to learn more about the ServeRAID Manager interface, use the
tool tips that are displayed when you hover the mouse over a window
element.

Physical devices |
[ Controller 1 1
Channel 1 22[102- Ready (1.0 GE)]

D@ @ @R

:

Note: If tool tips are not displayed when you hover over a window, verify that
tool tips are enabled. Click View - Tool tips to enable or disable tool tips.

If you want context-sensitive information about the current window (for example,
"Creating logical drives” in the Configuration wizard), click Help » Information
about this window or the Help push-button.
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The following items on the Help menu provide additional information resources:
. lets you search for terms in the ServeRAID Assist pages.

* [ServeRAID publicationg| lists IBM publications and where to find them.

* [IBM online supporf lists IBM Web sites and available online support.

+ |What's new in the ServeRAID Manager|lists the new features delivered in this
version of the ServeRAID Manager program.

* About ServeRAID Manager reports the ServeRAID Manager version number,
copyright, and legal information.

More information

» |Using ServeRAID Assist, hints, and tips|

+ [Hints and tips (action)|

» [Searching for information in ServeRAID Assist (action)]

Using hints and tips: Use this action to view information about objects in the
[Enterprise view| or the [Physical and Logical device views

1. In the Enterprise view, Physical devices view, or Logical devices view, click an
object.

2. Right-click Hints and tips. The "ServeRAID Manager Assist” window opens.

To exit the ServeRAID Manager Assist window, click . to return to the
ServeRAID Manager.

More information
+ |Using ServeRAID Manager Assist, hints, and tipq

Searching for information in ServeRAID Manager Assist: Use this action to search the
ServeRAID Manager Assist pages.

1. Click Help » Search. The Search window opens.

2. Type one or more words in the entry field of the topic that you want to find.
Search looks for any page that contains all the words you typed (that is, it is a
Boolean AND search). To search for a specific phrase, surround the phrase with
double quotes. For example, "logical-drive migration.”

Note: The search is not case sensitive.

3. Click OK. The Search window opens listing all the pages that contain all the
words you typed.

4. Click on a topic to view its information.

5. Click . (Back) on the toolbar to view the Search listing again.

ServeRAID Manager accessibility features: Successful access to information and
use of information technology by people who have disabilities is known as
"accessibility.”

The ServeRAID Manager provides keyboard accessibility for its supported
operating systems.

On Microsoft Windows, the ServeRAID Manager works with the types of assistive
technologies used by people who have disabilities and also supports high-contrast
screen colors.
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If you require accessibility, use the ServeRAID Manager on a Microsoft Windows
operating system. If you need to work with systems that are installed with other
operating systems, connect to these systems through the network using a Microsoft
Windows system.

More information

« |Accessing the ServeRAID Manager using the keyboard|

* |Accessing the ServeRAID Manager using screen-reading software|
* |Adding remote systems|

Setting your preferences in the ServeRAID Manager: You can change some
settings in the ServeRAID Manager to match your preferences.

The ServeRAID Manager uses [an alarm to announce warning and error events|
You can turn the repeating alarm on and off, change the amount of time between
each repeating alarm, and change the duration of the alarm.

You can choose to hide the [toolbar] the [status bar] and the To do so, click
View in the menubar and click the item you want to turn off.

Also, you can refresh the ServeRAID Manager, including the Enterprise view. Click
View > Refresh.

Additionally, you can adjust the size of the ServeRAID Manager viewing areas to
make it easier to see information in which you are interested. Just drag the
horizontal and vertical bars that separate the ServeRAID Manager panes.

More information
* |[Using the ServeRAID Manager interface]
* |Changing the alarm settings (action)|

Using ServeRAID in a cluster environment

Note: This action is not supported when using the following:
Integrated RAID controller

ServeRAID-5i controller

ServeRAID-6i/6i+ controller

ServeRAID-7k controller

ServeRAID-7t controller

ServeRAID-8i controller

HostRAID controller

NookrwN =

A cluster is a group of independent computer systems that work together as a
single logical system. A client interacts with a cluster as though it is a single server.
In other words, a cluster is a group of computers linked together in such a way
that they share and manage a set of resources that can support a number of users
at the same time.

The ServeRAID high-availability clustering solution is based on a two-server
cluster, where both servers can access the same storage devices, but only one
server at a time controls the storage devices shared by both servers. If one of the
two running servers fails, the remaining server automatically assumes control of
the shared resources managed by the failed server while still controlling its own
resources at the same time. The failed server can then be repaired offline without
the loss of time or work efficiency because the shared data and applications earlier
managed by the failed server are still online to the clients.

Chapter 3. Using ServeRAID Manager 23



24

When the failed server is operational again, it can be placed back into the cluster;
the resources are reallocated between the two servers and the cluster resumes
normal operation.

You will need clustering hardware and software to configure a cluster. You can
install IBM ServeRAID Cluster Solution by using one of the following software
applications:

* Microsoft Cluster Server, which is part of Windows NT Server Enterprise
Edition.

* Microsoft Cluster Server using Windows 2000, which is part of Windows 2000
Advanced Server Edition.

Important: Be sure to review |Installing the IBM ServeRAID Cluster Solution]

Using Active PCI features

Note: This action is not supported when using the following:
* Integrated RAID controller
* ServeRAID-5i controller
* ServeRAID-6i/6i+ controller
¢ ServeRAID-6M controller under Windows operating systems

Some IBM servers support Active PCI (also called hot-plug PCI) features. You can
use these features to install or remove PCI controllers without turning off the
server. The following table summarizes which operating systems support these
features.

Windows NT | Windows Windows
Feature 4.0 2000 Server 2003 NetWare 4.x | NetWare 5.x
Hot add Yes Yes Yes No Yes
Hot remove |No Yes Yes Yes Yes
Hot replace | Yes No No No No

You can use the hot-add feature to add a controller to a running server, thus
expanding its capacity.

Note: If you are not using the hot-add feature, restore the controller to the
factory-default settings before configuring arrays and logical drives.

Use the hot-remove feature to remove a controller from a running server. If a
controller fails, use the hot-replace feature to replace a controller with an identical
controller.

Attention: Do not attempt a hot-replace operation on Windows 2000, Windows
Server 2003, or NetWare by hot-removing a failed controller and then hot-adding a
new controller. Loss of data can occur. If a controller fails on these operating
systems, you must shut down the server to replace the controller.

More information

» |Using Windows NT 4.0 with Active PCI features|
¢ [Rebuilding a defunct drive|

* [Recovering from defunct drives|

¢ |[Rebuilding a hot-swap drive|

+ [Replacing a controller (action)|
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« |Failing from the active to the passive controller (action)|

Using Windows NT 4.0 with Active PCI features: To use Active PCI with
Windows NT 4.0 and a ServeRAID-4 controller, you must install the following
software components in this order:

1. DMI Service provider. A free version is included on the IBM ServeRAID
Support CD in the following directory:

e \WINNT\DMISP\setup.exe
where ¢ is the CD-ROM drive.

Note: This version is sufficient for most users’ needs, but a Y2K compliant
version is available at the following Web site:

http:/ /www.enablers.com

2. IBM Hot Plug for Windows NT 4.0 Package, version 4.2 or later. This package
is available from the [[BM Support Web site}

Note: Be sure to read the instructions and restrictions for this software
program.

3. ServeRAID Active PCI DMI component. This is component is installed
automatically when you install the ServeRAID Manager program.

To perform a hot-replace operation, tart the IBM ServeRAID Hot Replace Wizard|
You can start this program from within either the IBM Hot Plug for Windows NT
4.0 program or the ServeRAID Manager program. You can use the ServeRAID
Manager program to start the wizard either on the server with the failed controller,
or across the network from a remote installation of the ServeRAID Manager.

Note: It is useful to start the IBM ServeRAID Hot Replace Wizard from a remote
installation when the server with the failed controller does not have a
monitor.

More information
« |Using Active PCI features|

* [Replacing a ServeRAID controller (action)|

Understanding unattended mode

Unattended mode is a setting that alters how the ServeRAID Manager startup code
(that is, BIOS) handles failures during a system startup. Examples of possible
failures during the startup are the following:

¢ The BIOS cannot communicate with the controller.
* A physical drive state has changed.
* Alogical drive state has changed.

You can set unattended mode: either Disabled or Enabled. The default is Disabled.

When unattended mode is disabled and the BIOS detects a failure, the system
remains at the recovery option screen and waits for the user to respond.

When unattended mode is enabled and the BIOS detects a failure, the system waits
for 30 seconds for the user to respond to the recovery options screen. If no user
responds, the BIOS automatically selects the first recovery option in the list and
continues the system startup process. This mode is useful for remote systems
where a user is not present for system startups.
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Consider carefully whether to enable unattended mode. Depending on how you
use the system, unattended mode might be undesirable.

For example, consider a system that includes an enclosure of multiple physical
drives. If the enclosure is turned off when you start the system, the BIOS reports a
drive failure. If unattended mode is enabled, the BIOS accepts a recovery option
that changes the configuration. When the system restarts with the enclosure turned
on, the configuration is no longer correct and the system no longer works as
originally configured.

You can change unattended mode with the ServeRAID Manager in bootable-CD
mode only.

Note: If you are configuring your system for clustering, you must enable
unattended mode. If you use the ServeRAID Manager to enable your system
for clustering, the ServeRAID Manager automatically enables unattended
mode.

More information
+ [Enabling and disabling unattended mode (action)|

+ |Configuring controllers for clustering (action)|

+ |Using ServeRAID Manager in a cluster environment]

Using the ServeRAID Manager interface

Before you begin using the ServeRAID Manager, take some time to review the
layout of its user interface.

. enubar

ii

¢ |Toolbar

« [Enterprise view]

+ |Physical and Logical device views|

.
e |Status ba

You can work with the ServeRAID Manager interface by doing any of the
following:

¢ Select actions from the menubar.
¢ (Click an item on the toolbar.

* Right-click an object in the Enterprise view, the Physical devices view, or Logical
devices view.

* Drag and drop objects in the Configuration wizard.
* Double-click objects and events.

More information
» |Using ServeRAID Manager Assist, hints and tips|

+ [Finding information in the ServeRAID Manager

* |Hints and tips (action)

* [Searching for information in ServeRAID Manager Assist

* [ServeRAID Manager accessibility features

* |Setting your preferences in the ServeRAID Manager
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Finding information on the World Wide Web
IBM home page http://www.ibm.com/pc/

IBM support page http://www.ibm.com/pc/support/

Complete the following steps to access ServeRAID and Clustering support:

1. From the Browse the support site list box, select Servers. The IBM xSeries,
Netfinity, and PC Server Support page opens.

2. From the Family list box, select ServeRAID or Clustering. The ServeRAID or
Clustering Support page opens.

3. Click one of the following options that appear in the left margin:

Downloadable files
Download the latest versions of Clustering software, the ServeRAID
Manager program, BIOS and firmware code, device-driver updates, and
other important information.

Hints and tips
Obtain useful information about IBM Clustering and ServeRAID
products, as well as tips for troubleshooting potential problems.

Online publications
Download the installation and user’s guides, references, white papers,
and other IBM publications.

Note: All[[BM ServeRAID publications|are available on the IBM
ServeRAID Support CD.

4. From the ... by Category list box, select RAID; a list of downloadable files
appears below the list box.

IBM ServerProven compatibility page http://www.ibm.com/PC/us/compat/
Detailed information about server compatibility issues.

IBM ServeRAID publications
The following publications are available in Portable Data Format (PDF) on the
IBM ServeRAID Support CD in the /BOOKS directory:
* IBM ServeRAID User’s Reference (SRAID.PDF)
* IBM ServeRAID Installation Guide (series 4, 5, 6, and 7 controllers) (INSTALL.PDF)
* IBM ServeRAID Device Driver Installation Instructions (DEVDRV.PDF)

Note: Use Adobe Acrobat Reader to view these publications. The IBM ServeRAID
Support CD contains the Acrobat Readers for Microsoft Windows, IBM OS/2,
and Linux in the /BOOKS/READERS directory.

If you are installing the IBM ServeRAID Cluster Solution, you might need to refer
to the IBM Shared Disk Clustering Hardware Reference. This publication provides
general information about planning and configuring a shared-disk cluster using
IBM server products. It contains illustrations, descriptions, and parts listings for
various high-availability, shared-disk cluster examples.

Note: You can obtain this publication from the [BM Support Web site]

In addition, the following IBM Redbooks might be of interest:
* Implementing Netfinity Disk Subsystems: ServeRAID SCSI, Fibre Channel, and SSA
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 Tuning Netfinity Server for Performance: Getting the most out of Windows 2000 and
Windows NT 4.0

* Netfinity Director: Integration and Tools
* Netfinity Clustering Planning Guide

You can download these publications from the IBM Web site:
www.ibm.com/redbooks

Understanding RAID technology

28

Redundant array of independent disk (RAID) is the technology of grouping several
physical drives in a computer into an array that you can define as one or more
logical drives. Each logical drive appears to the operating system as a single drive.
This grouping technique greatly enhances logical-drive capacity and performance
beyond the physical limitations of a single physical drive.

When you group multiple physical drives into a logical drive, the ServeRAID
controller can transfer data in parallel from the multiple drives in the array. This
parallel transfer yields data-transfer rates that are many times higher than with
nonarrayed drives. This increased speed makes the system better able to meet the
throughput (the amount of data processed in a given amount of time) or
productivity needs of the multiple-user network environment.

The ability to respond to multiple data requests provides not only an increase in
throughput, but also a decrease in response time. The combination of parallel
transfers and simultaneous responses to multiple requests enables disk arrays to
provide a high level of performance in network environments.

More information
* [Things to consider when changing the RAID level|

* [Understanding stripe-unit size]
* |RAID level-0

AID level-

AID level-1E

AID level-5

¢ [RAID level-5 Enhanced|

* |RAID level-5EE]

AID level-6

AID level-x0
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Understanding stripe-unit size

With RAID technology, data is striped across an array of physical drives. This
data-distribution scheme complements the way the operating system requests data.

The granularity at which data is stored on one drive of the array before subsequent
data is stored on the next drive of the array is called the stripe-unit size .

You can set the stripe-unit size to 8 KB, 16 KB, 32 KB, or 64 KB. You can maximize
the performance of your ServeRAID controller by setting the stripe-unit size to a
value that is close to the size of the system I/O requests. For example,
performance in transaction-based environments, which typically involve large
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blocks of data, might be optimal when the stripe-unit size is set to 32 KB or 64 KB.
However, performance in file and print environments, which typically involve
multiple small blocks of data, might be optimal when the stripe-unit size is set to
8 KB or 16 KB.

i I i I i I The ServeRAID-7t, ServeRAID-8i, and HostRAID controllers
do not support an 8 KB stripe-unit size. The ServeRAID-7t and ServeRAID-8i
controllers support these additional stripe-unit sizes: 128 KB, 256 KB, 512 KB, and
1024 KB.

The collection of stripe units, from the first drive of the array to the last drive of
the array, is called a stripe.

5 ] Hos TR

After you configure an array and store data on the logical drives,

you cannot change the stripe-unit size without destroying data in the logical
drives.

You can set the stripe-unit size to 8 KB, 16 KB, 32 KB, or 64 KB. The default setting
is 8 KB data bytes.

* When the stripe-unit size is 8 KB or 16 KB, the maximum number of physical
drives in an array is 16.

* If you have a ServeRAID-3H or ServeRAID-3HB controller using ServeRAID
firmware (version 4.0, or later) and the stripe-unit size is 32 KB or 64 KB, the
maximum number of physical drives in an array is 16. Otherwise, when the
stripe-unit size is 32 KB or 64 KB, the maximum number of physical drives in an
array is 8.

* If you have a ServeRAID-4 controller and the stripe-unit size is set to 32 KB or
64 KB, the maximum number of physical drives in an array is 16.

More information
* |Changing the stripe-unit size (action)|
« |Application environment groups reference

Understanding RAID level-0

RAID level-0 stripes the data across all the drives in the array. This offers
substantial speed enhancement, but provides no data redundancy. RAID level-0
provides the largest storage capacity of the RAID levels that are offered, because
no room is taken for redundant data or data-parity storage.

RAID level-0 requires a minimum of one drive and, depending upon the level of
firmware and the supports a maximum of 8 or 16 drives.

i I i I i I For ServeRAID-8i, ServeRAID-7t, and HostRAID controllers,
RAID level-0 requires a minimum of two drives.

The following illustration shows an example of a RAID level-0 logical drive.
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RAID level-0 example

Start with two physical drives.

10

Create an array using the two physical drives.

10

Then create a logical drive within that array.

The data is striped across the drives, creating blocks. Notice that the data is striped
across all the drives in the array, but no redundant data is stored.

A physical drive failure within the array results in loss of data in the logical drive
assigned RAID level-0, but only in that logical drive. If you have logical drives

assigned [RAID level-1 E or bE[in the same array, they will not lose data.

Note: If you have an array that contains only one physical drive, you can assign
only RAID level-0 to the logical drive in that array.

When you replace a failed drive, the controller can rebuild all the RAID level-1, 1E,
5, 5E, and 5EE logical drives automatically onto the replacement physical drive.
However, any data stored in a failed RAID level-0 logical drive is lost.

Although the risk of data loss is present, you might want to assign RAID level-0 to
one of the logical drives to take advantage of the speed this RAID level offers. You
can use this logical drive to store data that you back up each day and can re-create
easily. You also might want to use a RAID level-0 logical drive when you require
maximum capacity.
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Advantages and disadvantages

RAID level-0 offers the following advantages and disadvantages.

Advantages Disadvantages

No data redundancy, resulting in data loss

* Substantial speed enhancement
in the event that a physical drive fails

* Maximum utilization of physical drive
storage capacity, because no room is taken
for redundant data or data-parity storage

More information

» |Understanding RAID technology|
* |[Understanding stripe-unit size]

* [Selecting a RAID level

 [RAID level-1]

+ [RAID level-1 Enhanced|

+ [RAID level-5|

« |RAID level-5 Enhanced)|

+ [RAID level-5EE]|

* |RAID level-6

* |RAID level-x0

* |IRAID volume

* |Software and hardware support of RAID levels|

Understanding RAID level-1

RAID level-1 uses data mirroring. Two physical drives are combined into an array,
and data is striped across the array. The first half of a stripe is the original data;
the second half of a stripe is a mirror (that is, a copy) of the data, but it is written
to the other drive in the RAID level-1 array.

RAID level-1 provides data redundancy and high levels of performance, but the
storage capacity is diminished. Because the data is mirrored, the capacity of the
logical drive when assigned RAID level-1 is 50% of the array capacity.

RAID level-1 requires two physical drives.

The following illustration shows an example of a RAID level-1 logical drive.

RAID level-1 example

Start with two physical drives.

10

Create an array using the two physical drives.

10
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Then create a logical drive within that array.

The data is striped across the drives, creating blocks. Notice that the data on the
drive on the right is a copy of the data on the drive on the left.

With RAID level-1, if one of the physical drives fails, the controller switches read
and write requests to the remaining functional drive in the RAID level-1 array.

Advantages and disadvantages

RAID level-1 offers the following advantages and disadvantages.

Advantages Disadvantages

+ 100% data redundancy Allows only 50% of the physical drive
storage capacity to be used

* High performance

More information

+ |Understanding RAID technology]
+ |[Understanding stripe-unit sizel

* |Selecting a RAID level|

+ |RAID level-0|

+ |RAID level-1 Enhanced)|

+ |RAID level-5|

* |RAID level-5 Enhanced)|

* |RAID level-5EE]

* |RAID level-6

* [RAID level-x0

* |IRAID volume

* |Software and hardware support of RAID levels|

Understanding RAID level-1 Enhanced

RAID level-1 Enhanced (RAID level-1E) combines mirroring and data striping. This
RAID level stripes data and copies of the data across all of the drives in the array.
As with the standard RAID level-1, the data is mirrored, and the capacity of the
logical drive is 50% of the array capacity.

RAID level-1E has a similar profile to RAID level-1; it provides data redundancy
and high levels of performance, but the storage capacity is diminished. However,

RAID level-1E allows a larger number of physical drives to be used.

RAID level-1E requires a minimum of three drives and, depending upon the level
of firmware and the supports a maximum of 8 or 16 drives.
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The following illustration is an example of a RAID level-1E logical drive.
RAID level-1 Enhanced example

Start with three physical drives.

117

Create an array using the physical drives.

117

Then create a logical drive within that array.

The data is striped across the drives, creating blocks. Notice that the stripe labeled
* is the data stripe and the stripe labeled ** is the copy of the preceding data
stripe. Also, notice that each block on the mirror stripe is shifted one drive.

With RAID level-1E, if one of the physical drives fails, the controller switches read
and write requests to the remaining functional drives in the RAID level-1E array.

Advantages and disadvantages

RAID level-1E offers the following advantages and disadvantages:

Advantages Disadvantages

* 100% data redundancy Allows only 50% of the physical drive

- High performance storage capacity to be used

More information

* [Understanding RAID technology|
+ [Understanding stripe-unit size]

* [Selecting a RAID levell

* |RAID level-0
* [RAID level-1
* [RAID level-5
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* |RAID level-5 Enhanced|
* |RAID level-5EE]

* |RAID level-6

* |RAID level-x0

* |RAID volume

Understanding RAID level-5

RAID level-5 stripes data and parity across all drives in the array.

RAID level-5 offers both data protection and increased throughput. When you
assign RAID level-5 to an array, the capacity of the array is reduced by the
capacity of one drive (for data-parity storage). RAID level-5 gives you higher
capacity than RAID level-1, but RAID level-1 offers better performance.

RAID level-5 requires a minimum of three drives and, depending upon the level of
firmware and the supports a maximum of 8 or 16 drives.

The following illustration is an example of a RAID level-5 logical drive.
RAID level-5 example

Start with four physical drives.

1301

Create an array using three of the physical drives, leaving the fourth as a hot-spare
drive.

107

Then create a logical drive within that array.

The data is striped across the drives, creating blocks.

Notice that the storage of the data parity (denoted by *) also is striped, and it
shifts from drive to drive.

A parity block ( *) contains a representation of the data from the other blocks in
the same stripe. For example, the parity block in the first stripe contains data
representation of blocks 1 and 2.
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If a physical drive fails in the array, the data from the failed physical drive is
reconstructed onto the hot-spare drive.

Advantages and disadvantages

RAID level-5 offers the following advantages and disadvantages.

Advantages Disadvantages

Lower performance than RAID level-1 and

* 100% data protection
level-1E

* Offers more physical drive storage
capacity than RAID level-1 or level-1E

More information

+ |Understanding RAID technology]
+ [Understanding stripe-unit size]

* [Selecting a RAID level

* |RAID level-0
* |RAID level-1
* |RAID level-1 Enhanced|
* [RAID level-5 Enhanced
* [RAID level-5EE]

Understanding RAID level-5 Enhanced
Note: This RAID level is not available on all controllers.

RAID level-5E is the same as[RAID level-5|with a built-in spare drive. Like RAID
level-5, this RAID level stripes data and parity across all of the drives in the array.

RAID level-5E offers both data protection and increased throughput. When an
array is assigned RAID level-5E, the capacity of the logical drive is reduced by the
capacity of two physical drives in the array (one for parity and one for the spare).

Reading from and writing to four physical drives is more efficient than reading

from and writing to three physical drives and an idle hot spare. Therefore, RAID
level-5E provides a higher level of performance than RAID level-5.

Chapter 3. Using ServeRAID Manager 35



36

The spare drive is actually part of the RAID level-5E array, as shown in the
following example. With such a configuration, you cannot share the spare drive
with other arrays. If you want a spare drive for any other array, you must have
another spare drive for those arrays.

RAID level-5E requires a minimum of four drives and, depending upon the level
of firmware and the supports a maximum of 8 or 16 drives. RAID
level-5E is also firmware-specific.

Note: For RAID level-5E, you can have only one logical drive in an array. When
using RAID level-5E, you can have a maximum of seven logical drives on
the controller.

The following illustration is an example of a RAID level-5E logical drive.

RAID level-5 Enhanced example

Start with four physical drives.

JA00

Create an array using all four physical drives.

1031

Then create a logical drive (labeled as 1) within the array. Notice that the
distributed spare drive is the free space (labeled as 2) shown below the logical
drive.

The data is striped across the drives, creating blocks in the logical drive. The
storage of the data parity (denoted by * ) is striped, and it shifts from drive to
drive as it does in RAID level-5. Notice that the spare drive is not striped.

If a physical drive fails in the array, the data from the failed drive is reconstructed.
The array undergoes compression, and the distributed spare drive becomes part of
the array. The logical drive remains RAID level-5E.

When you replace the failed drive, the data for the logical drive decompresses and
returns to the original striping scheme.
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If you use a RAID level-5E logical drive in a failover or cluster configuration, the
RAID level-5E logical drive will not failover while undergoing compression or
decompression.

Advantages and disadvantages

RAID level-5E offers the following advantages and disadvantages.

Advantages Disadvantages

* 100% data protection * Lower performance than RAID level-1

* Offers more physical drive storage and level-1E
capacity than RAID level-1 or level-1E * Supports only one logical drive per array

Cannot share a hot-spare drive with other
arrays

* Higher performance than RAID level-5

* Not supported on all controllers

More information
+ |[Understanding RAID technology]|
* [Understanding stripe-unit size]
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* [RAID level-1
AID level-5

* [RAID level-5EE]|
RAID level-6

* [RAID level-x0

* [RAID volume

Understanding RAID level-5EE
Note: This feature is not supported on all

RAID level-5EE is similar to [RAID level-5E| but with a more efficient distributed
spare and faster rebuild times. Like RAID level-5E, this RAID level stripes data
and parity across all of the drives in the array.

=

ii

RAID level-5EE offers both data protection and increased throughput. When an
array is assigned RAID level-5EE, the capacity of the logical drive is reduced by
the capacity of two physical drives in the array: one for parity and one for the
spare.

The spare drive is part of the RAID level-5EE array. However, unlike RAID
level-5E, which uses contiguous free space for the spare, a RAID level-5EE spare is
interleaved with the parity blocks, as shown in the following example. This allows
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data to be reconstructed more quickly if a physical drive in the array fails. With
such a configuration, you cannot share the spare drive with other arrays. If you
want a spare drive for any other array, you must have another spare drive for
those arrays.

RAID level-5EE requires a minimum of four drives and, depending upon the level
of firmware and the supports a maximum of 8 or 16 drives. RAID
level-5EE is also firmware-specific.

Note: For RAID level-5EE, you can have only one logical drive in an array.

The following illustration is an example of a RAID level-5EE logical drive.

RAID level-5EE example

Start with four physical drives.

JA00

Create an array using all four physical drives.

1030

Then create a logical drive within the array.

The data is striped across the drives, creating blocks in the logical drive. The
storage of the data parity (denoted by *) is striped, and it shifts from drive to
drive as it does in RAID level-5E. The spare drive (denoted by $) is interleaved
with the parity blocks, and it also shifts from drive to drive.

If a physical drive fails in the array, the data from the failed drive is reconstructed.
The array undergoes compaction, and the distributed spare drive becomes part of
the array. The logical drive remains RAID level-5EE.
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When you replace the failed drive, the data for the logical drive undergoes
expansion and returns to the original striping scheme.

Advantages and disadvantages

RAID level-5EE offers the following advantages and disadvantages.

Advantages
* 100% data protection
* Offers more physical drive storage capacity than RAID level-1 or
level-1E
* Higher performance than RAID level-5
¢ Faster rebuild than RAID level-5E

Disadvantages
* Lower performance than RAID level-1 and level-1E
* Supports only one logical drive per array
* Cannot share a hot-spare drive with other arrays
* Not supported on all controllers

More information

+ [Understanding RAID technology]|
* [Understanding stripe-unit size]

* [Selecting a RAID level

* [RAID level-0
* |RAID level-1
« [RAID level-1 Enhanced|
* [RAID level-5
* |RAID level-6

* |RAID level-x0
* |IRAID volume
Understanding RAID level-6

RAID level-6 is similar to but with two sets of parity information
instead of one. RAID level-6 blocks of data and parity across all drives in
the array like RAID level-5, but adds a second set of parity information for each
block of data.

When you assign RAID level-6 to an array, the capacity of the array is reduced for
data-parity storage (the exact amount depends on the size of the drives in the
array). The second set of parity information is added to improve fault tolerance.
RAID level-6 can handle two simultaneous drive failures, where other single RAID
levels can handle, at most, only one.

RAID level-6 requires a minimum of four drives and supports a maximum of 16
drives. The maximum stripe-unit size depends on the number of drives in the

array.

The following illustration is an example of a RAID level-6 logical drive.
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RAID level-6 example

Start with six physical drives.

ERER R

Create a logical drive using four physical drives, leaving two for hot spare drives.

1]

The data is striped across the drives, creating blocks in the logical drive. The
storage of the data parity (denoted by * and **) is striped, and it shifts from drive
to drive as it does in RAID level-5.

1]

If a physical drive fails in the array, the logical drive is degraded but remains fault

tolerant.

If a second physical drive fails in the array, the data from the failed drives are
reconstructed onto the hot-spare drives, and the data for the logical drive return to
the original striping scheme.

s

_—

-
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Advantages and disadvantages

RAID level-6 offers the following advantages and disadvantages.

Advantages Disadvantages
* 100% data protection * Lower performance than RAID level-5
* Extremely high data fault tolerance because of two parity drives
* Can sustain two simultaneous drive * Not supported on all controllers
failures
* Good solution for mission critical
applications

More information

+ |[Understanding RAID technology]|
* [Understanding stripe-unit size]

* [Selecting a RAID level|

* |RAID level-0
* [RAID level-1
* |RAID level-1 Enhanced)|
+ [RAID level-5|

+ |RAID level-5E Enhanced|

¢ |RAID level-x0
¢ |RAID volume

Understanding RAID level-x0

Note: RAID level-x0 is not available on all controllers.

RAID level-x0 refers to RAID level-00, 10, 1EO, 50 and 60. RAID level-x0 uses an
array of arrays, or a spanned array. The operating system uses the spanned array
logical drive in the same way as a regular array logical drive.

RAID level-x0 allows more physical drives in an array. The benefits of doing so are
larger logical drives, increased performance, and increased reliability. RAID level-0,
10, 1E, 5, 5E, and 6 cannot use more than 16 physical drives in an array; however,
RAID level-1EO, 50, and 60 support 60 to 128 drives.

RAID level-x0 requires a minimum of two drives and supports a maximum of 60
to 128 drives, depending on the controller.

The following illustration is an example of a RAID level-10 logical drive.
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RAID level-10 example

Start with six physical drives.

LHRRLE

Create three arrays (labeled A, B, and C), each array using two physical drives.

A

C

Then create a spanned array (labeled as *) that spans the three arrays.

n

A sub-logical drive is created within each array (A, B, and C). Then the data is
striped across the physical drives in the array, creating blocks.

Notice that, in each array, the data on the drive on the right is a copy of the data
on the drive on the left. This is because the sub-logical drives (A, B, and C) are
RAID level-1 in a RAID level-10 implementation (see the following table).

L]

L

Then create a logical drive within the spanned array (*).

The data is striped across this logical drive, creating blocks ( 1- 12). Notice that
none of these blocks are redundant. This is because the logical drive is RAID
level-0 in a RAID level-x0 implementation (see the following table).

RAID level

Sub-logical drive

Spanned array logical drive

00

RAID level-0

RAID level-0

10

RAID level-1

RAID level-0

1E0

RAID level-1E

RAID level-0

50

RAID level-5

RAID level-0
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RAID level Sub-logical drive Spanned array logical drive
60 RAID level-6 RAID level-0

With RAID level-10, 1EQ, and 50, if one of the physical drives fails in a sub-logical
drive, the ServeRAID controller switches read and write requests to the remaining
functional drives in the sub-logical drive. With RAID level-60, if one or two of the
physical drives fails in a sub-logical drive, the ServeRAID controller switches read
and write requests to the remaining functional drives in the sub-logical drive. With
RAID level-00, a physical drive failure within the sub-logical drive results in loss of
data.

Advantages and disadvantages

RAID level-x0 offers the following advantages and disadvantages.

Advantages Disadvantages

* Not available on all controllers

* Supports up to 60 physical drives on SCSI
* No data redundancy for RAID level-00

controllers

* Supports up to 128 physical drives on
SAS and SATA controllers

* 100% data redundancy (except for RAID
level-00)

More information

+ [Understanding RAID technology]|
* |Understanding stripe-unit siz

* [Selecting a RAID level

* [RAID level-0
* |RAID level-1
* |RAID level-1 Enhanced|
* IRAID level-5|

* IRAID level-5 Enhanced|
* [RAID level-5EE]|

¢ |RAID level-6
¢ |RAID volume

Understanding RAID volumes

Note: HostRAID controllers do not support RAID volumes.

For the ServeRAID-8i SAS controller and ServeRAID-7t SATA controller, the
ServeRAID Manager supports the following RAID volume types:

e Simple Volume - a single disk drive or segment; not redundant.

* Spanned Volume - two or more disk drives or segment with the same or
different capacity, connected end-to-end. A spanned volume offers no
redundancy or performance advantage over a single drive.

* RAID Volume - two or more logical drives with the same RAID level, connected
end-to-end. The logical drives may have the same or different capacity and are
not together; they may be redundant, depending on the RAID level.

Notes:
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— You must create the individual logical drives before you create a
RAID Volume. Use the |Configuration wizard|to create the logical
drives; then, run the Configuration wizard again to create the RAID
Volume.

— When you create a RAID Volume, the ServeRAID Manager replaces
the individual logical drives with a single RAID Volume icon in the
Logical devices view; then, it reports the logical drives as deleted in
the event viewer. The event message is normal and does not indicate a
loss of data.

More information

* |Understanding RAID technologyl
* |[Understanding stripe-unit size]

* [Selecting a RAID level

* [RAID level-0
* [IRAID level-1
+ [RAID level-1 Enhanced|
+ [RAID level-5]|

+ |RAID level-5 Enhanced)|
+ [RAID level-5EE]|

* [RAID level-6
* |RAID level-x0
Creating a simple volume

Use this action to create a simple volume. A simple volume is a single disk drive
or segment used for storage in a RAID system; it is not redundant.

Complete the following steps to create a simple volume:

1. In the [Physical devices view] click & (online physical drive).

2. Right-click Create simple volume.
3. Click Yes to confirm.

More information
+ |Understanding RAID technology]|

Selecting a RAID level and tuning performance

Disk arrays are used to improve performance and reliability. The amount of
improvement depends on the application programs that you run on the server and
the RAID levels that you assign to the logical drive.

Each RAID level provides different levels of fault-tolerance (data redundancy),
utilization of physical drive capacity, and read and write performance. In addition,
the RAID levels differ in regard to the minimum and maximum number of
physical drives that are supported.

When selecting a RAID level for your system, consider the following factors.

Note: Not all RAID levels are supported by all ServeRAID controllers.

Physical
drive Min. Max.
Data redun- |capacity Read perfor- | Write perfor- | Built-in number of |number of
RAID level |dancy utili- zation |mance mance spare drive |drives drives
RAID level-0| | No 100% Superior Superior No 1 16
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Physical

drive Min. Max.

Data redun- |capacity Read perfor- | Write perfor- | Built-in number of |number of
RAID level |dancy utili- zation |mance mance spare drive |drives drives
[RAID level-1| | Yes 50% Very high Very high No 2 2
RAID| Yes 50% Very high | Very high  [No 3 16
level-1H
[RAID level-5 | Yes 67% to 94% | Superior High No 3 16
RAID| Yes 50% to 88% | Superior High Yes 4 16
level-5E|
RAID| Yes 50% to 88% | Superior High Yes 4 16
level-5EE]|
[RAID level-6| | Yes 50% to 88% | Very High High No 4 16
RAID| No 100% Superior Superior No 2 60
level-00|
RAID| Yes 50% Very high Very high No 4 16
level-10|
RAID| Yes 50% Very high Very high No 6 60
level-1EQ)
RAI Yes 67% to 94% | Superior High No 6 60 (SCSI) 128
level-5 (SAS, SATA)
RAI Yes 50% to 88% | Very High High No 8 128
level-6
Spanne No 100% Superior Superior No 2 48
Volume)
RAI No 50% to 100% | Superior Superior No 4 48
Volume)

Physical drive utilization, read performance, and write performance depend on the
number of drives in the array. Generally, the more drives in the array, the better

the performance.

More information

* |Understanding RAID technology]|

* [Selecting the logical drive size|

* [Selecting the RAID level by array capacity|

* [Creating logical drives (action)|

e |Configuring RAID and creating arrays (action)l

* [Creating logical drives in the wizard]|

+ [Things to consider when changing the RAID levell
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Selecting the RAID level by array capacity

Note: Not all RAID levels are supported by all ServeRAID controllers.

If your array has...

Consider this RAID level...

One or more physical drives in an array.

Notes:

* This is the only choice if the array
contains only one physical drive.

* You can select RAID level-0 for any
logical drive.

i

1D level-0

Two physical drives. The default for two
physical drives is RAID level-1.

1D level-1

Three or more physical drives.

1D level-1

Three or more physical drives.

1D level-5

Four or more physical drives.

1D level-5

Four or more physical drives.

RAID level-5EE

Four or more physical drives.

1D level-6

Two or more physical drives.

ID level-0

Four or more physical drives.

ID level-1

Six or more physical drives.

0

Six or more physical drives.

iiiiiliii i

ID level-5

Eight or more physical drives.

S

ID level-60]

More information

* [Selecting a RAID level and performance tuning]

Example: Total disk capacity

Physical drives in an array can be of different capacities (1 GB, or 2 GB, for
example). The sum of the physical drives’ capacity grouped in an array is the total

disk capacity.

For example, if you group two 2 GB drives and one 3 GB drive into an array, the
total disk capacity is the 7 GB physically available.

—_
T}
s T o -
— — e g L
2 GB 2 GB 3 GB
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Similarly, if you group three 2 GB drives and 1 GB drive into an array, the total
disk capacity is the 7 GB physically available.

More information

Example: Usable and unusable capacity|

Example: Usable and unusable capacity

Physical drive capacities influence the way you create arrays and logical drives.
Drives in an array can be of different capacities (1 GB, or 2 GB, for example), but
RAID controllers treat them as if they all have the capacity of the smallest physical
drive.

For example, if you group two 2 GB drives and one 3 GB drive into an array, the
usable capacity of the array is 2 GB times 3, or 6 GB, not the 7 GB physically
available. The 7 GB is the total disk capacity. In the following diagram, usable
capacity is labeled as 1 and unusable capacity is labeled as 2.

—
=
1
e e — e —
2 GB 2 GB 3 GB

Similarly, if you group three 2 GB drives and 1 GB drive into an array, the usable
capacity of that array is 4 GB, not the 7 GB physically available. The 7 GB is the
total disk capacity. The remaining capacity left on the three 2 GB drive is unusable
capacity.

The optimal way to create arrays is to use physical drives that have the same
capacity. Doing so avoids unusable capacity

For the ServeRAID-8i controller and ServeRAID-7t controller, usable capacity is the
same as the total disk capacity. That is, you can use the remaining space to define
another logical drive. The segments that make up the logical drive must be the
same size on each physical drive. For example, you can group two 1 GB segments
with the remaining space from the previous example to define a 3 GB logical drive.
In the following diagram, the new logical drive is labeled 2; 4 GB of usable
capacity remain, 2 GB on each drive, labeled 3.
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2 GB 2 GB

More information

3GB

+ [Example: Total disk capacity|

3 GB

3 GB

Understanding physical drive capacity and unusable capacityl|

Software and hardware support of RAID levels

RAID level

ServeRAID software*
release that supports the
RAID level

Hardware levels that
support the RAID level

All

ServeRAID on the board,
ServeRAID, ServeRAID-II,
ServeRAID-3 family,
ServeRAID-4 family,
ServeRAID-5i,
ServeRAID-6M,
ServeRAID-6i/6i+,
ServeRAID-7Kk,
ServeRAID-7t, ServeRAID-8i

All

ServeRAID on the board,
ServeRAID, ServeRAID-II,
ServeRAID-3 family,
ServeRAID-4 family,
ServeRAID-5i,
ServeRAID-6M,
ServeRAID-6i/6i+,
ServeRAID-7k,
ServeRAID-7t, ServeRAID-8i,
integrated RAID controller

1E

All

ServeRAID on the board,
ServeRAID, ServeRAID-II,
ServeRAID-3 family,
ServeRAID-4 family,
ServeRAID-5i,
ServeRAID-6M,

ServeRAID-6i/6i+,
ServeRAID-7k, ServeRAID-8i

All

ServeRAID on the board,
ServeRAID, ServeRAID-II,
ServeRAID-3 family,
ServeRAID-4 family,
ServeRAID-5i,
ServeRAID-6M,
ServeRAID-6i/6i+,
ServeRAID-7Kk,
ServeRAID-7t, ServeRAID-8i
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RAID level ServeRAID software* Hardware levels that
release that supports the support the RAID level
RAID level
5E ServeRAID 3.50 or later ServeRAID-3 and
ServeRAID-4 families.
5EE ServeRAID 6.00 or later ServeRAID-4 family except
ServeRAID-4H,
ServeRAID-6M,
ServeRAID-6i/6i+,
ServeRAID-7k, ServeRAID-81
6 ServeRAID 7.30 or later ServeRAID-8i
x0 ServeRAID 4.00 or later ServeRAID-4 family,

ServeRAID-5i,
ServeRAID-6M,
ServeRAID-6i/6i+,
ServeRAID-7Kk,
ServeRAID-7t, ServeRAID-81

* ServeRAID software refers to BIOS, firmware, device drivers, programs, and so
forth.

RAID levels that can use a hot-spare or standby hot-spare

drive

Hot-spare and standby hot-spare drives supply additional protection to a RAID
configuration. When you select the RAID level for your configuration, consider the

following:
RAID level Can use a hot spare? Can use a standby hot
spare?

0 No No

1 Yes Yes

1E Yes Yes

5 Yes Yes

5E * Yes Yes
5EE * Yes Yes

6 Yes No

00 No No

10 Yes Yes

1EO Yes Yes

50 Yes Yes

60 Yes No

*

RAID level-5E|and [RAID level-5EH integrate a distributed hot-spare drive, but

al

so can use traditional hot-spare and standby hot-spare drives. If a physical drive
fails in a RAID level-5E or level-5EE logical drive and the configuration includes a
hot-spare or standby hot-spare drive, the data is rebuilt on the hot-spare or
standby hot-spare drive. A RAID level-5E compression or RAID level-5EE
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compaction does not occur. If a second physical drive fails in the RAID level-5E or
level-5EE logical drive, a data compression or compaction will take place on the
distributed hot-spare drive.

More information
+ |Understanding RAID level-5E|
+ |Understanding RAID level-5EF]

Selecting the RAID level in the migration wizard
To select a new RAID level for the array:

1. Click the RAID level radio button. Only the most common choices appear in
the list.

'/ Selectthe RAID level for this array.
@ RAIDD (Striping, 2 or more drives required, not redundant)
@ RAID 5 (Striping with parity, 3 ar mare drives reguired, redundant)

2. To choose a different RAID level, click Advanced settings; then, choose a RAID
level from the available options.

F Advanced settings

@ RAID 10 (Striped mirrorg, even number of drives reguired, redundant)

Note: Only valid RAID level migrations appear in the list. Migration
requirements for each RAID level are described

3. When you are ready to continue, click Next. The "[Modify array]' window

opens.

More information
+ [Things to consider when changing RAID levels|
+ |Understanding RAID technology]|

Starting the ServeRAID Manager task

This topic describes how to start ServeRAID Manager in IBM Director.

To start ServeRAID Manager, in the IBM Director Console Tasks pane, drag the
ServeRAID Manager task onto a managed system that supports ServeRAID.

The left pane is the Enterprise view pane, and the right pane is the Physical and
Logical devices pane. The bottom pane is the event viewer.

You can use ServeRAID Manager to view information about RAID controllers and
the RAID subsystem, which includes arrays, logical drives, hot-spare drives, and
physical drives.

Logging in to the ServeRAID Manager

50

Use this action log into the ServeRAID Manager. You must log in when you first
start the ServeRAID Manager, or if you are
You can log into the ServeRAID Manager as:

e Administrator: The Administrator log in allows you to view and modify the
RAID configuration. You can create and delete logical drives, synchronize logical
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drives, perform migrations, add and remove hot-spare drives, and verify logical
drives. To log in as Administrator, you must be a member of the Administrator
group for your operating system. Use the Administrator user name and
password or your own user name and password if you are a member of the
Administrator group.

User: The User log in allows you to view the RAID configuration, verify logical
drives, and add and remove hot-spares. You cannot create or delete logical
drives or perform migrations. To log in as User, use your normal network user
name and password.

Note: On Linux systems, the user name and password is defined in
/etc/pam.d/storman.

Guest: The Guest log in allows you to view the RAID configuration only. You
cannot change or modify any information. To log in as Guest, simply click
Cancel when the ServeRAID Manager "Log in” window opens.

Logging in at ServeRAID Manager startup

1.
2.

3.

In the User Name field, type your user name.
In the Password field, type your password.

Note: The password is case sensitive.
Click Connect. (To log in as "Guest”, click Cancel.)

Logging in if you are currently logged out or logged in as Guest

N

5.

In the Enterprise view, click = (system).

Click Action » Log in. The ServeRAID Manager "Log in” window opens.
In the User Name field, type your user name.

In the Password field, type your password.

Note: The password is case sensitive.
Click Connect.

More information

Logging ouﬂ

Configuring NetWare user authentication|

Logging out of the ServeRAID Manager

Use this action to log out of the ServeRAID Manager.

1.
2.

In the Enterprise view, click m (system).
From Action menu, click Action » Log out.

Note: After log out, you can still use the ServeRAID Manager Guest account.
The Guest account allows you to view the RAID configuration but not
change it.

More information

Logging in to the ServeRAID Manager|
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Using the ServeRAID Manager from the command line

You can use the following command-line parameters when starting the ServeRAID
Manager:

-h | -2 | help
Displays basic help for the ServeRAID Manager.

-1
Starts the ServeRAID Manager in local-only mode.

The ServeRAID Manager does not obtain TCP/IP information and the
remote actions are disabled. The only system appearing in the Enterprise
view is the local system.

If you have remote systems defined in the Enterprise view when you run
in nonlocal-only mode (that is, not using the -1 flag), they do not appear in
the Enterprise view when you run in local-only mode.

Note: Starting in local-only mode does not change any remote systems you
have defined. The next time you start the ServeRAID Manager in
nonlocal-only mode, your remote systems will appear in the
Enterprise view again.

Resets the Enterprise view. That is, it removes all remote systems from the
Enterprise view tree.

Note: This command does not remove remote systems from the remote
notification list.

Using the ServeRAID Manager with screen-reading software

To use the ServeRAID Manager with screen-reading software, follow these

steps:</>
1. Download and install the Java 2 Platform for Microsoft Windows Operating
System:
2.
a. Go to http://java.sun.com/j2se/1.4.2/download.html and download the
Java 2 Platform Standard Edition Java Runtime Environment Version 1.4.2.
An executable is available for installation.
b. Follow the instructions provided by the installation program, accepting all
defaults.
3. Download and install the Java Access Bridge for Microsoft Windows Operating
System:
4.

a. Go to http://java.sun.com/developer/earlyAccess/accessbridge/ and
download the compressed zip file. An older version is available at
http:/ /java.sun.com/products/accessbridge/.

b. Extract the zip file and navigate to the Installer folder. Execute the file
Install.exe.

C. Make sure that the installation program detects the Java Virtual Machine
you just installed.

d. Follow the instructions provided by the installation program.
5. Install the screen reader software (ie, JAWS).
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6. Double click the RaidManAcc.bat file to start the ServeRAID Manager program.
7.

Note: Be sure that the java command is in your classpath. This should occur
automatically when you install the Java Virtual Machine. If not, edit the
batch file to explicitly point to the java.exe file found in the bin directory
of the Java installation.

More information

Accessing the ServeRAID Manager using the keyboard|

Using the ServeRAID Manager in bootable-CD mode

The ServeRAID Manager program operates in two ways:
* bootable-CD mode
* As an installed software program.

When you run the ServeRAID Manager program from the IBM ServeRAID Support

CD, you are using bootable-CD mode. The bootable-CD mode allows you to

configure your ServeRAID controller before you install your operating system. After

you have configured the ServeRAID controller and installed the operating system,
ou also can use bootable-CD mode to [fine-tune specific ServeRAID controller]

To run the ServeRAID Manager program in bootable-CD mode, turn on the server;
then, insert the IBM ServeRAID Support CD (or the CD that contains the
ServeRAID Manager program that came with your server) into the CD-ROM drive.

If the ServeRAID Manager program detects unconfigured ServeRAID controllers
and ready drives, the program automatically starts the [Configuration wizard|

These are the actions that are available in bootable-CD mode only:
* |Changing the rebuild rate]

+ |Changing the stripe-unit size|

+ |Changing BIOS-compatibility mapping]

* |Changing the SCSI-transfer speed|

+ |[Enabling and disabling read-ahead cache mode|

+ |[Enabling and disabling unattended mode|

* |Changing the write-cache mode on a physical drive|

¢ |Changing the write-cache mode on a logical drives|

* |Configuring for clustering]

Accessing the ServeRAID Manager using the keyboard

Use the following key combinations to navigate in windows, tables, text areas, and
the ServeRAID Manager tree.

Navigating in windows

Action Key Combination
Navigate out forward Tab
Navigate out backward Shift + Tab
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Action Key Combination
Activate Enter
Spacebar

Alt + character accelerator key, if defined

Navigate within group Arrow keys
Check / Uncheck Spacebar

To beginning of list Home

To end of list End

Select all entries in list Ctrl + A

Select additional item in list Ctrl + Spacebar
Navigate out of menu, toolbar and tool tip Esc

components

Open or post menu

Up arrow, Down arrow
Enter
Spacebar

Alt + character accelerator key, if defined

Retract menu

Esc

Activate menu item

Enter
Spacebar

Alt + character accelerator key, if defined

Open submenu Right arrow
Retract submenu Left arrow
Esc

Toggle drop-down list

Alt + Up arrow

Alt + Down arrow

Move to next link in Web page

Ctrl + T

Activate link in Web page

Ctrl + Spacebar

Navigating in tables or text areas

Action Key Combination
Navigate out forward in table or text area Ctrl + Tab
Navigate out backward in table or text area |Ctrl + Shift + Tab
Move to next cell Tab

(wrap to next row)

(Right arrow)

Move to previous cell

(wrap to previous row)

Shift + Tab

(Left arrow)

Move to cell above

Up

Move to cell below

Down

ServeRAID Management Installation and User's Guide




Accessing and navigating in the tree

Action Key Combination
Accessing the tree pane Ctrl + Tab
Expand entry Right

Collapse entry Left

Single select

Ctrl + Spacebar

Other keyboard navigation shortcuts

devices

Action Key Combination
Close active window Alt + F4

Display context menu for selected object Enter

Select controller, channel, or drive object Spacebar

Display selected object properties Alt + Enter

Open Help window F1
Expand/collapse physical and logical Up arrow

Down arrow

Display event detail window (focus in event
viewer)

Spacebar

More information

* |ServeRAID Manager accessibility features|

* |Accessing the ServeRAID Manager using screen-reading software

Verifying that the ServeRAID Manager agent is running

Use the following procedure to verify that the ServeRAID Manager agent is

running on your system.

Windows 2000, Windows XP, Windows Server 2003

1. In the lower-left corner of the desktop, click Start » All Programs »
Administrative Tools » Services. The Services window opens.

2. In the Services table, verify that the "ServeRAID Manager Agent” is listed and

started.

Windows NT

1. In the lower-left corner of the desktop, click Start > Settings > Control Panel.

The Control Panel window opens.

2. Double-click Services. The Services window opens.
3. In the Services table, verify that the "ServeRAID Manager Agent” is listed and

started.

0S/2

1. Press Ctrl + Esc. The OS/2 Window List opens.
2. Verify that the "ServeRAID Manager Agent” is listed.
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NetWare
1. Press Alt + Esc to cycle through the NetWare consoles.

2. Verify that "ServeRAID Manager” is displayed on the first line of a console
screen. If none of the console screens display "ServeRAID Manager,” the agent
is not running.

Linux, OpenServer, UnixWare and Open UNIX
1. Open a shell window.
2. At the command prompt, type the following:
ps -ef | grep RaidAgnt.sh
3. If the agent is running, the process is listed as the following: sh RaidAgnt.sh.

More information
* |Using the ServeRAID agentl
. ‘Starting the ServeRAID Manager agent

+ |Configuring the ServeRAID Manager agent|

ServeRAID Manager and LED flash states

56

The amber and blue LEDs are controlled by the backplane (for internal physical
drives) or enclosure (for external physical drives). Controllers send commands to
the backplane or enclosure processor to set a logical state for the LED, and the
subsystem translates that LED state into the following flash states:

Controller device state Slot state LED flash state
defunct Device is faulty On

Rebuilding Device is rebuilding Slow flash
Identify Identify the device Fast flash
Other No error Off

The green LED is an activity indicator for the physical drive and is controlled by
the physical drive.

More information
« [Identifying devices (action)|
« |Using Identify to work with your systems|
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Chapter 4. Managing ServeRAID devices

Configuring ServeRAID controllers and enclosures in the
Configuration wizard

Configuring an enclosure: the basic steps

The following steps are an overview of the enclosure configuration process:

1.

© © N s

In the Enterprise view, click € (enclosure) that you want to configure.

In the Logical devices view, click ; or click on the toolbar. The
Configuration wizard opens.

[Select the physical drives| that you want to include in your arrays or create as
hot-spare drives.

[Define the logical drives for your arrays.
[Define the authentication method| for each logical drive (iSCSI initiators only).

[Define the initiators| that can access the enclosure.

[Assien logical drives to initiators]

[Review the configuration summary]

Click Apply. The ServeRAID Manager will configure the controller and
synchronize the logical drives.

More information

[Configuring RAID)|

Configuring ServeRAID SCSI controllers (ServeRAID series 3,
4, 5, 6, and 7K)

Choosing between Express and Custom configuration

Note: If you intend to use your ServeRAID controllers in a Microsoft Windows

failover or clustering environment, review the [ServeRAID publications|
before configuring ServeRAID.

In the Configuration wizard, you can choose from two paths to configure your
ServeRAID subsystem:

* Click Express configuration for a quick and easy path for you to automatically

configure your ServeRAID controller. This path creates the most efficient
ServeRAID configuration based on the number and capacity of the ready
physical drives available in your system. If four or more ready drives of the
same capacity are available, this choice also will define a hot-spare drive.

Express configuration does the following:

— Creates arrays by grouping together same-sized physical drives.

— Creates one logical drive per array up to 2 terabytes (TB) maximum.

— Assigns a RAID level based on the number of physical drives in an array:

An array with a single physical drive is assigned RAID level-0.
- An array with two physical drives is assigned RAID level-1.
- An array with three or more physical drives is assigned RAID level-5.

© Copyright IBM Corp. 1999, 2005
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Note: If the physical drive size exceeds 2TB, Express configuration removes
drives until the size is less than 2 TB. It creates an additional array
with the left-over drive(s).

— Designates a hot-spare drive for the controller. If one or more arrays has four
or more physical drives, the largest-sized drive from those arrays will be
designated the hot-spare drive.

Note: When you choose Express configuration, you have the opportunity to
review and approve the configuration before the ServeRAID Manager
applies the configuration. If you need to modify the configuration, you
can do it from the configuration summary.

* Click Custom configuration for a path that lets you manually configure your
ServeRAID controller. Choose this path to do any of the following:

— Configure your controller manually.

— Assign RAID level-1E, RAID level-5E, RAID level-5EE, or RAID level-x0 to a
logical drive.

— Create more than one logical drive per array.

Using the Custom path, you can:

— Select the [physical drives that you want to include in each array and that youl
[want to use as hot-spare drives|

— Define the jnumber, size, and RAID level of the logical drives for each arrayl

- Review the[configuration summaryl

Click Automatically initialize new logical drives. Initializing a logical drive erases
the first 1024 sectors on the drive and prevents access to any data previously
stored on the drive. You can [initialize the drive later|if you do not choose
automatic initialization.

When you are ready to continue, click Next.

More information

* [Understanding stripe-unit size]

* |Initializing a logical drive

+ |[Understanding physical drive capacity and unusable capacity|

Creating arrays and hot-spare drives
Complete the following steps to create arrays:

1. [Start the custom configuration wizard and complete all previous steps.|

2. Click the appropriate Array tab in the right pane: ‘ HewarrayC [IERRIER

3. Then, from the list of ready drives, select the drives you want to add to the
array:

Systermn merlyn, Controller 2

{3 Ready Ch1,1D 3 (1000 MB)

; Ready Ch1,1D 4 (1000 ME)
¢ Ready Ch1,1D5 (1000 MB)
&3 Ready Ch1,1006 (1000 MB)
&3 Ready Ch1,1D8 (1000 MB)

4. Click ] >> (Add selected drives) to add the drives to the array. You can

click >> (Add all drives) to move all ready drives to an array.
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5. Repeat steps 2 and 3 for each additional array or hot-spare drive that you want
to configure.

6. If you do not want to create a spanned array, skip to step 6. Otherwise, select
the Span arrays check box [& spanarrays . Then, click Next. If you created two
arrays only, the ServeRAID Manager uses those arrays to create the spanned
array; continue to step 6. Otherwise, the " [Create spanned arrays| window
opens.

Note: To create a spanned array, each array must have the same number of
physical drives.

7. After you select the ready drives for your arrays and hot-spare drive, click
Next. The " [Create logical drives|’ window opens.

To return to the " [Express and Custom configuration| window, click Back. To leave
the Configuration wizard, click Cancel.

More information

+ |Understanding creating basic arrays|

+ |[Example: Express configuration|

* |Creating spanned arrays

+ |Understanding creating spanned arrays|

+ |Configuring the ServeRAID controller: the basic steps|

Creating spanned arrays
If you want to assign [RAID level-x0|to an array, you must create a spanned array.

Note: Spanned arrays are supported only by IBM ServeRAID-4 Ultral60,
ServeRAID-5i Ultra320, ServeRAID-6M Ultra320, and ServeRAID-6i/6i+
Ultra320 SCSI controllers.

Complete the following steps to create one or more identical spanned arrays:

1. |Start the custom configuration wizard and complete all previous steps.|

2. In the list of arrays, click the arrays that you want to add to your spanned

| Systern merlyn, Controller 2
‘ et Array A (4000 ME) 4 drives

st Array B (4000 MB) 4 drives
et rray (4000 ME) 4 drives

fr—

array.

3. Click [ >> (Add selected arrays) to add the arrays to the spanned array. You
can click @ >> (Add all arrays) to move all arrays to the spanned array.

4. To create additional spanned arrays, click the New spanned array tab in the
right pane.

Spanned array 1 \| Hew spanned array 2 \|

Then, repeat steps 2 and 3.

5. Click Next; the " [Create logical drives| window opens.

To return to the ” ’ window, click Back. To leave the Configuration

wizard, click Cancel.

More information
Understanding RAID level-x0|
« |Understanding creating spanned arrays
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Creating logical drives
Complete the following steps to create logical drives:

1. [Start the custom configuration wizard and complete all previous steps.|

2. Click the appropriate Array tab.

| Array C \| Hew array D \|

3. Select a RAID level from the drop-down list.

FAID level
| |
0
1E
5
5EE
Note:
a. RAID level-5E and RAID level-5EE allow only one logical drive per
array.

b. If you are configuring a spanned array, you can set the RAID level
only for the first logical drive you create.

c. If you plan to use "[Change RAID level)” you must assign the same
RAID level to all logical drives within a single array.

Attention: Before assigning a logical drive RAID level-5E or RAID level-5EE,
consider the following. If a physical drive fails during a post-failover
resynchronization, the logical drive will enter the blocked state. Data might be
lost or damaged.

4. If you do not want to use the maximum size for the logical drive, type the size
in the Data (MB) field.

Dt (M)
[ a000|
Note:
a. You can define up to eight logical drives per controller. There are two
exceptions:

* If an array contains a logical drive assigned RAID level-5E
* If you want to use the logical-drive migration feature

In these cases, one logical drive slot must be left free; therefore, you
must define no more than seven logical drives.

b. Some operating systems have size limitations for logical drives.
Before you save the configuration, verify that the size of the logical
drive is appropriate for your operating system. For more detailed
information, see your operating-system documentation.

c. Alogical drive cannot exceed 2048 GB (2 terabytes); the minimum
size is nMB, where n equals the number of drives in the array.

d. Typically, the first logical drive defined on the first ServeRAID
controller found by system BIOS during startup will be your startup
(boot) drive.

e. The actual logical-drive size might be slightly different from what
you select. The RAID level and the number of physical drives
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7.
8.

determine the size of the logical drive. For example, an array
consisting of three, 1 GB physical drives with a requested RAID
level-0 logical drive of 1000 MB will actually contain only 999 MB
because the data is striped across all three drives, with 333 MB on
each drive.

If you have free space available and want to create additional logical drives,

click L B Define new logical drive ] )

Repeat steps 3 through 5 for each logical drive that you want to define in this
array.

Repeat steps 2 through 6 for each additional array that you want to configure.

Click Next. The " |Configuration summary| window opens.

To return to the ” ’ window, click Back. To leave the Configuration

wizard, click Cancel.

More information

Selecting the RAID level by array capacity|

Selecting the array size|

Understanding physical drive capacity and unusable capacity]|

Confirming your express system configuration

Use the configuration summary to review all the changes that the ServeRAID
Manager will apply to your configuration:

1.

Review the information that is displayed in the "Configuration summary”

window. To change the configuration, click or

[ 53 Modity logical drives |

Notes:
a. Additional jnotes and attentions|regarding the configuration appear

in the |event Vieweﬂ

b. Some operating systems have size limitations for logical drives.
Before you save the configuration, verify that the size of the logical
drive is appropriate for your operating system. For more detailed
information, see your operating-system documentation.

Click Apply; then, click Yes when asked if you want to apply the new
configuration. The configuration is saved in the ServeRAID controller and in
the physical drives.

Note: If you clicked [Automatically initialize new logical drives| the ServeRAID
Manager will initialize the logical drives automatically.

When you have completed configuring your controllers, you can change certain
controller settings to [fine-tune your configuration|

More information

Configuration wizard notes and attentions

Understanding logical-drive synchronization|

‘Initializing a logical drivel

‘Fine-tuning your systeml

Confirming your custom system configuration

Use the configuration summary to review all the changes that the ServeRAID
Manager will apply to your configuration:
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1. Review the information that is displayed in the "Configuration summary”
window. To change the configuration, click Back.

Note: Additional jnotes and attentiong regarding the configuration appear in

the |event viewej

2. Click Apply; then, click Yes when asked if you want to apply the new
configuration. The configuration is saved in the ServeRAID controller and in
the physical drives.

Note: If you clicked [Automatically initialize new logical drives| the ServeRAID
Manager will initialize the logical drives automatically.

3. When you have completed configuring your controller, you can change certain
controller settings to [fine-tune your configuration|

More information
« |Configuration wizard notes and attentions

+ |Understanding logical-drive synchronization|

+ [Initializing a logical drive|

+ |Fine-tuning your system|

Configuring ServeRAID SAS, SATA, and HostRAID controllers
(ServeRAID-7t, ServeRAID-8i, HostRAID)

Choosing between Express and Custom configuration
In the Configuration wizard, you can choose from two paths to configure your
ServeRAID-8i, ServeRAID-7t, or HostRAID controller:

* Click Express configuration for a quick and easy path for you to automatically
configure your controller. This path creates the most efficient configuration based
on the number and capacity of the ready physical drives available in your
system. If four or more ready drives of the same capacity are available, this
choice also will define a hot-spare drive.

Express configuration does the following:

— Creates one logical drive, up to 2 terabytes (TB) maximum, by grouping
together same-sized physical drives.

Note: If the physical drive size exceeds 2TB, Express configuration removes
drives until the size is less than 2 TB. It creates an additional logical
drive with the left-over drive(s).

— Assigns a RAID level based on the number of available physical drives:

- Alogical drive with a single physical drive is assigned RAID level-0.

- Alogical drive with two physical drives is assigned RAID level-1.

- Alogical drive with three physical drives is assigned RAID level-5.

HostRAID:

For HostRAID controllers, Express configuration creates a RAID level-1
logical drive.

— Designates a hot-spare drive for the controller. If four or more ready drives
are available, the largest drive will be designated the hot-spare drive.

Note: When you choose Express configuration, you have the opportunity to
review and approve the configuration before the ServeRAID Manager
applies the configuration. If you need to modify the configuration, you
can do it from the configuration summary.
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¢ Click Custom configuration for a path that lets you manually configure your
controller. Choose this path to do any of the following;:

— [Define the RAID level of the logical drives.
Select the [physical drives that you want to include for each logical drive}

— Define the jpumber and size of the logical drives

[Fine tune your configuration| for optimal performance

Review the|configuration summary]|

When you are ready to continue, click Next.

More information

« |Understanding stripe-unit size]

» |Understanding logical drive synchronization|

« |Understanding physical drive capacity and unusable capacityl|

Choosing between Express and Custom configuration
In the Configuration wizard, you can choose from two paths to configure your
integrated RAID controller subsystem:

* Click Express configuration for a quick and easy path for you to automatically
configure your integrated RAID controller.

Express configuration does the following:

— Creates an array by grouping the first two physical drives that appear in the
[Physical devices view]|

— Creates a RAID level-1 logical drive.

Note: If you click Express, you will have the opportunity to review and approve
the configuration before the ServeRAID Manager applies the
configuration. If you need to modify the configuration, you can do so
from the |configuration summary]

* Click Custom configuration for a path that lets you to manually configure your
integrated RAID controller. Choose this path to do any of the following:

Configure your controller manually.

Select the two physical drives that you want to configure.
— Create a hot-spare drive.

Preserve data on a mirror primary drive .

Using this path, you can:

— Select the [physical drives that you want to include in the array and that you|
[want to use as a hot-spare drive]

— Review the |configuration summaryl

To initialize the new logical drives, click Automatically initialize new logical
drives. Initializing a logical drive erases the first 1024 sectors on the drive and

prevents access to any data previously stored on the drive. You can [initialize the
if you do not choose automatic initialization.

When you are ready to continue, click Next.

More information

+ [Understanding stripe-unit size]

+ [Initializing a logical drive|
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Example: Express configuration: If your server contains the following:
* One 1024 MB ready drive,

e Two 2150 MB ready drives,

* And four 4300 MB ready drives,

Express configuration will create three arrays and one hot-spare drive as follows:

Array A:

The total capacity of this array is 1024 MB (1 x 1024 MB) and it contains
one, 1024 MB RAID level-0 logical drive.

Array B:

The total capacity of this array is 4300 MB (2 x 2150 MB) and it contains
one, 2150 MB RAID level-1 logical drive.

Array C:

The total capacity of this array is 12900 MB (3 x 4300 MB) and it contains
one, 8600 MB RAID level-5 logical drive.

Hot Spare:

Express configuration defines one of the four 4300 MB drives as a
hot-spare drive.

Notes:

1. When there are four or more ready drives of the same capacity, Express
configuration groups three of the drives into one array (as in Array C)
and defines one of the drives as a hot spare.

2. A hot-spare drive must be of equal or greater capacity than the drive
that it is intended to replace. In this configuration, the 4300 MB drive
can replace any failed drives in Array B or Array C. Array A is not
redundant, therefore a hot-spare drive is not used.

More information

Choosing between Express and Custom configuration in the wizard (SCSI)|

Choosing between Express and Custom configuration in the wizard (SAS, SATA |

HostRAID)|

Configuring RAID and creating arrays (action)

Choosing the RAID Level
Complete the following steps to choose the RAID level for the logical drive:

1.

Click the RAID level radio button to choose the RAID level for the logical
drive. Only the most common choices appear in the list.

—) Selectthe RAID lewel for this logical device.

@ RAID O (Striping, 2 ar more drives required, not redundant)
@ RAID 1 (Mirroring, 2 drives required, redundant)
® RAID 5 {Striping with parity, 3 ar mare drives required, redundant)

2. To choose a different RAID level, click Advanced settings; then, choose a RAID

level from the available options.

64  ServeRAID Management Installation and User's Guide



Note: Not all RAID levels are available on all controllers.

P Advanced settings

@ RAID 1E

@ RAID 5EE

@ RAID 6

@ RAID 10

@ RAID 50

i@ RAID 60

@ Simple volume
@ Spanned volume
@ RAID volume

SR-Gi SR-7t

In addition to[RAID Level-1E} FEE] ff|and [x} the ServeRAID
Manager supports the following RAID types for the ServeRAID-8i and
ServeRAID-7t controllers:

¢ Simple Volume - a single disk drive or segment; not redundant.

* Spanned Volume - two or more disk drives or segments with the same or

different capacity, connected end-to-end. A spanned volume offers no
redundancy or performance advantage over a single drive.

* RAID Volume - two or more logical drives with the same RAID level,

connected end-to-end. The logical drives may have the same or different

capacity and are not together; they may be redundant, depending on

the RAID level.

Notes:

a. You must create the individual logical drives before you create a
RAID Volume. Use the Configuration wizard to create the logical

drives; then, run the Configuration wizard again to create the

RAID Volume.
b. When you create a RAID Volume, the ServeRAID Manager

replaces the individual logical drives with a single RAID Volume
icon in the Logical devices view; then, it reports the logical drives
as deleted in the event viewer. The event message is normal and

does not indicate a loss of data.

4. When you are ready to continue, click Next. The ”[Create logical drivey’
window opens.

More information

* |Understanding RAID technologz]
¢ |Understanding stripe-unit siz

+ |[Understanding physical drive capacity and unusable capacityl|

Creating logical drives

Note: The ServeRAID-7t and ServeRAID-8i firmware supports a maximum of 10

"logical slices” per physical drive.

Complete the following steps to create logical drives:

1. In the Physical devices view (on the right), click the drives you want the logical

drive to use. To view available segments on each disk drive, switch to the
[full-size capacity view]or [relative-size capacity view]
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5.

Physical Devices Wigw

Faorts 0...3: 1.580 Ghis {4 devices found)

Note: A segment shaded in light blue and outlined by a dashed line is not part
of any logical drive.

To select a hot-spare for the logical drive, or to deselect a hot-spare,
control-click the drive.

In the Name field, enter a name for the logical drive.
If you do not want to use the maximum size for the logical drive, click
Advanced settings; then, type the size in the Size (MB) field:

% Advanced settings

Size (MB) 200585
Stripe size (KB) B4 =

Wirite cache |Disab|ed (write-through)

Read cache Enabled -

Initialize method |Aut0—synchrunizatianj

Initialize priority High hd

HostRAID:
For HostRAID controllers, the logical drive uses all of the space on each
disk drive; you cannot adjust the logical drive size.

To configure the logical drive for optimal performance, adjust the
as needed.

Note: The default settings usually are adequate for most applications.
If you have free space available and want to create additional logical drives,

click ; then, repeat steps 1-4.

When you are ready to continue, click Next. The "|Configuration summary[
window opens.

More information
¢ |Understanding physical drive capacity and unusable capacity|

Creating logical drives > advanced settings

Note: Not all options are available for all RAID levels.

Use the Advanced settings in the Configuration wizard to tune your logical drive
configuration for optimal performance. You can set the following options:

Write cache - Determines how data is stored in the controller’s cache memory.
You can choose from two available settings: fwrite-through| and [write-back]

stripe-unit size - Determines the amount of data, in kilobytes (KB), written to
one segment of a logical drive before the next segment is used for subsequent
data. Depending on the controller, you can choose a stripe-unit size from 16 KB
to 1024 KB.
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Notes:

1. The default stripe size usually provides the best performance for
typical applications.

2. For RAID Level-6 and Level-60 logical drives, the number of choices
for stripe-unit size decreases as the number of disks in the logical
drive increases.

* Read cache - Enables and disables read caching. When read-caching is enabled,
the controller monitors read access to the logical drive. If it detects a pattern, it
pre-loads the cache with the data that seems most likely to be read next. The
default is Enabled.

* Initialize method - Determines the method used to initialize the logical drive.
You can choose from three available methods:

— Auto-synchronization - For RAID Level-1 logical drives, copies the data from
the primary drive to the mirror drive. For RAID Level-5 logical drives,
computes and writes the correct parity for the entire logical drive.

Note: Auto-synchronization can be a lengthy operation. The ServeRAID
Manager performs this task in the background. However, you cannot
use the logical drive until the task is complete.

— Clear - removes pre-existing data by overwriting every block in the logical
drive. This method is faster than auto-synchronization but the logical drive is

Hos TR

not available immediately. For HostRAID controllers, the ServeRAID
Manager supports the Clear initialization method only.

— Quick - makes the logical drive available immediately. It is the fastest method
but should be used only for new physical disks.

* Initialize priority - Adjusts the priority of the initialization task. The default is
High: initialize the logical drive as fast as possible.

When you are ready to continue, click Next. The ” [Configuration summary[
window opens.

More information
+ |[Understanding stripe-unit size]

« |Understanding write-cache mode for logical drives|

« |[Understanding logical-drive synchronization|

Confirming your integrated RAID controller subsystem
configuration

Use the configuration summary to review all the changes that the ServeRAID
Manager will apply to your configuration:

1.

Review the information that is displayed in the "Configuration summary”
window. To change the configuration, click Back.

2. Click Apply; then, click Yes when asked if you want to apply the new
configuration. The configuration is saved in the integrated RAID controller.

Note: If you clicked |[Automatically initialize new logical drives| the ServeRAID
Manager will initialize the logical drives automatically.
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More information

« |Configuration wizard notes and attentions

+ |Understanding logical-drive synchronization|

Confirming your integrated RAID controller subsystem
configuration

Use the configuration summary to review all the changes that the ServeRAID
Manager will apply to your configuration:

1. Review the information that is displayed in the "Configuration summary”

window. To change the configuration, click .

Notes:

a. Additional jnotes and attentions|regarding the configuration appear
in the Event viewer]

b. Some operating systems have size limitations for logical drives.
Before you save the configuration, verify that the size of the logical
drive is appropriate for your operating system. For more detailed
information, see your operating-system documentation.

2. Click Apply; then, click Yes when asked if you want to apply the new
configuration. The configuration is saved in the integrated RAID controller.

Note: If you clicked [Automatically initialize new logical drives} the ServeRAID
Manager will initialize the logical drives automatically.

More information

* |Configuration wizard notes and attentions|

+ |[Understanding logical-drive synchronization|

Confirming your system configuration
Use the configuration summary to review all the changes that the ServeRAID
Manager will apply to your configuration:

1. Review the information that is displayed in the "Configuration summary”

window. To change your Express configuration, click | Mosifylogical drives | ; to
change your Custom configuration, click Back.

Note: Additional jnotes and attentiong regarding the configuration appear in

the |event viewej

2. Click Apply; then, click Yes when asked if you want to apply the new
configuration. The configuration is saved in the ServeRAID controller and in
the physical drives.

Note: The ServeRAID Manager will initialize the logical drives automatically.
The initialization method depends on the RAID level and controller type.

3. After you configure your controller, you can change certain controller settings
to [fine-tune your configuration| for optimal performance.

Note: During Custom configuration, you can fine tune your configuration
using the [Advanced settings|in the Configuration wizard.
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Attention: After you apply the configuration, the logical drives will display as
physical drives under your operating system. Before you can use these drives to
store data, you must partition and format the drives using the disk management
tools provided with your operating system. Each operating system provides its
own disk management tools. For example, under Microsoft Windows, use the
Computer Management tool to partition and format drives; then, assign each
logical drive to a drive letter. For more information, see your operating system
administrator’s guide.

More information

» |Configuration wizard notes and attentions

+ [Understanding synchronizing logical drives|

Selecting controllers to update
To select the ServeRAID controllers or enclosures to update:

1. In the tree, click the controller(s) or enclosure(s) you want to update. You can
also choose the controllers or enclosures you want to omit from the update
process.

For direct-attached storage devices, all controllers of the same type are selected
by default. If the controller or enclosure software is already up-to-date, it is
grayed out. To remove a controller or enclosure from the selection, just click it.

Note: To force a controller or enclosure to be updated, for example, if you want
to down-level the software, press the Control key, then click the
controller or enclosure.

2. When you are ready to continue, click Next; the ” [Update summary{’ window
opens.

Configuring ServeRAID enclosures

Choosing the configuration path

The Configuration wizard guides you through the configuration of your external
storage enclosure. You can use the Configuation wizard to create arrays and logical
drives for each controller in the enclosure. The Configuration wizard allows you to
add drives to the array; choose the RAID level for each logical drive; choose an
authentication method; and assign logical drives to users and machines (access
control).

Note:

¢ The maximum number of arrays depends on the number of physical disks
on the controller. You can configure one array per disk. Example: 4
physical disks=4 arrays maximum.

* You can create up to 64 logical drives per array.
* You can create up to 512 logical drives for each controller.

1. In the Enterprise view, click & (enclosure).
2. Right-click Configure storage, or click in the Logical devices view. The
Configuration wizard opens.

3. In the Select a configuration option field, choose a configuration path. Click
either:
* Create a logical drive in a new array
* Create a logical drive in existing array
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4. If you choose to create a logical drive in an existing array, select the array name
from the drop-down list.

5. Click Next. For new arrays, the " [Create arrayd’ window opens. For existing
arrays, the " [Create logical drived” window opens.

More information
+ |Configuring an enclosure: the basic steps|
¢ |Increasing logical drive capacity]|

Creating arrays and hot-spare drives
Complete the following steps to create arrays:

1. Click the appropriate Array tab in the right pane:

New array C \| Spares W

2. Then, from the list of ready drives, select the drives you want to add to the
array:

Enclosure merlyn, Contraller 2

= Ready Ch1,1D 3 (1000 ME)
&3 Ready Ch1,1004 (1000 MB)
¢ Ready Ch1,1D5 (1000 MB)
y Ready Ch1,10 6 (1000 ME)
= Ready Ch1, 1D 8 (1000 ME)

3. Click =) >> (Add selected drives) to add the drives to the array. You can
click >> (Add all drives) to move all ready drives to an array.

4. Repeat steps 1 and 2 for each additional array or hot-spare drive that you want
to configure.

5. If you do not want to create a spanned array, skip to step 5. Otherwise, select
the Span arrays check box [& spanarrays . Then, click Next. If you created two
arrays only, the ServeRAID Manager uses those arrays to create the spanned
array; continue to step 5. Otherwise, the " [Create spanned arrays| window
opens.

Note: To create a spanned array, each array must have the same number of
physical drives.

6. After you select the ready drives for your arrays and hot-spare drive, click
Next. The " [Create logical drives’ window opens.

To return to the " [Configuration pathl’ window, click Back. To leave the
Configuration wizard, click Cancel.

More information
* |Creating spanned arrays|
+ [Understanding creating spanned arrays|

Creating spanned arrays

If you want to assign [RAID level-x0| to an array, you must create a spanned array.

Complete the following steps to create one or more identical spanned arrays:

1. In the list of arrays, click the arrays that you want to add to your spanned
array.
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| Enclosure merlyn, Cantraller 1
|‘ E Array & (4000 WB) 2 drives

£ Array B (4000 MB) 2 drives

2. Click [ >> (Add selected arrays) to add the arrays to the spanned array. You
can click @ >> (Add all arrays) to move all arrays to the spanned arrays.

3. To create additional spanned arrays, click the New spanned array tab in the
right pane.

| Spanned array 1 \| Hew spanned array 2 \|

Then, repeat steps 1 and 2.

4. Click Next; the " [Create logical drives| window opens.

To return to the ” ’ window, click Back. To leave the Configuration

wizard, click Cancel.

More information
+ |Understanding RAID level-x0|

+ |Understanding creating spanned arrays|

Creating logical drives
Complete the following steps to create logical drives:

1. Click the appropriate Array tab.

| Array C \| Hew array D \|

2. Select a RAID level from the drop-down list.

RAID level

| 52|
0
1
5

 If you are configuring a spanned array, you can set the RAID level only for
the first logical drive you create.

¢ In addtion to the standard RAID levels (0, 1, 5, x0), you can also create a
simple volume: a single disk drive, non-redundant.

3. If you do not want to use the maximum size for the logical drive, type the size
in the Data (MB) field.

Diata (ME)
[ a000|

Notes:

a. Some operating systems have size limitations for logical drives.
Before you save the configuration, verify that the size of the logical
drive is appropriate for your operating system. For more detailed
information, see your operating-system documentation.

b. A logical drive cannot exceed 2048 GB (2 terabytes); the minimum
size is 10MB.
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c. Typically, the first logical drive defined on the first controller found
by system BIOS during startup will be your startup (boot) drive.

d. The actual logical-drive size might be slightly different from what
you select. The RAID level and the number of physical drives
determine the size of the logical drive. For example, an array
consisting of three, 1 GB physical drives with a requested RAID
level-0 logical drive of 1000 MB will actually contain only 999 MB
because the data is striped across all three drives, with 333 MB on
each drive.

4. From the Stripe Size drop-down list, select the stripe-unit for the logical drive.

Stripe size (KE)

16~

Note: The default stripe-unit size is usually adequate for most applications.

5. From the Controller drop-down list, select the preferred owner for the logical
drive, Controller A or Controller B. (For single controller configurations, this
field is grayed out.)

Note: You can only choose the controller for the first logical drive in the array.
6. If you have free space available and want to create additional logical drives,

click [ Define new logical drive | | To create a new logical drive with the same

settings as the current logical drive, click 3 Replicate logical drive |  then, choose
the number of replicas from the drop-down list.

Attention: Use care when allocating space for new a new logical drive. You
must leave enough space for [FlashCopy backups|to grow to their virtual size.
For example, if the virtual size of a FlashCopy backup is 20 GB, you must leave
at least 20 GB of free space in the array. Note that the Configuration wizard
displays the actual size of the first FlashCopy backup (not the virtual size), and
0 for all other FlashCopy backups.

7. Repeat steps 2 through 6 for each logical drive that you want to define in this
array.

8. Repeat steps 1 through 7 for each additional array you want to configure.

9. Click Next. Depending on the initiator type, the " [Define authentication|
method| window opens or the ” [Define initiatory" window opens.

To return to the ” ’ window, click Back. To leave the Configuration
wizard, click Cancel.

Defining the authentication method
Note: The ServeRAID Manager supports authentication for iSCSI initiators only.

Use the Authentication information window to define the authentication method (if
any) for each user permitted to use the logical drives in the array. Optionally, you
can enable Radius authentication (an external authentication service) and define
the SLP (Service Location Protocol) Scope name.

1. Select a logical drive from the list on the left.

2. From the Authentication type list, select the method used to authenticate users
of this logical drive. You can choose:
* None - Do not authenticate users
* CHAP - Challenge Handshake Authentication Protocol
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* SRP - Secure Remote Password

If you enabled authentication (by choosing CHAP or SRP), click AddUser | . the
"Global user name and password management” window opens. Then,

[users to the user list|

To enable Radius authentication for the CHAP authentication method, click
Radius authentication; then, enter the following:

¢ In the Primary server field, enter the host name or TCP/IP address of the
authentication service; then, in the Port field, enter the server’s startup port.

* In the Secondary server field, enter the host name or TCP/IP address of the
authentication service; then, in the Port field, enter the server’s startup port.

Note: Radius authentication is supported by the CHAP authentication method
only.

To modify the default SLP Scope name, click Advanced settings; then, in the

SLP Scope Name field, type a unique scope name or choose an existing name

from the drop-down list.

Repeat steps 1 through 5 to enable authentication for additional logical drives.

To replicate the settings for all logical drives, click .

When you are ready to continue, click Next. The ”|Define initiators| window
opens.

To return to the " |Create logical drives|’ window, click Back. To leave the
Configuration wizard, click Cancel.

More information
+ |Adding users to the user list]

Defining initiator information

Use the Initiator information window to define an alias, or "friendly” name, for
each initiator that can access the enclosure, including the initiator IQN (iSCSI
Qualified Name) or fibre channel port name. An initiator represents a machine on
the network that can access the enclosure.

The ServeRAID Manager displays previously defined initiators in a list. The alias is
shown on the left. Depending on the initiator type (iSCSI or fibre channel), the
IQN or port name is shown on the right. Initiator types are not mixed. You can
add a new initiator, modify an initiator, or delete an initiator.

To add an initiator:

1.

2.

3.

Click

. Depending on the initiator type, the "Add iSCSI initiator” window opens or
the "Add Port Name” window opens.

Follow the steps below to fadd an iSCSI initiator| or fadd a fibre channel port]
[namd]

When you are ready to continue, click Next. The ”[Assign logical drives to|
i

nitiators]’ window opens.

To return to the previous Configuration wizard window, click Back.

To leave the Configuration wizard, click Cancel.
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Adding an iSCSI initiator

1.

In the Initiator IQN field, type a well-formed IQN in the format:
ign.yyyy-mm.sl.s2[.|:]s3 where:

* yyyy is the 4-digit year

¢ mm is the 2-digit month (01-12)

* sl and s2 are 1-n character alphanumeric strings (for example, mydomain.com)
* s3is 5 or more alphanumeric characters, separated from s2 by "." or "/

In the Initiator alias filed, type a name for the initiator. The initiator alias must
start with a letter. It can contain only letters and numbers.

Optionally, click Advanced settings; then, click the check boxes to enable or
disable the following features:

= Advanced settings

Communications with initiator include

o Seperate status PDU separate status Protocol Data Unit (PDU).
o Reguires PDU alignment Communications with initiator include PDU
alignment.

[ Supports iSCEl ping

Initiator supports iSCSI ping.

4.
5.

Note: Refer to your initiator documentation for more information about these
features.

Click OK; then, repeat steps 1-3 to add additional initiators.
Click Cancel to close the "Add iSCSI initiator” window.

Adding a fibre channel port name

1.

5.

In the Port Name field, enter the 16-character Port Name. Each octet (8
characters) can be separated by a " or ’-'.

Port Mame |5?9984490?850444

In the Initiator alias field, type a name for the initiator. The initiator alias must
start with a letter. It can contain only letters and numbers.

Click OK; then, repeat steps 1 and 2 to add additional initiators.

Note: You can define a maximum of 255 ports (LUNSs) for each fibre channel
initiator.

To automatically detect initiators on your network, click

L Discover new initiators 1

. The "Select a discovered initiator” window opens.

Note: The button will be grayed out if no new initiators are detected.

Then, fselect a discovered initiator| from the list.
Click Cancel to close the "Add Port Name” window.

More information

Modifying and deleting initiator information|

Selecting discovered initiatorg

Selecting a discovered initiator
Use the "Select a discovered initiator” window to add an existing fibre channel
initiator to the list of initiators that can access the enclosure.
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4.

5.

From the Port Name list, select an initiator.

In the Initiator alias field, type a name for the initiator or accept the default.
The initiator alias must start with a letter. It can contain only letters and
numbers.

Click OK. The "Select a discovered initiator” window closes.

To select another discovered initiator, click | Discover new initiators | Then, repeat
steps 1-3 to add additional initiators.

Assigning logical drives to initiators

Note: You can assign up to 32 initiators to each logical drive.

Complete the following steps to assign logical drives to initiators:

1.

o

Click the appropriate Initiator tab in the right pane. To allow anyone to access
the logical drive, regardless of users in the|user lisﬂ click the Unrestricted tab.

| admin\I jiohn3 \| Unrestrictedw

Then, from the list of logical drives, select the drives you want the initiator to
access:

Enclosure merlyn, Controller 1

Logical drive 1 - Okay (10.0 GE)
Mev logical drive 2 (50.0 GB)

Click & >> (Add selected drives) to assign the logical drives to the

initiator. You can click >> (Add all drives) to assign all logical drives to
the initiator.

Repeat steps 1 and 2 for each initiator.

After you assign logical drives to initiators, click Next. The "

" window opens.

To return to the " [Define initiatord’ window, click Back. To leave the Configuration
wizard, click Cancel.

Confirming your system configuration
Use the configuration summary to review all the changes that the ServeRAID
Manager will apply to your configuration:

1.

Review the information that is displayed in the "Configuration summary”
window. To change the configuration, click Back.

Note: The Configuration wizard displays the actual size of the first FlashCopy
backup (not its virtual size), and 0 for all other FlashCopy backups.

Click Yes when asked if you want to apply the new configuration. A status
window opens, displaying the progress of the operation. When finished, the
configuration is saved in the controller and physical drives in the enclosure.

Note: The ServeRAID Manager initializes the logical drives automatically.
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More information
* |[Understanding logical-drive synchronization|

* |Initializing a logical drive|

Configuring NetWare user authentication

NetWare user authentication may be configured in one of two ways: out-of-box
authentication and NDS authentication. The two methods are mutually exclusive.

Out-of-box authentication

Out-of-box authentication works as follows:

* Administrative access is exclusively granted to the “Admin’ user account, which
must be defined within the NetWare Bindery context of the server running the
ServeRAID Manager agent.

* User access is granted to all Bindery and NetWare Directory Services (NDS) user
accounts. For NDS users, the user account must reside within the same tree as
the server running the ServeRAID Manager agent.

When logging into the ServeRAID Manager, NDS users must provide the fully
distinguished account name.

NDS authentication

NDS authentication is based on NDS group membership. To set up NDS group
membership, create and populate a NDS group for storage administration. After
you install the ServeRAID Manager, edit the ServeRAID Manager agent properties
file to restrict authentication to the new group.

For example:
1. Choose the group name ".CN=5StorageAdmins.O=Acme".

Note: The group must reside within the same NDS tree as the server running
the ServeRAID Manager agent.

2. Using the Novell Administration utility, add the appropriate users to the new
group.
3. Add the following entry to the SYS:\RAIDMAN\RaidAgent.pps file:

agent.group.NetWareStorageAdmin=< fully distinguished group name>The
new entry should look like this :

agent.group.NetWareStorageAdmin=.CN=StorageAdmins.0=Acme
4. Restart the server.

Limited user access is granted to all NDS user accounts.

More information
* |Logging in to the ServeRAID Managerl

* [Adding a remote system|

+ |Configuring the ServeRAID Manager agent]

Novell NetWare considerations

(NetWare 5.x only) If you are preparing to install Novell NetWare 5.x from the
startable Novell NetWare 5.x CD, set the write-cache mode only to write-through
mode.
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Attention: Do not attempt a hot-replace operation on Windows 2000, Windows
Server 2003, or NetWare by hot-removing a failed controller and then hot-adding a
new controller. Loss of data can occur. If a controller fails on these operating
systems, you must shut down the server to replace the controller.

Copying the configuration from drives

Note:
1. This action is not supported on the integrated RAID controller.

2. (Cluster environment only) Use this action to merge non-shared logical
drives.

Use this action to copy the configuration from all physical drives into a ServeRAID
controller. This action is useful when replacing a controller and you want to
reestablish the original configuration on the new controller.

If you are replacing a controller in a cluster environment, you must first configure
the cluster parameters by using the " [Configure for clustering]’ action. The cluster
parameters are the following:

* The controller name

* The partner controller name

* The SCSI initiator IDs

After you have configured these parameters, you can use "Copy configuration
from drives” to copy the configuration from only the non-shared drives into the
new controller.

1. In the Enterprise view, click ¥ (controller).
2. Right-click Copy configuration from drives.

3. If clustering is not enabled, go to step 4. Otherwise, right-click one of the
following from the menu:
* Non-shared 206
* Non-shared 207

4. A confirmation window opens; click Yes.

Restore the configuration to the factory-default settings

Note: This action is not supported on the following:
Integrated RAID controller

ServeRAID-7t controller

ServeRAID-8i controller

HostRAID controller

Network storage controllers

oD~

Use this action to restore all parameters in the configuration to the factory-default
settings:

1. In the Enterprise view, click ¥ (controller).

2. Right-click Restore to factory-default settings. A confirmation window opens.
3. Click Yes.

Note: In the following step, the ServeRAID Manager will destroy all data on
these logical drives.
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4. If there are logical drives defined, click Yes to delete all logical drives and
restore all parameters in the configuration to the factory defaults. If there are
no logical drives defined, the ServeRAID Manager automatically restores all
parameters in the configuration to the factory-default settings.

Saving a printable configuration and event logs

Use this action to save a report of your configuration and event logs that you can
print.

1. In the Enterprise view, click E (server).

2. Right-click ServeRAID Manager Actions » Save printable configuration and
event logs. The ServeRAID Manager creates one text file for each controller.
The file name is Raid x.log where x is a number assigned to the file.

Note: If you are in bootable-CD mode, you can save the files to a diskette in
the A drive only.

The ServeRAID Manager copies to each text file all configuration information for
the following:

* The controller in the selected system

* Any physical drive on the controller

* Any array on the controller

* Any logical drive on the controller

* Device event logs

¢ defunct drive event logs

* Software event logs

e Hardware event logs

The ServeRAID Manager saves all events currently in the event log, not only the
events associated with the selected system.

More information
+ |Example: Printable configuration|
* |Saving a printable configuration|

Saving a printable configuration
Use this action to save a report of your configuration that you can print.

1. In the Enterprise view, click m (system).
2. Right-click Save printable configuration. The "Save file” window opens.

3. Choose the directory and file name for your report. The default directory is the
directory in which the ServeRAID Manager is installed. The default file name is
RaidCfg.log.

Note: If you are in bootable-CD mode, you can save to a diskette in the A
drive only.

The ServeRAID Manager copies to a text file all configuration information for the
following:

¢ Each controller in the selected system

 All physical drives on the controller

+ All arrays on the controller

* All logical drives on the controller
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More information

Example: Printable configuration|

Saving a printable configuration and event logs|

Example: Printable configuration
July 13, 2001 7:30:58 AM EDT

Configuration summary

SErVer NAME. ..vveereereerneenannn myserver
ServeRAID Manager Version....... 4.80.xx
Number of controllers........... 1

Operating system.......covvuunnn Windows 2000

Information for controller 1

Controller type..ieeieeineenanns ServeRAID-4Mx
BIOS version.....coveviiiinnnnns 4.80.xx
Firmware version........cceee.n. 4.80.xx
Device driver version........... 4.80.xx
Physical slot...eeeeeeenennn.n.. 4
Battery-backup cache............ Installed
Read-ahead cache mode........... Adaptive
stripe-unit size.......... ... 8K
Rebuild rate.....cevevevenen.... High
Hot-swap rebuild................ Enabled
Data scrubbing.................. Enabled
Auto-synchronization............ Enabled
Clustering...eeee e inenenennnn Disabled
Unattended mode...............n. Disabled
BIOS compatibility mapping...... Extended
Number of arrays........ceceeee.. 2

Number of logical drives........ 2

Number of hot-spare drives...... 0

Number of ready drives.......... 0

Array A

Array identifier................ A

Array size in MB........covvn.n. 4157
Free space in MB.........cvvutn. 0

Number of Togical drives........ 1

Stripe order (Channel/Device)...1/4
Number of physical drives....... 1

Logical drives in array A

Logical drive...coveeeenennnnnn. 1

Array Tetter.....ccoeieueninnn. A

State. ettt it Okay

RAID Tevel..veeeieieeenennnnnnn 0

Data space in MB................ 4157
Parity space in MB.............. 0

Date created.....oeveeennnnnnnn. 7/13/01
Write-cache mode.......covvuunnn Write back
Merge group number.............. 207

Merge group state.........eeennn Non-shared

Physical drives in array A

N PPN Hard disk drive
ChanneT...coviiiiiiiiiiiinnnn, 1

SCST IDuieei it it iiennnnnns 4

Vendor. . ee e iiiiii i IBM_PSG
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Product or model number......... XXXXXXXX

Serial number.........ccevvinnn. XXXXXXXX
Firmware level....covveunnnn.. 1.00
Size iNn MBovveieienninennnennns 4157
State. ettt i i i it OnTline
Array Tetter......covevueninn.n. A

PFA error. ..o iiiininnnnnn No

Array B

Array identifier................ B

Array size in MB................ 6143
Free space in MB................ 2

Number of logical drives........ 1

Stripe order (Channel/Device)...1/0 1/1 1/2
Number of physical drives....... 3

Logical drives in array B

Logical drive....covvveenennnnnn. 2

Array Tetter......cccvivieenan... B

State. .o i it ittt i Okay

RAID Tevel..vieiiiiieenennnnnn. 5

Data space in MB................ 4094
Parity space in MB.............. 2047

Date created.......cocvvuiiinnn. 7/13/01
Write-cache mode.......covvuunns Write back
Merge group number.............. 207

Merge group state.........eeenn Non-shared

Physical drives in array B

TP et iee et ieeeneennennennnns Hard disk drive
Channel....ciiiiiiniiinnnnn, 1

SCST IDueeeei i it ieinenannns 0
Vendor....oovviiiiiniiiinnnnn, IBM_PSG
Product or model number......... XXXXXXX
Serial number............. ..., XXXXXXX
Firmware level.....cvvvveinan... 1.00
Size iNMBuvveveieneninenennnnnn 2047
State.ee it e Online
Array Tetter......covvvenenn.n. B

PFA error....coeiiiiniiiennnnnnns No

T P ettt ettt ieineeenenaaanns Hard disk drive
Channel....oviiiniiiiiinnnnn. 1

SCST IDu et i i it ieinennnnns 1
Vendor..ooeeeviiiiiiiiiiiinnn, IBM_PSG
Product or model number......... XXXXXXX
Serial number............. ... ... XXXXXXX
Firmware level......cvvueunnnnn. 1.00
Size iNMBuvvuieieneninenennnnns 2047
State.e it i Online
Array Tetter.....ccovevennnn... B

PFA error. .. iiieiiieiennnnns No

T P ettt ittt ieinennnenananns Hard disk drive
Channel...ceeeiininininenenennnn 1

SCST IDueeee i et ieieinennns 2
Vendor..ooeeeiiiiiin i, IBM_PSG
Product or model number......... XXXXXXX
Serial number........ccevuvinnn. XXXXXXX
Firmware level.....ocvvueuvnn... 1.00
Size iNn MBovvuieienninenenennns 2047
State. ettt i i i it OnTline
Array Tetter.....ccovevenvnn... B
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PFA error...ceeee i iiiennnnnnns No

SCSI channel 1

T P ettt it ieieneennenaannns Hard disk drive
Channel....ciiiiiiiiiiiiinnnnn, 1

SCST IDueee e ie it ieenennnnns 0
Vendor..oveeeiiiiiiin i, IBM_PSG
Product or model number......... XXXXXXX
Serial number................... XXXXXXX
Firmware level....covivuennnnnn. 1.00
Size iNMBuwveieieneninenenennns 2047
State.ee it Online
Array Tetter.....ccoeevuennnn... B

PFA error. . .eeeeiineiiieiennnnns No

T P ettt ettt nennnanananns Hard disk drive
Channel...ceveininininnenennnn 1

SCST IDueeee i et ieinenannns 1
Vendor..ovee i, IBM_PSG
Product or model number......... XXXXXXX
Serial number........coevuvinnn. XXXXXXX
Firmware level....covvvuennnn.n. 1.00
Size iN MBuvveieiennininenennns 2047
State. ettt i i it e Online
Array Tetter.....ccovevuennnn... B

PFA error. ..o iiiininnnnnn No

LN =3 Hard disk drive
Channel....uveeeninininenenennnn 1

SCST IDueee e i it ieieenannns 2
Vendor....covvvviiiiiiiiiinnennn, IBM_PSG
Product or model number......... XXXXXXX
Serial number........ceviviann. XXXXXXX
Firmware level....covvvueunnnnn. 1.00
Size iN MBovveieiinininnenennns 2047
State. ettt ittt i Online
Array Tetter.....coviiviininnnns B

PFA error...coeeiiiniiiininnnnnn No

T Pt ettt ittt iernennnanannnns Hard disk drive
Channel.....veeeninininenenennnn 1

SCST IDueuei it iiieenannns 4
Vendor..ee e iiiiiii i, IBM_PSG
Product or model number......... XXXXXXX
Serial number.........ccvviann. XXXXXXX
Firmware level.....ovvvuennnnnn. 1.00
Size in MB...iveiiiiiiiinnnnn, 4157
State. ettt it i Online
Array Tetter.....ccoeieueninnn. A

PFA error...coeeiiiiiiiniinnnnn No

T P ettt it ieiernennnannnnans Enclosure
Channel...c.veeenenininenenennns 1

SCST IDe ettt i i i eeinennnn 14
VEeNndor. e i i e it e e SDR
Product or model number......... GEM200
Serial number............ciiu... 0
Firmware level.....covvvuennnn... 2

SCSI channel 2
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More information

* [Saving a printable configuration (action)|

* |Saving a printable configuration and event logs (action)

Working with systems in the ServeRAID Manager

You can use the ServeRAID Manager to view information about managed systems,
ServeRAID controllers, and the ServeRAID Manager subsystem (such as arrays,
logical drives, hot-spare drives, and physical drives).

To view information, click an object in the [Enterprise view|or the

Logical device views} then, click (Properties) on the toolbar. Using
preferences| you can sort tree objects alphabetically or chronologically.

Note: The local system always appears first when you sort the tree alphabetically.

To display available actions for an item, right-click the item in the Enterprise view,
Physical devices view, or Logical devices view.

You can use the following actions and applications in the ServeRAID Manager to
modify or monitor other ServeRAID Manager systems in a network:

* |Add| or [remove|a remote system

+ |Notification Manager]

+ |[Email Notification Manager

.

* |ServeRAID Manager agent|

To configure a new ServeRAID controller with the Configuration wizard, click
(Create) on the toolbar or (Create) in the Logical devices view.

More information

* [The ServeRAID Manager menubar|

* [The ServeRAID Manager toolbar]

* |Using the ServeRAID Manager interface|

+ |Changing the ServeRAID Manager interface|

* [Finding information in ServeRAID Manager|

« |Using ServeRAID Manager Assist, hints and tips|

Using the ServeRAID Manager interface > Menubar
In addition to using the mouse, you can use keyboard shortcuts to access the

Selections from the Actions menu also are available when you right-click

an object in the Enterprise view, Physical devices view, and Logical devices view.

Note: No actions from the Actions menu are available during any of the following
operations:

* Rebuild

* Foreground synchronization

* Verification

* Logical-drive migration

¢ RAID level-5E compression or decompression

* RAID level-5EE compaction or expansion
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* FlashCopy with backup option
* Copy back

More information

¢ [The ServeRAID Manager menubar|

* [The toolbar]

e |The Enterprise Viewl

+ |The Physical and Logical device views|
* [The event viewer|

e |The status bagl

The ServeRAID Manager menu bar: The ServeRAID Manager menu bar has the
following functions:

File >
[Clear configuration event log]
Clears the current contents of the event viewer. This option does
not clear or delete the event logging file.
Preferences
Opens a window that you can use to specify the following settings:
* |Remote acces
* |Alarm
+ |Display options|
Close help
Closes the Help window
Exit  Exits the ServeRAID Manager.
View >
Toolbar
Turns the toolbar on and off. The default is on (that is, selected).
Status bar
Turns the status bar on and off. The default is on (that is, selected).
Tool tips
Turns the tool tips on and off. The default is on (that is, selected).
Refresh
Refreshes the display with the latest configuration information.
Remote >
[Add remote system|
Adds a remote system to the Enterprise view for monitoring and
configuration. This action is disabled in bootable-CD mode and
when the ServeRAID Manager is a plug-in to another program.
IRemove remote systeml
Displays a menu of all the remote systems currently in your
Enterprise view. You can select one remote system to remove at a
time. This action is disabled in bootable-CD mode and when the
ServeRAID Manager is a plug-in to another program.
Actions >

Display any action that is valid for the selected object in the Enterprise
view, the Physical devices view, or Logical devices view.
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Note: If there are no valid actions for the object you selected, the Actions
menu is grayed out.

Help >

Information about this window
View context-sensitive information for the current window.

Search
Searches for one or more specified words in ServeRAID Assist and
displays a list of topics that include the words.

Contents
Presents the ServeRAID Assist contents. You can use the contents
to acquaint yourself with ServeRAID Assist topics.

General Concepts
Presents ServeRAID concepts that you use with the ServeRAID
Manager.

Publications
Lists IBM publications and where to find them.

IBM online support
Lists IBM Web sites and available online support.

What's new
Lists the new features in this version of the ServeRAID Manager
program.

About ServeRAID Manager
Reports the ServeRAID Manager version number, copyright, and
legal information.

The ServeRAID Manager toolbar: The ServeRAID Manager toolbar has the
following functions:

Add a remote system to the Enterprise view for monitoring and configuration.

Note: This action is not supported when using the following:
* ServeRAID Manager in bootable-CD mode
¢ ServeRAID Manager as a plug-in application

|

Create a logical drive with the Configuration wizard. Choose Express or Custom
configuration, if there are ready drives and you have not assigned the maximum
number of logical drives.

u Silence

Silence the console alarm and agent alarm on all connected systems. All Warning

and Error events produce an audible alarm every five minutes, notifying you of
the event. You can adjust the in the "Preferences” window.
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Properties

When a system, controller, or device is selected, displays system, controller, or
device properties.

E Events

Open the event log in a stand-alone viewer. The stand-alone viewer shows all
ServeRAID Manager events. Use the embedded to view events for
the current ServeRAID Manager session.

le Configure

List tools for configuring the local or remote [ServeRAID Manager agent or
management station agent} To use a tool, select it from the drop-down list.

View context-sensitive information for the current window.

Using the ServeRAID Manager interface > Toolbar: The toolbar provides
quick-access icons for .
0@ add A4 create /1 Silence Properties  F=| Events  J, Configure_ 485 Help

More information

* |The menubaﬂ

* [The Enterprise view]

s [The Physical and Logical device views|
* [The event viewer|

e |The status baj

Using the ServeRAID Manager interface > Enterprise view: The Enterprise view
provides an expandable "tree” view of the systems, controllers, and enclosures you
are managing. It is divided into two parts:

* Direct attached storage - managed systems with directly attached controllers
and storage devices.

* Networked storage - management stations with network-attached storage
enclosures.

You can perform most configuration and management tasks by selecting a
controller or enclosure from the tree and working with related objects in the
[Physical and Logical device views,
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Enterprise view

=1 [Ef3 Direct attached storage
=l @ BLO207 34 (Local system)
¥ Controller 1
= [ nike
& Controller 1
= Controller 2
= Controller 3
= Networked storage
=] @ flipper (Management station)
#z3 Enclosure (SN 56789)

Tip: You can use to group related systems under single tree object.

More information

* [The menuba

e [The toolbari

+ |The Physical and Logical device views|
+ [The event viewer|

¢ |The status baﬂ

Using the ServeRAID Manager interface > Physical and Logical device views:
The Physical and Logical device views show the physical devices and logical
devices connected to the controller or enclosure.

The Physical devices view (on the left) displays information about the drives,
enclosures, and other devices attached to the controller. The devices are shown
organized by the channel or port they are connected to and shown in numerical
order. The display for each channel or port includes information on maximum
speed capability, the number of the channel on the controller, and the number of
devices attached to the controller.

The Logical devices view (on the right) displays information about the arrays and
logical drives created using the physical devices. This information includes the
number of arrays and logical drives, the RAID level of each device, and whether a
logical drive is protected by a hot spare drive.

To view device information, click @ in the [Enterprise view| to expand a managed
system or management station. Then, select a controller or enclosure from the tree.

Physical devices || Logical devices
@Oy
Channel 1 320 MBIs (4 devices found) Arrays (29
P & & # v B &
EXP300- Enclosure 1D 0 Logical drives (2)
peopoooboopeobb # >

For [network storage|, the Physical devices view also shows the controllers in the
enclosure. All other information is the same.
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Physical devices | | Logical devices

BEIY

Cantraller {13 Arrays (2
] r & 8
Channel 1 320 MBS (12 devices found) Logical drives (1)

@ oo e P

Tip: You can drag the bar between the Physical devices view and Logical devices
view to adjust the size of each pane.

In the Physical devices view, four indicators report status of the fan, battery,
temperature, and power modules on SAF-TE (enclosure management) devices and
other devices that monitor these conditions. The indicator is blue for normal,
yellow for warning, and red for error; the indicator is grayed out if none of the
devices on the controller monitor the condition. Example: the fan indicator changes
to yellow when one fan fails; it changes to red when a second fan fails and cooling
is no longer adequate.

In the Logical devices view, use the to create and delete arrays and logical

drives. The Create option ( 8| ) opens a wizard that presents the steps necessary to
create a new array.

Other buttons in the Logical devices view allow you to:

* |Change the way configuration information is displayed|
+ |Collapse and expand configuration information|

+ |Identify components of an array or logical drive|

You can also [create|and |delete| hot-spare drives.

More information
* [The menubaﬂ

* [The toolbar

* [The Enterprise view|
* [The event viewer|

e |The status ba£|

Using the ServeRAID Manager interface > Event viewer: The event viewer
provides advisory and progressive-status information and messages for your
ServeRAID Manager system. Every event includes a severity icon, a date and time
stamp, the host name where the event originated, and a description.

Note: All Warning and Error events cause an audible alarm to sound, notifying
you of the event.

You can double-click an event in the event viewer and the "Configuration event
detail” window opens. This window contains the same information as the event
viewer, but in a larger, easier-to-read window. Some events have additional details
listed in this window.

If the ServeRAID Manager is not in bootable-CD mode, it appends each event to a
log file, RAIDEVT.LOG. If this file exceeds 200 KB, the ServeRAID Manager copies

Chapter 4. Managing ServeRAID devices 87



88

the file to RAIDEVT.OLD and creates a new RAIDEVT.LOG. If there is a
RAIDEVT.OLD already, the ServeRAID Manager overwrites it.

More information

e [The menubaﬂ

 |The toolbar

¢ |The Enterprise viewl

» |The Physical and Logical device views|

e |The status baj

Using the ServeRAID Manager interface > Status bar: The status bar displays
the following information from left to right. You can drag the vertical bars to the
right and left to adjust the size of the viewing areas.

| —— e

@ Managed systems status icon. This icon is the same as the Managed systems
icon displayed in the Enterprise view. The text next to the icon states whether the
ServeRAID Manager has detected problems on any of the systems. You can see the
text by dragging the vertical bar to the right.

Tree path. Reports the tree path location of the selected object.

lmerlanCDntroller JiLogical drives/Drive 3

Progress indicator (ServeRAID legacy controllers only). A labeled progress
indicator is displayed in this pane if the currently selected system has one or more
controllers containing a logical drive undergoing any of the following operations:
* Rebuild

* Migration

* Synchronization (either foreground or background)

* Compression or decompression (RAID level-5E only)

* Compaction or expansion (RAID level-5EE only)

* FlashCopy

* Copy back

w"I w"I ml For ServeRAID-8i, ServeRAID-7t, and HostRAID controllers,

the ServeRAID Manager displays ™ (in animation) in the [Logical devices view]
instead of the progress indicator.

If no action is in progress, this pane is empty. The progress indicator is labeled
with the controller number and logical drive number. If more than one controller is
undergoing one of these operations, the progress of the selected controller is
displayed in the pane.

More information

¢ |[The menuba

¢ [The toolbar

« [The Enterprise view|

* [The Physical and Logical device views|
¢ [The event viewer|

Physical and Logical device views > Icons, buttons, and status indicators: The
ServeRAID Manager displays the following licons} puttons| and [status indicators| in
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the Physical and Logical device views, representing the physical and logical
devices in your system, their status, and the actions you can take to manage them.

lcons

L

Controller card

Array with no free space
Enclosure management device
Array with free space

Enclosure

[] Logical drive
& Ready hard drive
{3 Logical drive with hot spare

& Hard drive with no free space

u Creating/modifying array or logical drive
n Hard drive with free space
E] Initialize logical drive

<> Hot spare drive protecting logical drive

& FlashCopy backup
= Hot spare drive not protecting logical drive

¢¢ CD-ROM drive
@ defunct drive

E Removable drive
€ Tape drive

Buttons

Use the following buttons to view physical and logical device information and to
create and delete arrays and hot spares.

& e W = @

4 v [ H

To view physical device information in format (visible only if
system has an attached storage enclosure)
To view physical device information in format

To view physical device information in [full size capacity| format

To view physical device information in [relative size capacity| format

To create or delete a hot spare drive
To create an array or logical drive

To delete an array or logical drive

To expand and contract information in the

To expand and contract physical and logical device information
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Status indicators

Use the following indicators to monitor the status of controllers and SAF-TE
enclosure management devices in your system.

@ To monitor status of the fan module

B To monitor status of the battery module
| To monitor temperature status

¥ To monitor status of the power module

More information

« |Physical device view options|

« |Component views|

« |Collapsed and expanded views|

Physical and Logical device views > Collapsed and expanded views: In addition
to changing the way physical device information is displayed in the
(either textual or graphical), you can also view a collapsed or
expanded view of the system configuration information. Initially, the ServeRAID
Manager displays a collapsed textual view of the configuration information in both
the Logical devices view and Physical devices view.

[+ Click to expand and collapse information
about arrays and logical drives. The
expanded display shows the following
In Logical devices view information about each logical device:

?

* Array name and capacity (if available)
* Logical drive size
* Logical drive state
* Build progress
[ Click to expand and collapse information
about physical drives. The expanded display
- shows the following information about each
drive:
In Physical devices view * Capacity of the drive
¢ Drive ID
* Drive state

More information

 |Icons, buttons, and status indicatorsl

+ [Physical device view options|

+ [Component views|

Physical and Logical device views > Physical device view options: You can
choose the way information is displayed in the Physical devices view. To choose a
view option, click the associated button in the Logical devices view.
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Displays physical device information in text format. This is the default view
for controllers with direct attached storage devices.

Physical devices

w2 Controller 5

Channel 1 320 MBI (B devices found)

¥ @ 1D 0- optirmal (17537 ME)
€ 101 - Optimal (17537 ME)
G 1D 2 - Ready (17537 ME)

2 1D 3 - Ready (3678 ME)

1D 4 - Ready (3675 ME)

ID 5 - Ready (3678 MB)

B

[

D

D

Displays physical device information in full size capacity format. A full-length
bar is displayed for each drive, regardless of capacity. A small segment on
each drive is reserved for the RAID signature; this area is indicated by a gray
"cap” at the end of each bar.

Physical devices |

¥& Controller 5
Channel 1 320 MB/s (B devices found) [136 KE reserved segment |
< @ | 0

i | 8]

o O

o O

Note: A drive shaded in light blue is not part of any array.

Displays physical device information in relative size capacity format. A full
length bar is displayed for the largest drive. Proportionally shorter bars are
displayed for other drives.

Physical devices

w2 Controller 5

Channel 1 320 MBI (B devices found)

v @l 0
[ 0
o B]

¥

DR VR)
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Displays physical device information in enclosure view format. Drives in the
enclosure are shown in the physical slots they occupy with the proper vertical
or horizontal orientation. Empty slots are shown as drive outlines. This is the
default view for systems with an attached storage enclosure.

Physical devices |
4 Controller 2 AR

E¥P300- Enclosure 1D 0

ppppepeooopopoD +

o -

For network storage, enclosure view also shows the controllers in the
enclosure.

Physical devices |
iy
DE5300
pERDRDUDERDERD #

Attention: The enclosure view button is visible in the Logical devices view
only if an enclosure is attached to the system. HostRAID controllers do not
support enclosure view. Nor do some older enclosures.

More information

+ |Icons, buttons, and status indicators
+ |Component views|

+ |Collapsed and expanded views|

Physical and Logical device views > Component views: When you click either a
physical or logical device in the device views, the related components are
highlighted in the other view.

When you click an array, the associated logical drives are highlighted in the
Logical devices view and the physical drives that are members of the array are
highlighted in the Physical devices view.

Physical devices || Logical devices
@14
Channel 1 320 MB/s (14 devices faund) Artays (20
Do 6 G G R 6 G 6 v (B8
G S AR AR AR Logical drives (2)
Channel 2 320 MBrs (14 devices found) b fjj +®
U i B & e & & &
B e e e P

When you click a the logical drives protected by that spare are

highlighted.
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Physical devices || Logical devices
@iy
Channel 1 320 MB/s (14 devices faund) Artays (20
Pl e @ @ @ @ @ @ . N
g g @I g dly g Logical drives (2)
Channel 2 320 MBrs (14 devices found) I fjj +@
P a e & B e 6 & &
B e e e P

In the [graphical views] if the logical drive uses only part of the available storage,

only those segments are highlighted, using the following color code:
# dark blue - storage used by selected logical drive

# brown - storage used by other logical drives
# light blue - free space (not used by any logical drive)
s gray - space reserved for RAID signature
Physical devices || Logical devices
Channel 1 320 MBJs {4 devices found) Arrays (1)
v @ i i 0 b 8
g i i ] Logical drives (2)
& O i i p > @
a ] ] ]

Note: Partially filled hard drive EY ind array & icons indicate that the device

has free space.

More information

* |Icons, buttons, and status indicatorsl
* |Physical device view options|

+ |Collapsed and expanded views|

Sending a test trap from the SNMP Trap Manager

Use this action to send a test trap to a remote system.
1. Click a system in the SNMP traps list.

Note: This action is disabled if you do not select a system.
2. Click Actions » Send test trap.

Note: The SNMP Trap Manager cannot verify that the trap was received
successfully. You must verify that the trap was received on the remote
system. If the test fails, verify the following and try the test send again:

1. You typed the correct TCP/IP information when you [added the system|

to the traps list.
2. The SNMP console is running on the remote system.
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More information

« |Using the SNMP Trap Manager

* |Adding a system to the SNMP traps list]

* |Deleting a system from the SNMP traps list|

* [Modifying system properties in the SNMP traps list|

Working with objects in the Enterprise view and device views
Use objects in the Enterprise view and the Physical and Logical device views to
review information and to change or manage the ServeRAID configuration.

* |Direct attached storage objec
* [System object

 |Display group objectI

« [Controller object]

+ [Integrated RAID controller object

* [Networked storage objec

« [Management station object|

* [Enclosure object]

* larrays object|

* larray [letter] object|

+ |logical drives object]

+ |llogical drive [number] object]

+ |Channel [number] object|

+ |Ports [numbers] object]

+ |Physical drive [number] object|

+ |Hot-spare drive object]

+ |[Enclosure management device object]
+ |CD-ROM drive object]

+ |Removable-media drive object|

* [Tape drive object]

Direct attached storage object: Use this object, in the [Enterprise view} to work
with managed systems with direct attached storage devices or to display their
properties. When you click this object, the ServeRAID Manager displays a
summary of managed systems in the Direct attached storage view.

Possible subobject
. |(Display group)

Warning and error conditions
* BA (warning) is displayed if any system has a warning or error condition.

Actions
+ |Add remote system|

* |[Remove a remote system|

Update controller images|

Adding a remote system:

Note: This action is not supported when using the following:
* ServeRAID Manager in bootable-CD mode
* ServeRAID Manager as a plug-in application

94  ServeRAID Management Installation and User's Guide



Use this action to connect to a remote system or management station and add it to
the Enterprise view.

Tip: Before adding a remote system, verify that the system is running the required
software. To add a remote system with direct-attached storage, the ServeRAID
Manager must be running on that system. To add a management station with
a network-attached storage enclosure, the ServeRAID Manager management
station software must be running on that system.

1. From the Remote menu, select Remote » Add or click = (Add) on the
toolbar. The Add managed system window opens.

2. From the Type drop-down list, select:
* Managed System, to add a remote system with direct-attached storage

* Management Station, to add a remote management station with a
network-attached storage enclosure

3. Type the remote host name or TCP/IP address.

4. (Managed system only) Type the remote system startup port number. The
default port number is 34571.

5. Type your user name and password.

Note: The password is case sensitive.

6. If you want to save the user name and password, select the Save user
name/Password box. Once you successfully connect to the remote system, the
ServeRAID Manager stores this information in a file along with the host name

so you do not have to type your user name and password every time you run
the ServeRAID Manager.

7. Click Connect.

More information

+ |Failing to add a remote system|

* [Successfully adding a remote system|
* |Specifying remote access settings|

* [Removing a remote system|

Failing to add a remote system: If you fail to connect to the remote system, the
ServeRAID Manager displays an error message and does not add the remote
system to the Enterprise view. If the ServeRAID Manager fails to connect, verify
the following:

¢ The ServeRAID Manager is running on the remote system.
* The remote system is using a compatible version of the ServeRAID Manager.
* The remote system has TCP/IP installed.

* You supplied the correct user name and password, if security is enabled on the
remote system.

* The remote system is turned on.

¢ The host name is defined in the Domain Name Server or a Hosts file, if you are
trying to connect using a host name.

¢ The remote session is running on the appropriate port.

More information

Adding a remote system|

Successfully adding a remote system: When you successfully add a remote system,
the ServeRAID Manager updates the Enterprise view with the newly added
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system. The next time you start the ServeRAID Manager, it automatically loads the
systems into the Enterprise view. When you click one of these systems, the
ServeRAID Manager either:

* Opens the "Add managed system” window and prompts for the security
information, if the remote ServeRAID Manager has security enabled and you did
not save the user name and password.

* Connects to the system and retrieves the system information, if you saved the
user name and password, or security is disabled.

More information

Adding a remote system|

Specifying remote access settings:

Note: This action is not supported when using the following:
* ServeRAID Manager in bootable-CD mode
* ServeRAID Manager as a plug-in application

Local-only mode

Complete the following steps to run the ServeRAID Manager in local-only mode:
1. In the "User preferences” window, click the Remote access settings tab.

2. Select the Local only box.

3. Click OK.

4. Restart the ServeRAID Manager for this setting to take effect.

The next time you start the ServeRAID Manager, TCP/IP networking will be
disabled. In local-only mode, you cannot monitor any remote systems and no
remote systems can monitor your system.

Networking mode

Complete the following steps to run the ServeRAID Manager in networking mode:
1. In the "User preferences” window, click the Remote access settings tab.

2. If the Local only box is selected, deselect it.

3. Click OK.

4. Restart the ServeRAID Manager for this setting to take effect.

Note: The default port numbers for remote access are 34571-34574. If you have a
conflict with these numbers, you must jconfigure the agent|to use different
ports.

More information

« |Adding a remote system|

+ [Removing a remote system|

+ [Configuring the ServeRAID Manager agent]

Removing a remote system:

Note: This action is not supported when using the following:
* ServeRAID Manager in bootable-CD mode
* ServeRAID Manager as a plug-in application
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Removing a remote system does not take a remote system offline, but only
removes it from the ServeRAID Manager Enterprise view.

1. From the Remote menu, click either:

* Remote » Remove managed system and then the system name, to remove a
remote system with direct-attached storage

* Remote > Remove management station and then the system name, to
remove a remote management station with network storage

2. If you are removing a remote system with direct-attached storage, the
"Remove managed system” window opens; continue to step 2. Otherwise, skip
to step 3.

3. If you want to continue receiving events from the remote system after having
removed it, click "Continue to receive events from the remote system” from the
drop-down list.

4. Click OK.

More information

* |[Receiving events from a removed svsteml
+ |Adding a remote system|

* [Specifying remote access settings|

System object: Use this object, in the [Enterprise view] to work with a local or
remote system, or to display its properties.

If a system object is gray, the ServeRAID agent is not available on that system.
Note: The ServeRAID software supports a maximum of 16 ServeRAID controllers.

Possible subobject

. B 5 RAID controllen)]

. = [(Integrated RAID controller)

Warning and error conditions
* B (warning) is displayed if any controller in the system has any problem.

Actions

Note: Not all actions are supported on all controllers.

e If the system is remote, Iremove remote systeml

* Agent actions:
— Configure (not available in bootable-CD mode):

- ‘Notificationsl

- [Email Notifications|
- [[ask Manager,
— [View event log

Save printable configuration|
* ServeRAID actions:
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— [Save printable configuration and event logsg

- [Clear all controller event logs|

— |Validate cluster

* |Change display grou

* |Save support archive

Display group object: Use this object, in the [Enterprise view] to work with a
Eisélai‘ groué

Possible subobject

[(Management station)]

Warning and error conditions
. (warning) is displayed if any system in the display group has any problem.

Actions
+ |Delete display group|

+ |Rename display group|

ServeRAID controller object: Use this object, in the [Enterprise view| to work with
ServeRAID controllers and related objects in the Physical and Logical device views,
or to display controller properties.

Possible subobject

o Prays | |1Arrazs !I

o Lopicaldrives | |(Logical drives)|
+ [hannel|[(Channel [number])|
+ [FaiE ] |(Port [numbers])|

Warning and error conditions
* B (warning) is displayed for the following conditions:
— Any subobject of the controller has any warning or error conditions.
— The controller has a battery-backup cache problem.
* g (error) is displayed for the following conditions:
— The controller has failed.
— The controller has a bad configuration.

Actions

Note: Not all actions are supported on all controllers.
+ |Configure RAID|
* |Restore to the factory-default settings|

* |Copy configuration from drives|

+ [Delete all arrays

+ |Create logical drive in array [number]|

+ |Scan for new or removed ready drives|
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« |[Enable or disable copy back mode]

+ [Identify all physical drives|

* Clustering actions ==

- [Configure for clustering]|

— |View shared drives|

— [Fail from active to passive controller]

Replace a hot-swap controller]

The following actions are available only on the ServeRAID-7t, ServeRAID-8i, and
network-attached storage enclosures:

Enable data scrubbing]
* Change data scrubbing rate

The following actions are available only in bootable-CD mode:
+ [Enable or disable unattended mode|

* |Change rebuild rate]

+ |Change stripe-unit size|
+ [Enable or disable read-ahead cache modé]
* |Change BIOS-compatibility mapping]

Integrated RAID controller object: Use this object, in the [Enterprise view] to
work with integrated RAID controllers and their subobjects or to display their
properties.

The integrated RAID controller is displayed in the ServeRAID Manager Enterprise
view as two controller objects. However, you can configure only one array and
RAID level-1 logical drive on an integrated RAID controller. The controller
information in the tree lists the controller type as LSI 1030.

] Managed systems)

=1 [38 blo2073 (Local system)
¥ Controller 1 {ServeRAID-GM)
w Controller 2 {L 51 1030)
w Controller 3 {LSI 1030)

Note:

1. The integrated RAID controller provides [limited function|compared to
ServeRAID controllers.

2. The ServeRAID Manager can display a maximum of four LSI 1030
controller objects in a system.

3. Under Windows, LSI 1030 controller objects are not visible unless devices
are attached to one of the LSI 1030 controller channels. If devices are
attached to only one channel then only one controller object will be
visible.

Possible subobject

. Ml(ArraXs)l

o |Logical drives |(L0gical drives)|
«  [Ehaniel ] [(Channel [number])|

Chapter 4. Managing ServeRAID devices 99



100

Warning and error conditions
* B (warning) is displayed for the following conditions:

— Any subobject of the controller has any warning or error conditions.
* @@ (error) is displayed for the following conditions:

— The controller has failed.

— The controller has a bad configuration.

Actions

Identify all physical drives|

The following actions are available only in bootable-CD mode:
* [Configure RAID
* [Delete all arrays

Enable or disable unattended mode|

Enabling and disabling unattended mode:
Note: This action is supported in bootable-CD mode only.

Use this action to change the unattended-mode setting. This setting determines
how the ServeRAID Manager startup code (BIOS) handles failures during a system
startup. The default is Disabled.

1. In the Enterprise view, click ¥ (controller).

2. Right-click Enable or Disable unattended mode.

3. Click Yes to confirm.

More information
+ |Understanding unattended mode]

Identifying devices: You can identify the devices in a server or enclosure, such as a
physical drive, because the light associated with the device you selected is flashing.

1. Click any object in the [Physical devices view|or [Logical devices view] except
the following:

8 (Controller)
‘2 (CD-ROM drive)
€ (Tape drive)

E (Removable-media drive)
2. Right-click the appropriate Identify.

The ServeRAID Manager sends a command to the firmware (microcode) to
start flashing one or more physical drive or enclosure lights, depending on the
following:

* The selected object

* Whether the item and its subsystems are all controlled by an enclosure
device

Note: Identify works only on controllers with a SAF-TE processor and the
appropriate firmware. If a device light or a series of device lights do not
flash, it is because all or part of the subsystem is not controlled by a
SAF-TE processor.
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3. Click OK to stop the drive lights from flashing.

More information
* |Using Identify to work with your systems|
* [ServeRAID Manager and LED flash states|

Using Identify to work with your systems: When you click Identify for an object in
the [Physical devices view]or [Logical devices view} the ServeRAID Manager makes
the hardware light associated with the selected object flash.

Depending on what you clicked, you can identify the following:
e Adrive

 All drives

* A channel of drives

* Alogical drive

* All logical drives

e An array

* A spanned array

e All arrays

* An enclosure

You can make only one selection at a time. The hardware will continue flashing
until you click OK in the message window.

Identify works only on controllers with a SAF-TE processor and the appropriate
firmware. The processor uses a SCSI ID; therefore, it is displayed in the Physical
devices view as the following;:

# Enclosure management device

If a device light or a series of device lights do not flash, it is because all or part of
the subsystem is not controlled by a SAF-TE processor.

For example, if SCSI channel 1 has a SAF-TE processor, but SCSI channel 3 does
not, and you select to Identify all physical drives, only SCSI channel 1 will flash.

Identify is particularly useful for enclosures. You can use Identify to clarify which
drives in the enclosure you need to work with, before you pull them out of the
enclosure.

If a SAF-TE processor is present and the controller supports device identification,
you can identify the components by doing the following:

Right-click: To Identify...
Enclosure management device The enclosure itself

é--}
Enclosure All physical drives in the enclosure

. All physical drives in the selected array or
Array [number] spanned array
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Right-click: To Identify...
Lg All physical drives in the selected logical
Logical drive [number] drive
Physical drive [number] The selected physical drive.
( All physical drives in all arrays
([Logical drives object) All physical drives in all logical drives
([Channel object) All physical drives on the selected channel
Forts
([Ports object) All physical drives on the selected ports

More information
+ |Identifying devices (action)|
+ |ServeRAID Manager and LED flash states|

IBM ServeRAID SCSI controllers: You can use the IBM ServeRAID Manager with
the following:

* IBM ServeRAID-7K Ultra320 SCSI controller

e IBM ServeRAID-6i/6i+ Ultra320 SCSI controller
e IBM ServeRAID-6M Ultra320 SCSI controller

e IBM ServeRAID-5i Ultra320 SCSI controller

e IBM ServeRAID-4H Ultral60 SCSI controller

e IBM ServeRAID-4Mx Ultral60 SCSI controller

e IBM ServeRAID-4Lx Ultral60 SCSI controller

e IBM ServeRAID-4M Ultral60 SCSI controller

e IBM ServeRAID-4L Ultral60 SCSI controller

e IBM ServeRAID-3HB Ultra2 SCSI controller

e IBM ServeRAID-3H Ultra2 SCSI controller

e IBM ServeRAID-3L Ultra2 SCSI controller

e IBM ServeRAID-II Ultra SCSI controller

e IBM ServeRAID SCSI controller

More information

e [ServeRAID-5 hardware features|
e [ServeRAID-4 hardware features|
* [ServeRAID-3 hardware features|
* [ServeRAID software features|

Integrated RAID controller: The integrated RAID controller (such as an LSI 1030) is
a standard feature on some IBM xSeries servers. This controller has limited RAID
capabilities. With an integrated RAID controller, you can use the ServeRAID
Manager to:

* Configure two physical drives into a logical drive and assign it RAID level-1.
* Configure a ready physical drive as a hot-spare drive.
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* Monitor the physical drives for PFA errors.
* Set drive status lights for a failed physical drive or PFA error.

The integrated RAID controller is displayed in the ServeRAID Manager Enterprise
view as two controller objects. However, you can configure only one array and
RAID level-1 logical drive on an integrated RAID controller. The controller
information in the tree lists the controller type as LSI 1030.

] Managed systems)

=1 [38 blo2073 (Local system)
¥ Controller 1 {ServeRAID-GM)
w Controller 2 {L 51 1030)
w Controller 3 {LSI 1030)

Attention: If you choose to install a ServeRAID controller in the server, you
cannot migrate the data from an array configured on the integrated RAID
controller to an array configured on the ServeRAID controller.

For additional information about the integrated RAID controller, see the
installation instructions and CDs provided with your IBM xSeries server.

More information

+ |Understanding RAID level-1]

+ |Understanding RAID level-1 Enhanced|

+ |Choosing to create a hot-spare or standby hot-spare drive|
* [ServeRAID software features|

Configuring the ServeRAID controller for clustering:

Note: This action is not supported when using the following:

* Integrated RAID controller

* ServeRAID-5i controller

* ServeRAID-6i/6i+ controller

* ServeRAID-7k controller

* ServeRAID-7t controller

* ServeRAID-8i controller

* HostRAID controller

Use this action to configure and view ServeRAID settings for clustering computers
or using high-availability.

The ServeRAID Manager configures the controller name, partner controller name,
and SCSI initiator IDs in bootable-CD mode only; otherwise, you can view only
this information .

You can configure merge-group numbers for a logical drive that you have created
during the current session of the ServeRAID Manager. If you have exited from the
ServeRAID Manager since you created the logical drive, you cannot configure
merge-group numbers for it. You must use the ServeRAID Manager in startable-CD
mode to change merge-group numbers for logical drives that are not new.

1. In the Enterprise view, click ¥ (controller).

2. Right-click Clustering actions » Configure for clustering.
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7.

Enter the controller name and partner controller name. You can specify a name
up to 12 characters. When you enter the partner controller name, the
merge-group information displays in the window.

Note: Names are case sensitive.
Select the SCSI initiator IDs which can be 6 or 7.

Note: The SCSI initiator IDs must be unique from the partner controller
initiator IDs. The default is 7.

If you want a logical drive to merge to another controller if this controller fails,
select the Shared box. Otherwise, if you do not want a logical drive to merge to
another controller, select the Non-shared box.

Note:

a. Non-shared is the default for all logical drives. The merge-group
number is defined as [200 + the SCSI initiator ID]. You cannot change
the merge-group number for a non-shared logical drive.

b. If a logical drive is defined as shared, all physical drives in the
logical drive must be on a shared channel.
Enter a merge-group number for the shared logical drive. This merge-group
number must be unique from the partner controller (that is, the merge-group
number for any logical drive belonging to the partner controller cannot be the
same merge-group number).

Note: The default merge-group number is the logical-drive number.

Once you have configured both controllers for clustering, you can click
*

hared drives|to view the physical drives owned by a partner controller.

More information

+ |Using ServeRAID in a cluster environment|

Validating a cluster:

Note: This action is not supported when using the following:

¢ ServeRAID Manager in bootable-CD mode

¢ ServeRAID Manager as a plug-in application
* Integrated RAID controller

¢ ServeRAID-5i controller

* ServeRAID-6i/6i+ controller

¢ ServeRAID-7t controller

* ServeRAID-8i controller

* HostRAID controller

Note: You must have the ServeRAID Manager installed and running on all servers

in the cluster for this feature to work. You must run the Validate cluster
feature from one of two nodes in the cluster; you cannot run it remotely.

Use this action to determine if your cluster configuration is configured correctly.

1.
2.

In the Enterprise view, click & (local system only).

Right-click ServeRAID actions » Validate cluster. The "Validate cluster”
window opens. The system you selected in step 1 is listed in the Node A box.
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Note: You cannot change the Node A system in the "Validate cluster” window.
To select a different system, click Cancel to return to the tree.

3. Select your second system from the Node B drop-down list.

Note: The Node B system defaults to the first system in the Enterprise view
other than the Node A system. If there are no remote systems in the

Enterprise view, click Cancel to return to the Enterprise view and

4. Click Start. The ServeRAID Manager scans both systems to verify the
configuration.

5. If you want to stop the validation before it is completed, click Cancel.
Otherwise, if the ServeRAID Manager found problems with the configuration,
it reports the problems in the message field. If there are no problems with the
configuration, the message field reports only the cluster pairings found.

6. To view the problem report events in an easy-to-read window, double-click an
event in the message field.

7. To save the contents of the message field, click Save. A "Save as” window
opens.

8. Specify the file name for the message field log and click OK.

9. Click Done to exit the "Validate cluster” window. If the configuration has

problems, use ” [Configure for clustering]’ to fix the problems; then, use
"Validate cluster” again.

More information
+ |Configuring the ServeRAID controller for clustering]
»  |IBM ServeRAID User’s Reference]

Clearing controller event logs: Use this action to clear (erase) all controller event
logs. If you are having problems, do not clear the event logs; your service
representative might need to reference the logs. If you must clear the logs, save the
logs first.

Note: The event logs are automatically cleared when you update the firmware
(microcode) on the controller.

1. In the Enterprise view, click m (system).
2. Right-click ServeRAID Manager Actions » Clear all controller event logs. The

ServeRAID Manager clears all event logs belonging to all controllers in the
selected server.

More information
« [Saving a printable configuration|
» [Saving a printable configuration and event logs|

Replacing a ServeRAID controller:

Note: This action is not supported when using the following:
* Integrated RAID controller
* ServeRAID-5i controller
* ServeRAID-6i/6i+ controller
* ServeRAID-6M controller under the Windows operating system

Use this action to perform a hot-swap replace of a controller.

1. In the Enterprise view, click ¥ (controller).
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2. Right-click Replace controller. The IBM ServeRAID Hot-Swap Wizard opens.
Click Next. The wizard turns off the PCI slot.

4. Click Next. The "Replace the controller” window opens. This window
that you must follow to replace the controller hardware in the server.

5. When complete, click OK. The wizard does the following:
a. Turns on the PCI slot.
b. Verifies that the controller is working properly.

w

c. Configures the controller by importing the configuration from the physical
drives.

Note: Configuration can take several minutes.

6. Click Next.
7. Click Finish.

More information
* |Steps for hot-replacing a ServeRAID controller|
+ |Using Active PCI features|

Configuring a ServeRAID controller: the basic steps: The following steps are an
overview of the ServeRAID configuration process:

1. In the Enterprise view, click 8 (controller) that you want to configure.
2. Right-click Create logical drive, or click in the Logical devices view. The

Configuration wizard opens.

3. Click either Express configuration or Custom configuration: If you select
Express configuration, the ServeRAID Manager automatically:

a. Creates one or more arrays, based on the number and size of ready physical
drives in your system.

b. Defines a hot-spare drive, if four or more ready physical drives of the same
size are available.

c. Defines a logical drive for each array.

If you select Custom configuration, the ServeRAID Manager walks you
through:

a. [Selecting the physical drives| that you want to include in your arrays or
create as hot-spare drives.

b. |Defining the logical drives|for your arrays.

4. Click Automatically initialize new logical drives. Initializing a logical drive
erases the first 1024 sectors on the drive and prevents access to any data
previously stored on the drive.

5. Click Next; then, review the [configuration summary}

6. Click Apply. The ServeRAID Manager will configure the controller and
initialize and synchronize the logical drives.

L I L I b I For HostRAID controllers, Express configuration creates a

single logical drive. Custom configuration allows you to select the physical drives
and segments used to define your logical drives.
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More information

« |Example: Express configuration|

* |Choosing between Express and Custom configuration (SAS, SATA, HostRAID)|
* |Configuring RAID|

Configuring two ServeRAID controllers in a failover environment:

Note: This action is not supported when using the following controllers:
¢ Integrated RAID controller
* ServeRAID-5i controller
* ServeRAID-6i/6i+ controller
* ServeRAID-7t controller
* ServeRAID-8i controller
* HostRAID controller

You can configure two ServeRAID controllers in a failover environment when
using Microsoft Windows 2000 or Microsoft Windows NT 4.0. Recent versions of
ServeRAID device drivers utilize fault-tolerant technology. With fault tolerance,
you can pair two controllers and connect them to the same enclosure to ensure
access to the physical drives, even after one controller fails.

Failover requires specific controller settings. You must set or change these settings
by using the ServeRAID Manager in bootable-CD mode. The settings are the
following:

* Controller name

* Partner controller name

* SCSI initiator IDs

Use [Configure for Clustering| to change these settings. You can use this action to
view the settings from the installed ServeRAID Manager. To set or change these
settings, you must use this action in bootable-CD mode.

Important: Be sure to review |Configuring IBM ServeRAID Controllers for Failoven.

More information

« [Failing from active to passive controller (action)|

Steps for hot-replacing a ServeRAID controller: If you are hot-replacing a ServeRAID
controller in a server that you are monitoring remotely, print these steps so you
can refer to them while working at the server.

1. Review the Safety Information in the ServeRAID book and the Safety
Information book provided with your IBM server.

2. Detach the SCSI cables from the ServeRAID controller.
Open the locking handle and raise the latch.

w

4. Unseat the controller from the PCI slot and remove the controller from the
server.

5. Insert the replacement controller in the PCI slot.
6. Lower the latch and close the locking handle.
7. Connect the SCSI cables to the replacement controller.

More information
» |Replacing a ServeRAID controller (action)|
 |Using Active PCI features|
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Failing from the active to the passive controller:

Note: This action is not supported when using the following:
Integrated RAID controller

ServeRAID-5i controller

ServeRAID-6i/6i+ controller

ServeRAID-7t controller

ServeRAID-8i controller

HostRAID controller

o0 rLN =

Use this action to force a failover from the active to the passive controller for the
following reasons:

* To test your failover configuration.

* If you are having problems accessing data through ServeRAID, attempt to
failover to see if that fixes the problem.

Note:
1. This action is available only if clustering is enabled.

2. Failover detects only failed controllers.

1. In the Enterprise view, click ¥ (controller).
2. Right-click Clustering actions » Fail from active to passive.
3. Click Yes to confirm the failover.

Networked storage object: Use this object, in the [Enterprise view] to work with
the management stations and network-attached enclosures in your configuration or
to display their properties. When you click this object, the ServeRAID Manager
displays a summary of management stations in the Networked storage view.

Possible subobject

. |Management station)|

. [(Display group)|

Warning and error conditions

* BA (warning) is displayed if any management station has a warning or error
condition.

Actions
* |Add management station|

* |[Remove management stationl

+ [Update controller images|

Management station object: Use this object, in the [Enterprise view] to work with
a managment station or to display its properties.

Possible subobject

1.

man

#E |(Enclosure)

Warning and error conditions

* BA (warning) is displayed if any enclosure has a warning or error condition.
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Actions

* [Add agent
* [Remove agent

* |Configure management station|

 |View management station event logl

Change display group|

Adding an agent: Use this action add almanagement station agent| or IFlashCopyl

QO
O

* The management station agent is a monitoring agent for network storage. After
you add a management station agent, you can monitor and configure the
attached enclosures from a ServeRAID Manager console.

* The FlashCopy agent monitors FlashCopy backups for network storage. You
must run at least one FlashCopy agent to manage FlashCopy backups of logical
devices on external storage enclosures.

Adding a management station agent

To add a management station agent:

1. In the Enterprise view, click E (management station).
2. Right click Add agent. The "Add agent” window opens.

3. Enter the management port host name or TCP/IP address of one of the
controllers in the enclosure. (Single controller configurations have only one
controller in the enclosure.)

4. Enter the administrator’s password in the password field.

Note: The administrator’s password is established when the enclosure is
installed on the network. It is not the same as the management station
password.

5. Click Add.
Adding a FlashCopy agent

To add a FlashCopy agent:

1. In the Enterprise view, click m (management station).
2. Right click Add agent. The "Add agent” window opens.

3. Enter the host name or TCP/IP address of the machine on which the agent is
running.

Note: For the FlashCopy agent, no password is required.
4. Click Add.

More information
* |Using the management station agent|
¢ [Removing an agent|

Removing an agent: Use this action to remove a management station agent or
FlashCopy agent for networked storage. Removing the management station agent
deletes the enclosure from the Enterprise view, but does not take the enclosure
offline.
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To remove an agent:

3.

In the Enterprise view, click E (management station).

Right click Remove agent and then the agent name. In the pull-right menu,
management station agents are listed first, above the horizontal rule. FlashCopy
agents are listed below the rule. The rule is visible (near the top of the panel)
even if no management station agents are defined.

Click Yes.

More information

Using the management station agent
Adding an agen

Configuring a management station: Use this action to configure a management
station. After you configure a management station, you can monitor the attached
enclosures from a ServeRAID Manager console running on another system.

1.
2.

3.

In the Enterprise view, click m (management station).

Right click Management station actions > Configure. The "Management Station
Configuration” window opens.

Configure the Security Manage SNMP Traps Manager] and [Email Notification|

[Manager]

More information

Using the management station agent|
Using the Security Manager

Using the SNMP Traps Managei]
Using the Email Notification Manager|

Viewing the management station event log: Use this action to view events in the
management station event log.

1.
2.

4.

In the Enterprise view, click = (management station).

From the Actions menu, click Management station actions » View event log.
The "Management station event viewer” window opens.

If you want to save the event log to a file, click File » Save as. The default is
Events.txt.

Click File » Close to close event viewer window.

More information

[Using the management station agent|

Using the management station agent: The management station agent is a monitoring
agent for network storage. After you add an agent, you can configure the
management station to:

Notify users by email when events occur on the enclosures attached to the
management station. Use the [Email Notification Manager from the Management
Station Configuration console, to add recipients to the email notification list.

Prevent unauthorized users from connecting to the management station using its
built-in security feature. The management station checks the security list user
name and password to ensure that only authorized users can log in. Use the
[Security Manager} from the Management Station Configuration console, to add
users to the agent security list.
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* Send SNMP traps. You can receive SNMP traps using any available SNMP
management program. Use the [SNMP Trap Manager| from the Management
Station Configuration console, to add systems to the SNMP traps destination list.

The agent monitors and generates events for critical or fatal problems in the
enclosure configuration every 5 seconds. These changes include, but are not limited
to:

* defunct drives

» PFA drives

* Failed battery

* Offline or critical logical drives
* Failed controllers

* Enclosure problems

* Non-warranted drives. An event is sent at startup, console connection, and every
30 days

More information

+ |Adding a management station agent|

+ |Configuring a management station|

+ |Viewing the management station event log|

Enclosure object: Use this object to work with an enclosure or to display its
properties.

Possible subobject
None.

Warning and error conditions

. (warning) is displayed if the enclosure has the following conditions:
— A fan has failed.
— A power supply has failed.

e & (error) is displayed if the enclosure has the following conditions:

It is not responding.

It is overheating.

Multiple fans have failed.

Multiple power supplies have failed.

» & (enclosure) is displayed if the enclosure is one of the following;:
— Working properly.
- Not supported.

— Supported, but not monitored for problems. For example, enclosures that are
internal to a server do not have separate fans or power supplies.

Actions
» |Identify all physical drives|

* [Fail back storage| (dual controller configurations only)

* |Shut down enclosure|

+ |Restart enclosure]
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« |Enter software key|

+ |Change controller date and time]

* [Save support archive|

Save support archive: Use this action to save the ServeRAID Manager configuration
and status information in an archive file. Your ServeRAID Manager service
representative might ask you to create this file to help diagnose a problem with
your system.

1. In the Enterprise view, click E (system) or € (enclosure).

2. From Action menu, select Save support archive. The "Save as” window opens.

3. In the File name field, type a name for the archive file or accept the default
name.

4. Click Save.

More information

e |View event 10g|

+ [Save printable configuration|

+ [Save printable configuration and event logs|

Arrays object: Use this object, in the [Logical devices view/ to work with basic
arrays or spanned arrays or to display their properties:

| Logical devices

> & B8

Note: A controller supports a maximum of eight arrays or four spanned arrays. An
integrated RAID controller supports a maximum of one basic array.

Possible subobject

. [(Array or spanned array)

Warning and error conditions
* None.

Actions

* |Delete all arrays|

* |[Identify all arrays|
« If the array has free space, [Create logical drive in array|

Understanding creating basic arrays: When you group one or more physical drives
together and configure the ServeRAID controller to access them in a particular
pattern, you create a basic array. The maximum number of basic arrays depends on
the controller and RAID level.

Arrays are used to improve security, and reliability. The amount of

improvement depends on the application programs that you run on the server,

ServeRAID parameters, and the RAID levels that iou assiin to_the l(ﬁical drives in

your arrays. The ServeRAID software supports EI and @

(Not all RAID levels are supported by all controllers.)

ServeRAID Management Installation and User's Guide



Note: Each ServeRAID controller supports up to eight logical drives. If any of the
existing arrays contain a RAID level-5 Enhanced logical drive, you can have
only seven logical drives on a controller.

SR-Gi SR-7t

For the ServeRAID-8i controller you can configure a maximum of 128
logical drives. For the ServeRAID-7t controller, you can configure a maximum of 24
logical drives.

More information

« |Understanding creating spanned arrays
 |Creating arrays and hot-spare drives in the wizard|
+ [Configuring RAID and creating arrays (action)|
 [Example: Express configuration|

« [Physical drive capacity and unusable capacity|

Understanding creating spanned arrays:
Note: This feature is not supported on the integrated RAID controller.

When you group one or more arrays together and configure the ServeRAID
controller to access them in a particular pattern, you create a spanned array.

Spanned arrays are used to create logical drives using as many as 60 physical
drives. The ServeRAID controller supports RAID level-00, 10, 1E0, and 50.

More information

* |Creating spanned arrays in the wizard|

+ |[Understanding RAID level-x0|

* |[Understanding when RAID level-x0 logical drives change state]
« |[Understanding creating basic arrays|

* [Physical drive capacity and unusable capacity]

Configuring RAID and creating arrays:

Note: This action is supported on the integrated RAID controller in bootable-CD
mode only.

You can use the Configuration wizard to create up to eight arrays and up to eight
logical drives for each ServeRAID controller. The Configuration wizard provides
two configuration options: Express and Custom. Express configuration
automatically configures your ServeRAID controller. Custom configuration allows
you to configure your controller manually. If you want to use RAID level-1E, RAID
level-5E, RAID level-5EE, or RAID level-x0, you must use Custom configuration.

Note: If you intend to use your ServeRAID controllers in a Microsoft Windows
failover or clustering environment, review the ServeRAID publications|
before configuring ServeRAID.

1. In the Enterprise view, click ¥ (controller).

Note: The integrated RAID controller is displayed in the ServeRAID Manager
Enterprise view as two controller objects. However, you can configure
only one array and RAID level-1 logical drive on an integrated RAID
controller.
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A

Right-click Create logical drive, or click on the toolbar or Logical devices
view. The Configuration wizard opens.

3. |Click either Express configuration or Custom configuration)

Note: If you click Express configuration, you will have the opportunity to
review and approve the configuration before the ServeRAID Manager
applies the configuration.

4. Click Automatically initialize new logical drives. Initializing a logical drive
erases the first 1024 sectors on the drive and prevents access to any data
previously stored on the drive.

Create the arrays and hot-spare drives|

If you want spanned arrays, create the spanned arrays.|

Create the logical drives.

© N o O

Review the configuration summary and apply the configuration

More information
+ |Configuring a ServeRAID controller: the basic steps|

+ [Initializing a logical drive|

Creating arrays and a hot-spare drive for your integrated RAID controller subsystem:
Complete the following steps to create arrays:

1. Click the Array tab in the right pane:

New array C \| Spares W

2. Then, from the list of ready drives, select the drives you want to move to the
array:

Systermn merlyn, Controller 2

{3 Ready Ch1,1D 3 (1000 MB)
&3 Ready Ch1,1004 (1000 MB)
¢ Ready Ch1,1D5 (1000 MB)
&3 Ready Ch1,1006 (1000 MB)
&3 Ready Ch1,1D8 (1000 MB)

3. Click ] >> (Add selected drives) to add the drives to the array.
4. If you want to configure a hot-spare drive, complete the following steps:
a. Click the Spares tab.

b. Select the physical drive you want to designate as the hot-spare drive; then,

click = >> (Add selected drives).

5. Click Next. The "|Configuration summary|' window opens.

To return to the ” [Express and Custom configuration| window, click Back. To leave
the Configuration wizard, click Cancel.

More information

Understanding creating basic arrays|

Deleting all arrays:

Note:
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1. This action is supported on the integrated RAID controller in
bootable-CD mode only.

2. This action is not supported on the ServeRAID-8i and ServeRAID-7t
controllers.

Use this action to delete all arrays on the specified controller.

For some operating systems, deleting an array and its associated logical drives
might change the drive-letter assignments of the remaining drives when you
restart the system.

Attention:  If you delete all arrays associated with the controller, all data on the
controller is destroyed.
1. In the Enterprise view, click ¥ (controller).

Attention: Before proceeding, ensure that you have backed up any data and
programs that you want to save.

2. Right-click Delete all arrays.
3. Click Yes to confirm the delete.

Replacing physical drives in an array: If you have an array built with one or more
physical drives that are not the same size, or you simply want to upgrade the
array with new, larger drives, you can replace the physical drives in the array.

Attention: During the rebuild operation, if another physical drive fails, there is
the risk of losing data.

1. Replace the physical drive in the server or enclosure with a larger physical
drive.

2. Wait for the rebuild to complete.

3. Repeat steps 1 and 2 until you have replaced all the smaller physical drives in
the array.

More information
« [Example: Usable and unusable capacity]|

Modifying an array in the migration wizard: To add or remove drives in an array:

1. In the Physical devices view (on the right), click the drives you want the array
to use. To view available segments on each disk drive, switch to the
[capacity view]| or [relative-size capacity viewt

Physical devices Wieny
Channel 2 320 MBIs (8 devices found)
v @ U 18]
E [ 0
g O 0
& U I 0
g O ] 0
an O )]
6 H| 0
* Enclosure management device

Note: A segment shaded in light blue is not part of any array or logical drive.
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2. To remove or replace a physical drive, click the drive you want to remove
(indicated by € ). Then, click the drive you want to replace it with. To cancel

your changes and start over, click .

Physical devices Wieny
Channel 2 320 MBIs (8 devices found)
v @ U 18]
E [ 0
@& O 0
K O I 0
g O ] 0
an O )]
6 H| 0
* Enclosure management device

3. When you are ready to continue, click Next. The " [Configuration summary[
window opens.

More information
+ |Understanding physical drive capacity and unusable capacity|

Choosing the primary physical drive of the array: When you create a [RAID level-1

logical drive on an integrated RAID controller, you must specify the primary
physical drive. Doing so ensures that you retain the data on the primary physical

drive. In a RAID level-1 logical drive, the data on the primary physical drive is
copied to the secondary physical drive (the mirror). Any data on the secondary

physical drive is destroyed.

After the logical drive is created, the physical drive Properties panel reports the
mirror role (primary or secondary) of each drive:

x|

ID 0 - Online (1000 ME)

Denvice \| Capacily\| Status
State Qnline
Array letter A
Mirrar role Frirmary
FFA error Mo
Pattitionad es

Knowing the mirror role of each physical drive can be useful in the following
situations:

* Creating a logical drive with a physical drive that already contains data. A
server has one physical drive and the operating system is installed on that
physical drive. You decide that you want a RAID level-1 logical drive to achieve
redundancy. When you install a second physical drive and configure the logical
drive, you must specify the original physical drive as the primary physical drive
so you do not destroy the data on that drive.

* During a synchronization failure. After the logical drive is created, a
synchronization begins to create the mirror of the primary physical drive. While
the synchronization is in progress, the logical drive is displayed as critical,
because the mirror is not complete and the logical drive has not achieved
redundancy. During the synchronization, if the primary physical drive fails, all
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of the data on the drive is lost because the mirror is incomplete. If the secondary
physical drive fails, the data on the primary physical drive is intact and you can
create the mirror using a hot-spare drive.

More information
+ |Understanding RAID level-1|
» |Understanding logical-drive synchronization|

Confirming your array migration configuration: Use the configuration summary to
review all the changes that the ServeRAID Manager will apply to your modified
array and logical drive configuration.

1. Review the information displayed in the "Configuration summary” window. It
describes how the new configuration will affect the RAID level and free space.
To change the configuration, click Back.

2. Click Apply.
3. Click Yes when asked if you want to apply the new configuration.

Note: Logical-drive migration is a lengthy process. The ServeRAID Manager

displays ™ (in animation) in the Logical devices view while the
operation is in progress. When the migration is complete, the
configuration is saved in the controller and in the physical drives.

More information
+ |Understanding logical-drive migration|

Exporting an array: Use this action to export the specified array. Exporting an array
prepares the RAID configuration for transfer to another enclosure.

Note: When you export an array, its status changes to foreign. You cannot perform
any action on a foreign array except view array components and a

RAID configuration.

To export an array:

1. In the [Logical devices view| click (array).

2. Right-click Export array.
3. Click Yes to confirm the export.

More information
+ [Managing Foreign arrays and Alien arrays|

* |Importing an arra
¢ |Deleting an arra

Deleting an array:

Note: This action is supported on the integrated RAID controller in bootable-CD
mode only.

Use this action to delete a specified array.
For some operating systems, deleting an array and its associated logical drives

might change the drive-letter assignments of the remaining drives when you
restart the system.
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Attention: If you delete an array, you delete all logical drives that are defined in
that array. All data and programs on the logical drives in the array are lost during
this procedure.

To delete an array:

1. In the[Logical devices view] click (array).

Attention: Before proceeding, ensure that you have backed up any data and
programs that you want to save.

2. Right-click Delete array.

3. Click Yes to confirm the delete.

Importing an array: Use this action to import the RAID configuration into the
specified foreign array. Importing the RAID configuration completes the transfer of

an array from another enclosure.

To import an array:

1. In the[Logical devices view] click (foreign array).

2. Right-click Import array.
3. Click Yes to confirm the import.

More information

+ [Managing Foreign arrays and Alien arrays|
* [Exporting an array|

* |Deleting an array|

Moving an array to a different controller:

Note: This action is not supported on enclosures with a single controller
configuration.

Use this action to move an array to a different controller in the enclosure. This
action changes the preferred owner of the array and moves all associated logical
drives to the new controller.

1. In the[Logical devices view| click 8 (array).

2. Right-click Move to controller and then the controller name (A or B).
3. Click Yes when prompted to confirm the move.

More information

Recovering storage with fail back|

Array [letter] object: Use this object, in the [Logical devices view} to work with an
array or to display its properties.

Notes:

1. Basic arrays are labeled with letters starting with A. Spanned arrays are
labeled with numbers starting with 1. Spanned arrays are used in RAID
level-x0 configurations only.

2. To view the array labels, switch to [Text view} then, lexpand| the array
list.
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3. A ServeRAID SCSI controller supports a maximum of eight basic arrays
or four spanned arrays. An integrated RAID controller supports a
maximum of one basic array.

Possible subobject
- [ogiealdives | |(Logical drives)|

. L; (Logical drive)

Warning and error conditions
. (warning) is displayed if the logical drives object has a warning condition.

. (error) is displayed if the logical drives object has an error condition.

Actions

.
* If the selected array is not a subarray in a [RAID level-x0| configuration, the

following actions are available:
-

— |Change RAID level from..)
RAID 0 to RAID 5

- RAID 1 to RAID 5

- RAID 5 to RAID 0

- RAID 5E to RAID 5

— [Increase free space]

— [Increase logical drive size]

* If the array is on a network-attached storage enclosure:

- (if the array is online)
- (if the array is foreign)

— [Move array to controller| (dual controller configurations only)

— [Expand or migrate array|

Logical drives object: Use this object, in the [Logical devices view)to work with
logical drives or to display their properties:

| Logical devices

Arrays (2

& 8

ogical drives (23
]

Notes:
1. ServeRAID SCSI controllers support a maximum of eight logical drives.

2. The ServeRAID-7t SATA controller supports a maximum of 24 logical
drives.

3. The ServeRAID-8i SAS controller supports a maximum of 128 logical
drives.
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4. An integrated RAID controller supports a maximum of one logical
drive.

Possible subobject

. L; (Logical drive)

Warning and error conditions
* None.

Actions
* |Delete > logical drive number|

+ |Identify all logical drives|

« |Configure access control lis{ (networked storage only)

Configure target information| (networked storage only)

Understanding when RAID level-x0 logical drives change state: Start with four
physical drives.

Use two physical drives to create array A and two physical drives to create array
B.

Use arrays A and B to create spanned array 1. As part of a spanned array, arrays A
and B are now called "subarrays.”

A sub-logical drive is created in array A and another sub-logical drive is created in
array B.

Then, create a logical drive in spanned array 1.

If the sub-logical drive in subarray A is in the okay state and the sub-logical drive
in subarray B is in the okay state, then the logical drive in spanned array 1 is in
the okay state.

If a physical drive fails in subarray A, then the sub-logical drive in subarray A
changes to the critical state. Subarray B is still in the okay state. The logical drive
in spanned array 1 changes to the critical state.

If the second physical drive fails in subarray A, then the sub-logical drive in
subarray A changes to the offline state. Subarray B remains in the okay state. The
logical drive in spanned array 1 changes to the offline state.

If the sub-logical drive in subarray A is in the critical state and a physical drive
fails in subarray B, then the sub-logical drive in subarray B changes to the critical
state. With both sub-logical drives in the critical state, the logical drive in spanned
array 1 remains in the critical state.

More information

e |Understanding creating spanned arravs|

* [Creating spanned arrays in the wizar

e |Understanding RAID 1eve1—x0|

« [Physical drive capacity and unusable capacity]
* |[Understanding creating basic arrays|
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Understanding logical-drive synchronization: The purpose of synchronizing logical
drives is to compute and write the parity data on the selected drives.
Synchronizing a logical drive verifies that the data redundancy for the logical drive
is correct.

Note: You can determine if your controller firmware supports
auto-synchronization and data scrubbing by viewing the controller
properties. The properties pane reports if these features are enabled or
disabled.

Using auto-synchronization

If the logical drive is attached to a controller that supports auto-synchronization,
the ServeRAID Manager automatically synchronizes all new RAID level-5, 5E, 5EE,
and 50 logical drives. These logical drives must be synchronized before storing
data. Auto-synchronization ensures that the parity data is accurately computed.
Accurate parity is critical for updating the parity when you begin to store data.

S R-2i SR-Tt

For the ServeRAID-8i controller and ServeRAID-7t controller, the
ServeRAID Manager also supports auto-synchronization for RAID level-1 and 10
logical drives. During auto-synchronization, data from the primary drive is
automatically copied to the mirror drive.

Depending on the controller, the ServeRAID Manager displays either a progress
indicator in the oral™ (in animation) in the Logical devices view,

indicating that auto-synchronization is in progress. You can perform some actions
on the controller during an auto-synchronization, such as deleting a logical drive;
however, you cannot perform a logical drive migration. Also, you can turn off the
server during an auto-synchronization and, when you turn on the server, the
firmware will continue the auto-synchronization where it left off.

Using manual synchronization

When you create a logical drive that is attached to a controller that does not
support auto-synchronization, you will receive a warning event in the
stating that you must manually synchronize the logical drive before storing data.
Use " [Synchronize logical drives| to manually synchronize the logical drive. You
must synchronize new RAID level-5 logical drives after you create them.

Manual synchronization can be a lengthy operation. You cannot perform any other
actions on the controller until the manual synchronization is completed. You can
synchronize the logical drive immediately or it for a later date and time.
You can also schedule the synchronization as a recurring task. A recurring
synchronization task starts at the initial start time, then runs periodically according
to the given interval: the same time each day, each week, or each month. Do not
turn off the server until the manual synchronization is complete.

Using manual synchronization for data scrubbing

Data scrubbing is an automatic background synchronization process. Data
scrubbing keeps data "fresh” by doing the following:

* (For RAID level-5, 5E, 5EE, or 50) Reading data and rewriting the data parity.
* (For RAID level-1, 1E, 10, 1E0) Reading data and rewriting the mirror data.
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If data scrubbing is disabled or your controller firmware does not support data
scrubbing, consider manually synchronizing your logical drives weekly. This does
not alter data on the drive.

Note: If data scrubbing is disabled on your controller, you can enable data
scrubbing, but not through the ServeRAID Manager. Instead, use the
IPSSEND command-line program. This program comes with the device
option and is on the IBM ServeRAID Support CD. For more information,
refer to the IBM ServeRAID User’s Reference.

More information
» [Synchronizing logical drives (action)|
» |Understanding scheduled taskg

Using the Task Manager|

Creating logical drives: Complete the following steps to create logical drives:

1. |Start the custom configuration wizard and complete all previous steps.|

2. Click the appropriate Array tab.

| Array C \| Hew array D \|

3. Select a RAID level from the drop-down list.

RAID level
| 5EE ]|
i
1E
5
5EE
Note:
a. RAID level-5E and RAID level-5EE allow only one logical drive per
array.

b. If you are configuring a spanned array, you can set the RAID level
only for the first logical drive you create.

c. If you plan to use ”[Change RAID level}” you must assign the same
RAID level to all logical drives within a single array.

Attention: Before assigning a logical drive RAID level-5E or RAID level-5EE,
consider the following. If a physical drive fails during a post-failover
resynchronization, the logical drive will enter the blocked state. Data might be
lost or damaged.

4. If you do not want to use the maximum size for the logical drive, type the size
in the Data (MB) field.

Dt (ME)
[ a000|
Note:
a. You can define up to eight logical drives per controller. There are two
exceptions:

* If an array contains a logical drive assigned RAID level-5E
* If you want to use the logical-drive migration feature
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7.
8.

In these cases, one logical drive slot must be left free; therefore, you
must define no more than seven logical drives.

b. Some operating systems have size limitations for logical drives.
Before you save the configuration, verify that the size of the logical
drive is appropriate for your operating system. For more detailed
information, see your operating-system documentation.

c. Alogical drive cannot exceed 2048 GB (2 terabytes); the minimum
size is nMB, where n equals the number of drives in the array.

d. Typically, the first logical drive defined on the first ServeRAID
controller found by system BIOS during startup will be your startup
(boot) drive.

e. The actual logical-drive size might be slightly different from what
you select. The RAID level and the number of physical drives
determine the size of the logical drive. For example, an array
consisting of three, 1 GB physical drives with a requested RAID
level-0 logical drive of 1000 MB will actually contain only 999 MB
because the data is striped across all three drives, with 333 MB on
each drive.

If you have free space available and want to create additional logical drives,

click L B Define new logical drive ] .

Repeat steps 3 through 5 for each logical drive that you want to define in this
array.

Repeat steps 2 through 6 for each additional array that you want to configure.

Click Next. The "|Configuration summary| window opens.

To return to the " ’ window, click Back. To leave the Configuration

wizard, click Cancel.

More information

Selecting the RAID level by array capacity

Selecting the array size|

Understanding physical drive capacity and unusable capacity|

Creating arrays and hot-spare drives: Complete the following steps to create arrays:

1.

2.
3.

[Start the custom configuration wizard and complete all previous steps.|

Click the appropriate Array tab in the right pane: HewarrayC [IERRIER

Then, from the list of ready drives, select the drives you want to add to the
array:

| Systermn merlyn, Controller 2

£ Ready Ch1, 1D 3 {1000 ME)
€2 Ready Ch1,1D 4 {1000 MEB)
@2 Ready Ch1,1D 5 {1000 ME)
£ Ready Ch1, 1D 6 {1000 MEB)
@2 Ready Ch1, D8 {1000 ME)

Click =) >> (Add selected drives) to add the drives to the array. You can
click >> (Add all drives) to move all ready drives to an array.

Repeat steps 2 and 3 for each additional array or hot-spare drive that you want
to configure.

If you do not want to create a spanned array, skip to step 6. Otherwise, select
the Span arrays check box [&spanarrays . Then, click Next. If you created two
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arrays only, the ServeRAID Manager uses those arrays to create the spanned
array; continue to step 6. Otherwise, the " [Create spanned arrays| window
opens.

Note: To create a spanned array, each array must have the same number of
physical drives.

7. After you select the ready drives for your arrays and hot-spare drive, click
Next. The " [Create logical drives’ window opens.

To return to the " [Express and Custom configuration!’ window, click Back. To leave
the Configuration wizard, click Cancel.

More information

» |Understanding creating basic arrays|

« [Example: Express configuration|

e [Creating spanned arrays|

« |[Understanding creating spanned arrays

« |Configuring the ServeRAID controller: the basic steps|

Creating spanned arrays: If you want to assign [RAID level-x( to an array, you must

create a spanned array.

Note: Spanned arrays are supported only by IBM ServeRAID-4 Ultral60,
ServeRAID-5i Ultra320, ServeRAID-6M Ultra320, and ServeRAID-6i/6i+
Ultra320 SCSI controllers.

Complete the following steps to create one or more identical spanned arrays:

1. |Start the custom configuration wizard and complete all previous steps.|

2. In the list of arrays, click the arrays that you want to add to your spanned

| Systern merlyn, Controller 2
‘ et Array A (4000 ME) 4 drives

x Array B (4000 MB) 4 drives
et rray (4000 ME) 4 drives

array.

3. Click [ >> (Add selected arrays) to add the arrays to the spanned array. You
can click @ >> (Add all arrays) to move all arrays to the spanned array.

4. To create additional spanned arrays, click the New spanned array tab in the
right pane.

Spanned array 1 \| Hew spanned array 2 \|

Then, repeat steps 2 and 3.

5. Click Next; the " [Create logical drives| window opens.

To return to the ” ’ window, click Back. To leave the Configuration

wizard, click Cancel.

More information
» |Understanding RAID level-x(|
* [Understanding creating spanned arrays|

Creating additional logical drives:

Note: This action is not supported on the integrated RAID controller.
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Use this action to create additional logical drives in an existing configuration. If
you configured your ServeRAID subsystem but left free space in an array, you can
use this action to create additional logical drives using the free space.

1. In the Enterprise view, click ¥ (controller) that contains the array in which
you want to create the logical drives.

2. In the[Logical devices view] click B ] (|érrazs objec'fl).

3. Right-click Create logical drive. If the controller includes more than one array,
right click Create logical drive in array and then the array name. The
Configuration wizard opens with the "Create logical drives” window.

4. |Create the logical drive.|

5. [Review the configuration summary and apply the configuration|

Changing the logical drive name: Use this action to change the name of a logical
drive:

1. Press the Delete key to clear the drive’s current name.

2. In the Type new name field, type the drive’s new name.
3. Click OK.

Clearing a logical drive: Use this action to initialize a logical drive using the
Clear initialization method. Initialization is usually automatic when you create a
logical drive.

Attention: The Clear initialization method erases the entire logical drive and
prevents access to any data previously stored on the drive.

1. In the[Cogical devices view] click Il (logical drive).
2. Right-click Clear.
3. Click Yes.

Deleting a logical drive:

Note:

1. This action is supported on the integrated RAID controller in
bootable-CD mode only.

SR-SCSI

For ServeRAID SCSI controllers, this action is available only if the
selected logical drive is the last logical drive that was created in the
array.

Hos R

3. To delete a partitioned logical drive on a HostRAID controller, you
must remove the partition with your operating system disk management
tools first. Then, you can delete the logical drive with the ServeRAID
Manager.

£ | To delete a logical drive on a networked storage enclosure, all
iSCSI initiators must be disconnected first. Then, you can delete the
logical drive.

Attention: If you delete a logical drive, all data on that logical drive is destroyed.
Before proceeding, ensure that you have backed up any data and programs that
you want to save.

1. In the[Logical devices view] click [] (logical drive).
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2. Right-click Delete.
3. Click Yes to confirm the delete.

Initializing a logical drive: Use this action to initialize a logical drive. Initialization
is usually automatic when you create a logical drive.

Attention: Initializing a logical drive erases the first 1024 sectors on the drive and
prevents access to any data previously stored on the drive.

1. In the|[Logical devices view] click i (logical drive).
2. Right-click Initialize.
3. Click Yes.

Synchronizing logical drives:
Note: This action is not supported on the integrated RAID controller.

If auto-synchronization is not supported on your controller, you must use this
action to manually synchronize new RAID level-5, 5E, and 50 logical drives after
you create them.

If data scrubbing is disabled or your controller firmware does not support data
scrubbing, consider manually synchronizing your logical drives weekly using this
action.

Manual synchronization can be a lengthy operation. You can synchronize the
logical drive immediately or schedule it for a later date and time. You can also
schedule the synchronization as a recurring task. A recurring task starts at the
initial start time, then runs periodically according to the given interval: the same
time each day, each week, or each month.

Note: You cannot perform any other actions on the controller until the manual
synchronization is completed. For example, you cannot schedule a
synchronization if another logical drive synchronization is in progress.

An example

You schedule a synchronization task with an initial start time of Sunday, October

13, 2004 at 2:00 AM. It recurs weekly. It will run again on Sunday October 20, 2004

at 2:00 AM.

Note: Do not turn off the server while manual synchronization is in progress.

To synchronize a logical drive:

1. In the[Logical devices view] click i (logical drive).

2. Right-click Synchronize.

3. Click Yes to synchronize the logical drive immediately (now). Depending on
the controller, the ServeRAID Manager displays either a progress indicator in
the or ZH (in animation) in the Logical devices view, indicating that
the operation is in progress.

4. Or click Schedule to schedule the synchronization for a later date and time.
The ServeRAID Manager displays the Synchronization Scheduler pane:

¢ From the drop-down lists and calendar display, select the day, month, year,
and time you want the task performed.

ServeRAID Management Installation and User's Guide



¢ From the Recurring drop-down list, select the interval at which you want the
task to recur: Never, Daily, Weekly, Monthly.

e (Click OK to schedule the task; click Cancel to cancel the scheduled task and
return to the initial confirmation pane.

More information

* [Understanding logical-drive svnchronizationl
* [Understanding scheduled taskg

* |Using the Task Manager]|

Unblocking a logical drive:

Note: This action is not supported on the integrated RAID controller.

After the rebuild operation is completed on an array, if the array contained RAID
level-0 logical drives, you can unblock the RAID level-0 logical drives and access
them once again. But remember, the logical drive contains damaged data. You

must re-create, install, or restore the data from the most recent backup disk or tape.

To unblock a blocked logical drive:

1. In the [Logical devices view] click G (logical drive).
2. Right-click Unblock logical drive.

3. Click Yes to confirm, understanding that the data on the logical drive is not
valid. The ServeRAID Manager unblocks the blocked logical drive.

all unblocked logical drives before using them.
5. Restore the data to the drive from your most recent backup disk or tape.

&

More information
* [Recovering from a defunct drive]

Selecting the logical drive size: When you select the logical drive size, consider the
following:

* If you change the RAID level of a logical drive, the total size (data plus parity)
of the logical drive might change.

* If you do not use all available free space, you can create another logical drive.
Click Create new logical drive to do so. You can assign the same or a different
RAID level to additional logical drives.

* You cannot delete the last remaining logical drive in the array. You must have at
least one logical drive for each array.

* Refer to the documentation provided with your operating system for
information about the recommended logical-drive size.

* The default RAID configuration uses all available free space.

More information

+ [Selecting the RAID level by array capacity|

* |Creating logical drives (action)|

e |Configuring RAID and creating arrays (action)l
* |Creating logical drives in the wizard|

+ [Example: Usable and unusable capacity]|

Scheduling the logical-drive migration: Use the calendar display to choose the date
and time for the logical drive migration:
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From the calendar display, select the day, month, year, and time that you want
the task performed.

Click Apply.

Click Yes when asked if you want to schedule the migration.

More information

Understanding logical-drive migration|

Confirming your logical drive migration configuration|

Understanding scheduled taskg

Using the Task Manager|

Logical drive [number] object: Use this object, in the [Logical devices view) to
work with a logical drive or to display its properties.

Notes:

1. ServeRAID SCSI controllers support a maximum of eight logical drives.

2. The ServeRAID-7t SATA controller supports a maximum of 24 logical
drives.

3. The ServeRAID-8i SAS controller supports a maximum of 128 logical
drives.

4. HostRAID controllers support a maximum of 2 logical drives.

5. An integrated RAID controller supports a maximum of one logical
drive.

Possible subobject

None.

Warning and error conditions

, (warning) is displayed if the logical drive is in a critical, critical migrating,
or critical system state. It is also displayed if a physical drive in the logical drive
is a defunct drive or a defunct hot-spare drive.

(& (error) is displayed if the logical drive is in a blocked or offline state.

KA (initialize) is displayed when the logical drive is initialized (ServeRAID-8i,
ServeRAID-7t, HostRAID controllers only).

™ ouild/ modify) is displayed during a [logical-drive migration|
(ServeRAID-8i, ServeRAID-7t, HostRAID controllers only).

Actions

Note: Not all actions are supported on all controllers.

Delete logical drive]

Initialize logical drive]

Clear logical drive

‘Sznchronize logical drivej

[Enable read-ahead cache

Expand or change logical drive]

If a logical drive is blocked, funblock logical drive]
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« |Identify logical drive [number]|
* |Create FlashCopy]|
* |Remove FlashCopy]|

The following actions are supported for networked storage only (enclosures):

Configure access control lis{

+ |Configure target information|

* |Increase logical drive capacity]|

The following action is supported in bootable-CD mode only, except for
ServeRAID-8i and ServeRAID-7t controllers:

Change write-cache mode to write back or write throughl

Channel [number] object: Use this object, in the [Physical devices view) to work
with a selected SCSI channel or to display its properties:

Physical devices

¥=a Controller 3

Channel 1 160 MB/s (5 devices found)|
o 6 6 .0

Notes:
1. A controller supports a maximum of four SCSI channels.

2. The ServeRAID-5i controller does not support tape drives and physical
drives on the same channel.

Possible subobject

. e [(Physical drive)|

. 4 [(Hot-spare drive)

. R [(Enclosure management device)|

. [(CD-ROM drive)|

. [(Removable drive)|

Warning and error conditions
None.

Actions

* [Scan for new or removed ready drives|

+ [Identify all physical drives on SCSI channel [number]|

The following action is available only in bootable-CD mode:
* [Change the SCSI transfer speed|

Scanning for new or removed ready drives:
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Note: This action is not supported on the integrated RAID controller.

Use this action to scan all SCSI channels or ports for either of the following:
* Physical drives that have been added.
* Ready physical drives that have been removed.

After physically removing a ready drive from a server or enclosure, the ServeRAID
Manager still reports the drive as ready. The firmware (microcode) does not
communicate with ready drives, therefore the firmware does not report the drive
as removed. Use this action to remove the ready drive from the configuration.

1. In the Enterprise view, click ¥ (controller) or & (enclosure).
2. Click & (Scan for new or removed ready drives).

For ServeRAID SCSI controllers, the "Scan for new or removed ready
drives on controller” window opens. The ServeRAID Manager scans all SCSI
channels on the selected controller. Review the scan report; then, click Done. To
stop the scan before it completes click Cancel.

o @] (] ®] rorhe ServeRAID-8i, ServeRAID-7t, and HostRAID
controllers, the ServeRAID Manager scans all ports on the selected controller. It
reports the results of the scan in the

Changing the SCSI-transfer speed:

Note:
1. This action is supported in bootable-CD mode only.
2. This action is not supported on the integrated RAID controller.

3. This action is not supported on the ServeRAID-8i controller and
ServeRAID-7t controller.

Use this action to change the SCSI-transfer speed.
1. In the [Physical devices view] click the SCSI channel identifier:

Physical devices

¥ Controller 4

[Channel 1 320 MBis (14 devices found)|

[ T T e Y e T e T S S

fwad el el i et et el

2. Right-click Change the SCSI transfer speed and then a transfer speed. The
following choices are available:
¢ Optimal
This value is available if your controller supports it; otherwise, Optimal does
not appear in the menu. Optimal is the default value. When the transfer speed
is set to Optimal, the ServeRAID controller determines the best transfer speed,
based on the types of SCSI drives and enclosures in use.
 Ultra320 SCSI
+ Ultral60 SCSI
 Ultra2 SCSI
e UltraSCSI
* Fast SCSI-2
s SCSI-2
* SCSI-1

This value is available if your controller is set to SCSI-1; otherwise, SCSI-1 does
not appear in the menu.
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Ports [numbers] object: Use this object, in the [Physical devices view|to work
with selected ports or to display their properties:

[¥#4 Controller 2

Ports 0..3: 1.60 Ghis (4 devices found)|
Pogh & é gD

Possible subobject

. G [(Physical drive)|

. 4 [(Hot-spare drive)|

Warning and error conditions
* None.

Actions

* [Scan for new or removed ready drives|

Physical drive [number] object: Use this object, in the [Physical devices view} to
work with a physical drive or to display its properties.

Note: A SCSI channel supports a maximum 15 physical drives.
Possible subobject
None.

Warning and error conditions

* 4 (warning) is displayed if the selected physical drive is undergoing a rebuild
operation, reports a PFA, or is a non-warranted physical drive.

* @ (error) is displayed if the selected physical drive is a defunct drive.

Actions
« |Identify physical drive|

* If the drive is ready:

— [Create hot-spare drive]

[Create standby hot-spare drive]

— [Create assigned hot-spare drive

- [Clear|

~ [Iitialize]

* [Rebuild drivd

« If the drive is defunct, [Remove the defunct drive|

¢ |Set drive state to onling|

* |Change write-cache mode to write back or write throu@
* If the drive is rebuilding, online, or reports a PFA, |set drive state to defuncﬂ
» |Verify physical drive]

Understanding physical drive capacity and unusable capacity: Physical drive capacities
influence the way you create arrays. Drives in the array can be of different
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capacities (1 GB or 2 GB, for example), but the ServeRAID controller treats them as
if they all have the capacity of the smallest physical drive.

For example, if you group three 1 GB drives and one 2 GB drive into an array, the
total capacity of the array is 1 GB times 4, or 4 GB, not the 5 GB physically
available. The remaining space on the 2 GB drive is unusable capacity.

SR-8i SR-Tt

For the ServeRAID-8i controller and ServeRAID-7t controller, the
remaining space is usable capacity. That is, you can use the remaining space to
define another logical drive; see [Example: Usable and unusable capacityl

Conversely, if you add a smaller drive to an array of larger drives, such as a 1 GB
drive to a group containing three 2 GB drives, the total capacity of that array is 4
GB, not the 7 GB physically available. Therefore, the optimal way to create arrays
is to use physical drives that have the same capacity.

A hot-spare drive also must be at least as large as the smallest drive in the array.

More information

+ |[Example: Usable and unusable capacity]
+ |[Example: Total disk capacity]

+ [Understanding creating basic arrays|

Clearing a disk drive: Use this action to remove all data from a disk drive:

1. In the[Physical devices view] click € (online physical drive).
2. Right-click Clear.
3. Click Yes to confirm.

More information
+ |[Identify physical drive|

Verifying physical drives: Use this action to check a physical drive for inconsistent
or bad data. The Verify action examines each sector and block on the disk to
ensure that it is readable. It does not repair the drive if bad data is found.

To verify a physical drive:

1. In the|Physical devices view] click € (physical drive).
2. Right-click Verify.
3. Click Yes to verify the drive.

Note: To check the progress of the operation, switch to

More information
+ |Understanding synchronizing logical drives|

Initializing physical drives: Use this action to erase the metadata for a ready
physical drive. The metadata includes all logical drive definition data.

To initialize a physical drive:

1. In the [Physical devices view] click €2 (physical drive).
2. Right-click Initialize.
3. Click Yes to initialize the drive.
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Note: To check the progress of the operation, switch to

More information
* |Verifying physical drives|

Manually rebuilding a defunct drive: Use this action to rebuild a critical logical drive
when a physical drive in the array is defunct. Normally, the controller rebuilds a
logical drive when it detects the removal and reinsertion of a drive that is part of
an array. Use this operation to force the rebuild to begin immediately, without
physically removing and replacing the disk drive.

Note: The controllers can rebuild RAID level-1, level-1E, level-5, level-5E,
level-5EE, level-10, level-1EQ, and level-50 logical drives. They cannot,
however, rebuild RAID level-0 logical drives because RAID level-0 is not
redundant.

Complete the following steps to manually rebuild a defunct drive:

1. In the [Physical devices view] click cig (defunct physical drive).
2. Right-click Rebuild drive.
3. Click Yes to confirm.

Note: During the rebuild operation, the defunct drive enters the rebuild state
and the logical drive remains critical until the rebuild operation is
completed.

More information
* |Rebuilding a defunct drive (concepts)|
* [Recovering from defunct drives|

Removing a defunct drive:

Note: This action is not supported on network storage controllers. It is supported
on the integrated RAID controller in bootable-CD mode only.

You can use this action only on defunct physical drives that are not part of any
array. Although the ServeRAID software implicitly removes defunct drives from
the configuration, this action is useful if you want to remove a defunct drive from
the Physical devices view so you can view an accurate configuration.

1. In the[Physical devices view] click ¢ig (defunct physical drive).

2. Right-click Remove defunct drive. The ServeRAID Manager removes the
defunct drive from the configuration.

Setting a drive state to online:
Note: This action is not supported on the integrated RAID controller.

You can use this action only when the following is true:
* The defunct drive is part of an array.

* There are no critical logical drives in the array.

Attention: When you set a defunct drive to online, there is a high risk of data
loss.

1. In the [Physical devices view] click cig (defunct physical drive).

2. Right-click Set drive state to online.

Chapter 4. Managing ServeRAID devices 133



3. Click Yes to confirm.
Setting a drive state to defunct:

Note: This action is not supported on the ServeRAID-8i controller and
ServeRAID-7t controller.

You can use this action only on a physical drive that is part of an array. If a
physical drive is part of an array, you must change the drive state to defunct
before removing the drive from the server or enclosure. Doing so eliminates the
risk of losing data. After you replace the physical drive, you can rebuild the
affected array.

This action is useful in situations such as the following;:
* You want to replace a physical drive that is marked with a PFA.
* You want to replace a physical drive that is unwarranted.

* You have an array built with one or more physical drives that are not the same
size. You can [replace the smaller physical drives in the array with larger physicall
[drives| so that the array no longer has unusable capacity and an inefficient
configuration.

Attention:
1.

If you do not change an online physical drive state to defunct before removing
the drive from the server or enclosure, you risk losing data or damaging the
physical drive.

2. You cannot use this action on a physical drive undergoing a rebuild operation.

3. (For non-RAID level-x0 logical drives) If you choose to use this action and a
logical drive is:

* In a critical state, the logical drive state will change to offline.
* RAID level-0 and in an okay state, the logical drive will change to offline.

* Not RAID level-0 and in an okay state, the logical drive state will change to
critical.

4. (For RAID level-x0 logical drives) If you choose to use this action and a logical
drive is in a critical state, |the logical drive state| might change to offline.

1. In the[Physical devices view] click &4 (physical drive) or @ (physical drive).

2. Right-click Set drive state to defunct. A confirmation window opens to warn
that this action might corrupt data.

Note: If the logical drive that contains this physical drive is already offline, the
ServeRAID Manager does not display this warning because the data is
already corrupt. Continue to step 4.
3. Click Yes. The ServeRAID Manager sets the drive status to defunct.

4. Replace the selected physical drive. If the logical drive is not offline, a rebuild
automatically occurs.

More information
+ [Replacing physical drives in an array|
+ |Understanding when RAID level-x0 logical drives change state]
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Rebuilding a defunct drive: A physical drive is marked defunct when there is a loss

of communication between the controller and the physical drive. This can be

caused by any of the following:

* An improperly connected cable, physical drive, or controller

* Loss of power to a drive

* An improperly assembled SCSI channel in an unsupported configuration

* A defective cable, backplane, physical drive, or controller

* Connecting unsupported SCSI devices (such as tape drives or CD-ROM drives)
to the same SCSI channel used for an array

In each case, after the communication problem is resolved, a rebuild operation is
required to reconstruct the data for the device in its disk array. The ServeRAID
controllers can reconstruct RAID level-1, level-1E, level-5, level-5E, level-5EE,
level-10, level-1EQ, and level-50 logical drives. They cannot, however, reconstruct
data stored in RAID level-0 logical drives because RAID level-0 is not redundant.
If an array contains only RAID level-0 logical drives, the logical drives in the array
are marked offline and the logical drives contain damaged data. You cannot
rebuild the logical drives. You must correct the cause of the failure or replace the
physical drives; then, you must restore your data.

To prevent data-integrity problems, the ServeRAID controllers set the RAID level-0
logical drives in the affected array to blocked during the rebuild operation for
RAID level-1 or RAID level-5. After the rebuild operation is completed, you can
unblock the RAID level-0 logical drives and access them once again. Remember,
however, that the RAID level-0 logical drives contain damaged data.

Note: For logical drives in an IBM ServeRAID Cluster Solution:

* Because shared logical drives can have only one logical drive for each
array, blocking a RAID level-0 logical drive during a rebuild operation
does not apply to shared logical drives.

* Because non-shared logical drives can have more than one logical drive for
each array, blocking a RAID level-0 logical drive during a rebuild
operation does apply to non-shared logical drives.

More information

* [Recovering from defunct drives|

* |Rebuilding a hot-swap drive

« [Manually rebuilding a defunct drive|

* |Changing the rebuild rate (action)|

+ |Unblocking a logical drive (action)|
* [RAID level-0
* |RAID level-1
+ [RAID level-1E|
* [RAID level-5
* [RAID level-5E|

+ |RAID level-5EE]|

* |RAID 1eve1—x0|

Recovering from defunct drives: If the defunct drives are not part of an array, contact
your service representative.

If a physical drive fails in an array or multiple physical drives fail in separate
arrays (one physical drive per array), complete the following steps:
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1.

4.

5.

Replace each defunct physical drive. The controller starts the rebuild operation
when it detects the removal and reinsertion of a drive that is part of an array.

Note: (For a configuration that contains a hot-spare drive) If you replace a
failed physical drive, it is not necessary to position the new physical
drive on the same SCSI channel and SCSI ID as the original hot-spare
drive. The replacement physical drive is automatically incorporated into
the configuration as a hot-spare drive. Here is an example of how this
works:

a. The original configuration consists of a RAID level-5 logical drive
composed of four physical drives. The physical drives are connected
to SCSI channel 1; they are assigned SCSI IDs 0, 1, 2, and 3. SCSI ID
3 is a hot-spare drive.

b. The physical drive at Channel 1, SCSI ID 2, fails; the logical drive
enters the critical state.

c. The hot-spare drive at Channel 1, SCSI ID 3, is rebuilt into the array.

d. You remove the failed physical drive at Channel 1, SCSI ID 2, and
replace it with a new physical drive. The new physical drive at

Channel 1, SCSI ID 2, is automatically assigned to be a hot-spare
drive.

If a rebuild operation is in progress, wait until the rebuild is complete.
Otherwise, go to step 3.

Note: If you are replacing multiple defunct drives, you must wait for each
rebuild operation to complete before starting subsequent rebuild
operations.

Verify the cables, physical drives, and controllers are installed properly.

Attempt to rebuild the defunct physical drive by [performing a hot-swap)

If the hot-swap rebuild fails, contact your service representative.

More information
* [Rebuilding a defunct drive|

* |Rebuilding a hot-swap drive

+ [Manually rebuilding a defunct drive|

* |Changing the rebuild rate (action)|

« [Unblocking a logical drive (action)

* |RAID level-0

RAID level-1

RAID level-5

Viewing shared drives:

Note: This action is not supported when using the following:

* Integrated RAID controller
* ServeRAID-5i controller

* ServeRAID-6i/6i+ controller
* ServeRAID-7k controller

* ServeRAID-7t controller

* ServeRAID-8i controller

* HostRAID controller
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Use this action to view the physical drives owned by a cluster partner system in
the Enterprise view.
1. In the Enterprise view, click ¥ (controller).

2. Right-click Clustering actions » View shared drives to view the physical drives
owned by a partner system.

3. Select the Enable view shared drives box. To disable viewing shared drives,
deselect the Enable view shared drives box.

4. Define the location of the partner system online drive by specifying the SCSI
channel and SCSI ID in the drop-down lists.

5. Click OK.

The ServeRAID Manager displays the physical drives owned by the partner system
in the Enterprise view as i§ (Reserved). You only can view these reserved drives;
you cannot perform any actions upon them.

More information
+ |Configure controller for clustering|

Hot-spare drive object: Use this object, in the [Physical devices view] to work with
a hot-spare drive in your configuration or to display its properties.

Possible subobject
None.

Warning and error conditions

e 4 (warning) is displayed if the hot-spare drive reports a PFA or is a
non-warranted physical drive.

* @ (error) is displayed if the hot-spare drive is defunct.

Actions
* |Create standby hot-spare drivce|
* |Delete hot-spare drive|

Hot-spare configuration summary: If a hot-spare drive of the appropriate size is
available, this column reports Yes.

If the logical drive is redundant (that is, [RAID level-1 or EI), but a hot-spare

drive of the appropriate size is not available, this column reports No (in red).
If the logical drive is|RAID level-(} this column reports No (in black).
Creating a hot-spare drive:

Note: This action is supported on the integrated RAID controller in bootable-CD
mode only.

Use this action to create a hot-spare drive.

1. In the [Physical devices view] click €= (ready physical drive) or & (standby
hot-spare drive).

2. Click in the Logical devices view. The ServeRAID Manager creates the
hot-spare drive.
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Note: A hot-spare drive with a blue plus sign next to it indicates that the
logical devices are protected by the hot spare. A hot-spare drive with a
yellow plus sign next to it indicates that:

* The drive is too small to protect any drives in the logical devices

* None of the logical devices support hot spares (for example, a RAID
Level-0 array)

* No logical devices are defined

More information
+ [Choosing to create a hot-spare drivel
» [RAID levels that can use a hot-spare or standby hot-spare drive|

Creating a standby hot-spare drive:

Note: This action is not supported on the ServeRAID-8i SAS controller,
ServeRAID-7t SATA controller, and the integrated RAID controller.

Use this action to create a standby hot-spare drive.

1. In the[Physical devices view] click € (ready physical drive) or & (hot-spare
drive).

2. Right-click Create standby hot-spare drive. The ServeRAID Manager creates
the standby hot-spare drive.

Note: A standby hot-spare drive with a blue plus sign next to it indicates that
the logical devices are protected by the hot spare. A standby hot-spare
drive with a yellow plus sign next to it indicates that:

* The drive is too small to protect any drives in the logical devices

* None of the logical devices support hot spares (for example, a RAID
Level-0 array)

* No logical devices are defined

More information

* |Choosing to create a standby hot-spare drive|

* |Deleting a hot-spare drive|

* |RAID levels that can use a hot-spare or standby hot-spare drive]

Creating an assigned hot-spare drive:

Note: This action is supported only on the ServeRAID-7t, ServeRAID-8i, and
external storage enclosures (networked storage).

Use this action to assign one or more hot-spare drives to a logical drive. An
assigned hot-spare drive is a dedicated spare: it is used only to rebuild the logical
drive to which it is assigned. An unassigned hot-spare drive is "global”: it can be
used to rebuild any logical drive on the controller.

Note: You cannot assign a hot-spare drive while a logical drive is being built or
modified (such as a[logical drive migration).

1. In the [Physical devices view] click & (ready physical drive).

2. Right-click Create assigned hot-spare drive for the logical device name. The
ServeRAID Manager creates a dedicated hot-spare drive for the logical drive.
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More information
* |Choosing to create a hot-spare drive]
« IRAID levels that can use a hot-spare or standby hot-spare drive]

Deleting a hot-spare drive:

Note: This action is supported on the integrated RAID controller in bootable-CD
mode only.

Use this action to delete a hot-spare physical drive from your configuration.

1. In the [Physical devices view] click &= (hot-spare drive).

2. Right-click Delete hot-spare drive. The ServeRAID Manager deletes the
hot-spare drive from the configuration by setting the drive state to ready. If you
removed the drive from the server, the ServeRAID Manager removes the drive
from the configuration.

Deleting a standby hot-spare drive:

Note: This action is not supported on the ServeRAID-8i SAS controller,
ServeRAID-7t SATA controller and the integrated RAID controller.

Use this action to delete a standby hot-spare physical drive from your
configuration.

1. In the [Physical devices view] click 4 (standby hot-spare drive).

2. Right-click Delete standby hot-spare drive. The ServeRAID Manager deletes
the standby hot-spare drive from the configuration by setting the drive state to
ready. If you have physically removed the drive, the ServeRAID Manager
removes the drive from the configuration.

Choosing to create a hot-spare or standby hot-spare drive: Hot-spare drives and
standby hot-spare drives supply additional protection to a RAID configuration. If a
physical drive fails in configurations other than RAID level-0 and RAID level-00,
the hot-spare drive automatically replaces the failed physical drive. Subsequently,
the logical drive can be rebuilt automatically.

Note: You cannot use hot-spare drives with RAID level-0 and RAID level-00.

You can create a hot-spare drive in the Configuration wizard when you first
configure the controller. If you choose not to create a hot-spare drive at that time,
you can do so later.

More information

« |Creating a hot-spare drive (action)

« |Creating a standby hot-spare drive (action)|

¢ |Creating an assigned hot-spare drive (action)|

* [Deleting a hot-spare drive (action)|

+ [RAID levels that can use a hot-spare or standby hot-spare drive|

Rebuilding a hot-swap drive: A hot-swap rebuild refers to a rebuild operation that is
started by the controller when it detects that a drive that is part of an array and in
the defunct state has been removed and reinserted on the SCSI cable or backplane.
The reinsertion of the physical drive, whether it is the same drive or a new drive,
will trigger the controller to start the rebuild operation. During the rebuild
operation, the drive being rebuilt is in the rebuild state, and the logical drive
remains critical until the rebuild operation has been successfully completed.
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On most servers, when a hot-spare drive is available, the rebuild operation begins
automatically without the need to replace the failed drive. If more than one drive
fails within the same array, no rebuild takes place. If multiple drives fail in
separate arrays (one physical drive per array), the controller initiates a rebuild
operation for the logical drives within the array containing the first failed physical
drive. This rebuild operation is performed on the first hot-spare drive of sufficient
size to become a valid member of the array.

Complete the following steps to start a hot-swap rebuild:

1. Without removing the drive completely, gently remove the physical drive from
the server, using the handle of the hot-swap tray. If necessary, refer to the
documentation that comes with your server for information about removing a
physical drive.

Attention: When power is removed from a hot-swap drive, the drive
immediately parks the heads, locks the actuator in the "landing zone,” and
begins spinning down. However, the spinning down of the disk might require
up to 20 seconds after power is removed. Do not move the drive while it is
spinning down. Moving the drive while it is spinning down might damage the
drive.

2. Wait 20 seconds to allow the physical drive to completely stop spinning.

3. If you are certain there is nothing wrong with the physical drive you removed,
gently reinstall the drive into the server. Make sure the drive is completely
installed in the backplane connector.

Otherwise, replace the physical drive with a new drive that is the same size (or
larger) and continue with the rebuild operation.

Note:

a. If multiple drives fail in separate arrays (one physical drive per
array), replace each defunct physical drive. If multiple physical drives
fail at the same time within the same array, contact your service
representative.

b. Although it is possible to rebuild a defunct physical drive to an
online physical drive that is defective, avoid doing so.

More information

* [Rebuilding a defunct drive]

* [Recovering from defunct drives|

« [Manually rebuilding a defunct drive|
* |Changing the rebuild rate (action)|

+ |Unblocking a logical drive (action)

Enclosure management device object: Use this object, in the [Physical deviced

to work with a storage enclosure attached to controller with a SAF-TE

processor.

Note: The integrated RAID controller does not support enclosure monitoring. Any
enclosure in an integrated RAID controller RAID subsystem is displayed in
the ServeRAID Manager Enterprise view; however, the ServeRAID Manager
and the ServeRAID Manager agent will not generate any events or enclosure
status information.

Possible subobject

None.
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Warning and error conditions

« # (warning) is displayed if the enclosure has the following conditions:
— A fan has failed.
— A power supply has failed.

« M@ (error) is displayed if the enclosure has the following conditions:
— It is not responding.
— It is overheating.

Multiple fans have failed.

Multiple power supplies have failed.

« # (enclosure) is displayed if the enclosure is one of the following:
— Working properly.
— Not supported.

— Supported, but not monitored for problems. For example, enclosures that are
internal to a server do not have separate fans or power supplies.

Actions

[[dentify enclosure]

CD-ROM drive object: Use this object to display CD-ROM drive properties.

Note: The ServeRAID-5i, 6i/6i+, 6M, and 7t controllers do not support CD-ROM
drives.

Possible subobject

None.

Warning and error conditions

CD-ROM drive objects cannot have warning or error conditions.
Actions

None.

Removable-media drive object: Use this object to display removable-media drive
properties.

Possible subobject

None.

Warning and error conditions

Removable-media drive objects cannot have warning or error conditions.
Actions

None.

Tape drive object: Use this object to display tape drive properties.
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Note: The ServeRAID-5i controller does not support tape drives and physical
drives on the same channel.

Possible subobject

None.

Warning and error conditions

Tape drive objects cannot have warning or error conditions.
Actions

None.

Using display groups

Note: Display groups are not available when using:
* ServeRAID Manager in bootable-CD mode
* ServeRAID Manager as a plug-in application

Display groups allow you organize related systems in the [Enterprise view| under
an expandable tree object. Using actions on the [System| object, the [Management]
object, and the object, you can:

* |Create] |[deletd, and frenamé display groups

+ [Move a system into a display group)

+ |Remove a system from a display group|

* [Move a system from one display group to another|

In this example, managed systems are organized by location, using three display
groups.

Display groups are sorted alphabetically. They appear in the tree below all systems
that are not part of any display group.

= Direct attached storage
= EF computer room 1
[ nio2073
[T nike
= [EF computer room 2
[ kniz030a
[@® meriyn
(3 test lab

Note: A system can be part of only one display group at a time; it cannot appear
in multiple display groups.

More information
The Enterprise view|

Creating a display group:

Note: This action is not supported when using the following:
* ServeRAID Manager in bootable-CD mode
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* ServeRAID Manager as a plug-in application

Use this action to add a system or enclosure to a new display group. This action
creates the display group and moves the system into it in a single step.

1. In the Enterprise view, click [ £ | (system) or & (enclosure).

2. Right-click Change display group » new group. The "Group name” window
opens.

3. Enter a name for the group.
4. Click OK.

More information

+ [Using display groups|

* [Moving systems in and out of a display group (action)|
* |Deleting or renaming a display group (action)|

Deleting or renaming a display group:

Note: This action is not supported when using the following:
¢ ServeRAID Manager in bootable-CD mode
¢ ServeRAID Manager as a plug-in application

Use this action to delete or rename a display group.

1. In the Enterprise view, click [ 55 (display group).

2. To delete the display group, right-click Delete display group. All systems in
the group move back to their original location in the tree.

3. To rename the display group:
a. Right-click Rename display group. The "Group name” window opens.
b. Enter a new name for the display group.
c. Click OK.

More information

+ |Using display groups|

* |Creating a display group (action)|

« [Moving systems in and out of a display group (action)|

Moving systems in and out of a display group:

Note: This action is not supported when using the following:
* ServeRAID Manager in bootable-CD mode
* ServeRAID Manager as a plug-in application

Use this action to move a system or enclosure into an existing display group; to
move the system or enclosure from one display group to another; or to remove the
system or enclosure from a display group.

1. In the Enterprise view, click = (system) or & (enclosure).

2. To move the system into a display group or from one display group to another,
right-click Change display group and then the display group name.

3. To remove the system from the display group, right-click Change display
group > none.
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Note: When you remove the last system in a display group, the ServeRAID
Manager deletes the display group.

More information

« |Using display groups]

« |Creating a display group (action)|

+ |Deleting or renaming a display group (action)|

Changing the display options: You can sort objects in the ServeRAID Manager
Enterprise view alphabetically or chronologically. You can also view the disk
capacity unit of measure in megabytes (MB), gigabytes (GB), or terabytes (TB).

Note: The local system always appears first when you sort objects alphabetically.

Complete the following steps set the display options:
1. In the "User Preferences” window, click the Display options tab.

2. From the System tree sorting list, select chronological or alphabetical.

Note: This action is not supported in bootable-CD mode.

3. From the Capacity display units list, select one of the following:
* MB (megabytes)
* GB (gigabytes)
* TB (terabytes)
* Auto-select

Choose Auto-select to let the ServeRAID Manager choose the unit of measure
for you, based on the drive size. With this option, the ServeRAID Manager may
display different drives with different units.

4. Click OK.

Monitoring systems over a network

You can monitor other systems over a network. To do so, the ServeRAID Manager
must be installed and running on your local system and on the other systems.
Then, you can fadd the remote systems|to your ServeRAID Manager Enterprise
view. Also, you can choose to use the [ServeRAID Manager agent} instead of the
ServeRAID Manager program.

Note: You cannot monitor other systems when using:
* ServeRAID Manager in bootable-CD mode
* ServeRAID Manager as a plug-in application

In addition to the ServeRAID Manager, you can use the following:

The Notification Manager]is a tool that you can use to notify other systems
running the ServeRAID Manager of all events that occur on this (that is, the
local) system.

* Use the [Email Notification Manager to notify users by email when events occur
on the local system. You can send email notifications to anyone on the network;
the recipient does not have to be running ServeRAID Manager.

¢ Use the |iask Manageﬂ to manage scheduled tasks on local or remote systems,
such as [logical drive migration| or synchronization| You can modify the task
schedule, delete the scheduled task, or view task properties.

More information
+ |Adding a remote system (action)|
+ [Using the ServeRAID Manager agent|
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« [Starting the ServeRAID Manager agent]

* |Verifying that the ServeRAID Manager agent is running]
+ |Using the Notification Manager|

* |Using the Email Notification Managet|

* |Using the Task Manager]|

Using the Notification Manager:

Note: You cannot use the Notification Manager when using:
* ServeRAID Manager in bootable-CD mode
* ServeRAID Manager as a plug-in application

The Notification Manager is a tool that you can use to notify other systems
running the ServeRAID Manager of all events that occur on this (that is, the local)
system. The user of the system types system names in the notification list. Each
system in the list is notified of all events that occur on the local system.

You can use the Notification Manager to:

+ |Add a system to the notification lis{

* [Delete a system from the notification list]

+ [Modify system properties in the notification list]

* [Send a test event to a system in the notification list]

+ [Monitor events sent from the Notification Manager]|

The Notification Manager is enabled by default. To disable the Notification
Manager, click Actions » Disable notifications . If you disable the Notification
Manager, the events are generated, but not dispatched to remote systems.

An example

You install SystemA in a lab with a ServeRAID Manager subsystem. You run the
ServeRAID Manager on SystemA to monitor for events and problems, but you
want to monitor from your workstation and not from SystemA. You open the
SystemA Notification Manager from the ServeRAID Manager and define your
workstation in the notification list. When running the ServeRAID Manager from
your workstation, you are notified of all problems and events that occur on
SystemA.

Note: You can use the [Email Notification Manager| to notify users of events by
email. This allows you to notify users who have not installed or are not
currently running ServeRAID Manager.

The Notification Manager and its events

Events generated by the Notification Manager include the following:
* Progress information, such as rebuilds, synchronizations, and migrations.
* Problems, such as defunct physical drives and PFA errors.

* Changes to the local configuration, such as creating a hot-spare drive or defining
a logical drive.

When an event is generated on a system, the Notification Manager connects with

each system in the notification list and relays the event to these systems’
ServeRAID Manager. If the Notification Manager successfully connects and sends
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the event, the notification list updates its " |[Last event sent| column. If the

Notification Manager does not successfully connect or send the event, the
Notification Manager:

* Updates the "Last event sent” column with a @ notifying you of a problem.

* Logs an event in the Notification Manager event viewer detailing why the event
could not be sent.

The Notification Manager interface

The Notification Manager consists of the following:

Toolbar
Provides quick-path icons for common tasks.

Notification list
Displays the remote systems configured to receive event notification.

Notification event viewer
Displays status information for the Notification Manager.

In addition to displaying the events in the event viewer, the Notification
Manager appends each event to a logging file, RAIDNOT.LOG. If this file
exceeds 200 KB, the ServeRAID Manager copies the file to RAIDNOT.OLD
and creates a new RAIDNOT.LOG. If there is a RAIDNOT.OLD already,
the ServeRAID Manager overwrites it.

More information
+ |Adding a system to the notification list]

+ |Deleting a system from the notification list|

+ [Modifying system properties in the notification list|

* |Sending a test event to a system in the notification list

+ [Monitoring events sent from the Notification Manager|

* [The Notification Manager menubar
* [The Notification Manager toolbar|
* |Using the Email Notification Manager]

* |Using the ServeRAID Manager agent|

Notification Manager menubar: The Notification Manager menu bar has the
following functions:

File >
Clear event log
Click Notification Manager from the menu. Clears the current
contents of the Notification Manager event viewer. This option
does not clear or delete the event logging file.
Close Closes the Notification Manager.
View >
Toolbar
Turns the toolbar on and off. The default is on (selected).
Actions >
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1
Delete system|

S [Modify system|
|§end test even’g]

Help >

=

el Information about this window
View context-sensitive information for the current window.

Search
Searches for one or more specified words in ServeRAID Manager
Assist and displays a list of topics that include the words.

Contents
Presents the ServeRAID Manager Assist contents. You can use the
contents to acquaint yourself with ServeRAID Manager Assist
topics.

About ServeRAID Manager
Reports the ServeRAID Manager version number, copyright, and
legal information.

Notification Manager toolbar: The Notification Manager toolbar has the following
functions:

Py
1
Delete syste

e [Modify syste

Information about this window View context-sensitive information for the
current window.

Adding a system in the Notification Manager:

Note: This action is not supported when using the ServeRAID Manager in
bootable-CD mode.

Use this action to add a new system to the notification list. Every new system that
you add to the list is notified of all events that occur on this system.

1. Click =1 (Add system).
2. Type the host name or TCP/IP address of the system that you want to add.

3. Type the TCP/IP port for the remote system Startup port number. The default
port is 34571. If you changed the system Startup port number in the "User
preferences” window on the remote system, type that number here.

4. Click Add.
5. Continue to add systems, or click Cancel to close the window.
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After you add the system to the notification list, the ServeRAID Manager will
attempt to connect to the remote system and send an initial set of events. The
Manager uses these events to update the ServeRAID Manager interface running on
the remote system.

More information

« [Using the Notification Manager|

« [Deleting a system from the notification list]

« [Modifying system properties in the notification list|

* |Sending a test event to a system in the notification list
* |[Monitoring events sent from the Notification Manager]

Deleting a system in the Notification Manager:

Note: This action is not supported when using the following:
* ServeRAID Manager in bootable-CD mode
¢ ServeRAID Manager as a plug-in application

Use this action to delete a remote system from the notification list. After deleting
the remote system, the Notification Manager no longer notifies the remote system
of events occurring on the local system.

1. Click the system you want to delete from the notification list.
2. Click g (Delete system).

3. Click Yes to confirm. The Notification Manager deletes the system from the
notification list.

More information

* [Using the Notification Manager|

+ |Adding a system to the notification list|

+ [Modifying system properties in the notification list|

* |Sending a test event to a system in the notification list
* |Monitoring events sent from the Notification Manager

Monitoring events sent from the Notification Manager: For each system in the
notification list, you can view details about the last event the Notification Manager
sent (or tried to send) to that system.

In the notification list, double-click the Last event sent column for the system in
which you are interested. The "Last event detail” window opens. This window
contains information about the last event the Notification Manager sent (or tried to
send) to the selected system. The event information includes the following: status,
type, date, time, source, target, and description.

More information

* [Using the Notification Manager|

+ |Adding a system to the notification list|

« |Deleting a system from the notification list

« [Modifying system properties in the notification list|

* [Sending a test event to a system in the notification list|

Modifying a system in the Notification Manager:

Note: This action is not supported when using the following:
* ServeRAID Manager in bootable-CD mode
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* ServeRAID Manager as a plug-in application

Use this action to modify a remote system host name, TCP/IP address, or port
number:

1. Click the system that you want to modify from the notification list.
2. Click g (Modify system). The "System properties” window opens.
3. Change the system properties in the appropriate entry fields.

4. Click OK.

More information

+ [Using the Notification Manager|

« |Adding a system to the notification list]

« [Deleting a system from the notification list

* [Sending a test event to a system in the notification lisf
* [Monitoring events sent from the Notification Manager

Sending a test event in the Notification Manager:

Note: This action is not supported when using the following:
* ServeRAID Manager in bootable-CD mode
* ServeRAID Manager as a plug-in application

Use this action to send a test event to a remote system:
1. Click the system in the notification list that you want to send a test event.

Note: If you click no system or more than one system, this action is disabled.

2. Click Actions » Send test event. A window opens to report success or failure.
The remote system will respond to the test event with a beep.

3. Click OK.

If the test fails, verify the following and try the test send again:
1. You typed the correct TCP/IP information.
2. The ServeRAID Manager is running on the remote system.

More information

« |Using the Notification Manager|

* |Adding a system to the notification list|

* |Deleting a system from the notification list|

* [Modifying system properties in the notification list|

* [Monitoring events sent from the Notification Manager|

Changing the alarm settings:
Note: This action is not supported in bootable-CD mode.

Warning and Error events cause an audible alarm to sound every five minutes,
notifying you of the event. Any Error or Warning event can trigger the alarm if the
event causes the system to enter the critical state or the event arrives while the
system status is critical. Once triggered, the repeating alarm continues to sound as
long as any system in the ServeRAID Manager Enterprise view is critical.
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Some events, such as the non-warranted drive event, do not affect the system
status in the Enterprise view; if the system status is not critical, these events will
not sound the alarm.

You can adjust the alarm settings with the following steps:
1. In the User Preferences window, click the Alarm settings tab.
2. Select the check box to enable or disable the repeating alarm.

Note: If you disable the alarm, you will not hear an audible alarm when you
receive problem events.

3. If you have enabled the alarm, you can adjust the time interval (in seconds)
that you want between each alarm. The default is 300 seconds (5 minutes).

4. If you have enabled the alarm, you can adjust the length of time (in beeps) that
you want the alarm to continue. The default is 3 beeps.

5. Click OK.
6. Restart the ServeRAID Manager for these settings to take effect.

Using the Email Notification Manager:

Note: You cannot use the Email Notification Manager when using:
* ServeRAID Manager in bootable-CD mode
* ServeRAID Manager as a plug-in application

The Email Notification Manager is a tool that you can use to notify users by e-mail
of events that occur on this (that is, the local) system. The user of the system types
recipient names and e-mail addresses in the e-mail notification list. Each recipient
in the list is notified of all or selected events that occur on the local system.

You can use the Email Notification Manager to:

+ |Add a recipient to the email notification list]

« |Delete a recipient from the email notification list]

* [Modify recipient properties in the email notification list|

* |Send a test message to a recipient in the email notification list|

« [Monitor messages sent from the Email Notification Manager|

« |Configure the Email Notification Manager|

The Email Notification Manager is enabled by default. To disable the Email
Notification Manager, click Actions » Disable Email Notifications . If you disable
the Email Notification Manager, events are generated but users do not receive
e-mail notification when the events occur.

An example

You install SystemA in a lab with a ServeRAID Manager subsystem. You run the
ServeRAID Manager on SystemA to monitor for events and problems. You want to
monitor SystemA from your workstation but do not have ServeRAID Manager
installed. You open the SystemA Email Notification Manager from the ServeRAID
Manager and add your name and e-mail address to the e-mail notification list. You
are notified by e-mail of all problems and events that occur on SystemA.
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The Email Notification Manager and its events

Events monitored by the Email Notification Manager include the following:
* Progress information, such as rebuilds, synchronizations, and migrations.
* Problems, such as defunct physical drives and PFA errors.

* Changes to the local configuration, such as creating a hot-spare drive or defining
a logical drive.

Each event has an event type indicating its severity: error, warning, or
informational. You can configure a recipient to be notified of errors, errors and
warnings, or errors, warnings, and informational events.

When an event is generated on a system, the Email Notification Manager attempts
to send a message|to each recipient in the email notification list. If the Email
Notification Manager successfully sends the message, it updates the ”
’ column in the email notification list. If the Email Notification Manager does
not successfully connect or send the message, the Email Notification Manager:

* Updates the "Last message sent” column with a g notifying you of a problem.

* Logs an event in the Email Notification Manager event viewer detailing why the
message could not be sent.

The Email Notification Manager interface

The Email Notification Manager consists of the following:

Toolbar
Provides quick-path icons for common tasks.

Email notification list
Displays the recipients configured to receive e-mail notifications.

Email notification event viewer
Displays status information for the Email Notification Manager.

In addition to displaying the events in the event viewer, the Email
Notification Manager appends each event to a logging file,
RAIDSMTP.LOG. If this file exceeds 200 KB, the ServeRAID Manager
copies the file to RAIDSMTP.OLD and creates a new RAIDSMTP.LOG. If
there is a RAIDSMTP.OLD already, the ServeRAID Manager overwrites it.
The Email Notification Manager appends SMTP transport errors in a
separate log file, SMTPERR.LOG.

More information
+ |Adding a recipient to the email notification list|

+ |Deleting a recipient from the email notification lis]

+ [Modifying recipient properties in the email notification list]

* |Sending a test message to a recipient in the email notification list]

+ [Monitoring messages sent from the Email Notification Manager|

+ |Configuring the Email Notification Manager|

* |The Email Notification Manager menubar|

¢ |The Email Notification Manager toolbar

* |The Email Notification Manager message format|

+ [Using the ServeRAID Manager agent|
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About Email Notification Manager:

Email Notification Manager menu bar: The Email Notification Manager menu bar
has the following functions:
File »

Clear event log
Click Email Notifications from the menu. Clears the current contents
of the Email Notification Manager event viewer. This option does not
clear or delete the event logging file.

Close Closes the Email Notification Manager.

View -

Toolbar
Turns the toolbar on and off. The default is on (selected).

Actions »

i [Add email recipient|

@ [Delete email recipient|

% [Modify email recipient]

[Send test message|

ISMTP server settings|

Help -

=

el Information about this window
View context-sensitive information for the current window.

Search
Searches for one or more specified words in ServeRAID Manager
Assist and displays a list of topics that include the words.

Contents
Presents the ServeRAID Manager Assist contents. You can use the
contents to acquaint yourself with ServeRAID Manager Assist topics.

About ServeRAID Manager
Reports the ServeRAID Manager version number, copyright, and legal
information.

Email Notification Manager menu bar: The Email Notification Manager menu bar
has the following functions:
File >
Close Closes the Email Notification Manager.
View >

Toolbar
Turns the toolbar on and off. The default is on (selected).

Actions >
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i [Add email recipient|

@ [Delete email recipient|

“& [Modify email recipient]
Send test message]
SMTP server settings

Help >

=

el Information about this window
View context-sensitive information for the current window.

Search
Searches for one or more specified words in ServeRAID Manager
Assist and displays a list of topics that include the words.

Contents
Presents the ServeRAID Manager Assist contents. You can use the
contents to acquaint yourself with ServeRAID Manager Assist
topics.

About ServeRAID Manager
Reports the ServeRAID Manager version number, copyright, and
legal information.

Email Notification Manager toolbar: The Email Notification Manager toolbar has the
following functions:

i [Add email recipient]

@ [Delete email recipient|

E& [Modify email recipient|

Information about this window View context-sensitive information for the
current window.

Email Notification Manager toolbar: The Email Notification Manager toolbar has the
following functions:

i [Add email recipient|

@ [Delete email recipient|

“& [Modify email recipient

Information about this window View context-sensitive information
for the current window.
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The Email Notification Manager Message Format: When an event is generated on a
system, the Email Notification Manager sends a message to each recipient in the
email notification list. The message format is:

To: <recipient email address>

From: <administrator email adress>

Subject: ServeRAID Manager Event Notification - Event type <event type>

This message was generated by ServeRAID Manager Agent.

Please do not reply to this message.

Event Description: <event description>

Event Type: <event type>

Event Source: <agent domain name>

Date: <date>

Time: <time>

More information
* [Using the Email Notification Manager]

+ |Adding a recipient to the email notification list|

* [Deleting a recipient from the email notification lis{

+ [Modifying recipient properties in the email notification list|

* |Sending a test message to a recipient in the email notification list]

The Email Notification Manager Message Format: When an event is generated on a
system, the Email Notification Manager sends a message to each recipient in the
email notification list. The message format is:

From: <management station email adress>

Sent: <date>

To: <recipient email address>

Subject: <management station> - <Event message>

This message was generated by the ServeRAID Manager. Please
do not reply to this message.

Event Description: <event description>

Event Type: <event type>

Event Source: <management station> / <IP address>
Time: <date> <time>

More information

« |Using the Email Notification Manager|

+ [Adding a recipient to the email notification list]

+ [Deleting a recipient from the email notification lis{

+ [Modifying recipient properties in the email notification list

* [Sending a test message to a recipient in the email notification list]

Adding a recipient to the Email Notification Manager:

Note: This action is not supported when using the following:
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* ServeRAID Manager in bootable-CD mode
* ServeRAID Manager as a plug-in application

Use this action to add a recipient to the email notification list. Every recipient that
you add to the list is notified of all or selected events that occur on this system.

1. Click § (Add recipient).
2. Type the name of the recipient that you want to add to the list.

3. Type the recipient’s e-mail address. Include the user name and domain, such as
jack_smith@synteca.com.

4. Select the type of event you want the recipient to be notified of: error, error and
warning, or error, warning, and informational.

5. Click Add.

6. Continue to add recipients, or click Cancel to close the window.

More information

« |Using the Email Notification Manager|

+ [Deleting a recipient from the email notification lis{

+ [Modifying recipient properties in the email notification list|

+ [Sending a test message to a recipient in the email notification list|
+ [Monitoring messages sent from the Email Notification Manager]

Deleting a recipient from the Email Notification Manager:

Note: This action is not supported when using the following:
* ServeRAID Manager in bootable-CD mode
¢ ServeRAID Manager as a plug-in application

Use this action to delete a recipient from the e-mail notification list. After deleting
a recipient, the Email Notification Manager no longer notifies the user of events
occurring on the local system.

1. Click the recipient you want to delete from the e-mail notification list.
2. Click & (Delete recipient).

3. Click Yes to confirm. The Email Notification Manager deletes the recipient from
the e-mail notification list.

More information

* |Using the Email Notification Manager|

* |Adding a recipient to the email notification list]

* [Modifying recipient properties in the email notification list|

* |Sending a test message to a recipient in the email notification list]
* [Monitoring messages sent from the Email Notification Manager]

Modifying a recipient in the Email Notification Manager:

Note: This action is not supported when using the following:
* ServeRAID Manager in bootable-CD mode
¢ ServeRAID Manager as a plug-in application

Use this action to modify an e-mail recipient name, address, or event type:

1. Click the recipient that you want to modify in the e-mail notification list.

2. Click & (Modify email recipient). The "Modify email recipient” window opens.
3. Change the recipient properties in the appropriate fields.
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4. Click OK.

More information

« |Using the Email Notification Manager|

» [Adding a recipient to the email notification list

« [Deleting a recipient from the email notification lis

* [Sending a test message to a recipient in the email notification listl
* [Monitoring messages sent from the Email Notification Manager]

Sending a test message in the Email Notification Manager:

Note: This action is not supported when using the following;:
* ServeRAID Manager in bootable-CD mode
¢ ServeRAID Manager as a plug-in application

Use this action to send a test message to a recipient in the e-mail notification list:

1. Click the recipient in the e-mail notification list that you want to send a test
message.

Note: If you click no recipient or more than one recipient, this action is
disabled.

2. Click Actions » Send test message. If the Email Notification Manager does not
successfully connect or send the message, it:

» Updates the "Last message sent” column with a g notifying you of a
problem.

¢ Logs an event in the Email Notification Manager event viewer detailing why
the message could not be sent.

3. Click OK.

If the test fails, verify the following and try the test again:

1. You typed the correct e-mail address when you [added the recipient{to the
Email Notification Manager.

2. You typed the correct|SMTP server address| when you configured the Email
Notification Manager.

More information

+ |Using the Email Notification Manager]|

* |Adding a recipient to the email notification list|

* |Deleting a recipient from the email notification list

» [Modifying recipient properties in the email notification list]

+ [Monitoring messages sent from the Email Notification Manager|

Monitoring messages sent from the Email Notification Manager: For each recipient in
the e-mail notification list, you can view details about the last message the Email
Notification Manager sent (or tried to send) to that recipient.

In the e-mail notification list, double-click the Last message sent column for the
recipient in which you are interested. The "Last message detail” window opens.
This window contains information about the last message the Email Notification
Manager sent (or tried to send) to the recipient. The message information includes
the following: status, type, date, time, source, target, and description.
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More information

« |Using the Email Notification Manager]|

* |Adding a recipient to the email notification list]

+ |Deleting a recipient from the email notification lis{

» [Modifying recipient properties in the email notification lis{

* [Sending a test message to a recipient in the email notification list]

Configuring the Email Notification Manager:

Note: This action is not supported when using the following:
* ServeRAID Manager in bootable-CD mode
* ServeRAID Manager as a plug-in application

Use this action to specify the SMTP server address and the administrator’s "reply
to” address. The reply to address typically is the address of the ServeRAID
Manager system administrator or IT or network administrator.

1. Click Actions » SMTP server settings. The SMTP server settings window
appears.

2. Type the SMTP server address. You can enter the host name, including domain,
or the TCP/IP address.

3. Type the administrator’s reply to address. Include the user name and domain,
such as jack_smith@syntecha.com.

4. Click OK.

More information

+ |Using the Email Notification Manager]|

* |Adding a recipient to the email notification list]

* |Deleting a recipient from the email notification list

+ [Modifying recipient properties in the email notification list

* [Sending a test message to a recipient in the email notification list|
« [Monitoring messages sent from the Email Notification Manager]

Adding a recipient to the Email Notification Manager: Use this action to add a
recipient to the e-mail notification list. You can add one recipient only, typically the
ServeRAID Manager administrator, or system or network administrator. The
recipient is notified of all or selected events that occur on the enclosure(s)
connected to the management station.

1. Click § (Add e-mail recipient). The "Add e-mail recipient” window opens.

2. In the To e-mail address field, type the name of the recipient that you want to
add to the list. Include the user name and domain, such as
jack_smith@synteca.com.

3. Select the type of event(s) you want the recipient to be notified of: error,
warning, or informational.

4. Click Add.

More information

* [Using the Email Notification Manager]

+ [Deleting a recipient from the email notification list]

« [Modifying recipient properties in the email notification list

* [Sending a test message to a recipient in the email notification list]

Configuring the Email Notification Manager: Use this action to specify the SMTP
server address and the "from” address of the e-mail sender. The default "from”
address includes a generalized management station name and a partial e-mail
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address of the form <name@%s>. Replace the the partial address with the address
you want to appear in the From field of the e-mail message.

1. Click Actions » SMTP server settings. The "SMTP server settings” window
opens.

2. Type the SMTP server address. You can enter the host name, including domain,
or the TCP/IP address.

3. Type the from address, replacing the general management station name and
e-mail address with the name and address you want to appear in the From
field of the e-mail message.

4. Click Add.

More information

« |Using the Email Notification Manager|

+ [Adding a recipient to the email notification list

+ [Deleting a recipient from the email notification lis{

+ [Modifying recipient properties in the email notification list

* |Sending a test message to a recipient in the email notification list]

Deleting a recipient from the Email Notification Manager: Use this action to delete a
recipient from the email notification list. After deleting a recipient, the Email
Notification Manager no longer notifies the user of events occurring on the
enclosure(s) connected to the management station.

1. In the e-mail notification list, click the recipient you want to delete.
2. Click & (Delete e-mail recipient).

3. Click Yes to confirm. The Email Notification Manager deletes the recipient from
the e-mail notification list.

More information

+ |Using the Email Notification Manager]|

+ |Adding a recipient to the email notification list|

+ [Modifying recipient properties in the email notification list|

* |Sending a test message to a recipient in the email notification list]

Modifying a recipient in the Email Notification Manager: Use this action to modify the
e-mail recipient’s address or monitored event types:

1. In the e-mail notification list, click the recipient that you want to modify.

2. Click & (Modify email recipient). The "Modify email recipient” window opens.
3. Change the recipient properties in the appropriate fields.

4. Click Modify.

More information

« |Using the Email Notification Manager]

« [Adding a recipient to the email notification list

« |Deleting a recipient from the email notification list

+ [Sending a test message to a recipient in the email notification list

Sending a test message in the Email Notification Manager: Use this action to send a
test message to a recipient in the email notification list:

1. Click a recipient in the e-mail notification list.

Note: This action is disabled if you do not click a recipient.
2. Click Actions » Send test message.
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If the test fails, verify the following and try the test again:

1. You typed the correct e-mail address when you|added the recipient to the
Email Notification Manager.

2. You typed the correct[SMTP server address| when you configured the Email
Notification Manager.

More information

« [Using the Email Notification Manager]

« |Adding a recipient to the email notification lisY

« |Deleting a recipient from the email notification list

» [Modifying recipient properties in the email notification list]

Using the Task Manager:

Note: You cannot use the Task Manager in bootable-CD mode or when using the
ServeRAID Manager as a plug-in application.

The Task Manager is a tool that you can use to manage scheduled tasks, such as a
llogical drive migration| or|[synchronizing a logical drive|l For each scheduled task,
the Task Manager displays the task start time, status, and description.

You can use the Task Manager to:
+ [Modify a task’s schedule]

* |Delete a scheduled task]

+ |View task properties|

The Task Manager is enabled by default. To disable the Task Manager, click
Actions » Disable Task Scheduler .

Note: If you disable the Task Manager, a task may miss its start time. To run the
task, you must [reschedule|it. See [Understanding scheduled tasks| for more
about missed start times.

An example

You schedule a synchronization task with an initial start time of Sunday, October
13, 2003 at 2:00 AM. Due to a power outage, the task misses its start time. The Task
Manager flags the error. The next day, you modify the task schedule to run on
Sunday October 20, 2003 at 2:00 AM.

The Task Manager status

If a scheduled task runs successfully, the Task Manager updates the "Status”
column in the task list with Complete. For recurring tasks, an asterisk (*) indicates
that the task has completed one cycle and is scheduled to run again at the given
interval. If a scheduled task does not run successfully, the Task Manager:

* Updates the "Status” column in the task list with Error.

e Updates the first column of the task list with a 4, , notifying you of a
recoverable error (a warning message); it displays a @ if the error is
non-recoverable (a critical error).

To see details about the error, use [View task properties| See[Understanding|
lscheduled taskd for more about Task Manager status, start time validation, missed
start times, and error conditions.
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The Task Manager interface

The Task Manager consists of the following:

Toolbar
Provides quick-path icons for common tasks.

Task list
Displays the scheduled tasks.

Task event viewer
Displays status information for the Task Manager.

More information
» |Understanding scheduled task
* [Starting the Task Manager|

* |Deleting a scheduled task]
. ‘Modifving a scheduled task|
« |Viewing task properties|

+ |The Task Manager menubaif
* [The Task Manager toolbar
* [Using the ServeRAID Manager agent|

Task Manager menu bar: The Task Manager menu bar has the following functions:

File »

Clear event log
Click Task from the menu. Clears the current contents of the Task
Manager event viewer.

Close Closes the Task Manager.

View -

Toolbar
Turns the toolbar on and off. The default is on (selected).

Actions ~

¥ b
Y [View aod

[‘Sending a test message in the Email Notification Manager” on page 156|
Disable Task Scheduler

Turns the Task Scheduler on and off. The default is on.

Help »

el Information about this window
View context-sensitive information for the current window.
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Search
Searches for one or more specified words in ServeRAID Manager
Assist and displays a list of topics that include the words.

Contents
Presents the ServeRAID controller Assist contents. You can use the
contents to acquaint yourself with ServeRAID Manager Assist topics.

About ServeRAID Manager
Reports the ServeRAID Manager version number, copyright, and legal
information.

Task Manager toolbar: The Task Manager toolbar has the following functions:

¥ Do s
5N [View ]

Information about this window View context-sensitive information
for the current window.

Starting the Task Manager: Use this action to start the Task Manager. You must start
the Task Manager to manage [scheduled tasks}

1. In the Enterprise view, click m (system).

2. From the "Actions” menu, select Agent actions » Configure. The ServeRAID
Manager Agent window opens.

3. Click the Task note tab.

More information

* |[Using the Task Manager]|

* |Deleting a scheduled task|

+ [Modifying a scheduled task|

« |Viewing task properties|

* [The Task Manager menubai|

¢ [The Task Manager toolbar]

« |Using the ServeRAID Manager agent|

Modifying a scheduled task in the Task Manager:

Note: This action is not supported when using the following:
* ServeRAID Manager in bootable-CD mode
¢ ServeRAID Manager as a plug-in application

Use this action to modify a scheduled task’s start time and date, description, and
recurrence interval (if the task can be recurring):

1. Click the task that you want to modify in the task list.

2. Click B (Modify task). The "Modify task” window opens.
3. Change the task properties in the appropriate fields.

4. Click OK.
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More information

* |Using the Task Manager|

* |Starting the Task Manager|

+ |Understanding scheduled tasks
* |Deleting a scheduled task|

« [Viewing task properties|

Deleting a scheduled task from the Task Manager:

Note: This action is not supported when using the following:
¢ ServeRAID Manager in bootable-CD mode
* ServeRAID Manager as a plug-in application

Use this action to delete a scheduled task from the task list. After deleting a task,
the Task Manager no longer attempts to run the task at the scheduled time.

1. Click the task you want to delete from the task list.
2. Click @ (Delete task).
3. Click Yes to confirm. The Task Manager deletes the task from the task list.

More information

+ |Using the Task Manager]

+ [Starting the Task Manager]

+ |Understanding scheduled tasks
* [Modifying a scheduled task]|

+ |Viewing task properties|

Viewing task properties from the Task Manager: You can view details about each task
in the task list.

In the task list, double-click the task in which you are interested. The "Task
properties” window opens. This window contains information about the task,
including the following: description, task ID, start time, recurrence interval, and
last time a recurring task started. An error description appears if the Task Manager
flagged an error for the task.

More information

+ |Using the Task Manager|

* |Starting the Task Manager|

* |Understanding scheduled tasks
* |Deleting a scheduled task|

* [Modifying a scheduled task]|

Monitoring storage enclosures on a network: You can monitor network-attached
storage enclosures from a ServeRAID Manager console running on the local
system. The ServeRAID Manager management station software must be installed
and running on the system to which the storage enclosure is attached. Then, you
canadd a management station|to your ServeRAID Manager Enterprise view.

You can configure the management station to monitor and manage
network-attached storage:

* Use the Security Manager]to allow users to configure and view enclosure
information from remote systems.
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* Use the [Email Notification Manager to notify users by email when events occur
on the enclosures attached to the management station. You can send email
notifications to any user on the network; the recipient does not have to be
running ServeRAID Manager.

* Use the [SNMP Trap Manager] to notify other systems running an SNMP console
of all SNMP traps that occur on the enclosures attached to the management
station.

More information

Adding a management station|

» |Using the management station agent]

+ |[Adding a management station agent]

Using the Security Manager: Use the Security Manager to give users the ability to
connect to a management station from remote systems and configure and view the
attached enclosures. You must configure at least one user name and password
before any user can connect to the management station.

Note: You cannot disable security for a management station.

Use the following actions in the Security Manager to manage users’ ability to
configure and view network storage from remote systems:

* [Add a user
* [Delete a user
* [Modify a user|

The first time you open the Security Manager, the ServeRAID Manager prompts
you to type an Admin (administrator) password. Either type a password or click
Cancel to not have an Admin user.

The Security Manager interface

The Security Manager consists of the following;:

Toolbar
Provides quick-path icons for common tasks.

Security list
Displays the users with access to this management station.

The Security Manager logs events to a logging file, RAIDSEC.LOG. If this file
exceeds 200 KB, the ServeRAID Manager copies the file to RAIDSEC.OLD and
creates a new RAIDSEC.LOG. If there is a RAIDSEC.OLD already, the ServeRAID
Manager overwrites it.

More information

* [The Security Manager menubarf|

* [The Security Manager toolbar

+ |Using the management station agent]

Using the SNMP Trap Manager: Use the SNMP Trap Manager to notify other
systems running an SNMP console of all SNMP traps that occur on the enclosures
connected to a management station. You add system names to the SNMP traps list.
Each system in the list is notified of all traps that occur on the enclosure.
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You can use the SNMP Trap Manager to:

* |Add a system to the SNMP traps list|

* |Delete a system from the SNMP traps lis{|

¢ [Modify system properties in the SNMP traps list]

* |Send a test trap to a system in the SNMP traps list]

The SNMP Trap Manager is enabled by default. To disable the SNMP Trap
Manager, click Actions » Disable SNMP Traps . If you disable the SNMP Trap
Manager, the SNMP traps are generated, but not dispatched to remote systems.

An example

You install SystemA in a lab with a network-attached storage enclosure. You
configure SystemA to send SNMP traps from the enclosure, but you want to
monitor the traps from your workstation, not SystemA. You open the SystemA
SNMP Trap Manager from the ServeRAID Manager and define your workstation in
the SNMP traps list. When running the SNMP console from your workstation, you
are notified of all SNMP traps that occur on the enclosures attached to SystemA.

The SNMP Trap Manager and traps

Traps generated by SNMP include the following:

* Progress information, such as rebuilds, synchronizing, and migrations.

* Problems, such as defunct physical drives and PFA errors.

* Changes to the local configuration, such as adding or replacing a controller.

When an SNMP trap is generated on an enclosure, the SNMP Trap Manager
connects with each system in the SNMP traps list and relays the trap to these
systems” SNMP consoles.

The SNMP Trap Manager also logs each trap to a logging file, RaidSNMPlog. If
this file exceeds 200 KB, the Manager copies the file to RaidSNMP.old and creates a
new RaidSNMP.log. If there is a RaidSNMP.old already, the Manager overwrites it.

The SNMP Trap Manager interface

The SNMP Trap Manager consists of the following:

Toolbar
Provides quick-path icons for common tasks.

SNMP traps destination list
Displays the remote systems configured to receive SNMP traps.

More information

* [The SNMP Trap Manager menubar|
* [The SNMP Trap Manager toolbar
+ |Using the management station agent]

Using the Email Notification Manager: Use the Email Notification Manager to notify
users by e-mail of events that occur on enclosures connected to a management
station. You type the recipient’s name and e-mail address in the e-mail notification
list. The recipient is notified of all or selected events that occur on the enclosure.

You can use the Email Notification Manager to:
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* |Add a recipient to the email notification list]

* |Delete a recipient from the email notification list]

« [Modify recipient properties in the email notification list]

* |Send a test message to a recipient in the email notification list|

+ |Configure the Email Notification Manager]

The Email Notification Manager is enabled by default. To disable the Email
Notification Manager, click Actions » Disable Email Notifications. If you disable
the Email Notification Manager, events are generated but users do not receive
e-mail notification when the events occur.

An example

You install SystemA in a lab with a network-attached storage enclosure. You
[management station agent on SystemA to monitor for events and problems. You
want to monitor SystemA from your workstation but do not have ServeRAID
Manager installed. You open the SystemA Email Notification Manager from the
ServeRAID Manager and add your name and e-mail address to the e-mail
notification list. You are notified by e-mail of all problems and events that occur on
the enclosure attached to SystemA.

The Email Notification Manager and its events

Events monitored by the Email Notification Manager include the following:
* Progress information, such as rebuilds, synchronizing, and migrations.
* Problems, such as defunct physical drives and PFA errors.

* Changes to the local configuration, such as creating a hot-spare drive or defining
a logical drive.

Each event has an event type indicating its severity: error, warning, or
informational. You can configure a recipient to be notified of errors, errors and
warnings, or errors, warnings, and informational events.

The Email Notification Manager logs events to a logging file, RAIDSMTP.LOG. If
this file exceeds 200 KB, the ServeRAID Manager copies the file to
RAIDSMTP.OLD and creates a new RAIDSMTP.LOG. If there is a RAIDSMTP.OLD
already, the ServeRAID Manager overwrites it. The Email Notification Manager
appends SMTP transport errors in a separate log file, SMTPERR.LOG.

The Email Notification Manager interface

The Email Notification Manager consists of the following:

Toolbar
Provides quick-path icons for common tasks.

Email notification list

Displays the recipients configured to receive e-mail notifications.

More information
* |The Email Notification Manager menubar|

¢ |The Email Notification Manager toolbar

* |The Email Notification Manager message format]

+ [Using the management station agent|
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Modifying logical drives using the Configuration wizard

Understanding logical-drive migration

Logical-drive migration is a powerful and flexible feature of ServeRAID controllers.
You can use logical-drive migration to:

* Change the RAID level of existing logical drives

* Increase array free space, so you can create additional logical drives

* Increase the size of an existing logical drive

You can migrate a logical drive while the server is running with only minor
performance degradation for users during the process. You can start the migration
immediately or it for a later date and time.

Hos TR

HostRAID controllers do not support logical drive migration.

Note: To perform a logical-drive migration, the following must be true:

* For ServeRAID SCSI controllers, no more than seven logical drives
currently exist.

During logical-drive migration, the ServeRAID Manager creates one
logical drive for temporary use. (You must have an extra logical drive
onto which the data can migrate.) The ServeRAID Manager sets this
logical drive to the system state. When migration is complete, this logical
drive is removed.

* The logical drive that you have selected to migrate must be in the okay
state.

* For ServeRAID SCSI controllers, the logical drive cannot be configured
with RAID level-00, 10, 1EO, 50, or 5EE.

If a physical drive fails during a logical-drive migration and you are migrating
between RAID levels other than RAID level-0, the migration will continue and
complete. Then, you must replace and rebuild the failed physical drive.

Logical-drive migrations also can recover from a power failure. If power is lost to
the server during a logical-drive migration, the migration will restart as soon as
power is restored, and complete without data corruption.

Note: (Cluster and failover configurations only) A logical drive will not failover
while undergoing logical-drive migration.

More information

* |Things to consider when changing the RAID levell
 |[Example: Increasing free space|

e |[Example: Increasing logical drive size)

* [Understanding scheduled task:

¢ |Using the Task Manager|

Example: Increasing free space: Create an array with three physical drives. Then,
create two logical drives (labeled 1 and 2) in the array such that you have no
available free space. The logical drive stripes look similar to the following.
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Later, you decide to create another logical drive in the array. First, you must create
some free space by adding more physical drives to the array.
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If you add two more physical drives to the array, the logical drives migrate such
that they are striped across all five drives. The ServeRAID Manager retains the size
of the logical drive by decreasing the size of each block on a physical drive. The
space in the logical drives does not increase, so there is free space across the
bottom portion of each physical drive (labeled 3).
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When the operation is complete, use '|Create logical drive[' to create a new logical
drive in the free space.

e RS g G e R e P e |

When increasing free space, you can add up to three physical drives, as long as the
sum of the physical drives does not exceed the maximum number of physical

drives allowed for the array. The maximum number of physical drives you can
have in an array is limited by the controller

Example: Increasing the logical drive size:

Create an array with three physical drives. Then, create two logical drives (labeled

1 and 2) in the array such that you have no available free space. The logical drive
stripes look similar to the following.

e [ et [ cou—
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Later, you decide you need additional space in the logical drives in the array. First,
you must add more physical drives to the array.

Note: Blocks are labeled as x and * in these examples. All blocks labeled x are the
same size in logical drive 1. All blocks labeled * are the same size in logical

drive 2.
— — —— e —
1 X X X
f
z * * *
— . e T e

If you add two additional physical drives to the array, the logical drives migrate
such that they are striped across all five drives. The ServeRAID Manager expands
the size of each logical drive in proportion to the original configuration. If there
originally was free space in the array, the free space is increased also.

——, ——, ——, ——,
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When increasing logical drive space, you can add up to three physical drives, as
long as the sum of the physical drives does not exceed the maximum physical

drives allowed for the array. The maximum number of physical drives you can
have in an array is limited by the controller

SR-8i SR-7

For the ServeRAID-8i controller and ServeRAID-7t controller, the
ServeRAID Manager does not enforce the three physical drive limit when
increasing logical drive size.

More information

* |[Understanding stripe-unit size]

* |[Understanding creating basic arrays|

* |Creating logical drives (action)|

* |Increasing logical drive size (action)|

* |Increasing logical drive size (SAS, SATA) (action)|

Understanding scheduled tasks: The ServeRAID Manager Task Scheduler allows
you to run lengthy operations at a convenient time, such as a
fmigration| or [synchronizing a logical drive|] All schedulable tasks work the same
way: To schedule a migration, for example, you perform the standard set of steps;
then, in the last step, you can choose to run the task immediately or to schedule it
for another time.
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You can run the task at the given date and time or make it a recurring task. If the
task is recurring, it runs on a regular basis according to the interval you choose:
the same time each day, the same time each week, or the same time each month.
Not all tasks can be recurring tasks. For example, a logical drive migration cannot
be a recurring task.

The is a tool that you can use to manage scheduled tasks. It allows

you to:
» [Modify a task’s schedule]
* [Delete a scheduled task]

View task properties|

Start time validation

When you schedule a task, it executes on the agent machine which may be a
remote machine in a different time zone. To prevent scheduling problems due to
time differences between the agent and client machines, the Task Scheduler
performs the following checks:

¢ To accommodate differences in times zones, you can schedule a task up to 23
hours in the past, pending approval by the agent.

* If the agent determines that the task is scheduled in the past (based on the local
time on the agent machine), it will reject the task and you will be prompted to
select a different date and time.

Missed start times

If a non-recurring task misses its start time, the Task Manager flags it with an
error. You must modify the task schedule]if you want to run it at another time.

If a recurring task misses its start time, it is rescheduled to run at the next
scheduled interval. Example: a recurring task runs every Monday at 1:00 AM. The
agent machine is powered off at that time. When you restart the agent machine,
the missed task is rescheduled to run the following Monday at 1:00 AM.

Note: To accommodate temporary or brief interruptions on the agent machine,
each task has a 30-minute grace period built into its start time. Example: a
task is scheduled to run at 10:00 PM. A power outage lasts 20 minutes, from
9:55 PM to 10:15 PM. The task runs at 10:15 PM.

Error conditions

When a scheduled task does not run successfully, the Task Manager displays an
error icon and updates the "Status” column with an Error. If a task misses its start
time, it is flagged with a warning error condition. You must the task to
clear the error. If the error is non-recoverable it is considered critical. You must
from the Task Manager; to reschedule it, you must create a new
task. To see details about the error, use [View task properties; examine the Error
Description field for a description of what went wrong and what caused the task
to fail.

More information
* |Synchronize logical drives (action)|

+ [Understanding logical drive migration]|

+ |Using the Task Manager]
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* |Starting the Task Manager|

* |Deleting a scheduled task|

* [Modifying a scheduled task|
* |Viewing task properties|

+ |Using the ServeRAID Manager agent|

Extending a partition on a logical drive: (Microsoft Windows 2000, Windows XP,
Windows Server 2003, and Windows NT 4.0 only)

If you have [increased the size of a logical drive] you can extend the partition on
that logical drive to use the newly added space.

Notes:

* To complete this procedure, you must be logged on as one of the
following:

— An administrator
— A member of the Administrators group

 If your server is connected to a network, network policy settings might
prevent you from completing this procedure.

Windows 2000, Windows XP, Windows Server 2003

1. After completing "Increase logical drive space,” shut down and restart the
server.

2. In the lower-left corner of the desktop, click Start » Programs » Administrative
Tools » Computer Management. The Computer Management window opens.

3. Right-mouse click the volume and click Extend Volume.
4. Follow the Extend Volume wizard instructions.

Notes:
* You cannot extend the following types of volumes:
— Striped
— Mirrored
— RAID level-5
— FAT or FAT32 format
- System
— Startup (boot)

— Simple or extended volumes that were upgraded from basic to
dynamic.
* You can extend a volume only if the volume is formatted using NTFS or
does not contain a file system.

* You can extend a simple or extended volume only if the volume was
created as a dynamic volume.

* You can extend a simple volume if the extension will occur within its
original physical drive or onto additional physical drives.

* After a volume is extended onto multiple drives (spanned), it cannot be
mirrored or striped.

* You can extend simple and spanned volumes on dynamic disks onto a
maximum of 32 dynamic disks.

* After a spanned volume is extended, you cannot delete any portion of
the volume without deleting the entire spanned volume.
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Windows NT 4.0

1. After completing "Increase logical drive space,” shut down and restart the
server.

2. In the lower-left corner of the desktop, click Start > Programs > Administrative
Tools (Common) » Disk Administrator. The Disk Administrator window
opens.

3. Hold the Ctrl key down and right-click both the old volume and the new free
space on the logical drive; then, click Extend Volume Set.

4. Type the total size you want for the partition.
5. Click OK.

6. Right-mouse click the volume and click Commit Changes Now. A confirmation
window opens.

7. Click Yes. Another confirmation window opens.
8. Click Yes.

Notes:

* You can extend a volume only if it is formatted using NTFS. You must
convert FAT volume sets to NTFS before you can extend them.

* You can extend volume sets onto a maximum of 32 physical drives.

* You cannot extend the volume where the Windows NT 4.0 system files
reside.

* After a volume is extended, you cannot delete any portion of the volume
without deleting the entire volume.

More information

* [Increasing logical drive size (action)|

+ |Increasing logical drive size (SAS, SATA) (action)|

Configuration wizard notes and attentions: While you are creating the
configuration, the ServeRAID Manager reports notes and attentions regarding the
configuration in the event viewer. These events can help you create a better or
more optimized configuration.

Array storage space still available.

Explanation: You can create another logical drive in this array or make a logical
drive in this array larger.

Physical drives contain unusable capacity.

Explanation: You could redefine your arrays with the same size to

avoid wasting space.

There is(are) n ready drive(s) still available. (Where nis a
number)

Explanation: You can create another array, add the remaining ready drives to one
of the new arrays, or create a hot-spare drive.

This hot-spare drive will not work for any defined array.

Explanation: This hot-spare drive is not large enough to replace a failed drive in
any array, or there are no redundant logical drives.
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Modifying logical drives on ServeRAID SCSI controllers
(ServeRAID series 3, 4, 5, 6, and 7K)

Changing the RAID level:
Note: This action is not supported on the integrated RAID controller.

You can change the RAID levels of currently defined logical drives. To use
"Change RAID level,” all of the logical drives within the array must be the same
RAID level.

Note:
1. If the logical drive is RAID level-00, 10, 1EQ, 50, or 5EE, you cannot
change the logical drive to another RAID level. If the logical drive is
RAID level-0, 1, 1E, 5, or 5E, you cannot change the logical drive to
RAID level-00, 10, 1EO, or 50.
2. You can schedule the logical-drive migration for a later date and time
when you [review the configuration changes|

3. You cannot change the RAID level while the logical drive is being
4. (Cluster and failover configurations only) A logical drive will not failover
while undergoing logical-drive migration.

1. In the [Physical devices view] click (array).

2. Right-click Logical-drive migration and then the appropriate Change RAID
level.

Note: If the array already contains the maximum number of physical drives
(based on the , the following actions are not available:
* Change RAID level from RAID 0 to RAID 5
* Change RAID level from RAID 1 to RAID 5

3. If you click one of the following:
* Change RAID level from RAID 0 to RAID 5
* Change RAID level from RAID 1 to RAID 5

The Configuration wizard opens with the ” ’ window. Add the
physical drives to the array; then, review and apply your new configuration.
If you click Change RAID level from RAID 5 to RAID 0, the Configuration
wizard automatically removes the physical drives and opens the ”

[Configuration summary| window. Review and apply the new configuration.

If you click Change RAID level from RAID 5E to RAID 5, the Configuration
wizard does not add or remove a physical drive. Instead, the wizard changes
the spare space to become free space. Use this free space to |create a new logical|
rvd

More information
» |[Things to consider when changing RAID levels|
* |[Understanding scheduled taskg

Increasing free space:
Note: This action is not supported on the integrated RAID controller.

Using this action you can add one, two, or three physical drives to an existing
array so that you can create another logical drive in the array.
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When you create an array, logical drives are striped across all physical drives in
that array. To create more free space in an existing array, define additional physical
drives to add to the array. Then, the ServeRAID Manager migrates the logical
drives such that the data is spread across the existing and new physical drives.

Note:

1. To increase free space in an array, you need at least one ready drive that
is at least as big as the largest drive in the array.

2. You can schedule the logical-drive migration for a later date and time
when you [review the configuration changes|

3. (Cluster and failover configurations only) A logical drive will not failover
while undergoing logical-drive migration.

1. In the[Logical devices view| click (array).

2. Right-click Logical-drive migration ~» Increase free space. The Configuration
wizard opens with the "Create arrays” window.

3. |Add the physical drives to the array| When complete, click Next. The
"Configuration summary” window opens.

4. |Review and apply your new configuration.|

5. After the logical-drive migration is complete, fcreate a new logical drive|in the
new free space.

More information

+ |[Example: Increasing free space|

+ [Understanding logical-drive migration|
+ |[Understanding scheduled tasks|

Increasing logical-drive size:
Note: This action is not supported on the integrated RAID controller.

Using this action you can add one, two, or three physical drives to an existing
array so you can expand the size of the logical drives in the array. When increasing
logical drive space, the ServeRAID Manager migrates the logical drives such that
the logical drives gain additional space, much like adding paper to a notebook.

When you create an array, logical drives are striped across all of the physical
drives in that array. To increase the size of the logical drives in an existing array,
define additional physical drives to add to the array. Then, the ServeRAID
Manager migrates the logical drives such that the|data is spread across|the existing
and new physical drives.

Note:

1. To increase the logical drive size, you need at least one ready drive that
is at least as big as the largest drive in the array.

2. You can schedule the logical-drive migration for a later date and time
when you[review the configuration changes|

3. (Cluster and failover configurations only) A logical drive will not failover
while undergoing logical-drive migration.

1. In the[Logical devices view| click (array).

2. Right-click Logical-drive migration » Increase logical-drive size. The
Configuration wizard opens with the "Create arrays” window.
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Note: This option is not available if the logical drive exceeds 2 terabytes using
any available physical drive.

3. [Add the physical drives to the array| When complete, click Next. The
"Configuration summary” window opens.

4. [Review and apply your new configuration.|

5. After the logical-drive migration is complete, create additional partitions to use
the newly added logical-drive space. If the server is a Microsoft Windows
system, you can fextend the size of a pre-existing partition| with the newly
acquired logical-drive space.

More information

+ [Example: Increasing logical drive size|

* [Extending a partition on a logical drivel
* |[Understanding scheduled taskg

Adding physical drives in an existing configuration: You can add physical
drives (also called logical-drive migration or LDM) to dynamically modify an
existing array and its logical drives.

Note: You cannot add more than three physical drives. The maximum number of

physical drives you can have in an array is still limited by the controller

1. Click the appropriate Array tab in the right pane:

‘ New array C \| Spares W

Then, from the list of ready drives, select the

Systermn merlyn, Controller 2
drives you want to move to the array:

{3 Ready Ch1,1D 3 (1000 MB)
&3 Ready Ch1,1004 (1000 MB)
¢ Ready Ch1,1D5 (1000 MB)
&3 Ready Ch1,1006 (1000 MB)
&3 Ready Ch1,1D8 (1000 MB)

2. Click

>> (Add selected drives) to add the drives to the array. You can click

>> (Add all drives) to move all ready drives to an array.

Notes:

a. The list includes only physical drives that are at least the size of the
smallest physical drive in the selected array. When adding to an
existing array, you cannot add physical drives that are smaller than
the smallest drive currently in the array.

b. When adding to an existing array, if you add physical drives that
are larger than the physical drives currently in the array, you will
not be able to use all the space on the new drives.

€. You cannot add a physical drive to the array if the resulting logical
drive size will exceed 2 terabytes.
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d. Existing physical drives in the selected array are labeled Online.
Newly added physical drives are labeled New online. You cannot
remove online drives from an existing array.

3. After you add the physical drives to your arrays, click Next. The "

[Configuration summary| window opens.

To leave the Configuration wizard, click Cancel.

More information

Understanding logical-drive migration|

Things to consider when changing RAID levelg
Understanding scheduled tasks
Changing the RAID level of each logical drive in an array (action)

Increasing the array free space so you can create another logical drive in the]

array (action)|

[[ncreasing the logical drive space of each logical drive in the array (action)

[Example: Increasing free space

[Example: Increasing logical drive size]

Confirming your logical-drive migration configuration: Use the configuration

summary to review all the changes that the ServeRAID Manager will apply to
your modified logical drive configuration. You can start the migration immediately
or schedule it for another time.

1.

Review the information that is displayed in the "Configuration summary”
window. It describes how the new configuration will affect the logical drives
and free space. To change the configuration, click Back.

To start migration now, click Apply. Click Yes when asked if you want to apply
the new configuration.

Note: Logical-drive migration is a lengthy process. You cannot perform any
other actions on the affected controller until the migration is complete.
The ServeRAID Manager displays a progress indicator in the
while the operation is in progress. When the migration is complete, the

configuration is saved in the ServeRAID controller and in the physical
drives.

To schedule the migration for a later date and time, click Schedule. The
ServeRAID Manager displays the Scheduler pane:

* From the calendar display, select the day, month, year, and time you want
the task performed.

* Click Apply.

¢ Click Yes when asked if you want to schedule the migration.

More information

Configuration wizard notes and attentions

Understanding logical-drive migration|

Understanding scheduled tasks]

Using the Task Manager|
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Modifying logical drives on ServeRAID SAS and SATA controllers
(ServeRAID-7t, ServeRAID-8i)

Changing the RAID level: You can change the RAID levels of currently
defined logical drives.

1. In the[Logical devices view, click i (logical drive).

2. Right-click Expand or change logical drive. The Configuration wizard opens
with the "Choose RAID level” window.

3. [Choose a new RAID levell for the logical drive; then, click Next. The "Create
logical drives” window opens.

Note: Only valid RAID level migrations appear in the list. Migration
requirements for each RAID level are described .

4. [Add the physical drives|needed to support the new RAID level (if any). Click
Advanced settings to set the logical drive size; optionally, select a new

Then, click Next. The "Configuration summary” window opens.

Note: When you add drives, the migration wizard shows the current layout of
the data, including the current logical drive size. For most migrations,
you will need to increase the logical drive size setting; the default size is
not generally adequate once you add drives or segments.

5. [Review and apply the new configuration}

More information

* [Things to consider when changing RAID levels|

+ |Increasing logical-drive size (SAS, SATA) (action)|
+ |[Understanding scheduled tasks

Increasing logical-drive size: Use this action to add space to an existing logical
drive so you can increase its size.

When you create a logical drive, it is striped across all of the physical drives used
by the logical drive. To increase the size of an existing logical drive, you add
segments to the logical drive, which can be on the same or different disks. Then,

the ServeRAID Manager migrates the logical drive such that the

the existing and new physical drives.

Note:

1. The capacity of the modified logical drive must match or exceed its
current capacity.

2. The maximum size of a logical drive is 2 terabytes.

1. In the[Logical devices view] click i (logical drive).

2. Right-click Expand or change logical drive. The Configuration wizard opens
with the "Choose RAID level” window. Click Next. The "Create logical drives”
window opens.

3. [Add segments to the logical drivel Optionally, click Advanced to select a new

stripe-unit size| for the logical drive.

Note: To remove or replace a physical drive, click the drive you want to
remove (indicated by 3 ); then, click the drive you want to replace it

with. To cancel your changes and start over, click | Revert logical drive |
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When you are ready to continue, click Next. The "Configuration summary”
window opens.

4. [Review and apply your new configuration or schedule the migration forf

another time.|

5. After the logical-drive migration is complete, create additional partitions to use
the expanded logical-drive space. If the server is a Microsoft Windows system,
you can lextend the size of a pre-existing partition| with the newly acquired
logical-drive space.

More information

« |Example: Increasing logical drive sizel

+ [Extending a partition on a logical drivel

+ [Changing the RAID level (SAS, SATA) (action)
+ [Understanding scheduled tasks

Confirming your logical-drive migration configuration: Use the configuration
summary to review all the changes that the ServeRAID Manager will apply to
your modified logical drive configuration. You can start the migration immediately
or schedule it for another time.

1.

Review the information that is displayed in the "Configuration summary”
window. It describes how the new configuration will affect the logical drives
and free space. To change the configuration, click Back.

2. To start the migration now, click Apply. Click Yes when asked if you want to
apply the new configuration.

Note: Logical-drive migration is a lengthy process. The ServeRAID Manager
displays

(in animation) in the Logical devices view while the operation is in
progress. When the migration is complete, the configuration is saved in
the ServeRAID controller and in the physical drives.

3. To schedule the migration for a later date and time, click Schedule. The
ServeRAID Manager displays the Scheduler pane:

* From the calendar display, select the day, month, year, and time you want
the task performed.

* Click Apply.
¢ Click Yes when asked if you want to schedule the migration.

More information

Configuration wizard notes and attentions|

» |[Understanding logical-drive migration|
+ [Understanding scheduled tasks|

Using the Task Manager]|

Modifying logical drives on ServeRAID enclosures

Changing the RAID level: You can change the RAID level of currently defined
logical drives in an array.

1. In the[Logical devices view] click (array).
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Right-click Expand or migrate array. The Configuration wizard opens with the
"Choose RAID level” window.

3. [Choose a new RAID level| for the array; then, click Next. The "Modify array”
window opens.

Note: Only valid RAID level migrations appear in the list. Migration
requirements for each RAID level are described .

. |Add the physical drives|needed to support the new RAID level (if any).
Optionally, click Advanced settings to set the drive capacity display units (MB,
GB, TB). Then, click Next. The "Configuration summary” window opens.

N

5. [Review and apply the new configuration|

More information
* [Things to consider when changing RAID levelsl
* |[Increasing logical-drive capacity (enclosure)

Increasing logical drive capacity: Use this action to increase the size of logical
drives in an enclosure. To increase the size of one or more drives in an enclosure,
use the [Configuration wizard| To increase the size of a specific logical drive, use
the |[Increase logical drive capacity| action on the logical drive object.

Increasing logical drive size with the Configuration wizard

1. In the Enterprise view, click & (enclosure).

2. Right-click Configure storage. The Configuration wizard opens with the "
[Configuration path|" window.

3. Click Advanced options; then, select Increase logical drive capacity.

< Advanced options
® Increase logical drive capacity
@ Change authentication settings

@ Change access control

4. Click Next. The "Increase logical drive capacity” window opens.

Array-1 | Array-2 |
5. Click the appropriate array tab. I il 4

6. For each logical drive in the array, type amount space you want to add to the

Additional (ME)
| 5000

logical drive in the Additional (MB) field. | L
7. Repeat steps 5 and 6 to increase logical drive capacity for other arrays.
8. When you are ready to continue, click Next.

9. [Review the configuration summary and apply the changes|

Increasing the size of a single logical drive

1. In the[Logical devices view] click i (logical drive).

2. Right-click Increase logical drive capacity. The Configuration wizard opens
with the "Increase logical drive capacity” window.
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3. Type amount space you want to add to the logical drive in the Additional
(MB) field.

4. When you are ready to continue, click Next.

5. [Review the configuration summary and apply the changes|

More information
« |Changing authentication settings|
* [Changing access control settings|

Adding drives to an existing array: Use this action to add physical drives to an
existing array without changing the RAID level.

When you create an array, it is striped across all the physical drives used by the
array. To increase the size of an existing array, you add segments to the array,
which can be on the same or different disks. Then, the ServeRAID Manager
migrates the array such that the [data is spread across| the existing and new
physical drives.

Note:
1. The capacity of the modified array must match or exceed its current
capacity.
2. The maximum size of an array is 2 terabytes.
3. This action is not supported for all RAID levels.

1. In the|Logical devices view] click (array).

2. Right-click Expand or migrate array. The Configuration wizard opens with the
"Choose RAID level” window.

3. Click Next. (Do not change the RAID level!) The "Modify array” window
opens.

4. |Add segments to the array| Optionally, click Advanced settings to set the drive
capacity display units (MB, GB, TB).

5. When you are ready to continue, click Next. The "Configuration summary”
window opens.

6. [Review and apply your new configuration|

More information

« [Extending a partition on a logical drive|

Changing the authentication settings:
Note: The ServeRAID Manager supports authentication for iSCSI initiators only.

Use this action to modify the authentication method, user list, and advanced
settings for each logical drive in the enclosure.

1. In the[Logical devices view] click i (logical drive).

2. Right-click Configure target information. The Configuration wizard opens with
the "Define authentication method” window.

3. [Update the authentication settings for each logical drive)|

4. If you enabled authentication (by choosing CHAP or SRP), click Add User ;
then, add or remove users in the user list|

5. When you are ready to continue, click Next.
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6. [Review the configuration summary and apply the changes|

More information
* |Adding users to the user list]
* |Changing access control settings|

Defining the authentication method:
Note: The ServeRAID Manager supports authentication for iSCSI initiators only.

Use the Authentication information window to define the authentication method (if
any) for each user permitted to use the logical drives in the array. Optionally, you
can enable Radius authentication (an external authentication service) and define
the SLP (Service Location Protocol) Scope name.
1. Select a logical drive from the list on the left.
2. From the Authentication type list, select the method used to authenticate users
of this logical drive. You can choose:
¢ None - Do not authenticate users
* CHAP - Challenge Handshake Authentication Protocol
* SRP - Secure Remote Password

3. If you enabled authentication (by choosing CHAP or SRP), click AddUser | . the
"Global user name and password management” window opens. Then,
[users to the user list}

4. To enable Radius authentication for the CHAP authentication method, click
Radius authentication; then, enter the following;:

* In the Primary server field, enter the host name or TCP/IP address of the
authentication service; then, in the Port field, enter the server’s startup port.

¢ In the Secondary server field, enter the host name or TCP/IP address of the
authentication service; then, in the Port field, enter the server’s startup port.

Note: Radius authentication is supported by the CHAP authentication method
only.

5. To modify the default SLP Scope name, click Advanced settings; then, in the
SLP Scope Name field, type a unique scope name or choose an existing name
from the drop-down list.

6. Repeat steps 1 through 5 to enable authentication for additional logical drives.

To replicate the settings for all logical drives, click .

7. When you are ready to continue, click Next. The "|Define initiators| window
opens.

To return to the " |Create logical drives window, click Back. To leave the
Configuration wizard, click Cancel.

More information
Adding users to the user list|

Changing the rebuild rate:

Note:
1. This action is supported in bootable-CD mode only.
2. This action is not supported on the integrated RAID controller.
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Use this action to change the rebuild rate. The rebuild rate determines the rate that
the data from a failed physical drive is rebuilt to a new or hot-spare drive.
1. In the Enterprise view, click ¥ (controller).

2. Right-click Change rebuild rate and then click a rebuild rate. The following
choices are available:

¢ High
e Medium
e Low

When the rebuild rate is High, the rebuild I/O request gets high priority in the
controller execution order.

If you change the rebuild rate from High to Medium in a heavily loaded system,
the rebuild time can increase but provide better system performance.

If you change the rebuild rate from High or Medium to Low in a moderate to
heavily loaded system, the rebuild time can increase, but provide better system
performance.

Changing access control settings: Use this action to add, modify, and delete
initiators that are permitted to access an enclosure. You can also change the logical
drive assignments for an initiator.

1. In the|[Logical devices view] click i (logical drive).

2. Right-click Configure access control list. The Configuration wizard opens with
the "Define initiators” window.

3. |Add| |delete} or [modify| an initiator. When you are ready to continue, click Next.
4. |Update logical drive assignments] then, click Next.
5. [Review the Configuration summary and apply the changes.|

Adding an initiator

To add an initiator:

1. Click . Depending on the initiator type, the "Add iSCSI initiator” window
opens or the "Add Port Name” window opens.

2. [Define the initiator alias, IQN or port name, and optional advanced settings

Deleting an initiator

To delete an initiator:

1. Select an initiator from the list: simply point to the initiator and click left.
2. Click :
Modifying an initiator

To modify an initiator:
1. Select an initiator from the list.

2. Click . The "Modify initiator” window opens.
3. Type a new initiator alias.

Note: You cannot change the initiator IQN or port name. The ServeRAID
Manager updates the IQN and port name from the initiator alias.
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4. (iSCSI initiators only) Optionally, change the [advanced settings
5. Click OK.

More information
+ [Modifying the authentication method|

Defining the user list: You can define a user list for each logical drive. You must
add at least one user to the list if you|enabled authentication| for the logical drive.

1. In the User name field, enter a user name.

In the Password field, enter the user’s password.

In the Confirm password field, enter the password again.
Click Add.

Repeat steps 1-4 to add additional users.

A

Note: To remove a user from the list, select the user; then, click Delete.

6. When you are finished adding and deleting users, click Cancel.

Tuning your system for optimal performance

Fine-tuning your system

When fine-tuning your controller settings for optimal performance, consider the
applications that you intend to run on your server. Controller settings are usually
sensitive to the types of applications running on the server, not the server
workload or the number of users using the server. You must investigate your
application’s design, especially its input/output behavior, to make your decision.

When configuring your controller, your server application environment can
influence the following:

+ The|RAID level you select] for your server

* The controller[stripe-unit size setting

* The|write-back cache mode setting]

More information

* [Selecting a RAID level|

* |Application environment groups reference

+ |Understanding write-cache mode for logical drives|

* |Changing the write-cache mode on a logical drive (action)|

+ |Understanding write-cache mode for physical drives|

+ |Changing the write-cache mode on a physical drive (action)|
 [Understanding stripe-unit size

« [Changing the stripe-unit size (action)|

« |[Understanding adaptive read-ahead cache mode|

* [Understanding enabled and disabled read-ahead cache mode

* |[Enabling and disabling read-ahead cache mode (action

Fine-tuning the stripe-unit size: A new controller stripe-unit size is set at the
factory to 8 KB. If you need to change this setting, you must change the stripe-unit
size before you store data in the logical drives. After you store data in the logical

drives, you cannot change the stripe-unit size without destroying data in the
logical drives.

i I i I i I The ServeRAID-8i, ServeRAID-7t, and HostRAID controllers
do not support 8 KB stripe-unit size.
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Note: You must use the ServeRAID Manager in bootable-CD mode to change the
stripe-unit size setting.

Environment |stri2e-unit siz§
(such as Lotus Notes or 16 KB
Exchange)

[Transaction processing database 16 KB
[Decision support database] 16 KB

[Thin client environments| 8 KB
(Microsoft Windows NT, 16 KB

Windows 2000, Windows Server 2003,
Novell NetWare)

(Other) 8 KB
8 KB

Other 8 KB

More information
+ |Changing the stripe-unit size (action)|
+ |Fine-tuning your system|

Fine-tuning the write-cache mode: (Novell NetWare only)

If you are preparing to install Novell NetWare 5.x from the startable Novell NetWare
5.x CD, you must set the write-cache mode for all logical drives to write through.
Complete the following steps to accomplish this:

1. In the|Logical devices view] right-click i (logical drive).
2. Click Change write-cache mode to write-through.

3. Repeat steps 1 and 2 for each logical drive.

Selecting a RAID level and tuning performance

Disk arrays are used to improve performance and reliability. The amount of
improvement depends on the application programs that you run on the server and
the RAID levels that you assign to the logical drive.

Each RAID level provides different levels of fault-tolerance (data redundancy),
utilization of physical drive capacity, and read and write performance. In addition,
the RAID levels differ in regard to the minimum and maximum number of
physical drives that are supported.

When selecting a RAID level for your system, consider the following factors.

Note: Not all RAID levels are supported by all ServeRAID controllers.

Physical
drive Min. Max.
Data redun- |capacity Read perfor- | Write perfor- | Built-in number of |number of

RAID level |dancy utili- zation |mance mance spare drive |drives drives
[RAID level-0f | No 100% Superior Superior No 1 16
[RAID level-1] | Yes 50% Very high | Very high  [No 2 2
RAID| Yes 50% Very high Very high No 3 16
level-1F
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Physical
drive Min. Max.
Data redun- |capacity Read perfor- | Write perfor- | Built-in number of |number of

RAID level |dancy utili- zation |mance mance spare drive |drives drives
RAID level-5 | Yes 67% to 94% | Superior High No 3 16
RAI Yes 50% to 88% | Superior High Yes 4 16
level-5
RAI Yes 50% to 88% | Superior High Yes 4 16
level-5EE
RAID level-6| | Yes 50% to 88% | Very High High No 4 16
RAI No 100% Superior Superior No 2 60
level-0
RAI Yes 50% Very high Very high No 4 16
level-1
RAIL Yes 50% Very high Very high No 6 60
level-1EQ)
RAI Yes 67% to 94% | Superior High No 6 60 (SCSI) 128
level-5 (SAS, SATA)
RAI Yes 50% to 88% | Very High High No 8 128
level-6
Spanne No 100% Superior Superior No 2 48
Volume)
RAI No 50% to 100% | Superior Superior No 4 48
Volume

Physical drive utilization, read performance, and write performance depend on the
number of drives in the array. Generally, the more drives in the array, the better
the performance.

More information

¢ |[Understanding RAID technology]|

* [Selecting the logical drive size]

* [Selecting the RAID level by array capacity|

* |Creating logical drives (action)|

* |Configuring RAID and creating arrays (action)

* |Creating logical drives in the wizard|

* |Things to consider when changing the RAID levell

Things to consider when changing the RAID level:

ServeRAID SCSI controllers

If you have a... And you want... Then...

RAID level-0| array with two [|RAID level-5 Add one and only one drive

or more drives

RAID level-1] array with two | RAID level-5 Add one and only one drive

and only two drives

RAID level-5 array RAID level-0 The ServeRAID Manager
removes the last drive in the
array
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If you have a...

And you want...

Then...

[RAID level-5 Enhanced) array

RAID level-5

The ServeRAID Manager
does not add or remove a
drive

=1

SR-7
I:I ServeRAID SATA and SAS controllers

If you have a...

And you want...

Then...

RAID level-( logical drive

with two or more drives

RAID level-5

Add at least one drive

RAID level-5 logical drive

RAID level-0

Optionally, remove one drive

RAID level-0 logical drive

RAID level-10

Double (at least) the drive
count

RAID level-6 logical drive RAID level-5 Optionally, remove one or
two drives
RAID level-5 logical drive RAID level-5EH Add at least one drive

RAID level-5EE logical drive

RAID level-5

Optionally, remove one drive

RAID level-5 logical drive

RAID level-10

Make sure you have
(source-1)*2 drives total

RAID level-1] logical drive

RAID level-5

Add at least one drive

RAID level-1 logical drive

RAID level-10

Add at least two drives

clozure

8 | ServeRAID Enclosures (networked storage)

If you have a...

And you want...

Then...

RAID level-(f logical drive

with two or more drives

RAID level-5

Add at least one drive

RAID level-1] logical drive

RAID level-5

Add at least one drive

RAID level-1 logical drive

RAID level-10

Add at least two drives in
multiples of two

More information

+ [Changing the RAID level (action)|

* |Changing the RAID level (SAS, SATA, HostRAID) (action)|

e |Changing the RAID level (enclosures) (action)|

« |[Understanding logical-drive migration|

Application environment groups reference

Environment Applications

Groupware Lotus Notes
Microsoft Exchange
Other
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Environment Applications

Transaction processing DB2
Informix
Oracle
SQLServer
Sybase
Other

Decision support or data warehousing DB2 Informix Oracle SQLServer Sybase
Other

Thin client environments Citrix WinFrame or MetaFrame
Microsoft Terminal Server
Other

File server Novell NetWare

Microsoft Windows 2000

Microsoft Server 2003

Other network operating systems (for
example, OpenServer, Linux)

Web server Apache

Microsoft IIS

Netscape Commerce Server
Other

Understanding write-cache mode for physical drives
When using the write-cache-mode option, you can choose from two available
settings.

Write back

For the write back setting, the controller sends data to the physical drive for
storage. Subsequently, the physical drive sends a confirmation to the controller
before actually storing the data. Doing so increases performance, but also contains
an element of risk.

Attention:

1. It is possible to lose data if a power outage occurs while using the write back
setting. Consider carefully whether to enable write back on a physical drive.
Depending on how you use the system, write back might be undesirable.

2. If you set this feature to write back, wait at least 10 seconds after your last
operation before you turn off your system. Failure to follow this practice might
result in lost data.

Write through

For the write-through setting, the controller sends data to the physical drive for
storage. Subsequently, the physical drive stores the data; then, sends a confirmation
to the controller. Using write through can decrease performance, but has no risk of
losing data.

More information
* |Changing the write-cache mode on a physical drive (action)|

. ‘Fine-tuning your system|
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Understanding write-cache mode for logical drives
When using the write-cache-mode option, you can choose from two available
settings.

Write back

For the write-back setting, the operating system sends data to the controller to
write to a storage device. Subsequently, the controller sends a confirmation to the
operating system before actually writing the data to the storage device. Doing so
increases performance, but also contains an element of risk. For example, if there is
a power failure, the data currently in the controller cache is lost. This is no risk
when using a controller with a battery-backup cache. The battery preserves the
data in the controller cache in the event of a power failure.

Attention:

1. It is possible to lose data if a power outage occurs while using the write back
setting without a battery-backup cache device. If your controller does not have
a battery-backup cache installed and enabled, consider carefully whether to
enable write back on a logical drive. Depending on how you use the system,
write back might be undesirable.

2. If you do not have a battery-backup cache installed and enabled and you set
this feature to write back, wait at least 10 seconds after your last operation
before you turn off your system. Failure to follow this practice might result in
lost data.

Write through

For the write-through setting, the operating system sends data to the controller to
write to a storage device. Subsequently, the controller writes the data to the storage
device; then, sends a confirmation to the operating system. This setting can
decrease performance, but contains no risk of losing data.

More information

* |Changing the write-cache mode on a logical drive (action)|

« [Fine-tuning your system|

Understanding stripe-unit size
With RAID technology, data is striped across an array of physical drives. This
data-distribution scheme complements the way the operating system requests data.

The granularity at which data is stored on one drive of the array before subsequent
data is stored on the next drive of the array is called the stripe-unit size .

You can set the stripe-unit size to 8 KB, 16 KB, 32 KB, or 64 KB. You can maximize
the performance of your ServeRAID controller by setting the stripe-unit size to a
value that is close to the size of the system I/O requests. For example,
performance in transaction-based environments, which typically involve large
blocks of data, might be optimal when the stripe-unit size is set to 32 KB or 64 KB.
However, performance in file and print environments, which typically involve
multiple small blocks of data, might be optimal when the stripe-unit size is set to

8 KB or 16 KB.
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i I i I i I The ServeRAID-7t, ServeRAID-8i, and HostRAID controllers
do not support an 8 KB stripe-unit size. The ServeRAID-7t and ServeRAID-8i
controllers support these additional stripe-unit sizes: 128 KB, 256 KB, 512 KB, and
1024 KB.

The collection of stripe units, from the first drive of the array to the last drive of
the array, is called a stripe.

SR-5C31 HostRAID:

After you configure an array and store data on the logical drives,
you cannot change the stripe-unit size without destroying data in the logical
drives.

You can set the stripe-unit size to 8 KB, 16 KB, 32 KB, or 64 KB. The default setting
is 8 KB data bytes.

* When the stripe-unit size is 8 KB or 16 KB, the maximum number of physical
drives in an array is 16.

* If you have a ServeRAID-3H or ServeRAID-3HB controller using ServeRAID
firmware (version 4.0, or later) and the stripe-unit size is 32 KB or 64 KB, the
maximum number of physical drives in an array is 16. Otherwise, when the
stripe-unit size is 32 KB or 64 KB, the maximum number of physical drives in an
array is 8.

* If you have a ServeRAID-4 controller and the stripe-unit size is set to 32 KB or
64 KB, the maximum number of physical drives in an array is 16.

More information
+ |Changing the stripe-unit size (action)|
+ |Application environment groups reference]

Understanding enabled and disabled read-ahead cache mode for
logical drives

Note: You can enable and disable the read-ahead setting without destroying data
in a logical drive by using the ServeRAID Manager in bootable-CD mode.

Enabled read-ahead cache mode

The controller transfers data from the logical drive to its local cache in increments
equal to the stripe-unit size. This provides excellent overall performance when
workloads are steady and sequential. However, if the workload is random or the
system 1/O requests are smaller than the stripe-unit size, reading ahead to the end
of the stripe might degrade performance.

Disabled read-ahead cache mode

The controller transfers data from the logical drive to its local cache in increments
equal to the system I/O request size, without reading ahead to the end of the
stripe. This provides excellent overall performance when the workload is random
or the system I/0O requests are smaller than the stripe-unit size.

More information

Enabling and disabling read-ahead cache mode (action)

« |Changing the stripe-unit size (action)|

+ |Understanding stripe-unit size
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Understanding adaptive read-ahead cache mode

The ServeRAID controller continually reevaluates whether to transfer data from
disk to its local cache in increments equal to the stripe-unit size or in increments
equal to the system I/O request size.

The ServeRAID-4 controllers and the ServeRAID-3HB controller come with the
adaptive read-ahead mode as a standard feature. The ServeRAID-3H and
ServeRAID-3L controllers must use new ServeRAID firmware (version 3.50, or
later) to implement adaptive read-ahead cache mode. You can and
install the new firmware for the ServeRAID-3H and ServeRAID-3L controllers.

If you have the controller and firmware for adaptive read-ahead mode installed,
the ServeRAID Manager reports Adaptive on the controller properties pane.
Otherwise, the properties pane states either Enabled or Disabled.

Note: With this new firmware, the non-Adaptive read-ahead modes are no longer
available in the ServeRAID Manager. You can override Adaptive read-ahead,
but not through the ServeRAID Manager. Instead, use the IPSSEND
command-line program. This program comes with the device option and is
on the IBM ServeRAID Support CD. For more information, refer to the IBM
ServeRAID User’s Reference.

Read-ahead cache mode settings: Depending on your controller’s level of
firmware, there are three settings for read-ahead cache mode:

+ |[Enabled or Disabled|

:

You can change the read-ahead setting without destroying data in a logical drive
using the ServeRAID Manager in bootable-CD mode.

Changing the stripe-unit size

Note:
1. This action is supported in bootable-CD mode only.

2. This action is not supported on the ServeRAID-7t controller, the
ServeRAID-8i conroller, and the integrated RAID controller.

3. On ServeRAID-7t controller and ServeRAID-8i controller, use the
configuration wizard to change the stripe-unit size.

Use this action to set the size of the chunk of data that the controller reads from
each physical drive at a time. To maximize overall performance, choose a
stripe-unit size that is close to the size of the system 1/O request.

Attention: After you configure an array and store data on the logical drives, you
cannot change the stripe-unit size without destroying data in the logical drives.

1. In the Enterprise view, click ¥ (controller).

2. Right-click Change stripe-unit size and then click a stripe-unit size. The
following choices are available:

8 KB  With this stripe-unit size, an array can have a maximum of 16 physical
drives.

16 KB With this stripe-unit size, an array can have a maximum of 16 physical
drives.

32 KB This setting is available if the controller supports an array with 16
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physical drives using a 32 KB stripe-unit size, or the controller contains
no arrays with more than 8 physical drives. Otherwise, this setting is
unavailable.

64 KB This setting is available if the controller supports an array with 16
physical drives using a 64 KB stripe-unit size, or the controller contains
no arrays with more than 8 physical drives. Otherwise, this setting is
unavailable.

More information

e |Fine-tuning your svstem|

+ [Understanding stripe-unit sizd

» |Understanding enabled and disabled read-ahead cache mode]

Changing the write-cache mode on a logical drive

Note:

1. This action is supported in bootable-CD mode for ServeRAID SCSI
controllers.

2. This action is supported in interactive mode only for the ServeRAID-8i
controller and ServeRAID-7t controller.

3. This action is not supported on the integrated RAID controller.

Use this action to change the write-cache mode setting of a logical drive to write
through or write back. The write-cache mode determines if the controller writes
data to the drive before or after sending a confirmation to the operating system.

Note:

1. (RAID level-x0 only) All logical drives in a spanned array must be either
write back or write through. That is, the write-cache mode settings for
the logical drives in the spanned array cannot be a mixture of write back
and write through.

2. (Failover environment only) A fault-tolerant controller pairing must be
configured as write through. This is because the logical drives are
configured as "Shared.” For more information, refer to the
[ServeRAID User’s Reference| .

3. (Cluster environment only) If the logical drives are configured as
"Shared,” the controllers must be configured as write through. For more
information, refer to the [[BM ServeRAID User’s Reference|.

1. In the[Cogical devices view] click [l (logical drive).

2. Right-click Change write-cache mode to write back or write through.

3. If you click write back and you do not have a battery-backup cache, click Yes
to confirm your choice because there is a risk of losing data.

If you click write back and you do have a battery-backup cache, the
ServeRAID Manager changes the mode.

If you click write through, the ServeRAID Manager changes the mode.

More information

* [Understanding write-cache mode for logical drives|

Changing the write-cache mode

Note: This action is not supported on enclosures with a dual controller
configuration.
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Use this action to change the write-cache mode setting of all the physical drives in
an array. The write-cache mode determines if a physical drive stores data before or
after sending a confirmation to the controller.

Note: It is possible to lose data if a power outage occurs while using the
write-back setting. Consider carefully whether to use the write-back setting
on a physical drive. Depending on how you use the system, the write-back
setting might be undesirable.

1. In the[Logical devices view] click &8 (array).

2. Right-click Configure write cache »> write back or write through.
3. Click Yes to confirm.

More information

Understanding write-cache mode for physical drives

Enabling and disabling read-ahead cache mode
Use this action to set the read-ahead cache mode to Enabled or Disabled. If the
read-ahead cache mode is set to Adaptive, you cannot use this action.

Note: You can override the Adaptive setting, but not through the ServeRAID
Manager. Instead, use the IPSSEND command-line program. This program is
on the IBM ServeRAID Support CD.

1. In the [Logical devices view] click &8 (array).

2. Right-click Configure read cache > enabledor Configure read cache -»
disabled.

3. Click Yes to confirm.

More information
+ [Understanding read-ahead cache mode|
+ |[Understanding adaptive read-ahead cache mode|

Managing storage devices
Managing direct attached storage devices

Understanding FlashCopy backup: The FlashCopy function creates a quick
backup copy of data. It sets up a link between the source and target logical drives;
then, it creates a backup of the source data on the target drive. Any changes made
to the source drive after you create a FlashCopy backup are not reflected on the
target drive. You can use the backup copy of data for tape backup, drive cloning,
and multi-server rollout.

There are two primary FlashCopy functions: backup and nobackup. The FlashCopy
backup function copies the entire contents of the source drive to the target drive so
that entire logical drives can be moved from one server to another. The FlashCopy
nobackup function creates a temporary copy of a drive for tape drive backup and
reference purposes. The FlashCopy nobackup function is less I/O-intensive than
the FlashCopy backup function.

Before using FlashCopy, consider the following requirements:
* You can perform a FlashCopy backup operation on only one controller at a time.

* The source and target logical drives can have the same or different RAID level
(they do not have to match).
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* The source and target logical drives must be on the same controller.

* You can create a maximum of four independent FlashCopy backups per
controller.

* There is no limit on the size of the source and target logical drive. However, for
both FlashCopy backup and nobackup operations, the size of the target drive
must be greater than or equal to the source drive.

* You cannot perform any action on a FlashCopy source or target logical drive
(such as synchronizing the drive). You can only delete a FlashCopy backup.

More information
+ [Creating a FlashCopy backup]|
» [Removing a FlashCopy backup|

Understanding copy back mode:

Note: Copy back is supported on the ServeRAID-8i, ServeRAID-7k,
ServeRAID-6M, and ServeRAID-6i/6i+ controllers only. It is not supported
in cluster or failover pair configurations.

Copy back is a method of restoring a logical drive’s original configuration after
you replace a failed drive in an array. It allows you to restore the data to its prior
location, before the logical drive was rebuilt from its spare.

An example

A RAID Level-5 logical drive consists of three physical drives and a spare. When a
drive in the array fails, the spare drive is used to rebuild the logical drive. When
you replace the failed drive, copy back moves the data from the former spare to
the newly replaced drive. Then, the former spare resumes its original role as the
spare drive.

Copy back is enabled by default; it starts automatically when the ServeRAID

controller detects that a failed drive is replaced. The ServeRAID Manager displays
a progress indicator in the [status baq while the operation is in progress. To disable
copy back, choose [Disable copy back mode| from the [controller object| Action menu.

You cannot perform any other actions on the controller until copy back is
completed.

Note: Copy back is disabled by default when you upgrade the ServeRAID
software from a previous release.

More information

Enabling and disabling copy back mode (action)|

Enabling and disabling copy back mode:

Note: Copy back is supported on the ServeRAID-8i, ServeRAID-7k,
ServeRAID-6M, and ServeRAID-6i/6i+ controllers only. It is not supported
in cluster or failover pair configurations.

Use this action to change the copy back-mode setting. This setting determines if
the ServeRAID Manager restores a logical drive’s original configuration after you
replace a failed drive in an array.
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Copy back is enabled by default except when you upgrade the ServeRAID
software from a previous release; then, copy back mode is disabled by default.

1. In the Enterprise view, click ¥ (controller).

2. Right-click Enable or Disable copy back mode.

More information

Understanding copy back modé

Creating a FlashCopy backup: Use this action to create a FlashCopy backup
of data on a logical drive. You can create a FlashCopy with backup (full copy) or
without backup (temporary copy).

1. In the[Logical devices view] click i (Logical drive).

2. Right click Create FlashCopy » with backup to > the logical drive name or
Create FlashCopy » without backup to » the logical drive name.

More information
+ |Understanding FlashCopy backup|
+ |Removing a FlashCopy backup|

Removing a FlashCopy backup: Use this action to remove a FlashCopy
backup of a logical drive.

1. In the [Logical devices view| click & (FlashCopy).
2. Right click Remove FlashCopy.

More information
* [Understanding FlashCopy backup|
* |Creating a FlashCopy backup]

Managing networked storage devices (enclosures)

Shutting down an enclosure: Use this action to shut down the controllers in an
enclosure.

Attention: Use care when you shut down an enclosure. Users cannot access the
data on the arrays and logical drives until the enclosure is

Follow these steps to shut down an enclosure:

1. In the Enterprise view, click & (enclosure) that you want to shut down.
2. Right-click Shut down enclosure..
3. Click Yes when asked to confirm that you want to shut down the enclosure.

More information
e |Updating enclosure software|
* [Restarting an enclosure]

Restarting an enclosure: Use this action to restart the controllers in an enclosure.

1. In the Enterprise view, click & (enclosure) that you want to restart.
2. Right-click Restart enclosure.
3. Click Yes when asked to confirm that you want to restart the enclosure.

Attention:  Restarting the enclosure may take several minutes. Data on the
controller(s) are unavailable during that time.
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More information
« |Updating enclosure software|
¢ [Shutting down an enclosure]|

Changing controller date and time: Follow these steps to change the controller
date and time:
1. In the Enterprise view, click & (enclosure).

2. Right-click Change controller date and time. The " Change controller date and
time” window opens.

3. Select the new date, time, and time zone from the calendar and time controls.
4. Click OK. The ServeRAID Manager will apply the update to the controller.

More information
* [Updating enclosure softwarel
* [Shutting down a controller]

Configuring host information: Use this action to configure the network settings
for an external storage enclosure. You can set the host name, domain, primary and
secondary DNS servers, and the default gateway for network access.

1. In the Enterprise view, click & (enclosure).

2. Right-click Configure network details. The "Configure Host Information”
window opens

3. In the Host name field, type the enclosure’s host name.

4. In the Domain name field, type the enclosure’s network domain; for example,
mydomain.com.

5. In the Primary Domain Name Server field, type the TCP/IP address of the
enclosure’s primary DNS.

6. (optional) In the Secondary Domain Name Server field, type the TCP/IP
address of enclosure’s secondary DNS.

7. In the Default Gateway field, type the TCP/IP address of the default gateway
for network access.

8. Click OK.

More information
* |Configuring Ethernet ports|

Configuring Ethernet ports: Use this action to configure the Ethernet settings for
the controllers in an enclosure. For iSCSI initiators, you can configure three ports
per controller: the management port and two iSCSI ports. For fibre channel
initiators, you can configure the management port for each controller.

For the management port|(iSCSI or fibre channel), you can configure the port link
speed. For ports, you can configure network settings, such as Maximum
Transfer Unit (MTU), TCP/IP address, and subnet mask. If your network uses
dynamic IP addresses, you can enable DHCP.

Configuring the management port

To configure the management port:

1. In the [Physical devices view] click a controller in the enclosure.

Attention: Be sure to switch to first.
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2. Right click Configure Ethernet port » ETH 0 (management). The Configure
Ethernet port window opens.

3. From the Link speed drop-down list, select the port link speed, in megabytes.
To automatically detect the link speed (1 GB or less), select AUTO.

4. Click OK.
Configuring iSCSI ports (iSCSI initiators only)

To configure the iSCSI ports:

1. In the[Physical devices view] click a controller in the enclosure.
Attention: Be sure to switch to first.

2. Right-click Configure Ethernet port > ETH 2 (iscsi) or Configure Ethernet port
» ETH 3 (iscsi). The Configure Ethernet port window opens.

3. From the Link speed drop-down list, select the port link speed, in megabytes,
as described above.

4. From the Maximum transmission unit drop-down list, select the MTU packet
size, in megabytes; either 1500 MB or 9000 MB.

5. If your network uses dynamic IP addresses, click DHCP; then, skip to step 9.
6. In the IP address field, enter the iSCSI port’s TCP/IP address.

7. In the Subnet mask field, enter the TCP/IP number of the device’s TCP/IP
subnet.

8. (optional) In the Broadcast address field, enter the TCP/IP address for sending
messages to machines on the network.

9. Click OK.

More information

+ |Configuring host information|

Updating controller and enclosure software: The ROM Update wizard
guides you through the process of updating the software for your direct-attached
and network-attached storage devices:

* For direct-attached storage devices, the wizard updates the BIOS software for all
ServeRAID controllers of the same type on the local and remote systems. You
can update only one type of controller at a time.

* For external (network-attached) storage devices, the wizard updates the
enclosure and controller software for all controllers in the enclosure (single or
dual controller configurations).

Before you can use the ROM update wizard, you must download the latest
software images from your vendor’s software support site on the World Wide Web.
For direct-attachd storage devices, the image upgrade files typically come in sets of
two or more and have a .ufi file extension. For external storage enclosures, the
(single) image upgrade file has a .upgrade file extension.

To update the controller software for direct-attached or network-attached storage

devices:

1. In the Enterprise view, click @y (Direct attached storage object) or
(Networked storage object)

2. Right-click Update controller images. The ROM Update wizard opens.
3. Click Next.
4. |Choose the ROM image update files)
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5. Click Next; then, gelect the controllers or enclosures you want to update|

6. Click Next; then, review the jupdate summary]

7. Click Apply. The ServeRAID Manager applies the software update to the
selected controllers or enclosures.

8. Restart the server(s) or enclosures to activate the new ROM image.
Recovering storage with fail back:

Note: This action is not supported on enclosures with a single controller
configuration.

For enclosures with a dual controller configuration, use this action to restore an
array to its preferred owner. When a controller fails in an enclosure (or is
intentionally removed), its arrays and logical drives automatically fail over to the
other controller. This action moves the arrays and logical drives back to the
controller to which they were originally assigned.

Note: You cannot use fail back until the failed controller is replaced or repaired.

To fail back storage in an enclosure:

1. In the Enterprise view, click & (enclosure).
2. Right-click Fail back storage.
3. Click Yes when prompted to confirm the action.

More information
+ [Moving an array to a different controller]

Managing Foreign arrays and Alien arrays:
Foreign arrays

You can export RAID data and transfer the drives and RAID configuration to
another enclosure. When you export an array, it is called a

foreign array

. The array icon is grayed out in the Logical devices view. You cannot perform any
action on a foreign array, except view array components.

When you physically remove the component drives from the enclosure, the
ServeRAID Manager removes the foreign array icon from the console. When you
insert the drives in another enclosure, the ServeRAID Manager displays a foreign
array icon in the Logical devices view. You must then import the RAID data to
complete the transfer. You may then use the array to store and manage data.

Alien arrays

If the ServeRAID Manager only partially completes the array configuration
process, the resulting array is called an

alien array
. For example, an alien array might be created if power is interrupted during array

creation. You cannot use an alien array to store or manage data. The array icon is
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grayed out in the Logical devices view. The only action you can perform on an
alien array is to delete it.

More information
 [Exporting an array]
* [Importing an array]
* [Deleting an array]

Managing FlashCopy backups:

Note: You cannot use the ServeRAID Manager console create a FlashCopy for an
enclosure-based logical device. To create a FlashCopy backup, you must use
the command line interface provided with your IBM DS300 or DS400
storage enclosure. Or you can use the sstool command provided with the
FlashCopy agent.

A FlashCopy backup creates a point-in-time backup of logical drive data. It sets up
a link between the source and target logical drives. When data on the source drive
changes, the differences are captured on the target drive, maintaining the data as it
looked at the time the backup was created. You can use the backup copy of data
for tape backup, drive cloning, and multi-server rollout.

Initially, a FlashCopy backup starts at 10% the size of the FlashCopy source. As
new data are written to the source drive, the FlashCopy backup grows to the size
of FlashCopy source. This is known as the FlashCopy virtual size.

The ServeRAID Manager displays both the virtual size and actual size of a
FlashCopy backup, depending on the situation:

Logical drives (2)

® Id1 - Okay (275 GB)

I snapl - Okay (275 GB
¢ In the Logical devices view, it displays the virtual size: & onar . :

* In the Configuration wizard, it displays the actual size of the first FlashCopy
backup. It displays 0 for all other FlashCopy backups.

* In the logical drive Properties panel, it displays both the virtual size and actual
size.

You cannot perform any action on a FlashCopy target. You can only delete a
FlashCopy target, using the [Delete logical drive| action.

More information
+ |Deleting a logical drive]

Updating the software license key: Use this action to enable new features on
the specified enclosure. To enable new features, you must obtain a feature key
from your ServeRAID Manager sales or support representative.

To update the software license key:

In the Enterprise view, click € (enclosure).

Right-click Enter software key. The "Enter software key” window opens.
In the Feature key field, enter the feature key.

Click OK. A confirmation window opens.

Click OK to confirm.

ok wh =
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More information
« |Updating enclosure software|

Updating controller and enclosure software: The ROM Update wizard guides
you through the process of updating the software for your direct-attached and
network-attached storage devices:

* For direct-attached storage devices, the wizard updates the BIOS software for all
ServeRAID controllers of the same type on the local and remote systems. You
can update only one type of controller at a time.

* For external (network-attached) storage devices, the wizard updates the
enclosure and controller software for all controllers in the enclosure (single or
dual controller configurations).

Before you can use the ROM update wizard, you must download the latest
software images from your vendor’s software support site on the World Wide Web.
For direct-attachd storage devices, the image upgrade files typically come in sets of
two or more and have a .ufi file extension. For external storage enclosures, the
(single) image upgrade file has a .upgrade file extension.

To update the controller software for direct-attached or network-attached storage
devices:

1. In the Enterprise view, click @y (Direct attached storage object) or
(Networked storage object)

Right-click Update controller images. The ROM Update wizard opens.
Click Next.

[Choose the ROM image update files)

Click Next; then, [select the controllers or enclosures you want to update|

Click Next; then, review the [update summary]

No oo koD

Click Apply. The ServeRAID Manager applies the software update to the
selected controllers or enclosures.

8. Restart the server(s) or enclosures to activate the new ROM image.

Adding a remote system

198

Note: This action is not supported when using the following:
* ServeRAID Manager in bootable-CD mode
¢ ServeRAID Manager as a plug-in application

Use this action to connect to a remote system or management station and add it to
the Enterprise view.

Tip: Before adding a remote system, verify that the system is running the required
software. To add a remote system with direct-attached storage, the ServeRAID
Manager must be running on that system. To add a management station with
a network-attached storage enclosure, the ServeRAID Manager management
station software must be running on that system.

1. From the Remote menu, select Remote » Add or click = (Add) on the
toolbar. The Add managed system window opens.

2. From the Type drop-down list, select:
* Managed System, to add a remote system with direct-attached storage
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* Management Station, to add a remote management station with a
network-attached storage enclosure

3. Type the remote host name or TCP/IP address.

4. (Managed system only) Type the remote system startup port number. The
default port number is 34571.

5. Type your user name and password.

Note: The password is case sensitive.

6. If you want to save the user name and password, select the Save user
name/Password box. Once you successfully connect to the remote system, the
ServeRAID Manager stores this information in a file along with the host name
so you do not have to type your user name and password every time you run
the ServeRAID Manager.

7. Click Connect.

More information

« |Failing to add a remote system|

* [Successfully adding a remote system|
* |Specifying remote access settings|

+ [Removing a remote system|

Viewing the ServeRAID Manager event log

Note: This action is not supported in bootable-CD mode.

Use this action to view events in the ServeRAID Manager agent event log.

1. From the Actions menu, click Agent actions » View agent event log. The Agent
event log window opens.

2. If you want to save the event log to a file, click File » Save As. The default is
Events.txt.

3. Click File » Close to close event log window.

More information
* |Configuring the ServeRAID Manager agent|

« |Configuring the ServeRAID Manager agent general settings|

* |Using the ServeRAID Manager agent|

Using the ServeRAID Manager agent
Starting the ServeRAID Manager agent

The ServeRAID Manager agent is a monitoring agent for ServeRAID controllers
that uses less memory than the ServeRAID Manager graphical user interface (that
is, the console). You can manage and configure a server running the agent through
a ServeRAID Manager console running on another system.

Note: If the system administrator chose during installation to start the agent as a
background service (daemon), the agent is already running. |Verify that thel
[agent is not running before performing this procedure

Use the following procedure to start the ServeRAID Manager agent on your
system.
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Windows

On Windows systems, the ServeRAID Manager agent is installed as a background
service. It starts automatically when the system is started. To start the agent
manually, use the Windows Administrative tools. See [Verifying that the agent is|
running;

0S/2

To start the ServeRAID Manager agent on a Windows or OS/2 system:
1. Change to the directory where you installed the ServeRAID Manager program
by typing:

cd \RaidMan
2. Press Enter.
3. Type the following:

RaidAgnt
4. Press Enter.

NetWare

To start the ServeRAID Manager agent on NetWare:
1. From the NetWare console, type the following:

LOAD RaidAgnt
2. Press Enter.

OpenServer, UnixWare, and Open UNIX

To start the ServeRAID Manager agent on OpenServer, UnixWare, and Open UNIX:

1. Change to the directory where you installed the ServeRAID Manager program
by typing one of the following:

For OpenServer cd /opt/RaidMan
For UnixWare or Open UNIX cd /opt/RaidMan

2. Press Enter.
3. Type the following:

sh RaidAgnt.sh
4. Press Enter.

Linux

On Linux systems, the ServeRAID Manager agent runs as a background process
(daemon). It starts automatically when the system is started. It is loaded from the
following location:

/etc/init.d/raid_agent

More information
+ [Using the ServeRAID Manager agent|
+ |Configuring the ServeRAID Manager agent|
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* |Verifying that the ServeRAID Manager agent is running]

Viewing the ServeRAID Manager event log

Note: This action is not supported in bootable-CD mode.

Use this action to view events in the ServeRAID Manager agent event log.

1. From the Actions menu, click Agent actions » View agent event log. The Agent
event log window opens.

2. If you want to save the event log to a file, click File » Save As. The default is
Events.txt.

3. Click File » Close to close event log window.

More information
* [Configuring the ServeRAID Manager agent]

+ |Configuring the ServeRAID Manager agent general settings|

* [Using the ServeRAID Manager agent|

Receiving events from a removed system

When a remote system is in the Enterprise view, you always receive events that
occur on that remote system. With the Remove remote system action, you can
choose between "Continue to receive events from remote system” or "Do not
continue to receive events from remote system.” If you choose the first option, you
can monitor for problems on remote systems without having the system in your
Enterprise view.

The default is to continue receiving events.

If you choose not to continue receiving events, the ServeRAID Manager on your
local system must connect to the remote system. If the ServeRAID Manager

successfully connects, it removes your local system from the remote system
notification list} Because the notification list determines what systems receive
events from that remote system, your local system stops receiving events.

If the ServeRAID Manager cannot connect to the remote system and is therefore
unable to remove your system from the notification list, another window opens
asking if you want to remove the system from the Enterprise view even though
you will continue receiving events.

* If you click Yes, the ServeRAID Manager removes the remote system from the
Enterprise view tree and you continue receiving events.

* If you click No, the remote system remains in the Enterprise view tree and you
continue receiving events. You can reattempt removing your system from the
notification list at a later time.

Event viewer description of events
The event viewer description of events can inform you of the following:

A is started

* A configuration is applied
* A failed drive is detected
* Other potential problems that might occur to your managed systems.

Events for remote systems display in the event viewer when the following occurs:
1. Your local system is defined in a remote system’s |notification list|
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2. You have added the remote system to your Enterprise view using "
[systen]”

More information
* |Using the ServeRAID Manager interface > Event Viewed

» |Using the Notification Manager|

Configuring the ServeRAID Manager agent

You can configure the ServeRAID Manager agent port number and alarm. You can
also configure the ServeRAID Manager agent to log events to the operating system
event log. To configure the agent, edit the file RaidAgnt.pps or adjust the

in the ServeRAID Manager agent console. RaidAgnt.pps is located in the

same directory where you installed the ServeRAID Manager. If the RaidAgnt.pps
file does not exist when you start the ServeRAID Manager agent, a new file is
created with the default settings.

Note:
1. The RaidAgnt.pps file is preserved during a ServeRAID Manager
upgrade.
2. If you change settings while the ServeRAID Manager agent is running,
you must stop and restart the agent to make the changes take effect.

3. The ServeRAID Manager agent alarm is not supported by the ServeRAID
Manager in bootable-CD mode.

Configuring the port number

The default port number for the ServeRAID Manager agent and console (client) is
34571. To change the port number, edit the following line in the file RaidAgnt.pps:

agent.startupPortNum=34571

For accessing remote systems, the ServeRAID Manager uses four consecutive ports
starting from the startup port: 34571, 34572, 34573, and 34574. If your system has a
conflict with these ports, change the startup port to a different port number.

Configuring the alarm

When the ServeRAID Manager agent is started, it reads the alarm settings. When a
critical or fatal event occurs in the RAID subsystem, the ServeRAID Manager agent
triggers its alarm, if enabled. The alarm continues at the specified interval until
you either:

* Correct all the critical and fatal problems (if agent.auto.off.alarm is set to true).

* Delete the file alarm.on. This file is located in the same directory where you
installed the ServeRAID Manager. When you delete this file, the alarm stops
until the next critical or fatal event occurs. The alarm.on file is automatically
created each time the alarm starts.

You can configure the following alarm settings:

* agent.enable.alarm Specifies whether the agent alarm is enabled or disabled. Set
this value to true to enable the alarm or false to disable the alarm. The default
value is false.

* agent.interval.alarm Specifies the interval (in seconds) between audible alarms.
The default is 300 seconds (5 minutes).
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 agent.auto.off.alarm Specifies whether the alarm should turn off automatically
when no more problems are detected. Set this value to true to cause the alarm to
turn off automatically, or false to manually turn the alarm off. If you set this
value to false, you must delete the file alarm.on to turn off the alarm. The
default is true.

Configuring event logging

The ServeRAID Manager agent logs warning and fatal events to the operating
system event log. You can [view the event log|from the ServeRAID Manager
console. For Windows systems, you can also view the event log with the Windows
Event Viewer. For Unix systems, events are logged according to the
/etc/syslog.conf settings. (For more information, see the syslogd(8) man page.)

You can enable and disable event logging by editing the following line in the file
RaidAgnt.pps. Set the value to true to enable event logging (the default) or false to
disable event logging.

agent.enable.logEventsWithOS = true

More information

* [Using the ServeRAID Manager agent|

+ |Configuring the ServeRAID Manager agent general settings|
* |Configuring NetWare user authentication|

* [Verifying that the ServeRAID Manager agent is running|

+ |Starting the ServeRAID Manager agent]

* |Specifying remote access settings|

+ |Viewing the ServeRAID Manager agent event log]

Configuring the ServeRAID Manager agent > general settings

Note: This action is not supported in bootable-CD mode.

Use this action to configure The ServeRAID Manager agent general settings,
including the base port for the agent and console. The agent can log events to the
operating system event log, sound an alarm when an event occurs, and broadcast
events to users. If you enable event broadcasting, agents on Windows machines
will display pop-up alert dialogs when events occur. On Linux machines, a
message will be broadcast to all connected console processes using the "wall’
command.

You can adjust the agent general settings with the following steps:
1. In the "ServeRAID Manager Agent” window, click the General settings tab.

2. In the Agent base port number field, enter the port number for the ServeRAID
Manager agent and console. The default port is 34571.

Note: For accessing remote systems, the ServeRAID Manager uses four
consecutive ports starting from the base port: 34571, 34572, 34573, and
34574. If your system has a conflict with these ports, change the base
port to a different port number.

3. To log events to the operating system event log, click Save events in OS event
log.

Note: You can use the [View agent event log] option to view the event log. You
can also use joperating system administration tools| to view the event log.
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4. To broadcast events to users, click Broadcast events to logged-in users.

5. Select the check box to enable or disable the alarm. When a critical or fatal
event occurs in the RAID subsystem, the ServeRAID Manager agent triggers an
alarm, if enabled.

6. If you enabled the alarm, adjust the length of time (in seconds) between alarms.
The default is 300 seconds (5 minutes).

7. Click Save changes.
8. Restart the ServeRAID Manager for the settings to take effect.

Note: To load settings from the ServeRAID Manager agent configuration file} click

. Use this option if you change settings in the configuration

file while the agent is running. If you change the port number, you must
stop and restart the agent for the change to take effect.

More information
+ |Configuring the ServeRAID Manager agent|

+ [Starting the ServeRAID Manager agent|

+ |Verifying that the ServeRAID Manager agent is running]

+ [Viewing the ServeRAID Manager agent event log|

Using the ServeRAID Manager agent
The ServeRAID Manager agent includes the following components:
* Notification Manager
e Email Notification Manager
* Task Manager
* General settings

Because the agent runs as a background process, it uses less memory resources
than the ServeRAID Manager console. However, the ServeRAID Manager agent is
useful in the following situations:

* The agent can relay events to any ServeRAID Manager console installed on the
local system or on a remote system. As events occur, the agent sends the events
to each remote system. Use the [Notification Manager| from the agent console to
add systems to the agent destination list.

* The agent can notify users by email when events occur on the local system. Use
the [Email Notification Manager| to add recipients to the email notification list.

* The agent can run maintenance tasks on a reiular basis, such as allogical drive

[migration| or [synchronization| Use the [Task Manager| to manage scheduled tasks.

* The agent can log events to the operating system event log, sound an alarm
when an event occurs, and broadcast critical or fatal events to users. Use the
[General settings| from the agent console to configure these settings.

Note: ServeRAID Manager also logs events to a log file. Each component of the
agent (except for the Task Manager) has its own log file.

The ServeRAID Manager agent monitors and generates events for critical or fatal
problems in the ServeRAID Manager configuration every 5 seconds. These changes
include, but are not limited to:

¢ defunct drives

* PFA drives

* Failed battery

204 ServeRAID Management Installation and User's Guide



* Offline or critical logical drives

* Failed controllers

* Enclosure problems

* Non-warranted drives. An event is sent at startup, console connection, and every
30 days

More information

« |Configuring the ServeRAID Manager agent|

+ |Configuring the ServeRAID Manager agent general settings|
« [Starting the ServeRAID Manager agent|

+ [Verifying that the ServeRAID Manager agent is running|

+ |[Using the Notification Manager|

» |Using the Email Notification Manager|

* [Using the Task Manager]

« |Viewing the ServeRAID Manager agent event log (action)|

Using Security Manager
Security Manager menu bar

The Security Manager menu bar has the following functions:

File ~»
Close Closes the Security Manager.

View -

Toolbar
Turns the toolbar on and off. The default is on (that is, selected).

Actions »

i, Jrerwmes
I pereie wer

Help »

=

el Information about this window
View context-sensitive information for the current window.

Search
Searches for one or more specified words in ServeRAID Manager
Assist and displays a list of topics that include the words.

Contents
Presents the ServeRAID Manager Assist contents. You can use the
contents to acquaint yourself with ServeRAID Manager Assist topics.

About ServeRAID Manager
Reports the ServeRAID Manager version number, copyright, and legal
information.
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Security Manager toolbar

The Security Manager toolbar has the following functions:

. [
B e ol

Information about this window View context-sensitive information for the
current window.

Adding a user in the Security Manager
Use this action to permit a user access to the management station.
1. Click i (Add user). The "Add user” window opens.

2.
Fill in all the entry fields for the user you want to add. User name, Password,
and Confirm password are required fields.
Note: The password is case sensitive.

3. Click Add.

More information

+ |Using the Security Manager]

+ |Deleting a user in the Security Manager

+ [Modifying a user in the Security Manager|

Deleting a user in the Security Manager
Use this action to revoke access to the management stations for a selected user.
1. Click the user that you want to delete from the security list.
2. Click gg (Delete user).

3. Click Yes to confirm. The ServeRAID Manager deletes the user from the
security list.

More information

e |Using the Security Manageﬂ

« |Adding a user in the Security Manager]

+ [Modifying a user in the Security Manager|

Modifying a user in the Security Manager
Use this action to modify a user’s password.
1. Click the user you want to modify in the security list.
2. Click B8 (Modify user). The "User properties” window opens.

3. Enter a new password; then, enter it again to confirm.
4. Click Modify.
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More information

« |Using the Security Manager|

* |Adding a user in the Security Manager|
* |Deleting a user in the Security Manager|

Using SNMP Trap Manager

SNMP Trap Manager menu bar
The SNMP Trap Manager menu bar has the following functions:
File »
Close Closes the SNMP Trap Manager.

View -~
Toolbar
Turns the toolbar on and off. The default is on (selected).
Actions -~
P
¥
=)

et
!

Send test trap

Help ~

[Modify system|

=

el Information about this window
View context-sensitive information for the current window.

Search
Searches for one or more specified words in ServeRAID Manager
Assist and displays a list of topics that include the words.

Contents
Presents the ServeRAID Manager Assist contents. You can use the
contents to acquaint yourself with ServeRAID Manager Assist topics.

About ServeRAID Manager
Reports the ServeRAID Manager version number, copyright, and legal
information.

SNMP Trap Manager toolbar
The SNMP Trap Manager toolbar has the following functions:

|
=1
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Information about this window View context-sensitive information for the
current window.

Adding a system in the SNMP Trap Manager

Use this action to add a system to the SNMP traps list. You can add one system
only, such as an administrator’s workstation. The system is notified of the traps
that occur on the enclosures attached to the management station.

1. Click = (Add system). The "Add system” window opens.

Type the host name or TCP/IP address of the system you want to add.
Type the remote system SNMP trap port number. The default port is 162.
Type the Community for the system.

Al A

From the Version drop-down list, select the SNMP version number. The default
is SNMPv1.

6. Select the type of events you want to be notified of: error, warning, or
informational.

7. Click Add.

More information

* [Using the SNMP Trap Manager]

* [Deleting a system from the SNMP traps list|

+ [Modifying system properties in the SNMP traps list|

* [Sending a test trap to a system in the SNMP traps list|

Deleting a system in the SNMP Trap Manager

Use this action to delete a system from the SNMP traps list. After deleting the
remote system, the SNMP Trap Manager no longer notifies the remote system of
traps occurring on the enclosures connected to the management station.

1. In the SNMP traps list, click the system you want to delete.
2. Click g (Delete system).

3. Click Yes to confirm. The SMNP Trap Manager deletes the system from the
SNMP traps list.

More information

* |Using the SNMP Trap Manager|

» |Adding a system to the SNMP traps list]

+ [Modifying system properties in the SNMP traps list|

* [Sending a test trap to a system in the SNMP traps lis{

Modifying a system in the SNMP Trap Manager

Use this action to modify system properties in the SNMP trap list, such as the host
name, TCP/IP address, or port number.

1. In the SNMP traps list, click the system that you want to modify.
2. Click @ (Modify system). The "System properties” window opens.
3. Change the system properties in the appropriate fields.

4. Click Modify.
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More information

Using the SNMP Trap Manager

Adding a system to the SNMP traps list]

Deleting a system from the SNMP traps list|

Sending a test trap to a system in the SNMP traps list]

Managing software and firmware

Confirming your software update

Use the software update summary to review all the changes that the ServeRAID
Manager will apply to your controllers or enclosures:

1.

3.
4.

Review the information displayed in the "Update summary” window.

When you are ready to continue, click Apply; then, click Yes when asked if you
want to apply the software update.

When the update is complete, click OK.
Restart your server(s) or to activate the new software.

Changing BIOS-compatibility mapping

Note:

1. This action is supported in bootable-CD mode only.
2. This action is not supported on the integrated RAID controller.

Use this action to change BIOS-compatibility mapping. Extended indicates 8 GB
Extended; Limited indicates 2 GB Limited.

The ServeRAID controller allows the migration of drives from the PCI RAID
Adapter or Streaming RAID Adapter/A configurations. Using "Change
BIOS-compatibility mapping,” you can set your ServeRAID controller to be
compatible with these older drive configurations by selecting either 2 GB or 8 GB
mapping. The default is 8 GB.

1.
2.

3.

In the Enterprise view, click ¥ (controller).

Right-click either Change BIOS-compatibility mapping » Extended either or
Change BIOS-compatibility mapping » Limited.

Click Yes to confirm the setting.

Updating BIOS and firmware code

Before configuring the controller, you must have the latest BIOS and firmware code
installed on your server. Complete the following steps to update the levels of BIOS
and firmware code:

1.

Insert the IBM ServeRAID Support CD into the server CD-ROM drive, and turn
on the server.

The ROM Update Wizard automatically starts. The ROM (read-only memory)
Update Wizard is a program that updates the BIOS and firmware code on your
ServeRAID controllers. The wizard automatically identifies and scans each
controller.

If the BIOS and firmware code do not require updating, the wizard
automatically stops and the ServeRAID Manager program starts. Use the
ServeRAID Manager program to continue with configuring the controller.
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If the BIOS and firmware code require updating, a report screen opens with the

following information:

* Controller types found.

e Controller slot number, if known.

* Firmware version.

* BIOS version.

* Update status. If a controller has outdated BIOS or firmware code, the ROM
Update Wizard marks the controller as a candidate for update.

The ROM Update Wizard asks if you want to update. You decide whether to
update, but you must update all or none of the controllers in your server; you
cannot selectively update.

. If you want to update your controllers, click Update. If the wizard detects an

error, an error message appears and you are prompted to insert a diskette into
your diskette drive. The wizard saves details about the error to a file on the
diskette.

If you do not want to update your controllers, click Cancel.

. When all updates are completed, scroll through the Features window. This

window reports the changes that the ROM Update Wizard applied to your
controllers.

. Leave the ServeRAID Manager Support CD in the CD-ROM drive; shut down

and restart the server.

Selecting ROM update images
To select ROM update image files:

1. Click ; then, select the software image files from the file system.

Note: To remove an image from the file list, select the file, then click

|

2. When you are ready to continue, click Next; the ” [Select controller{’ window

opens.
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Chapter 5. Troubleshooting ServeRAID Manager

Could not copy the configuration from the drives: controller [number]

Explanation:

* There is no configuration on any of the physical drives that are attached to the
controller.

* There are no physical drives attached to the controller.
* The controller does not support one or more features of the drive configuration.

Action:

If you have physical drives attached to the controller and the physical drives
contain a valid controller configuration, complete the following steps:

1. Verify that the controller, cables, and physical drives are installed properly.
2. Verify that there is power to the physical drives.

3. Retry the command.

4. If the command still fails, restart the server and retry the command.

If the problem persists, the configuration data has been lost. Reconfigure the
controller using the ServeRAID Manager.

Could not restore the configuration to the factory-default settings:
controller [number]

Explanation:

The ServeRAID Manager could not restore the factory-default settings because of
one of the following;:

* Your configuration contains a large number of drives (10 or more).

e A hardware error occurred.

Action:

* If your configuration contains a large number of drives and all the logical drives
were deleted, ignore this error. If all the logical drives were not deleted, follow
the actions listed for the following list item.

* If your configuration does not contain a large number of drives:
1. Verify that the controller, cables, and physical drives are installed properly.
2. Retry the command.
3. If the command still fails, restart the server and retry the command.

If the problem persists, complete the following steps:
1. Disconnect all the SCSI cables from controller.

2. [Restore to the factory-default settings| If this does not work, contact your
service representative.

3. Connect the SCSI cables to the controller.
4. If step 2 was successful, restore to the factory-default settings.
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Could not unblock logical drive [number]: controller [number]
Explanation:

The specified logical drive could not be unblocked because of one of the following;:
* The rebuild operation was not completed successfully.
* A hardware error occurred.

Action:

Verify that the rebuild operation was completed successfully. If it did, then
complete the following steps:

1. Verify that the controller, cables, and physical drives are installed properly.
Verify that there is power to the physical drives.
Retry the command.

If the command still fails, restart the server and retry the command.

ok 0N

If the problem persists, contact your service representative.

Could not create a hot-spare drive: controller [number], < drive
location> Could not create a standby hot-spare drive: controller
[number], < drive location>

Explanation:

The hot-spare drive or standby hot-spare drive could not be defined because a
hardware error occurred.

Action:

1. Verify that the controller, cables, and physical drives are installed properly.
2. Verify that there is power to the physical drives.

3. Retry the command.
4

. If the command still fails, restart the server and retry the command.

Could not delete array: controller [number], array [letter]
Explanation:

The array could not be deleted because a hardware error occurred.

Action:

1. Verify that the controller, cables, and physical drives are installed properly.
Verify that there is power to the physical drives.

Retry the command.

If the command still fails, restart the server and retry the command.

A

If the problem persists, contact your service representative.
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Could not delete all of the arrays: controller [number]

Explanation:
A hardware error occurred.

Action:

Delete the arrays by using[Restore to factory-default settings|

If the problem persists, contact your service representative.

Could not delete logical drive: controller [number], logical drive

[number]

Explanation:
A hardware error occurred.

Action:
1. Verify that the controller, cables, and physical drives are installed properly.
Verify that there is power to the physical drives.

w

Retry the command.

P

If the command still fails, restart the server and retry the command.

o

If the problem persists, contact your service representative.

Logical drive was not initialized: controller [number], logical drive

[number]

Explanation:
A hardware error occurred.
Action:

Verify that the specified logical drive is not offline. If the logical drive is offline,
replace the failed physical drives and restore the data from tape backup.

If the specified logical drive is not offline, complete the following steps:

1. Verify that the controller, cables, and physical drives are installed properly.
2. Verify that there is power to the physical drives.

3. Retry the command.

4. If the command still fails, restart the server and retry the command.

If the problem persists, contact your service representative.

Could not start the logical drive synchronization: controller [number],
logical drive [number]

Explanation:

A hardware error occurred.
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Action:

Verify that the specified logical drive is not offline or critical (that is, one physical
drive that is offline in a RAID level-1, 1E, 5, 5E, 10, 1EQ, or 50 logical drive). If the
logical drive is critical, replace the failed physical drive. If the logical drive is
offline, replace the failed physical drives and restore the data from tape backup.

If the specified logical drive is not offline or critical, complete the following steps:
1. Verify that the controller, cables, and physical drives are installed properly.
Verify that there is power to the physical drives.

Retry the command.

oD

If the command still fails, restart the server and retry the command.

If the problem persists, contact your service representative.

Could not set the drive to online: controller [number], < drive location>

Explanation:

The specified drive could not be brought online because a hardware error
occurred.

Action:

1. Verify that the controller, cables, and physical drives are installed properly.
2. Verity that there is power to the physical drives.

3. Retry the command.

4. If the command still fails, restart the server and retry the command.

If the problem persists, replace the specified drive.

Could not remove the defunct drive: controller [number], < drive

location>

Explanation:
The defunct drive could not be removed because a hardware error occurred.

Action:

1. Verify that the controller, cables, and physical drives are installed properly.
2. Retry the command.

3. If the command still fails, restart the server and retry the command.

Could not replace the defunct drive: controller [number], < drive

location>

Explanation:
The defunct drive could not be replaced because a hardware error occurred.

Action:
1. Verify that the controller, cables, and physical drives are installed properly.
2. Verity that there is power to the physical drives.
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3. Retry the command.

4. If the command still fails, restart the server and retry the command.

Could not delete the hot-spare drive: controller [number], < drive
location> Could not delete the standby hot-spare drive: controller
[number], < drive location>

Explanation:

The hot-spare drive or standby hot-spare drive could not be deleted because a
hardware error occurred.

Action:

1.

Verify that the controller, cables, and physical drives are installed properly.

2. Verify that there is power to the physical drives.
3.
4. If the command still fails, restart the server and retry the command.

Retry the command.

If the problem persists, replace the specified drive.

Could not set the merge-group number: controller [number], logical

drive [number]

Explanation:

The specified merge-group number could not be set because a hardware error
occurred.

Action:

1.

Verify that the controller, cables, and physical drives are installed properly.

2. Verify that there is power to the physical drives.

o Mo

Retry the command.
If the command still fails, restart the server and retry the command.

If the problem persists, contact your service representative.

Could not blink the device lights
Explanation:

The device lights could not flash because of one of the following:

¢ The physical drives are not managed by an enclosure.

¢ A hardware error occurred.

Action:

Verify that the device is managed by an enclosure (SAF-TE) device on the SCSI
drive channel. If it is, complete the following steps:

1.

Verify that the controller, cables, and physical drives are installed properly.

2. Verify that there is power to the physical drives.
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3. Retry the command.
4. 1If the command still fails, restart the server and retry the command.
5.

If the problem persists, contact your service representative.

The battery-backup cache device needs a new battery: controller

[number]

Explanation:

The battery and battery-backup cache are malfunctioning because of one of the
following:

* The battery and battery-backup cache device are installed improperly.
¢ The battery is low, and the battery-backup cache device must be replaced.

Action:

Verify that the battery and battery-backup cache device are installed properly. If
they are installed properly, contact your service representative.

The battery-backup cache device is defective: controller [number]

Explanation:
The battery-backup cache device is installed improperly or is defective.

Action:
1. Verify that the battery-backup cache device is installed properly.

2. If the battery-backup cache device is installed properly but is defective, contact
your service representative.

Background polling commands are not responding: controller

[number]

Explanation:
A hardware error occurred.

Action:

1. Verify that the controller, cables, and physical drives are installed properly.
2. Verify that there is power to the drives.

3. Restart the server.
4

If the problem persists, contact your service representative.

Commands are not responding: controller [number]

Explanation:
* If the controller status displays "Not responding,” a hardware error occurred.

* If the controller status displays "Bad configuration,” a configuration error
occurred.
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Action:

* If the controller status displays "Not responding,” complete the following steps:
1. Verify that the controller, cables, and physical drives are installed properly.
2. Verify that there is power to the physical drives.
3. Restart the server.
If the problem persists, contact your service representative.

e If the controller status displays "Bad configuration,” complete the following
steps:
1. In the Enterprise view, click the specified ¥ (controller).

2. 1If the controller is not configured, click Actions » Restore to factory-default
settings. If the controller is configured, click Actions » Copy configuration
from drives. If "Copy configuration from drives” does not correct the
problem, click Actions » Restore to factory-default settings; then, recreate
the configuration using the ServeRAID Manager.

Rebuild failed: controller [number], logical drive [number]
Explanation:

A hardware error occurred.

Action:

1. Verify that the controller, cables, and physical drives are installed properly.
2. Verify that there is power to the physical drives.

3. If the command still fails, restart the server and retry the command.

4. If the problem persists, replace the specified drive.

Synchronization failed: controller [number], logical drive [number]
Explanation:

A hardware error occurred.
Action:

Verify that the specified logical drive is not offline or critical (that is, one physical
drive that is offline in a RAID level-1, 1E, 5, 5E, 10, 1EQ, or 50 logical drive). If the
logical drive is critical, replace the failed physical drive. If the logical drive is
offline, replace the failed physical drives and restore the data from tape backup.

If the specified logical drive is not offline or critical, complete the following steps:
1. Verify that the controller, cables, and physical drives are installed properly.

2. Verify that there is power to the physical drives.

3. Retry the command.
4.

If the command still fails, restart the server and retry the command.

If the problem persists, contact your service representative.
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Migration [logical-drive migration type] failed: controller [number],
logical drive [number]

Explanation:
A hardware error occurred.
Action:

Determine if one or more physical drives that are part of the specified logical drive
have failed. If such a failure has occurred, restore the data from a tape backup.
Otherwise, do the following:

1. Verify that the controller, cables, and physical drives are installed properly.
Verify that there is power to the physical drives.
Retry the command.

oD

If the command still fails, restart the server and retry the command.

Compression failed: controller [number], logical drive [number]

Explanation:
A hardware error occurred.
Action:

Determine if one or more physical drives that are part of the specified logical drive
have failed. If such a failure has occurred, restore the data from a tape backup.
Otherwise, do the following:

1. Verify that the controller, cables, and physical drives are installed properly.
2. Verify that there is power to the physical drives.

3. Retry the command.

4. 1If the command still fails, restart the server and retry the command.

Decompression failed: controller [number], logical drive [number]
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Explanation:
A hardware error occurred.
Action:

Determine if one or more physical drives that are part of the specified logical drive
have failed. If such a failure has occurred, restore the data from a tape backup.
Otherwise, do the following:

1. Verify that the controller, cables, and physical drives are installed properly.
Verify that there is power to the physical drives.
Retry the command.

oD

If the command still fails, restart the server and retry the command.
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defunct drive: controller [number], < drive location>
Explanation:

A hardware error occurred.

Action:

* If the specified physical drive is part of an array, refer to the event pertaining to
the logical drives in that array for additional information.

* If the specified physical drive is not part of an array, contact your service
representative.

PFA detected for drive: controller [number], < drive location>
Explanation:

The physical drive is going to fail.
Action:

Contact your service representative.

Logical drive is offline: controller [number], logical drive [number]
Explanation:

A hardware error occurred.
Action:

Contact your service representative.

Logical drive is critical: controller [number], logical drive [number]
Explanation:

A physical drive is defunct in the specified logical drive. The data on this logical
drive is at risk. If another physical drive fails, the data might be lost.

Action:

* If a rebuild operation is in progress, wait until the rebuild is complete.

* If a rebuild operation is not in progress, replace the failed physical drive with a
new physical drive. After the physical drive is replaced, a rebuild operation will
start automatically. Refer to the troubleshooting chapter of the

[User’s Reference.|.

Logical drive is blocked: controller [number], controller [number]
[number]

Explanation:

When the ServeRAID controller performs a rebuild operation on an array, it

reconstructs the data that was stored in RAID level-1 and RAID level-5 logical
drives. However, the ServeRAID controller cannot reconstruct the data that was
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stored in any RAID level-0 logical drives in that array. The data in the RAID
level-0 logical drives is blocked when the ServeRAID controller detects that the
array is valid, but the data might be damaged.

Action:

Restore the data from tape.

Could not communicate with controller: controller [number]
Explanation:

A hardware error occurred.

Action:

1. Verify that the controller, cables, and physical drives are installed properly.
Verify that there is power to the physical drives.

Retry the command.

If the command still fails, restart the server and retry the command.

ok wpn

If the problem persists, contact your service representative.

User name or password is not valid
Explanation:

An incorrect or undefined user name or password was typed.

Action:
* Verify that you specified a valid user name and password for the remote system.
Passwords are case sensitive.

* If you do not require security, you can disable security on the remote system. In
this case, a user name and password are not required to access the system
remotely.

ServeRAID Manager failed to start at port number [number]
Explanation:

The ServeRAID Manager was unable to use the specified port number on the local
system. Another session of the ServeRAID Manager or another application is
currently using the port.

Action:

Change the port number for the system by doing the following:
1. Click Agent actions === Configure.
2. Click the General settings tab.

3. In the Agent base port number field, type a new value for the port number.
The default port number for local access is 34571. Note: When changing the
port number, consider the following:

* This change does not take effect until you restart the ServeRAID Manager.
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¢ Any system that is accessing this system remotely must have the port
number changed to match the value you type. On the remote system, you
can change this value in the " |Add remote system| window.

* Any system that contains this system in its Notification list must change the

port number to the new port number. On the remote system, you can change
the port number in the Notification Manager by clicking [Modify syste

No controllers were found in this system.
Explanation:

The ServeRAID Manager did not detect any controllers in the system.

Action:

If you know there are controllers in the system, the ServeRAID Manager might not
identify the controllers because of the following;:

The device driver is not loaded.

(Linux, UnixWare, and OpenServer only) You are not running the ServeRAID
Manager as "root.” The ServeRAID Manager cannot access the device driver
unless it is run with root authority. Without access to the device driver, the
ServeRAID Manager cannot identify any controllers.

If the problem persists, contact your service representative.

Host name [ID] is unknown or the network is down
Explanation:

The ServeRAID Manager could not access the remote system.

Action:

Verity the following:

1.
2.
3.

4.

The remote system is on.
Both the local and remote systems are connected to the network.

TCP/IP networking support is configured on both the local and remote
systems.

The network is functioning. Verify that you can ping the remote system.

Failed to connect to host name [ID] due to incompatible versions
[Local=number Remote=number]

Explanation:

The local and remote versions of the ServeRAID Manager are incompatible
versions.

Action:

Upgrade the older version of the ServeRAID Manager to the newer version.
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Unable to connect to the remote system
Explanation:

The ServeRAID Manager could not communicate with the ServeRAID Manager
agent on the remote system.

Action:
1. |Verify that the ServeRAID Manager agent or console is running on the remote|

sxsteml
2. Verify that the port number specified for the remote system in the ”

" window matches the value on the remote system. You can
verify the port number on the remote system by going to the ServeRAID
Manager running on that system and doing the following:

a. Click Agent actions > Configure.
b. Click the General settings tab.

c. Verify the value for the port number. The default port numbers for remote
access are 34571-34574.

3. Verify the following:
a. The remote system is on.
b. Both the local and remote systems are connected to the network.

c. TCP/IP networking support is configured on both the local and remote
systems.

d. The host name of the remote system is defined in the Domain Name Server
or a Hosts file, if you are trying to connect using a host name.

e. The network is functioning.

Array [letter] storage space still available.
Explanation:

You have configured an array that still contains free space.
Action:

Before you apply this configuration, you can do either of the following;:
* Increase the size of the new logical drives.

* If there is enough free space, create more logical drives in this array by returning
to the "Configure logical drive” window in the Configuration wizard.

Physical drives in array [letter] contain unusable space
Explanation:
You have configured an array using physical drives of different sizes. If you
configure an array using physical drives of different sizes, you cannot use all the
physical drive space.

Action:

To create optimal array configurations, include only physical drives of the same
size in any one array.

222 ServeRAID Management Installation and User's Guide



Hot spare is too small for use by at least one array.

None of the logical drives in the specified array support
hot-spare drives.

At least one array is too large to use the hot spare drive
[number]. Replace the specified drive with a larger drive.

Explanation:

This hot-spare drive will not work for any defined array because of one of the
following:

* None of the existing array support hot-spare drives.

* The hot-spare drive must have the same capacity as or larger capacity than the
smallest physical drive in the array.

 If any of the physical drives in your arrays fail, the specified hot-spare drive
cannot replace the failed drive.

Action:

Remove the specified hot-spare drive and add a drive of the appropriate size.

Could not start logical drive migration: controller [number] logical
drive [number]

Explanation:

The logical-drive migration could not start because of one of the following:

A rebuild, synchronization, or migration operation is currently in progress on
the specified controller.

e A hardware error occurred.
Action:

Verify that there is no rebuild, synchronization, or migration operation currently in
progress on this controller. If you see a progress indicator in the or

H (in animation) in the Logical devices view, one of these operations is in
progress and you must wait for the operation to be completed. Otherwise,
complete the following steps:

1. Verify that the controller, cables, and physical drives are installed properly.
2. Verify that there is power to the physical drives.

w

Retry the command.

A

If the command still fails, restart the server and retry the command.

o

If the problem persists, contact your service representative.

Could not enable the hot-swap rebuild operation: controller [number]
Explanation:

A hardware error occurred.
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Action:

1. Verify that the controller, cables, and physical drives are installed properly.
Verify that there is power to the physical drives.

Retry the command.

If the command still fails, restart the server and retry the command.

A

If the problem persists, contact your service representative.

Could not create logical drive: controller [number], logical drive

[number]

Explanation:
A hardware error occurred.

Action:

Verify that the controller, cables, and physical drives are installed properly.
Verify that there is power to the physical drives.

Verify that none of the physical drives are defunct.

Retry the command.

If the command still fails, restart the server and retry the command.

o0~ wh =

If the problem persists, contact your service representative.

Logical drive was not initialized: controller [number], logical drive

[number]

Explanation:
The logical drive has not been initialized.
Action:

Do not store data on this logical drive until you initialize the logical drive.
Initialize the logical drive by doing the following;:

1. In the Logical devices view, click the specified logical drive.

2. Click Actions - Initialize; or, for the ServeRAID-7t or ServeRAID-8i controller,
click, Actions » Clear.

Logical drive must be synchronized: controller [number], logical drive

[number]

Explanation:
You must synchronize the specified logical drive before storing data on it.
Action:

Synchronize the logical drive by doing the following:
1. In the Logical devices view, click the specified logical drive.
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2. Click Actions » Synchronize.

[Number] ready drives still available.
Explanation:

You have ready drives still available for configuration.

Action:

You can configure these drives as new arrays, add them to other new arrays, or
define them as hot-spare drives.

Cannot communicate with the remote system

Explanation:

1. The local ServeRAID Manager has lost communication with the ServeRAID
Manager on the remote system.

2. The local ServeRAID Manager has lost communication with the server on
which it is installed. The ServeRAID Manager agent might fail leaving the
ServeRAID Manager console available, but unable to communicate with the
server.

Action:

For explanation 1, use the following actions:

¢ If the ServeRAID Manager is running in network mode, use the following
actions:

1.

2.

Verify that the ServeRAID Manager agent or console is running on the]

remote szsteml

Verify that the port number specified for the remote system in the " @
’ window matches the value on the remote system. You can
verify the port number on the remote system by going to the ServeRAID
Manager running on that system and doing the following:

a. Click Agent actions » Configure ServeRAID Manager agent.
b. Click the General settings tab.

c. Verify the value for the port number. The default port numbers for
remote access are 34571-34574.

Verify the following:
a. The remote system is on.
b. Both the local and remote systems are connected to the network.

c. TCP/IP networking support is configured on both the local and remote
systems.

d. The host name of the remote system is defined in the Domain Name
Server or a Hosts file, if you are trying to connect using a host name.

e. The network is functioning.

* If the ServeRAID Manager is running as a plug-in to another program, use the
following actions:

1.

2.

If the connection fails but has worked before, re-initiate the ServeRAID
Manager task by closing the current ServeRAID Manager window and then
dragging the RAID task icon onto the appropriate system.

If the connection fails and has not worked before, verify the following:
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a. The remote system is on.

b. The program using the ServeRAID Manager agent as a plug-in is
installed on the remote system.

c. Both the local and remote systems are connected to the network.

d. TCP/IP networking support is configured on both the local and remote
systems.

e. The network is functioning.

Note:
a. If you install a program that uses the ServeRAID Manager, the
ServeRAID Manager agent is installed also. The ServeRAID
Manager agent is started automatically by the program using it.
b. When using the ServeRAID Manager agent as a plug-in to another
program, the ServeRAID Manager does not recognize port
numbers.

For explanation 2, use the following actions:

1.

A

Verify that the ServeRAID Manager agent or console is running on the local
system. View processes or services to verify that the agent is running.

Restart the ServeRAID Manager console.
Verify that TCP/IP networking support is configured on the local system.
Verify that the network is functioning.

Restart the server.

Error getting controller configuration.
Explanation:

A hardware error occurred.

Action:

1.

2.
3.
4.

Verify that the controller, cables, and physical drives are installed properly.
Verify that there is power to the physical drives.

Retry the command.

If the command still fails, restart the server and retry the command.

If the problem persists, complete the following steps:

1.
2.

[Restore to factory-default settings|

[Recreate the configuration|

Agent is running in local only mode.
Explanation:

226

If you specified -1 (that is, minus and a lowercase letter L) as a command-line
parameter, the ServeRAID Manager starts in local-only mode. The ServeRAID
Manager is not network-enabled. In this mode, you can configure and monitor
the local system only. You cannot configure or monitor remote systems. If you
added remote systems to your Enterprise view, they are not visible in this mode.
They will be visible in the tree when you start the ServeRAID Manager in
non-local-only mode.
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¢ If the network is unreachable, the ServeRAID Manager starts in local-only mode.
An additional event is displayed in the event viewer indicating that the network
is unreachable.

¢ If the port number is in use on the local system, the ServeRAID Manager starts
in local-only mode. An additional event is displayed in the event viewer
indicating that the network is unreachable.

Action:

* If the network is unreachable, check the event viewer for details on any
networking errors.

¢ If the port number is in use, exit from the application using the port number, or

specify a different port number. Complete the following steps to specify a

different port number:

1. Click Agent actions » Configure.

2. Click the General settings tab.

3. In the Agent base port number field, type a new value for the port number.
The default port number for local access is 34571. Note: When changing the
port number, consider the following:

— This change does not take effect until you restart the ServeRAID Manager.
— Any system that is accessing this system remotely must have the port

number changed to match the value you type. On the remote system, you
can change this value in the ” [Add remote system| window.

— Any system that contains this system in its Notification list must change

the port number to the new port number. On the remote system, you can
chanie the port number in the Notification Manager by clicking

Networking support is not available.
Explanation:

The network is unreachable.
Action:

Verify the following:

1. The local system is connected to the network.
2. The TCP/IP networking support is configured.
3. The network is functioning.

Could not send the event to the system.
Explanation:

An event could not be sent to the remote system.

Action:
1. Verify that the ServeRAID Manager is running on the remote system.

2. Verify that the port number specified in the Notification list matches the value
for the start-up port number on the remote system.

* You can verify the port number for this event in the Notification Manager by
using the " System properties| window for this system.
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* You can verify the port number on the remote system by going to the
ServeRAID Manager running on that system and doing the following:

a. Click Agent actions » Configure.
b. Click the General settings tab.
C. Verify the value for the port number.
3. Verity the following:
a. The remote system is on.
b. Both the local and remote systems are connected to the network.

c. TCP/IP networking support is configured on both the local and remote
systems.
d. The network is functioning.
4. Verify that the local and remote systems are using compatible versions of the

ServeRAID Manager. If they are not, upgrade to the latest version of the
ServeRAID Manager.

Failed to connect to host name [ID] at port number [number].

228

Explanation:

The ServeRAID Manager could not communicate with the ServeRAID Manager
client on the remote system.

Action:
1. [Verify that the ServeRAID Manager agent or console is running on the remote

system|

2. Verity that the port number specified for the remote system in the "
” window matches the value on the remote system. You can

verify the port number on the remote system by going to the ServeRAID

Manager running on that system and doing the following:

a. Click Agent actions > Configure.
b. Click the General settings tab.

c. Verify the value for the port number. The default port numbers for remote
access are 34571-34574.

3. Verify the following:
a. The remote system is on.
b. Both the local and remote systems are connected to the network.

c. TCP/IP networking support is configured on both the local and remote
systems.

d. The host name of the remote system is defined in the Domain Name Server
or a Hosts file, if you are trying to connect using a host name.

e. The network is functioning.
Note: If the local ServeRAID Manager is trying to connect to a remote system that

has multiple network adapters, the local ServeRAID Manager must use a
host name to connect to the remote system.
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Failed to connect to host name [ID] due to incompatible versions
[Local=id Remote=id].
Explanation:

The local and remote versions of the ServeRAID Manager are incompatible
versions.

Action:

Upgrade the older version of the ServeRAID Manager to the newer version.

ServeRAID Manager failed to start at port number [number].
Explanation:

The ServeRAID Manager was unable to use the specified port number. The port is
currently in use.

Action:

Change the port number for the system by doing the following:
1. Click Agent actions » Configure.
2. Click the General settings tab.

3. In the Agent base port number field, type a new value for the port number.
The default port number for local access is 34571. Note: When changing the
port number, consider the following:

¢ This change does not take effect until you restart the ServeRAID Manager.

* Any system that is accessing this system remotely must have the port
number changed to match the value you type. On the remote system, you
can change this value in the " |Add remote system| window.

* Any system that contains this system in its Notification list must change the
port number to the new port number. On the remote system, you can change
the port number in the Notification Manager by clicking

Refused connection from [remote system ID].
Explanation:

Security is enabled on this system, and the ServeRAID Manager received a remote
log-in request containing an incorrect user ID or password.

Action:
The remote system requesting a log-in to this system must specify a valid user ID

and password. Be sure the remote system issuing the log-in request specifies a
valid user ID and password.
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FlashCopy with backup failed: controller [number], logical drive

[number]

Explanation:

The FlashCopy failed because a hardware error occurred. The specified logical
drive might be offline.

Action:

If the source logical drive is offline, replace the failed physical drives and restore
the data from tape backup. If the target logical drive is offline, replace the failed
physical drives. FlashCopy will not work when the source or target logical drives
are offline.

If the source or target logical drives are not offline, complete the following steps:
1. Verify that the controller, cables, and physical drives are installed properly.
Verify that there is power to the physical drives.

Retry the command.

If the command still fails, restart the server and retry the command.

oo

If the problem persists, contact your service representative.

Could not import configuration with more than eight drives into a
ServeRAID-3L controller.

Explanation:

The ServeRAID-3L controller does not support more than eight drives in an array
when the stripe-unit size is 32 KB or 64 KB.

Action:

Do one of the following:

* Replace the ServeRAID-3L controller with a ServeRAID-3H controller. The
configuration stored on the physical drives is supported only on a
ServeRAID-3H controller or later hardware. or

* Create a new configuration that does not contain more than eight drives in an
array with the stripe-unit size being 32 KB or 64 KB.

Attention: () When creating a new configuration, you will destroy the data
currently on the physical drives.

Could not copy the configuration from the drives: controller [number],
< drive location>

Explanation:
A hardware error occurred.

Action:
1. Verify that the controller, cables, and physical drives are installed properly.
2. Verify that there is power to the physical drives.
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3. Retry the command.
4. If the command still fails, restart the server and retry the command.

Possible non-warranted physical drive found: controller [number], <
device location>

Explanation:

The ServeRAID Manager has detected that the specified physical drive might not
be a qualified and warranted part.

Action:
This message is an alert only. The physical drive will continue to function and the
ServeRAID Manager will not make any changes or modifications to the

configuration.

For further assistance, contact the source from which you obtained the specified
physical drive.

Could not set the host name: controller [number]
Explanation:

A hardware error occurred.
Action:

Verify that the cluster partner system is turned off. If it is, complete the following
steps:

1. Verify that the controller, cables, and physical drives are installed properly.

2. Verify that there is power to the physical drives.

3. Retry the command.

4. If the command still fails, restart the server and retry the command.

Could not set the partner host name: controller [number]
Explanation:

A hardware error occurred.
Action:

Verify that the cluster partner system is turned off. If it is, complete the following
steps:

1. Verify that the controller, cables, and physical drives are installed properly.
2. Verify that there is power to the physical drives.

w

Retry the command.

&

If the command still fails, restart the server and retry the command.

o

If the problem persists, contact your service representative.
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Could not change the rebuild rate: controller [number], < device
location>

Explanation:
A hardware error occurred.

Action:

1. Verify that the controller, cables, and physical drives are installed properly.
Verify that there is power to the physical drives.

Retry the command.

If the command still fails, restart the server and retry the command.

oo

If the problem persists, contact your service representative.

Could not change the stripe-unit size: controller [number], < device
location>

Explanation:
A hardware error occurred.

Action:

1. Verify that the controller, cables, and physical drives are installed properly.
2. Verity that there is power to the physical drives.

3. Retry the command.

4. 1If the command still fails, restart the server and retry the command.

Could not change the write-cache mode: controller [number], logical
drive [number]

Explanation:
A hardware error occurred.

Action:

1. Verify that the controller, cables, and physical drives are installed properly.
Verify that there is power to the physical drives.

Retry the command.

If the command still fails, restart the server and retry the command.

Al A

If the problem persists, contact your service representative.

Could not change the SCSI transfer speed: controller [number],
channel [number]

Explanation:

A hardware error occurred.
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Action:

1.

Verify that the controller, cables, and physical drives are installed properly.

2. Verify that there is power to the physical drives.

ok w

Retry the command.
If the command still fails, restart the server and retry the command.

If the problem persists, contact your service representative.

Could not enable unattended mode: controller [number]
Explanation:

A hardware error occurred.

Action:

1.

Verify that the controller, cables, and physical drives are installed properly.

2. Verify that there is power to the physical drives.

ok w»

Retry the command.
If the command still fails, restart the server and retry the command.

If the problem persists, contact your service representative.

Could not disable unattended mode: controller [number]
Explanation:

A hardware error occurred.

Action:

1.

Verify that the controller, cables, and physical drives are installed properly.

2. Verify that there is power to the physical drives.

ok w

Retry the command.
If the command still fails, restart the server and retry the command.

If the problem persists, contact your service representative.

Could not enable read cache: controller [number]
Explanation:

A hardware error occurred.

Action:

1.

Verify that the controller, cables, and physical drives are installed properly.

2. Verify that there is power to the physical drives.

o ko

Retry the command.
If the command still fails, restart the server and retry the command.

If the problem persists, contact your service representative.

Could not disable read cache: controller [number]
Explanation:

A hardware error occurred.
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Action:

1.

A

Verify that the controller, cables, and physical drives are installed properly.
Verify that there is power to the physical drives.

Retry the command.

If the command still fails, restart the server and retry the command.

If the problem persists, contact your service representative.

Could not set the SCSI initiator ID: controller [number]
Explanation:

A hardware error occurred.

Action:

1.

A

Verify that the controller, cables, and physical drives are installed properly.
Verify that there is power to the physical drives.

Retry the command.

If the command still fails, restart the server and retry the command.

If the problem persists, contact your service representative.

Note: (Cluster and failover environment only) Verify that the cable from the

second system (for clustering) or controller (for failover) is disconnected
from the SCSI backplane.

Could not switch the active and passive controllers.
Explanation:

A hardware error occurred.

Action:

1.

Al S

Verify that the controller, cables, and physical drives are installed properly.
Verify that there is power to the physical drives.

Retry the command.

If the command still fails, restart the server and retry the command.

If the problem persists, contact your service representative.

Could not clear the controller event logs for system [number].
Explanation:

234

A hardware error occurred.

Action:

1.

o k0N

Verify that the controller, cables, and physical drives are installed properly.
Verify that there is power to the physical drives.

Retry the command.

If the command still fails, restart the server and retry the command.

If the problem persists, contact your service representative.
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Could not copy the configuration from the non-shared logical drives
(merge group [number]): controller [number]

Explanation:
A hardware error occurred.

Action:
1. Delete the arrays by using|Restore to factory-default settings}

2. Set the controller name, the partner controller name, and the SCSI initiator IDs.

3. Retry the command.

If the problem persists, contact your service representative.

Could not change the BIOS-compatibility mapping to [Extended or
Limited]: controller [number]

Explanation:
A hardware error occurred.

Action:
1. Verify that the controller, cables, and physical drives are installed properly.
2. Verify that there is power to the physical drives.

w

Retry the command.

E

If the command still fails, restart the server and retry the command.

o

If the problem persists, contact your service representative.

Could not change the write-cache mode: controller [number], channel
[number], SCSI ID [number]

Explanation:
A hardware error occurred.

Action:

1. Verify that the controller, cables, and physical drives are installed properly.
2. Verify that there is power to the physical drives.

3. Retry the command.

4. If the command still fails, restart the server and retry the command.

If the problem persists, replace the specified drive.

Enclosure device is not responding: controller [number], channel
[number]

Explanation:

A hardware error occurred.
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Action:

1. Verify that the controller, cables, and physical drives are installed properly.
Verify that there is power to the physical drives.

Retry the command.

If the command still fails, restart the server and retry the command.

A

If the problem persists, contact your service representative.

Enclosure fan [number] is malfunctioning: controller [number],
channel [number]

Explanation:
A hardware error occurred.
Action:

Verify that the fan in the enclosure device is installed properly. If it is, complete the
following steps:

1. Verify that the controller, cables, and physical drives are installed properly.
2. Verify that there is power to the physical drives.

3. Retry the command.
4

. If the command still fails, restart the server and retry the command.

If the problem persists, replace the specified fan.

Enclosure power supply [number] is malfunctioning: controller
[number], channel [number]

Explanation:
A hardware error occurred.
Action:

Verify that the power supply in the enclosure device is installed properly. If it is,
complete the following steps:

-y

. Verify that the controller, cables, and physical drives are installed properly.
Verify that there is power to the physical drives.
Retry the command.

oD

If the command still fails, restart the server and retry the command.

If the problem persists, replace the specified power supply.

Enclosure temperature is out of normal range: controller [number],
channel [number]

Explanation:

A hardware error occurred.
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Action:

Verify that the fans in the enclosure device are installed properly and working. If
they are, complete the following steps:

1. Verify that the controller, cables, and physical drives are installed properly.
2. Retry the command.

3. If the command still fails, restart the server and retry the command.

4.

If the problem persists, contact your service representative.

Could not save the event logs: controller [number]
Explanation:

A hardware error occurred.

Action:
1. Verify that the controller, cables, and physical drives are installed properly.
2. Verify that there is power to the physical drives.

w

Retry the command.

B

If the command still fails, restart the server and retry the command.

o

If the problem persists, contact your service representative.

Version mismatch detected: controller [number]
Explanation:

The version of the BIOS, firmware, and device driver are not compatible.
Action:

Install a compatible version of the BIOS, firmware, and driver for this controller.
You can download the latest version from the

[[BM Support Web site]

Compaction failed: controller [number], logical drive [number]
Explanation:

A hardware error occurred.
Action:

Determine if one or more physical drives that are part of the specified logical drive
have failed. If such a failure has occurred, restore the data from a tape backup.
Otherwise, do the following:

1. Verify that the controller, cables, and physical drives are installed properly.
2. Verify that there is power to the physical drives.

3. Retry the command.

4. If the command still fails, restart the server and retry the command.
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Expansion failed: controller [number], logical drive [number]

Explanation:
A hardware error occurred.
Action:

Determine if one or more physical drives that are part of the specified logical drive
have failed. If such a failure has occurred, restore the data from a tape backup.
Otherwise, do the following:

1. Verify that the controller, cables, and physical drives are installed properly.
2. Verify that there is power to the physical drives.

3. Retry the command.

4. 1If the command still fails, restart the server and retry the command.

Battery has exceeded normal operating temperature: battery controller

[number]

Explanation:

Battery temperature has exceeded 50 degrees Celsius.

Action:

Check operating environment: verify that the controller is installed properly, that

the server has adequate ventilation, and so on. If the problem persists, the battery
may be bad or the server may have a problem. Contact your service representative.

Network connection was not found and/or host name was not

resolved.

Explanation:

The ServeRAID Manager could not communicate with the network or establish a
network connection.

Action:
* If your workstation is not connected to the network, change your workstation
name to "localhost” or add an entry for your workstation to your local host file.

* If your workstation is connected to the network, make sure that your host name
is resolvable over DNS; for more information, contact your network
administrator.

One or more logical drives contain a bad stripe: controller [number],
logical drive [number]

Explanation:

The Bad Stripe Table (BST) provides a means of recovering most data on a logical
drive after multiple hardware errors prevent access to a logical drive stripe. An
entry in the BST indicates that the data contained in a stripe has been lost.
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While many conditions can produce a Bad Stripe Table entry, the most common
cause is an error accessing one of the stripe units within a stripe of a critical logical
drive. A single stripe unit failure is correctable and recoverable but two or more
failures within the same redundant RAID stripe are not.

For example, in a critical RAID-5 array, in which one of the drives in the array is
defunct, a stripe will be marked bad with an entry in the BST if a non-recoverable
media error occurs when accessing one of the other drives of the array.

Once an entry is logged in the BST, the controller will return an error code to the
driver whenever the host system tries to access a Logical Block Address (LBA)
within the affected stripe. This is one immediate indication that some part of the
logical drive is unusable.

Note: It is not possible to correlate the bad stripe with a specific file in the
operating system.

Action:

* Check the ServeRAID Manager event logs to identify the affected logical
drive(s).

e Because the data has been lost, the only way to recover from this condition is to
do the following:
1. Delete the array.
2. Recreate the array and its logical drives.
3. Restore the data from backup media.

* The alternative is to take the entire logical drive offline, thus resulting in the loss
of all data contained on that logical drive.

* To minimize the risk of lost data, be sure to schedule frequent periodic backups.

Exception removing timer from active queue

Explanation:

* There is no configuration on any of the physical drives that are attached to the
controller.

* There are no physical drives attached to the controller.

* The controller does not support one or more features of the drive configuration.
Action:

If you have physical drives attached to the controller and the physical drives
contain a valid controller configuration, complete the following steps:

1. Verify that the controller, cables, and physical drives are installed properly.
2. Verify that there is power to the physical drives.

3. Retry the command.

4. If the command still fails, restart the server and retry the command.

If the problem persists, the configuration data has been lost. Reconfigure the
controller using the ServeRAID Manager.
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Set drive to defunct: controller [number], < device location>
Explanation:

The specified physical drive reported an unrecoverable media error.
Action:

Replace the specified physical drive.

Set drive to defunct: controller [number], < device location>
Explanation:

There was an error in communication between the physical drive and the
controller.

Action:
1. Verify that there is power to external enclosures and connections.
2. Verify that cables are properly seated.
3. Check for damaged, bent, or pushed pins on the following:
¢ Termination (for non-backplane systems)
* Backplanes
* Physical drives
¢ Controller

If you cannot identify a connection problem, the replacement order for parts is the
following:

1. Termination (for non-backplane systems)
Cables

Physical drives

Backplanes

A A

Controller

Before replacing a physical drive or controller, verify that it is updated with the
latest firmware (microcode) and that they still fail.

Note: If multiple physical drives are marked defunct within the same time period,
check the cables and backplanes.

Set drive to defunct: controller [number], < device location>
Explanation:

One of the following occurred:
* The user has removed or rearranged the specified physical drive.

e There was an error in communication between the physical drive and the
controller.

Action:
1. Verify that there is power to external enclosures and connections.
2. Verity that cables are properly seated.
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3. Check for damaged, bent, or pushed pins on the following:
* Termination (for non-backplane systems)
¢ Backplanes
* Physical drives
* Controller

If you cannot identify a connection problem, the replacement order for parts is the
following:

1. Termination (for non-backplane systems)
2. Cables

3. Physical drives
4. Backplanes
5. Controller

Before replacing a physical drive or controller, verify that it is updated with the
latest firmware (microcode) and that they still fail.

Note: If multiple physical drives are marked defunct within the same time period,
check the cables and backplanes.

Set drive to defunct: controller [number], < device location>
Explanation:

One of the following occurred:
* The user has removed or rearranged the specified physical drive.

* A controller might be configured with unattended mode. Changes to the RAID
configuration are accepted automatically in unattended mode.

¢ There was an error in communication between the physical drive and the
controller.

Note: (Clustering and failover environments only) If you move a logical drive to
another controller, these entries might be normal.

Action:
1. Verify that there is power to external enclosures and connections.
2. Verify that cables are properly seated.
3. Check for damaged, bent, or pushed pins on the following:
* Termination (for non-backplane systems)
¢ Backplanes
* Physical drives
* Controller

If you cannot identify a connection problem, the replacement order for parts is the
following;:

1. Termination (for non-backplane systems)
2. Cables

3. Physical drives
4. Backplanes
5. Controller
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Before replacing a physical drive or controller, verify that it is updated with the
latest firmware (microcode) and that they still fail.

Note: If multiple physical drives are marked defunct within the same time period,
check the cables and backplanes.

Set drive to defunct: controller [number], < device location>

Explanation:
The specified physical drive reported an unrecoverable hardware error.
Action:

Replace the specified physical drive.

Set drive to defunct: controller [number], < device location>

Explanation:
The controller failed.
Action:

Update the controller with the latest firmware (microcode). If the problem persists,
replace the controller.

Set drive to defunct: controller [number], < device location>
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Explanation:

* There was an error in communication between the physical drive and the
controller.

e The controller failed.

Action:
1. Verify that there is power to external enclosures and connections.
2. Verity that cables are properly seated.
3. Check for damaged, bent, or pushed pins on the following;:
¢ Termination (for non-backplane systems)
* Backplanes
* Physical drives
* Controller

If you cannot identify a connection problem, the replacement order for parts is the
following:

1. Termination (for non-backplane systems)
Cables

Physical drives

Backplanes

o k0N

Controller
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Before replacing a physical drive or controller, verify that it is updated with the
latest firmware (microcode) and that they still fail.

Note: If multiple physical drives are marked defunct within the same time period,
check the cables and backplanes.

Set drive to defunct: controller [number], < device location>
Explanation:

The specified physical drive does not match the valid configuration signature after
the configuration was imported from the physical drives.

Action:

Do one of the following:
* Rebuild the critical array.
¢ Remove the specified physical drive.

Set drive to defunct: controller [number], < device location>
Explanation:

There was an error in communication between the physical drive and the
controller while the controller was attempting to validate the RAID configuration
of the physical drive.

Action:
1. Verify that there is power to external enclosures and connections.
2. Verify that cables are properly seated.
3. Check for damaged, bent, or pushed pins on the following:
* Termination (for non-backplane systems)
* Backplanes
* Physical drives
* Controller

If you cannot identify a connection problem, the replacement order for parts is the
following:

1. Termination (for non-backplane systems)
2. Cables

3. Physical drives
4. Backplanes
5. Controller

Before replacing a physical drive or controller, verify that it is updated with the
latest firmware (microcode) and that they still fail.

Note: If multiple physical drives are marked defunct within the same time period,
check the cables and backplanes.
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Set drive to defunct: controller [number], < device location>
Explanation:

A user used the operating-system utilities to mark the specified physical drive
defunct.

Action:

Rebuild the critical array.

Set drive to defunct: controller [number], < device location>
Explanation:

The specified physical drive is not part of a valid configuration but was found in a
cluster setup.

Action:

Rebuild the specified physical drive into an array. If you cannot rebuild the
physical drive, replace or remove the physical drive.

Set drive to defunct: controller [number], < device location>
Explanation:

The specified physical drive is not part of a valid configuration but was found in a
cluster setup.

Action:

Rebuild the specified physical drive into an array. If you cannot rebuild the
physical drive, replace or remove the physical drive.

Set drive to defunct: controller [number], < device location>
Explanation:

The specified physical drive is configured as part of another system.
Action:

Rebuild the specified physical drive into an array on this system. If you cannot
rebuild the physical drive, replace the physical drive.

Set drive to defunct: controller [number], < device location>
Explanation:

The specified channel or port is not working.

Action:
1. Verify that there is power to external enclosures and connections.
2. Verify that cables are properly seated.

244  ServeRAID Management Installation and User's Guide



3. Check for damaged, bent, or pushed pins on the following:
* Termination (for non-backplane systems)
¢ Backplanes
* Physical drives
* Controller

If you cannot identify a connection problem, the replacement order for parts is the
following:

1. Termination (for non-backplane systems)
2. Cables

3. Physical drives
4. Backplanes
5. Controller

Before replacing a physical drive or controller, verify that it is updated with the
latest firmware (microcode) and that they still fail.

Note: If multiple physical drives are marked defunct within the same time period,
check the cables and backplanes.

This event log entry is informational.
Explanation:

None required.
Action:

None required.
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Appendix A. Operating systems supported by ServeRAID

Manager

This topic provides information about the operating systems supported by the
ServeRAID Manager task.

Management-server support

This task is supported by IBM Director Server when installed on servers running
the following operating systems:

* Linux on xSeries

* Windows

Managed-object support

The following tables list the operating systems that this task supports for managed
objects. Managed objects can include IBM xSeries, iSeries , System p5 and pSeries,
and System z9 and zSeries hardware. Managed systems are a subset of managed
objects that use different levels of IBM Director support. This task can be used on
Level-2 managed systems only. These systems must be xSeries and Netfinity®
servers.

Table 1. Operating systems supported by xSeries servers and third-party Intel-based
systems

Operating system Level 2

Editions of Windows for 32-bit systems:

¢ Windows 2000, Advanced Server and Server Editions Yes
¢ Windows Server 2003 Standard Edition
* Windows Server 2003 Enterprise Edition

¢ Windows 2000 Professional Edition No
¢ Windows 2000 Datacenter Edition

¢ Windows XP Professional Edition

* Windows Server 2003 Web Edition

¢ Windows Server 2003 Datacenter Edition

Editions of Windows for 64-bit systems:

* Windows Server 2003 Standard x64 Edition Yes
* Windows Server 2003 Enterprise x64 Edition
* Windows XP Professional x64 Edition No

¢ Windows Server 2003 Web x64 Edition
¢ Windows Server 2003 Datacenter x64 Edition
* Windows Server 2003, Datacenter and Enterprise 64-bit Itanium Editions

Versions of Linux for 32-bit systems:

* Red Hat Enterprise Linux AS, ES, and WS, version 3.0 Yes
* Red Hat Enterprise Linux AS, ES, and WS, version 4.0

» SUSE LINUX Enterprise Server 8 for x86

» SUSE LINUX Enterprise Server 9 for x86

¢ VMware ESX Server, versions 2.1, 2.5, and 2.51, Console

* VMware ESX Server, versions 2.1, 2.5, and 2.51, guest operating systems

* VMware GSX Server, versions 3.1 and 3.2, Console No
* VMware GSX Server, versions 3.1 and 3.2, guest operating systems
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Table 1. Operating systems supported by xSeries servers and third-party Intel-based
systems (continued)

Operating system Level 2

Versions of Linux for 64-bit systems:

* Red Hat Enterprise Linux AS, ES, and WS, version 3.0, for AMD64 and Yes
EM64T

* Red Hat Enterprise Linux AS, ES, and WS, version 4.0, for AMD64 and
EM64T

» SUSE LINUX Enterprise Server 8 for AMD64

» SUSE LINUX Enterprise Server 9 for AMD64 and EM64T

* Red Hat Enterprise Linux AS, version 3.0, for Intel Itanium No
* Red Hat Enterprise Linux AS, version 4.0, for Intel Itanium

» SUSE LINUX Enterprise Server 8 for Itanium Processor Family
» SUSE LINUX Enterprise Server 9 for Itanium Processor Family

Other operating systems supported by xSeries servers:

Microsoft Virtual Server (guest operating system) No

NetWare, version 6.5 Yes

Table 2. Operating systems supported by iSeries servers and System p5 and pSeries

servers
Operating system Level 2
e AIX 5L, Version 5.2 No

e AIX 5L, Version 5.3

* i5/0S, Version 5 Release 3

* Red Hat Enterprise Linux AS, version 3.0, for IBM POWER
Note: System p5 and pSeries servers require Red Hat Enterprise Linux AS,
version 3.3 or later, for IBM POWER

* Red Hat Enterprise Linux AS, version 4.0, for IBM POWER

» SUSE LINUX Enterprise Server 8 for IBM POWER

» SUSE LINUX Enterprise Server 9 for IBM POWER

Table 3. Operating systems supported by System z9 and zSeries servers

Operating system Level 2

* Red Hat Enterprise Linux AS, version 4.0, for IBM System z9, zSeries and No
5/390

» SUSE LINUX Enterprise Server 9 for IBM System z9, zSeries and S/390
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Appendix B. Glossary

A

alien array

A partially configured array, usually created as a result of an error during the array
creation process, such as a power failure.

array

Two or more physical drives combined for increased capacity, speed, or fault
tolerance. Once created, an array is configured as one or more logical drives. The
operating system in the server recognizes a logical drive as a single drive.

auto-synchronization

Synchronization on RAID level-6, level-5, level-5E, level-50, and level-60 drives that
is automatically initiated when the logical drives are created. This type of
synchronization works in the background. The ServeRAID-8i controller and
ServeRAID-7t controller also support auto-synchronization on RAID level-1 and
level-10 logical drives.

battery-backup cache

Buffer storage that protects data during write-back operations; in the event of a
power failure, it preserves the data in the controller cache.

BIOS-compatibility mapping - Extended
An option of BIOS compatibility mapping. When the BIOS compatibility mapping

is set to Extended, the ServeRAID controller BIOS is aware that the operating
system supports 8 GB or smaller physical drives.

BIOS-compatibility mapping - Limited
An option of BIOS compatibility mapping. When the BIOS compatibility mapping
is set to Limited, the ServeRAID controller BIOS is aware that the operating

system supports 2 GB or smaller physical drives. This enables the user to migrate
data from older PCI or Micro Channel adapters.

BIOS-compatibility mapping
A ServeRAID controller setting with two options: Limited and Extended. The
default value is Extended.

block

A data unit created when data is striped across physical drives.

blocked

The blocked state is reserved for RAID level-0 logical drives that are part of the
same array as one or more of the following:
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* A RAID level-1 logical drive
* A RAID level-1E logical drive
* A RAID level-5 llogical drive

If a physical drive in such an array fails, the RAID level-0 logical drives enter the
offline state, while the other logical drives enter the critical state.

After you replace the failed physical drive, a rebuild operation starts and
reconstructs the data stored in any RAID level-1, level-1E, or level-5 logical drives;
at the same time, the RAID level-0 logical drives enter the blocked state. RAID
level-0 logical drives cannot be rebuilt, since they do not contain redundant data.

After the rebuild operation is completed, you can unblock the RAID level-0 logical
drives and access them once again. However, the logical drive might contain
damaged data. You must re-create, reinstall, or restore the data from the most
recent backup disk or tape to the RAID level-0 logical drive.
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cluster

In ServeRAID Manager technology, two independent computer systems organized
into a network for the purpose of sharing resources and communicating with each
other. A cluster provides fault-tolerance at the server level.

compaction

The process by which a RAID level-5EE logical driveutilizes the distributed spare
drive in the event of a physical drive failure. After the data is reconstructed, the
original array undergoes compaction and the distributed spare drive becomes part
of the new array.

compression

The process by which a RAID level-5E logical drive utilizes the distributed spare
drive in the event of a physical drive failure. After the data is reconstructed, the
original array undergoes compression and the distributed spare drive becomes part
of the new array.

controller

A device that coordinates and controls the operation of one or more input/output
devices, such as workstations, and synchronizes the operation of such devices with
the operation of the system as a whole.

controller names

In a cluster or failover pair, the unique names that identify the members of the pair
to one another.

copy back

A method of restoring a logical drive’s original configuration after replacing a
failed drive in an array. Copy back restores the data to its original location, before
the logical drive was rebuilt from its spare.
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critical

The state of a RAID level-1, level-1E, level-5, level-5E, level-5EE, level-10, level-1EQ,
or level-50 logical drive that contains a defunct drive. A RAID level-6 or level-60
logical drive with two defunct drives is also in the critical state. If a critical logical
drive sustains another drive failure the data cannot be recovered.

data mirroring

A technique that creates a single logical drive from two physical drives. All data
written to the logical drive is written to both physical drives, creating a pair of
physical drives containing exactly the same data.

data scrubbing

A feature that provides automatic, continuous synchronization during system use.
This features works in the background, and ensures that the redundant data
and/or parity is correct.

data striping

A technique that divides a logical drive into data blocks, called stripes, which are

then distributed over the physical drives. The layout is such that a sequential read
of data on the logical drive results in parallel reads to each of the physical drives,
resulting in improved performance.

decompression

The process by which a compressed array returns to its original striping scheme,
after a failed drive is replaced in a RAID level-5E logical drive. Contrast with

ompression|

defunct

A physical-drive state in which the ServeRAID controller cannot communicate
properly with the drive.

distributed spare drive

In the RAID level-5E, the logical drive designated as a spare drive. Because this
spare drive is spread over several physical drives, it is described as distributed.

enclosure

A direct-attached or network-attached storage expansion unit, such as the IBM
Netfinity EXP300 or IBM TotalStorage DS300, that contains disk drives.

expansion

The process by which a compacted array returns to its original striping scheme,
after a failed drive is replaced in a RAID level-5EE logical drive. Contrast with

ompactio
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fault tolerance

The ability of a computer system to operate correctly even though one or more of
its component parts are malfunctioning.

firmware

Proprietary code that is usually delivered as microcode as part of an operating
system. Firmware is more efficient than software loaded from an alterable medium
and more adaptable to change than pure hardware circuitry. An example of
firmware is the Basic Input/Output System (BIOS) in read-only memory (ROM) on
a PC motherboard.

FlashCopy

A point-in-time capture of logical drive data on a networked storage device. As
new data are written to the original logical drive, the FlashCopy view captures the
changes. If an error occurs in the original logical drive, you can roll-back the
logical drive to the point when the FlashCopy was created.

FlashCopy virtual size

For a FlashCopy backup of logical drive data, the virtual size is the maximum size
that the FlashCopy can grow to. The virtual size equals the size of the FlashCopy
source drive. The actual size of a FlashCopy backup starts at 10% of the FlashCopy
source. As new data are written to the source drive, the FlashCopy backup grows
to the size of FlashCopy source.

foreign array

An array with exported data, allowing the drives and RAID configuration to be
transferred to another enclosure.

free space
The space in an array currently not assigned to a logical drive.

GB

When referring to hard-disk-drive capacity, GB means 1 000 000 000 bytes, or 1000
MB. Total user-accessible capacity may vary depending on operating environment.
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high availability
A system designed and implemented with components that satisfy the system

functional requirements, but also has hardware and software component
redundancy to eliminate any unexpected behavior.

hot add

To add and configure a new ServeRAID controller while the server is operational.
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hot-pluggable

Pertaining to a system in which components can be added while the system is
running.

hot-spare drive

A physical drive that is defined for automatic use when a similar drive fails.

hot-swap rebuild

An operation that is started by the ServeRAID controller when it detects that a
physical drive that is part of an array and in the defunct state has been removed
and replaced on a SCSI cable or backplane.

hot-swappable

Pertaining to a component that can be removed and/or replaced while the system
is running.

Impacted

A RAID level-6, level-5, level-5EE, level-50, or level-60 logical drive moves to the
Impacted state if a drive fails during initialization or the initialization process is
stopped before it completes. This may occur during auto-synchronization or data
scrubbing (with background synchronization). In an Impacted drive, the
striping/synchronization process has not completed and you need to
resynchronize.

Note: A RAID level-1, level-1E, or level-10 logical drive moves to the Impacted
state during its initial build. When the build is complete, it returns to the
okay state.

integrated RAID controller

An integrated SCSI controller with RAID capabilities, such as the LSI 1020 and LSI
1030. Integrated RAID controllers are standard features on some IBM xSeries
servers. They can be used to create a RAID level-1 logical drive from two physical
drives. You can configure one additional physical drive as a hot spare drive.

initialize logical drive
To prepare a logical drive for use by erasing the first 1024 sectors on a drive. For
the ServeRAID-7t and ServeRAID-8i controllers, initialization clears the entire
drive. Initialization prevents access to any data previously stored on the drive.

initiator identifiers
The SCSI initiator IDs assigned to a cluster or failover pair.

IPSSEND command-line program

An advanced command-line program that can be used to manage your ServeRAID
controllers. It can be used to configure your controller, isolate and debug problems,
recover from errors, and to copy controller configurations from one server to
another.
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logical drive

A grouping of physical drives that the operating system recognizes as a single
drive.

logical-drive migration
To add or remove physical drives from an existing array, to change RAID levels,
change logical-drive size, or effect an increase in free space.

LSI 1030 controller
See fintegrated RAID controller|

management station

A system or server with a network-attached storage enclosure. After you install the
management station software on that system, you can monitor and configure the
enclosure from a ServeRAID Manager console.

When referring to physical-drive capacity, MB means 1 000 000 bytes. Total
user-accessible capacity may vary depending on operating environment.

merge-group number

In a clustering configuration, the numbers that identify each logical drive.
Non-shared logical drives are assigned merge-group numbers of either 206 or 207;
shared logical drives need unique merge-group numbers, so that they can be
identified even if they move to the other server.

merge-group state

In a clustering environment, whether or not a logical drive is shared.

migrating
The state of a logical drive undergoing a logical-drive migration.

mirror role

The role assigned to the two physical drives that an integrated RAID controller
uses to create a RAID level-1 logical drive. When the logical drive is created, data
is copied from the primary physical drive to the secondary physical drive. Any
data on the secondary drive is destroyed.

network-attached storage

An external storage enclosure with an embedded RAID controller, such as the IBM
DS400. You can monitor and configure network-attached storage from a ServeRAID
Manager console if the enclosure is connected to a [management station|
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Notification Manager

A tool used to notify remote systems of events, problems, and configuration
changes occurring on a local system.

offline
A logical drive state in which the logical drive is inaccessible.

okay

A logical drive state in which the logical drive is functional.

online

A physical-drive state in which the physical drive is functioning properly and is
part of an array.

parity
The data stored on a RAID level-5, level-5E, level-5EE, or level-50 logical drive that

can be used, in conjunction with the data on the remaining drives, to recreate a
failed physical drive’s data.

parity block

In a RAID level-5, level-5E, or level-50 logical drive, a data unit that contains a
representation of the data from other blocks in the same stripe.

partner name

In a cluster or failover pair, one of the two controller names entered during
configuration.

physical drive
A hard disk drive.

PFA

Predictive Failure Analysis event that announces the physical drive is about to fail.

plug-in
A "plug-in,” as referred to in ServeRAID Manager Assist, specifically refers to IBM
Director.

POST

Power-on self-test. During POST, the ServeRAID controller compares the stored
configuration information to the configuration that is actually present. If a
discrepancy exists, one or more status messages appear after the POST completes
but before the operating system loads.
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preferred owner

In a dual controller enclosure, the controller to which an array is originally
assigned. If the preferred owner fails (due to a hardware problem, for example),
the array automatically moves to the other controller (fail over). The ServeRAID
Manager allows you to restore the array to its preferred owner with
Intentionally moving an array to different controller in the enclosure changes its
preferred owner.

quorum drive

In the Microsoft Clustering Solution, a logical drive that stores the quorum
resource information.
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restore to factory-default settings

An action that restores all parameters in the controller to the factory-default
settings. If logical drives are defined, the data stored on them will be lost.

rack enclosure
See fenclosure]

RAID

A technology of grouping several physical drives in a computer into an array that
you can define as one or more logical drives. Each logical drive appears to the
operating system as a single drive. This grouping technique greatly enhances
logical-drive capacity and performance beyond the physical limitations of a single
physical drive.

RAID level-0

A RAID level that uses data striping to distribute data evenly across physical
drives. While it enables full utilization of physical drive capacity and performance
acceleration, RAID level- 0 provides neither fault tolerance nor redundancy.

RAID level-1

A RAID level that uses data mirroring to distribute data across two physical
drives. It provides data redundancy and performance acceleration, although the
usable physical drive space is reduced by 50 percent.

RAID level-1E

A RAID level that uses both data striping and data mirroring to distribute data
across three or more physical drives. Data is striped across each disk in the array;
the first set of stripes are the data stripes, and the second sets of stripes are mirror
copies of the first stripe, shifted one drive. It provides data redundancy and
performance acceleration, although the usable physical drive space is reduced by
50 percent.

ServeRAID Management Installation and User's Guide



RAID level-5

A RAID level that uses data striping and block interweaving to distribute data
across three or more physical drives. It provides full data protection and
performance acceleration, although only 67-94% of physical drive storage capacity
can be used.

RAID level-5E

A RAID level that uses data striping and block interweaving to distribute data
across four or more physical drives; it uses some space on each physical drive as a
distributed hot-spare. It provides full data protection and performance acceleration,
although only 50-88% of physical drive storage capacity can be used.

RAID level-5EE

A RAID level that uses data striping and block interweaving to distribute data
across four or more physical drives. Like it uses a distributed
hot-spare but offers faster rebuild times. It provides full data protection and
performance acceleration, although only 50-88% of physical drive storage capacity
can be used.

RAID level-6

A RAID level that uses data striping and block interweaving to distribute data
across four or more physical drives. It is similar to RAID level-5 but with two sets
of parity instead of one. The second set of parity information improves fault
tolerance. RAID level-6 can handle two simultaneous drive failures, where other
single RAID levels can handle, at most, only one.

RAID level-x0

Refers to RAID level-00, level-10, level-1EO, and level-50. These RAID levels use
spanned arrays (array of arrays) to enable the use of up to 60 physical drives.
RAID level-00 provides no data redundancy, but provides performance acceleration
and allows 100% of the physical drive storage capacity to be used. RAID levels -10,
-1E, and -50 provide full data protection, performance acceleration, and greater
reliability, although only 67-94% of physical drive storage capacity can be used.

RAID signature

A small segment on each physical disk in a RAID configuration that stores
information about drives and arrays.

read-ahead cache mode

A ServeRAID controller setting that determines whether the ServeRAID controller
transfers data from disk to its local cache in increments equal to the stripe-unit size
or the system I/O requests. The options are enabled, disabled, and adaptive; the
default value is adaptive.

read-ahead cache mode - Adaptive

The default value of the read-ahead cache mode. When the read-ahead cache mode
is set to adaptive, the ServeRAID controller continually reevaluates whether to set
the read-ahead cache mode to enabled or disabled.
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read-ahead cache mode - Disabled

An option of the read-ahead cache mode. When the read-ahead cache mode is
disabled, the ServeRAID controller transfers data from the logical drive to its local
cache in increments equal to the system 1/O request size. This optimizes
performance when the workload is random or the system I/O requests are smaller
than the stripe-unit size.

read-ahead cache mode - Enabled

An option of the read-ahead cache mode. When the read-ahead cache mode is
enabled, the ServeRAID controller transfers data from the logical drive to its local
cache in increments equal to the stripe-unit size. This optimizes performance when
workloads are steady and sequential.

ready

A physical-drive state in which the drive is available for definition.

rebuild

An operation to reconstruct data after the problem that caused a physical drive to
become defunct has been resolved.

rebuild rate
The speed (high, medium, or low) at which a rebuild operation will occur.

rebuilding

The state of a physical drive undergoing a rebuild operation.

recurring task

Alscheduled task|that runs periodically according to the interval you choose: the
same time each day, each week, or each month.

ROM Update wizard

A program that updates the BIOS and firmware codes on ServeRAID controller.
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ServeRAID Manager Mini-configuration program

A program that allows the user to display the ServeRAID controller settings, and
to perform a limited set of configuration functions without using the IBM
ServeRAID Support CD.

SAF-TE

A processor that manages small computer system interface (SCSI) accessed
fault-tolerant enclosures (SAF-TE). An example of such an enclosure is the IBM
Netfinity EXP15.

scheduled task

A technique that allows you to start a lengthy operation at a convenient time, such
as allogical drive migration| or [synchronizing a logical drive]
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SCSI

See [small computer system interfacel

SCSI initiator ID

In a failover or clustering environment, the ID assigned to a SCSI controller. Each
ServeRAID controller and its partner must have different SCSI initiator IDS; one
must be 6 and the other 7.

SCSil-transfer speed

The speed at which data can be transferred between a physical drive and the
ServeRAID controller.

segment

Disk drive or portion of a disk drive used to create a logical drive. A disk can
include RAID segments and available segments. A RAID segment is part of a
logical drive; it can be used by only one logical drive at a time. Available segments
can be used to define a new logical drive. If the disk is not part of any logical
drive, the entire disk is an available segment.

ServeRAID Manager

A program used to configure ServeRAID controllers, view the ServeRAID Manager
configuration, create arrays and logical drives, delete arrays, dynamically increase
the logical-drive size, change RAID levels, and more.

shared drives

The physical drives controlled by a cluster or failover pair.

small computer system interface

A standard hardware interface that enables a variety of peripheral devices to
communicate with one another.

spanned array

An array of arrays. Used in RAID level-00, level-10, level-1EQ, and level-50 to
permit the use of larger numbers of physical drives. The spanned array contains
arrays, each of which contains a sub-logical drive, which can be RAID level-0,
level-1, level-1E, or level-5. The RAID-level for the logical drive contained within
the spanned array is 0.

standby hot spare

A hot-spare physical drive that the ServeRAID controller has spun down. If an
online drive becomes defunct and no suitable hot-spare drive is available, a
standby drive of the appropriate size automatically spins up and enters the rebuild
state.

stripe-unit size
The granularity at which data is stored on one drive of the array before subsequent
data is stored on the next drive of the array. The performance of a ServeRAID
controller is maximized if the stripe-unit size is close to the size of the system
input/output requests.
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stripes

The collection of stripe units, from the first to last drive of the array.

sub-logical drive

In a RAID level-x0 configuration, a logical drive contained within each array of the
spanned array. A sub-logical drive can be RAID level-0, level-1, level-1E, or level 5.

Synchronize

The process of recalculating and rewriting either redundant data (RAID level-1,
level-1E, level-10, and level-1EO logical drives) or parity (RAID level-5, level-5E,
and level-50 logical drives).

throughput

The speed at which data can be moved from one place to another, usually
expressed in MB per second.

unattended mode

A ServeRAID controller setting that determines how the BIOS handles failures

during system startup. The settings are enabled and disabled; the default value is
disabled.

unattended mode -- Disabled

A setting of the unattended mode. When the unattended mode is disabled and the
BIOS detects a failure, the system stops at the recovery option screen and waits for
the user to respond.

unattended mode -- Enabled

A setting of the unattended mode. When the unattended mode is enabled and the
BIOS detects a failure, the system waits for 30 seconds for the user to respond to
the recovery options screen. Then, the BIOS automatically selects an appropriate
option and continues the system startup process. Unattended mode must be
enabled in a clustering environment.

write-cache mode

A ServeRAID controller setting that determines whether the controller writes data
to the physical drive before or after sending a confirmation to the operating
system. The settings are write back and write through.

write-cache mode -- Write-back

A setting of the write-cache mode. When the write-cache mode is set to write back
and the operating system sends data to the controller, the controller sends a
confirmation back to the operating system before actually writing the data to a
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storage device. This increases performance, but, if a battery-backup cache is not
used, increases the risk of data loss in the event of a power failure.

write-cache mode -- Write-through

A setting of the write-cache mode. When the write-cache mode is set to write
through and the operating system sends data to the controller, the controller writes
the data to a storage device before sending a confirmation to the operating system.
This mode decreases performance, but does not risk data loss.
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Appendix C. Notices
This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
US.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing

2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.
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IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation
MWO9A /050

5600 Cottle Road
San Jose, CA 95193
US.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Trademarks

The following terms are trademarks of International Business Machines
Corporation in the United States, other countries, or both:

AIX

AIX 5L

Alert on LAN
Asset ID
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BladeCenter

DB2

DB2 Universal Database
DirMaint

Electronic Service Agent
Enterprise Storage Server
eServer

eServer logo

FlashCopy
HiperSockets

i5/0S

IBM

IBM logo

ibm.com

IntelliStation

iSeries

Netfinity

NetServer

NetView

0S/400

POWER

Predictive Failure Analysis
pSeries

RACF

Redbooks

ServeProven

SurePOS

System p5

System z9

Tivoli

Tivoli Enterprise

Tivoli Enterprise Console
Virtualization Engine
Wake on LAN

xSeries

z/VM

zSeries

Intel and Pentium are trademarks of Intel Corporation in the United States, other
countries, or both.

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Sun Microsystems, Inc. in the United States, other countries, or both.

Linux is a trademark of Linus Torvalds in the United States, other countries, or
both.
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Microsoft, Windows, and Windows NT are trademarks of Microsoft Corporation in
the United States, other countries, or both.

Red Hat and all Red Hat-based trademarks and logos are trademarks or registered
trademarks of Red Hat, Inc., in the United States and other countries.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Other company, product, or service names may be trademarks or service marks of
others.
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Abbreviations, Acronyms, and Glossary

Abbreviation and acronym list

This topic lists abbreviations and acronyms used
in the IBM Director documentation.

Table 4. Abbreviations and acronyms used in IBM

Director documentation

Table 4. Abbreviations and acronyms used in IBM
Director documentation (continued)

Abbreviation or

Abbreviation or

acronym Definition

AES advanced encryption standard

APAR authorized program analysis
report

ASF Alert Standard Format

ASM Advanced System

Management

ASM PCI Adapter

Advanced System
Management PCI Adapter

BIOS basic input/output system

CEC Central Electronics Complex

CIM Common Information Model

CIMOM Common Information Model
Object Manager

CP control program

CRC cyclic redundancy check

CSM IBM Cluster Systems
Management

Csv comma-separated value

DASD direct access storage device

DBCS double-byte character set

DES data encryption standard

DHCP Dynamic Host Configuration
Protocol

DIMM dual inline memory module

DMI Desktop Management
Interface

DMTF Distributed Management Task
Force

DNS Domain Name System

DSA Digital Signature Algorithm

EEPROM electrically erasable
programmable read-only
memory

FRU field-replaceable unit

acronym Definition

FTMI fault tolerant management
interface

FTP file transfer protocol

GB gigabyte

Gb gigabit

GMT Greenwich Mean Time

GUI graphical user interface

GUID globally unique identifier

HMC Hardware Management
Console

HTML hypertext markup language

1Is Microsoft Internet Information
Server

170 input/output

P Internet protocol

1PC interprocess communication

IPMI Intelligent Platform
Management Interface

1PX internetwork packet exchange

ISDN integrated services digital
network

ISMP integrated system
management processor

JVM Java™" Virtual Machine

JCE Java Cryptography Extension

JDBC Java Database Connectivity

JEC Java Foundation Classes

JRE Java Runtime Environment

KB kilobyte

Kb kilobit

kpbs kilobits per second

KVvM keyboard/video/mouse

LAN local area network

LED light-emitting diode

LPAR logical partition

MAC media access control
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Table 4. Abbreviations and acronyms used in IBM
Director documentation (continued)

Table 4. Abbreviations and acronyms used in IBM
Director documentation (continued)

Abbreviation or

Abbreviation or
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acronym Definition acronym Definition
MB megabyte SAS Serial Attached SCSI
Mb megabit SATA Serial ATA
Mbps megabits per second SCSI Small Computer System
MD5 message digest 5 Interface
MDAC Microsoft Data Access Control SFS shared file system
MHz megahertz SHA Secure Hash Algorithm
MIB Management Information SI Solution Install
Base SID (1) security identifier (2)
MIF Management Information Oracle system identifier
Format SLP service location protocol
MMC Microsoft Management SLPD service location protocol
Console daemon
MPA Management Processor SMBIOS System Management BIOS
Assistant SMI System Management
MPCLI Management Processor Information
Command-Line Interface SMP symmetric multiprocessor
MSCS Microsoft Cluster Server SMS Systems Management Server
MST Microsoft sgftware SMTP Simple Mail Transfer Protocol
transformation
ART 1f- itoring, Analysi
NIC network interface card SM ;chﬁ?ﬁét%sﬁﬁolggyym and
NNTP Network News Transfer SMILS Storage Management
Protocol Initiative Specification
NTP network time protocol SNMP Simple Network Management
NVRAM nonvolatile random access Protocol
memory SPB software package block
ODBC Open DataBase Connectivity SQL Structured Query Language
OID object ID SSH Secure Shell
bl Penpheral component SSL Secure Sockets Layer
interconnect
TAP Tel Alph i
OSA Open Systems Adapter Pio(‘zzii)olr phanumeric
PCI-X Petripheral ctomforliergc TCP/IP Transmission Control
1nterconnect-extende Protocol/Internet Protocol
PDF Portable Document Format TTL time to live
PFA Predictive Failure Analysis® UDP User Datagram Protocol
POST power-on self-test UID unique ID
PTF program temporary fix UIM upward integration module
RAM random access memory UNC universal naming convention
RDM Remote Deployment Manager USB Universal Serial Bus
RPM (1) Red Ha.t Package Manager UuUID universal unique identifier
(2) revolutions per minute
RSA Rivest-Shamir-Adleman vPD vital product data
RXE Remote Expansion Enclosure




Table 4. Abbreviations and acronyms used in IBM
Director documentation (continued)

Abbreviation or

acronym Definition

VMRM Virtual Machine Resource
Manager

VRM voltage regulator module

WAN wide area network

WM Wired for Management

WINS Windows Internet Naming
Service

WMI Windows Management
Instrumentation

WQL Windows Management
Instrumentation Query
Language

XML extensible markup language

Glossary

This glossary includes terms and definitions from:

* The American National Dictionary for Information
Systems, ANSI X3.172-1990, copyright 1990 by
the American National Standards Institute
(ANSI). Copies may be purchased from the
American National Standards Institute, 1430
Broadway, New York, New York 10018.
Definitions are identified by the symbol (A)
after the definition.

* The Information Technology Vocabulary developed
by Subcommittee 1, Joint Technical Committee
1, of the International Organization for
Standardization and the International
Electrotechnical Committee (ISO/IEC
JTC1/SC1). Definitions of published parts of
this vocabulary are identified by the symbol (I)
after the definition; definitions taken from draft
international standards, committee drafts, and
working papers being developed by ISO/IEC
JTC1/SC1 are identified by the symbol (T) after
the definition, indicating that final agreement
has not yet been reached among the
participating National Bodies of SC1.

* The IBM Dictionary of Computing, New York:
McGraw-Hill, 1994.

* The IBM Glossary of Computing Terms, 1999.

To view other IBM glossary sources, see IBM
Terminology at [www.ibm.com/ibm/terminology]

A

Advanced Encryption Setting (AES)
A block cipher algorithm, also known as
Rijndael, used to encrypt data transmitted
between managed systems and the
management server, which employs a key
of 128, 192, or 256 bits. AES was
developed as a replacement for DES.

Advanced System Management (ASM)

interconnect
A feature of IBM service processors that
enables users to connect up to 24 servers
to one service processor, thus eliminating
the need for multiple modems,
telephones, and LAN ports. It provides
such out-of-band management functions
as system power control,
service-processor event-log management,
firmware updates, alert notification, and
user profile configuration.

Advanced System Management (ASM)

interconnect network
A network of IBM servers created by
using the ASM interconnect feature. The
servers are connected through RS-485
ports. When servers containing integrated
system management processors (ISMPs)
and ASM processors are connected to an
ASM interconnect network, IBM Director
can manage them out-of-band.

Advanced System Management (ASM) PCI

adapter
An IBM service processor that is built into
the Netfinity 7000 M10 and 8500R servers.
It also was available as an option that
could be installed in a server that
contained an ASM processor. When an
ASM PCI adapter is used with an ASM
processor, the ASM PCI adapter acts as an
Ethernet gateway, while the ASM
processor retains control of the server.
When used as a gateway service
processor, the ASM PCI adapter can
communicate with other ASM PCI
adapters and ASM processors only.

Advanced System Management (ASM)

processor
A service processor built into the
mid-range Netfinity and early xSeries
servers. IBM Director can connect
out-of-band to an ASM processor located
on an ASM interconnect; an ASM PCI
adapter, a Remote Supervisor Adapter, or

Abbreviations, Acronyms, and Glossary 269


http://www.ibm.com/ibm/terminology/

a Remote Supervisor II must serve as the
gateway service processor.

alert A message or other indication that
identifies a problem or an impending
problem.

alert forwarding
Alert forwarding can ensure that alerts
are sent, even if a managed system
experiences a catastrophic failure, such as
an operating-system failure.

alert-forwarding profile
A profile that specifies where remote
alerts for the service processor should be
sent.

alert standard format (ASF)
A specification created by the Distributed
Management Task Force (DMTF) that
defines remote-control and alerting
interfaces that can best serve a client
system in an environment that does not
have an operating system.

anonymous command execution
Execution of commands on a target
system as either system account (for
managed systems running Windows) or
root (for managed systems running
Linux). To restrict anonymous command
execution, disable this feature and always
require a user ID and password.

ASF  See alert standard format.

ASM interconnect gateway
See gateway service processor.

association
(1) A way of displaying the members of a
group in a logical ordering. For example,
the Object Type association displays the
managed objects in a group in folders
based on their type. (2) A way to display
additional information about the members
of the group. For example, the Event
Action Plans association displays any
event action plans applied to the
managed objects in the group in an Event
Action Plan folder.

B

basic input/output system (BIOS)
The code that controls basic hardware
operations, such as interactions with
diskette drives, hard disk drives, and the
keyboard.
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BIOS See Basic Input/Output System.

blade server
An IBM @server BladeCenter server. A
high-throughput, two-way, Intel
Xeon-based server on a card that supports
symmetric multiprocessors {SMP}.

BladeCenter chassis
A BladeCenter unit that acts as an
enclosure. This 7-U modular chassis can
contain up to 14 blade servers. It enables
the individual blade servers to share
resources, such as the management,
switch, power, and blower modules.

bottleneck
A place in the system where contention
for a resource is affecting performance.

Cc

chassis
The metal frame in which various
electronic components are mounted.

chassis detect-and-deploy profile
A profile that IBM Director automatically
applies to all new BladeCenter chassis
when they are discovered. The profile
settings include management module
name, network protocols, and static IP
addresses. If Remote Deployment
Manager (RDM) is installed on the
management server, the chassis
detect-and-deploy profile also can include
deployment policies.

CIM  See Common Information Model.

Common Information Model (CIM)
An implementation-neutral,
object-oriented schema for describing
network management information. The
Distributed Management Task Force
(DMTF) develops and maintains CIM
specifications.

component association
In the IBM Director Rack Manager task, a
function that can make a managed system
or device rack-mountable when the
inventory collection feature of IBM
Director does not recognize the managed
system or device. The function associates
the system or device with a predefined
component.



D

Data Encryption Standard (DES)
A cryptographic algorithm designed to
encrypt and decrypt data using a private
key.

database server
The server on which the database
application and database used with IBM
Director Server are installed.

deployment policy
A policy that associates a specific bay in a
BladeCenter chassis with an RDM
noninteractive task. When a blade server
is added to or replaced in the bay, IBM

Director automatically runs the RDM task.

DES  See Data Encryption Standard.

Desktop Management Interface (DMI)
A protocol-independent set of application
programming interfaces (APIs) that were
defined by the Distributed Management
Task Force (DMTF). These interfaces give
management application programs
standardized access to information about
hardware and software in a system.

Diffie-Hellman key exchange
A public, key-exchange algorithm that is
used for securely establishing a shared
secret over an insecure channel. During
Phase II negotiations, the Diffie-Hellman
group prevents someone who intercepts
your key from deducing future keys that
are based on the one they have.

digital signature algorithm (DSA)
A security protocol that uses a pair of
keys (one public and one private) and a
one-way encryption algorithm to provide
a robust way of authenticating users and
systems. If a public key can successfully
decrypt a digital signature, a user can be
sure that the signature was encrypted
using the private key.

discovery
The process of finding resources within
an enterprise, including finding the new
location of monitored resources that were
moved.

DMI  See Desktop Management Interface.

E

enclosure
A unit that houses the components of a

storage subsystem, such as a control unit,
disk drives, and power source.

event An occurrence of significance to a task or
system, such as the completion or failure
of an operation. There are two types of
events: alert and resolution.

event action
The action that IBM Director takes in
response to a specific event or events.

event-action plan
A user-defined plan that determines how
IBM Director will manage certain events.
An event action plan comprises one or
more event filters and one or more
customized event actions.

event-data substitution variable
A variable that can be used to customize
event-specific text messages for certain
event actions.

event filter
A filter that specifies the event criteria for
an event action plan. Events must meet
the criteria specified in the event filter in
order to be processed by the event action
plan to which the filter is assigned.

extension
See IBM Director extension.

F

field-replaceable unit (FRU)
An assembly that is replaced in its
entirety when any one of its components
fails. In some cases, a FRU may contain
other FRUs.

file-distribution server
In the Software Distribution task, an
intermediate server that is used to
distribute a software package when the
redirected-distribution method is used.

forecast
A function that can provide a prediction
of future performance of a managed
system using past data collected on that
managed system.

FRU  See field-replaceable unit.

G

gateway service processor
A service processor that relays alerts from
service processors on an Advanced
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System Management (ASM) interconnect
network to IBM Director Server.

group A logical set of managed objects. Groups
can be dynamic, static, or task-based.

GUID See Universal Unique Identifier.

IBM Director Agent
A component of IBM Director software.
When IBM Director Agent is installed on
a system, the system can be managed by
IBM Director. IBM Director Agent
transfers data to the management server
using several network protocols,
including TCP/IP, NetBIOS, and IPX.

IBM Director Console
A component of IBM Director software.
When installed on a system, it provides a
graphical user interface (GUI) for
accessing IBM Director Server. IBM
Director Console transfers data to and
from the management server using
TCP/1P.

IBM Director database
The database that contains the data stored
by IBM Director Server.

IBM Director environment
The complex, heterogeneous environment
managed by IBM Director. It includes
systems, BladeCenter chassis, software,
SNMP devices.

IBM Director extension
A tool that extends the functionality of
IBM Director. Some of the IBM Director
extensions are Capacity Manager,
ServeRAID Manager, Remote Deployment
Manager, Software Distribution.

IBM Director Server
The main component of IBM Director
software. When installed on the
management server, it provides basic
functions such as discovery of the
managed systems, persistent storage of
configuration and management data, an
inventory database, event listening,
security and authentication, management
console support, and administrative tasks.

IBM Director Server service
A service that runs automatically on the
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management server, and provides the
server engine and application logic for
IBM Director.

IBM Director service account
The Windows operating-system account
associated with the IBM Director Server
service.

in-band communication
Communication that occurs through the
same channels as data transmissions. An
example of in-band communication is the
interprocess communication that occurs
between IBM Director Server, IBM
Director Agent, and IBM Director
Console.

integrated system management processor

(ISMP)
A service processor built into the some
xSeries servers. The successor to the
Advanced System Management (ASM)
processor, the ISMP does not support
in-band communication in systems
running NetWare. For IBM Director
Server to connect out-of-band to an ISMP,
the server containing the ISMP must be
installed on an ASM interconnect
network. A Remote Supervisor Adapter or
a Remote Supervisor Adapter II must
serve as the gateway service processor.

interprocess communication (IPC)
1) The process by which programs
communicate data to each other and
synchronize their activities. Semaphores,
signals, and internal message queues are
common methods of interprocess
communication. 2) A mechanism of an
operating system that allows processes to
communicate with each other within the
same computer or over a network. It also
is called in-band communication

inventory-software dictionary
A file that tracks the software installed on
managed systems in a network.

IPC  See interprocess communication.

ISMP See integrated system management processor.

job A separately executable unit of work
defined by a user, and run by a computer.



L

Level-0 managed system
An IBM or non-IBM server, desktop
computer, workstation, or mobile
computer, that can be managed by IBM
Director but does not have any IBM
Director software installed on it.

Level-1 managed system
An IBM or non-IBM server, desktop
computer, workstation, and mobile
computer that has IBM Director Core
Services installed. IBM Director uses IBM
Director Core Services to communicate
with and administer the Level-2 managed
system. IBM Director Core Services
includes the SLP instrumentation, the IBM
Director Agent SLP service type, and
Common Information Model (CIM).

Level-2 managed system
An IBM or non-IBM server, desktop
computer, workstation, or mobile
computer that has IBM Director Agent
installed. IBM Director Agent provides
managed systems with the full
complement of IBM Director Agent
function that is used to communicate with
and administer the Level-2 managed
system. The function of a Level-2
managed system varies depending on the
operating system and platform.

light path diagnostics
A technology that provides a lighted path
to failed or failing components to
expedite hardware repairs.

MAC address
See media access control (MAC) address.

managed group
A group of systems or objects managed
by IBM Director.

managed object
An item managed by IBM Director. In
IBM Director Console, a managed object
is represented by an icon that shows its
type (such as chassis, cluster, system, or
scalable system, for example).

managed object ID
A unique identifier for each managed
object. It is the key value used by IBM
Director database tables.

managed system
A system that is being controlled by a
given system management application, for
example, a system managed by IBM
Director.

management console
A system (server, desktop computer,
workstation, or mobile computer) on
which IBM Director Console is installed.

management module
The BladeCenter component that handles
system-management functions. It
configures the chassis and switch
modules, communicates with the blade
servers and all I/O modules, multiplexes
the keyboard/video/mouse (KVM), and
monitors critical information about the
chassis and blade servers.

management server
The server on which IBM Director Server
is installed.

media access control (MAC) address
In a local area network, the protocol that
determines which device has access to the
transmission medium at a given time.

N

nonvolatile random-access memory (NVRAM)
Random access memory (storage) that
retains its contents after the electrical
power to the machine is shut off.

notification
See alert.

NVRAM
See nonvolatile random-access memory.

(o)

out-of-band communication
Communication that occurs through a
modem or other asynchronous
connection, for example, service processor
alerts sent through a modem or over a
LAN. In an IBM Director environment,
such communication is independent of
the operating system and interprocess
communication (IPC).

P

partition
See scalable partition.

PCI  See Peripheral Component Interconnect.
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PCI-X See Peripheral Component Interconnect-X.

Peripheral Component Interconnect (PCI)
A standard for connecting attached
devices to a computer.

Peripheral Component Interconnect-X (PCI-X)
An enhancement to the Peripheral
Component Interconnect (PCI)
architecture. PCI-X enhances the
Peripheral Component Interconnect (PCI)
standard by doubling the throughput
capability and providing additional
adapter-performance options while
maintaining backward compatibility with
PCI adapters.

PFA  See Predictive Failure Analysis.

physical platform
An IBM Director managed object that
represents a single physical chassis or
server that has been discovered through
the use of the Service Location Protocol
(SLP).

plug-in
A software module, often written by a
third party, that adds function to an
existing program or application such as a
Web browser. See IBM Director extension.

POST See power-on self-test.

power-on self-test
A series of internal diagnostic tests
activated each time the system power is
turned on.

Predictive Failure Analysis (PFA)
A scheduled evaluation of system data
that detects and signals parametric
degradation that might lead to functional
failures.

private key
1) In secure communication, an
algorithmic pattern used to encrypt
messages that only the corresponding
public key can decrypt. The private key is
also used to decrypt messages that were
encrypted by the corresponding public
key. The private key is kept on the user’s
system and is protected by a password. 2)
The secret half of a cryptographic key
pair that is used with a public key
algorithm. Private keys are typically used
to digitally sign data and to decrypt data
that has been encrypted with the
corresponding public key.
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public key
1) In secure communication, an
algorithmic pattern used to decrypt
messages that were encrypted by the
corresponding private key. A public key is
also used to encrypt messages that can be
decrypted only by the corresponding
private key. Users broadcast their public
keys to everyone with whom they must
exchange encrypted messages. 2) The
non-secret half of a cryptographic key
pair that is used with a public key
algorithm. Public keys are typically used
to verify digital signatures or decrypt
data that has been encrypted with the
corresponding private key.

R

redirected distribution
A method of software distribution that
uses a file-distribution server.

remote I/O enclosure
An IBM Director managed object that
represents an expansion enclosure of
Peripheral Component Interconnect-X
(PCI-X) slots, for example, an RXE-100
Remote Expansion Enclosure. The
enclosure consists of one or two
expansion Kkits.

Remote Supervisor Adapter
An IBM service processor. It is built into
some XxSeries servers and available as an
optional adapter for use with others.
When used as a gateway service
processor, the Remote Supervisor Adapter
can communicate with all service
processors on the Advanced System
Management (ASM) interconnect.

resolution
The occurrence of a correction or solution
to a problem.

resource-monitor threshold
The point at which a resource monitor
generates an event.

RXE Expansion Port
The dedicated high-speed port used to
connect a remote I/O expansion unit,
such as the RXE-100 Remote Expansion
Enclosure, to a server.



scalable node

A physical platform that has at least one
SMP Expansion Module. Additional
attributes are assigned to a physical
platform when it is a scalable node. These
additional attributes record the number of
SMP Expansion Modules, SMP Expansion
Ports, and RXE Expansion ports on the
physical chassis.

scalable object

An IBM Director managed object that is
used with Scalable Systems Manager.
Scalable objects include scalable nodes,
scalable systems, scalable partitions, and
remote I/O enclosures that are attached to
scalable nodes.

scalable partition

An IBM Director managed object that
defines the scalable nodes that can run a
single image of the operating system. A
scalable partition has a single, continuous
memory space and access to all associated
adapters. A scalable partition is the logical
equivalent of a physical platform. Scalable
partitions are associated with scalable
systems and comprise only the scalable
nodes from their associated scalable
systems.

scalable system

An IBM Director managed object that
consists of scalable nodes and the scalable
partitions that are composed of the
scalable nodes in the scalable system.
When a scalable system contains two or
more scalable nodes, the servers that they
represent must be interconnected through
their SMP Expansion Modules to make a
multinode configuration, for example, a
16-way xSeries 455 server made from four
scalable nodes.

Secure Sockets Layer (SSL)

A security protocol that provides
communication privacy. SSL enables
client/server applications to communicate
in a way that is designed to prevent
eavesdropping, tampering, and message
forgery.

Service Location Protocol (SLP)

In the Internet suite of protocols, a
protocol that identifies and uses network
hosts without having to designate a
specific network host name.

service processor

SLP

A generic term for Remote Supervisor
Adapters, Advanced System Management
processors, Advanced System
Management PCI adapters, and integrated
system management processors (ISMPs).
These hardware-based management
processors used in IBM Netfinity and
xSeries servers work with IBM Director to
provide hardware status and alert
notification.

See Service Location Protocol.

SMBIOS

See systems management BIOS.

SMP Expansion Module

An IBM xSeries hardware option. It is a
single module that contains
microprocessors, disk cache, random
access memory, and three SMP Expansion
Port connections. Two SMP Expansion
Modules can fit in a chassis.

SNMP Access and Trap Forwarding

An IBM Director Agent feature that
enables SNMP to access managed-system
data. When installed on a managed
system, this feature enables SNMP-based
managers to poll the managed system and
receive its alerts. If System Health
Monitoring is installed on the managed
system also, hardware alerts can be
forwarded as SNMP traps.

SNMP device

SQL
SSL

A network device, printer, or computer
that has an SNMP device installed or
embedded.

See Structured Query Language

See Secure Sockets Layer.

static partition

A view-only scalable partition.

sticky key

An input method that enables the user to
press and release a series of keys
sequentially (for example, Ctrl+Alt+Del),
yet have the keys behave as if they were
pressed and released at the same time.
This method can be used for those who
require special-needs settings to make the
keyboard easier to use.
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Structured Query Language (SQL)
A standardized language for defining and
manipulating data in a relational
database.

switch module
The BladeCenter component that provides
network connectivity for the BladeCenter
chassis and blade servers. It also provides
interconnectivity between the
management module and blade servers.

system
The computer and its associated devices
and programs.

System Health Monitoring
An IBM Director Agent feature that
provides active monitoring of critical
system functions, including system
temperatures, voltages, and fan speeds. It
also handles in-band alert notification for
managed systems running Windows and
some managed systems running Linux.

system variable
A user-defined keyword and value pair
that can be used to test and track the
status of network resources. System
variables can be referred to wherever
event-data substitution is allowed.

systems management BIOS (SMBIOS)

A key requirement of the Wired for
Management (WfM) 2.0 specification.
SMBIOS extends the system BIOS to
support the retrieval of management data
required by the WfM specification. To run
IBM Director Agent, a system must
support SMBIOS, version 2.2 or later.

T

target system
A managed system on which an IBM
Director task is performed.

time to live (TTL)
A technique used by best-effort delivery
protocols to inhibit endlessly looping
packets. The packet is discarded if the
TTL counter reaches 0.

triple data encryption standard (DES)
A block cipher algorithm that can be used
to encrypt data transmitted between
managed systems and the management
server. Triple DES is a security
enhancement of DES that employs three
successive DES block operations.
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TTL  See time to live.

U

universal unique identifier (UUID)
A 128-bit character string guaranteed to
be globally unique and used to identify
components under management.

uptime
The time during which a system is
working without failure.

upward integration
The methods, processes and procedures
that enable lower-level
systems-management software, such as
IBM Director Agent, to work with
higher-level systems-management
software, such as Tivoli Enterprise’ " or
Microsoft SMS.

upward integration module
Software that enables higher-level
systems-management software, such as
Tivoli Enterprise or Microsoft Systems
Manager Server (SMS), to interpret and
display data provided by IBM Director
Agent. This module also can provide
enhancements that start IBM Director
Agent from within the higher-level
systems-management console, as well as
collect IBM Director inventory data and
view IBM Director alerts.

UUID See universal unique identifier.

\'}

vital product data (VPD)
Information that uniquely defines the
system, hardware, software, and
microcode elements of a processing
system.

VPD  See vital product data.

w

Wake on LAN®

A technology that enables a user to
remotely turn on systems for off-hours
maintenance. A result of the Intel-IBM
Advanced Manageability Alliance and
part of the Wired for Management
Baseline Specification, users of this
technology can remotely turn on a server
and control it across the network, thus



walk

saving time on automated software
installations, upgrades, disk backups, and
virus scans.

An SNMP operation that is used to
discover all object instances of
management information implemented in
the SNMP agent that can be accessed by
the SNMP manager.

Windows Management Instrumentation (WMI)

WMI

An application programming interface
(API) in the Windows operating system
that enables devices and systems in a
network to be configured and managed.
WMI uses the Common Information
Model (CIM) to enable network
administrators to access and share
management information.

See Windows Management Instrumentation.

WMI Query Language (WQL)

A subset of the Structured Query
Language with minor semantic changes to
support Windows Management
Instrumentation.

WQL See WMI Query Language.
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keyboard
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M
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requesting access 2
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icon 2
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compatibility xi
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P

padlock icon 2
preferences, setting 2
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documentation xi
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S

Scheduler
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service packs xi
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documentation xi

SNMP devices
definition 1

starting
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T

tasks
IBM Director Console interface 2
Scheduler
Console toolbar 2
terminology
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toolbar
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Message Browser 2
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User Administration 2
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U

user
interface 2

User Administration
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\'

viewing
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w

Web site

IBM Director resources xi

IBM Redbooks xi

IBM ServerProven xi

IBM Support xi

IBM Systems Management

Software xi

IBM xSeries Systems Management xi

Windows High Contrast display 2
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